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From the government, I received this as a gift
I’ll read it, light up my knowledge and practise thrift
On my country’s own behalf, I’ll protect the national resources
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1fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihsPB

fuu mdvu yeoEÍfuka Tng"

² o;a; iy f;dr;=re fjka lr y÷kd .ekSu"

² moaO;shla hkq l=ula o"

² tÈfkod Ôú;fha § olakg ,efnk moaO;s"

² .=Kd;aul f;dr;=rl ,laIK"

² f;dr;=re yd ikaksfõok ;dlaIKh"

² f;dr;=re yd ikaksfõok ;dlaIKfha fhojqï"

² mß.Klfha mßKduh" 

  ms<sn| j wjfndaOhla ,nd .ekSug yels jkq we;'

 1'1      o;a; iy f;dr;=re
 

 fjka fjka jYfhka .;a l, w¾:hla §ug fkdyels wxl" jpk iy i,l=Kq 

o;a; (Data) f,i ye¢kafõ' o;a; f.dkq lsÍfuka iy ilia lsÍfuka w¾:j;a 

f;dr;=re (Information) ,nd .; yels jk w;r tu f;dr;=re" ;SrK .ekSu i|yd 

wmg WmldÍ jkq we;'

WÞyrK 1  

 mdi,a jdr úNd.h wjidkfha § mka;sfha <uhskaf.a kï iy ,l=Kq fjk 

fjk u igyka l<fyd;a bka tlajr úIh yd ,l=Kq ms<sn| woyila ,nd .ekSug 

fkdyels fõ' 

rù 78" 90" 79" 67" 76" 78  ßiajdka 87" 70" 80" 75" 80" 80  l%sIdka 76" 78" 67" 80" 79" 76

 tfy;a fuu ,l=Kq my; wdldrfhka j.= .; l< yels h'

ku NdIdj .‚;h úoHdj b;sydih  fi!LHh bx.%Sis

rù 78 90 79 67 76 78

l%sIdka 76 78 67 80 79 76

ßiajdka 87 70 80 75 80 80

 fuu j.=j ;=<ska <uhskaf.a ,l=Kq ms<sn`o f;dr;=re Èiafõ' tfy;a fuu 

f;dr;=re ks.ukhla i|yd m%udKj;a fkdúh yel'

1 f;dr;=re yd ikaksfõok ;dlaIKh
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fuu j.= .; fldg we;s ,l=Kq .Kkh lsÍulg ,la l< yelsh'

ku NdIdj .‚;h úoHdj b;sydih fi!LHh bx.%Sis uq‍¿ 

,l=Kq‍

idudkH ia:dkh

rù 78 90 79 67 76 78 468 78 2

l%sIdka 76 78 67 80 79 76 456 76 3

ßiajdka 87 70 80 75 80 80 472 78'66 1

 fuu j.=fõ ku" NdIdj" .Ks;h wd§ úIhhka o;a; jk w;r uq¿ ,l=Kq"  

idudkH" ia:dkh wdÈh f;dr;=re fõ' oeka fuu j.=j ;=<ska wjYH f;dr;=re 

.=re;=udg ,nd .ekSug yels nj Tng jegfykq we;' fufia ,nd .kakd f;dr;=re 

.=re;=udg ;SrK .ekSfï § o jeo.;a jkq we;' 

WodyrK 1

o;a; iy f;dr;=rej, fjki y`ÿkd .ekSu i`oyd my; ±lafjk rEm i,ld n,uq' 

WodyrK 2 

  cd;sl ye÷kqïm;la .;a úg tys tla tla ixLHd fjk fjku ie,l+úg 

w¾:hla fkdue;s fia fmkqk o tys wxl msysá ia:dk úYaf,aIKfhka mqoa.,hd 

ms<sn| f;dr;=re ,nd .; yels h'

fuu rEmh fjka 

fjka jYfhka .;a 

úg woyila ,nd .; 

fkdyels h' tfy;a 

.e<mSula iys; j tla  

lsÍfuka fuys isákafka 

mjq,l idudðlhka nj 

wmg jegfya'

rEmh 1'1 - ñksia rEm

rEmh 1'2 - mjq‍,la

cd;sl ye÷kqïm;a wxlh úYaf,aIKh Wmka j¾Ih

ia;%s$mqreI nj



3fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs2

 0 - 4 olajd wxl u.ska mqreIfhl=f.a ye`ÿkqïm;la nj;a ±lafõ'

 5 - 9  olajd wxl u.ska ia;%shlf.a ye`ÿkqïm;la nj;a ±lafõ'   

7 4  2 7 7 1 2 3 7 V
uq,a wxl foflka 

Wmka j¾Ih 

oelaùu

  l%shdldrlu 

o;a; yd f;dr;-=re i`oyd fjk;a WodyrK 5la ,shd olajkak'

 1'2     f;dr;=re moaO;s
 

 tod mEkla" mekai,la fyda fjk;a WmlrKhla wdOdrfhka o;a; ilia lr 

.;a ñksid wo mß.Kl Ndú;fhka o;a; ilia lr .kS'

moaO;shla hkq hï lsis ld¾hla bgq lr .ekSu i`oyd ix>gl lsysmhla 

tlsfklg iïnkaO j l%shd lsÍuhs' 

o;a; ilia lsÍug fhduq lsÍu wdodkh (Input) f,i;a ilia jQ f;dr;=re 

,nd .ekSu m%;sodkh (Output) f,i;a ye¢kafõ' fï ish,af,a tl;=j f;dr;=re 

moaO;shla f,i ye¢kaúh yels h' 

f;dr;=re moaO;sj, o;a; .nvd lsÍu jeo.;a ld¾hhls' hï wjia:dj, 

f;dr;=re ,nd §ug wdÞkh l< o;a; fukau .nvd l< o;a; o Ndú;d fõ'

tfia kï f;dr;=re moaO;shl m%Odk ld¾hh jkafka o;a; ,nd .ekSu;a" 

tajd ilia lsÍu iy iq/lSu;a" wjYH jQ úg wjYH f;dr;=re ,nd §u;a fõ' 

rEmh 1'3 ys oelafjk mßÈ mß.Klh" wm úiska ,nd fokq ,nk o;a; 

wmf.a úOdkhkag wkqj ilia lr wmg wjYH f;dr;=re wjYH wdldrhg ,nd fohs' 

tneúka mß.Klh moaO;shla f,i ye`Èkaúh yels h' 

rEmh 1'3 - mß.Kl moaO;shl ix>gl
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 tÈfkod Ôú;fha § fujeks moaO;s nyq, j Ndú; jk w;r" wmg ióm  

wjia:d lsysmhla i,ld n,uq'

WÞyrK 1 - nexl= moaO;sfhys fhdod .kakd iajhxl%Sh fg,¾ hka;%h 

            (ATM)

fuys§ nexl= ldâm; hka;%hg we;=,;a l< úg o;a; ieliSfï 

l%shdj,shla isÿ ù .sKqu iïnkaO f;dr;=re ,efí'

.sKqfï fYaIh

 ATM ldâm; iy 

h;=re mqjrej
nexl= mß.Kl moaO;sh

f;dr;=re ,eîu

rEmh 1'4 - iajhxl%Sh fg,¾ hka;%h

WÞyrK 2 - meñŒu jd¾;d lsÍu i`oyd wdh;kj, Ndú; flfrk weÕs,s 

     i,l=Kq‍ hka;%h
         

² meñ‚ 

fõ,dj

²   msg jQ 

fõ,dj

rEmh 1'5 - we`.s,s i,l=Kq‍ lshjk hka;%h

f;dr;=re ,eîu

o;a; ilia lsÍu

o;a; ilia lsÍu
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WÞyrK 3 - 

f;dr;=re fijq‍u i|yd Ndú; jk lsõ wd¾ fla;h (QR Code)
fuu lsõ wd¾ fla;h cx.u ÿrl:k  (Smart Phone) u`.ska iqmßlaiSfukaa 

(Scan) wk;=re j ta Tiafia wka;¾cd,h yd iïnkaO ùfuka tu fiajdj fydA 

NdKavh ms<sn`o j jeäÿr f;dr;=re tu wdh;kfha fjí wvúfhka ,nd .; yels 

fõ' 

lsõ wd¾ fla;h Ndú;jk ia:dk : mqj;am;aj," iÕrdj," fjf<| NdKavj, 

m%;sÞkho;a;

  rEmh 1'6 - lsõ wd¾ fla; mÍlaIdj

ieliSu

WÞyrK 4 - fjf<|fmd< f;dr;=re ieliSu 

 my; WodyrKj, fmkajk whqßka" o;a; ilia lsÍu i|yd mß.Klhla 

fyda mß.Kl .; lrk ,o hka;%hla Wmfhda.S lr .kakd nj;a tu.ska ,efnk 

f;dr;=re ;SrK .ekSu i|yd fhdod .kakd nj;a meyeÈ,s fõ'

 

;SrK .ekSu

ñ, § .ekSï" 

úl=Kqï" 

100000" 

j¾Ih" 

wdodhu" 2013" 

2014" ,dNh" 

2000" 50000"

wxlh" úhou" 

w,dNh

  

rEmh 1'7 - fjf<`om< f;dr;=re ieliSu

ilia lsÍu

o;a;

f;dr;=re

m%dfoaYSh YdLd ld¾hd,j, 

udisl wdodhu miq.sh 

jirg idfmalaIj

wvq wdÞhï iys; 

m%foaYj,g m%j¾Ok 

jevigyka meje;aùu
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 o;a; ilia lr .ekSfuka f;dr;=re ,nd .kakd w;r" tu f;dr;=re ;SrK 

.ekSï i|yd fhdod .; yels nj wmg meyeÈ,s h' tfy;a tfia ,nd .kakd iEu 

f;dr;=rla u ;SrK .ekSï i|yd iqÿiq fkdjkq we;' f;dr;=rej, .=Kd;aul nj 

jeo.;ajk w;r tu .=Kd;aul f;dr;=rl ;sìh hq;= ,laIKj,ska iuyrla my; 

±lafõ'

.=Kd;aul f;dr;=rl ,laIK ksoiqk

a)  wod< nj         

 
 

       
mqoa.,fhl=f.a Wiia u wOHdmk iqÿiqlï oelaùu wjYH 

wjia:djl m<uq jif¾ isg u ,enQ wOHdmk úia;r 

bÈßm;a lsÍu wjYH fkdfõ'

b) wx. iïmQ¾K    
 

 

   nj  

rgl tal mqoa., wdodhu .Kkh lsÍu i|yd iq¿‍ 

msßilf.a f;dr;=re muKla ,nd .ekSu m%udKj;a 

fkdfõ' wiïmQ¾K f;dr;=re jerÈ ;SrK ,nd foa'

c) ksrjoH;dj     frda.sfhl= ms<sn`o jerÈ f;dr;=re ffjoHjrfhl=g ,nd 

ÿk fyd;a frda.shdg wk;=rla úh yel'

d) ld,Sk nj       
 

          
f;dr;=re ieu úg u hdj;ald,Sk úh hq;=hs' wo Èk 

,nd .kakd ld,.=K jd¾;d fyg Èkfha ld,.=Kh 

;SrKh lsÍug fhda.H fkdfõ'

e) msßjeh wju     

   ùu   

wdh;khla ,dN bmhSï j¾Okh lsÍu i`oyd wjYH 

ie,iqï lsÍug fmr"  /ia lsÍug n,dfmdfrd;a;= jk 

f;dr;=re fjkqfjka wêl msßjehla oeÍug isÿfõ' 

fuh wdh;khg mdvqjls' 

 
 

  l%shdldrlu 

fuh Tn ñ, § .kakd iuyr NdKavj, 

wiqrKfhys ±lSug we;s rEmhls' fuh ;Sre 

fla;h (Barcode) ls' Tn NdKav ñ, § 

.kakd wjia:dfõ § fjf<`o wdh;k úiska 

;Sre fla; lshjkh (Barcode Reader) Ndú;d 

lrk wdldrh ksÍlaIKh lrkak'

fuh Tn ñ, § .kakd fyda 

mqia;ld,fhka ,nd .kakd fyda 

iuyr fmd;aj, msgqmi msgqfjys 

olakg ,efí' fuh (ISBN) 
cd;Hka;r iïu; fmd;a wxlh fõ'

rEmh BrEmh A

my; § we;s rEmh A iy rEmh B ksÍlaIKh lrkak'

(A)
(B)

fuu ISBN wxlh wdÞkh f,i Ndú;d lr Tng ,nd .; yels f;dr;=re  

fudkjd o hkak mqia;ld,dêm;s yuqù ±k.kak'
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 1'3      f;dr;=re yd ikaksfõok ;dlaIKh

o;a; ms<sfj<lg ilia lsÍfuka f;dr;=re ,nd .kakd nj;a" tu f;dr;=re 

wmg ;SrK .ekSug Wojq jk nj;a wms bf.k .;suq' fufia wm ,nd .kakd jQ 

f;dr;=re fjk;a wfhl= fyda fjk;a mßirhla fyda iu. yqjudre lr .ekSu 

f;dr;=re ikaksfõokh lsÍu fõ' 

wE; w;S;fha mgka u ñksid o;a; ilia lr f;dr;=re ,nd .ekSu;a 

yqjudre lr .ekSu;a lf<a h' túg fndfyda ÿIalr;dj,g uqyqK mEug isÿ jQ  kuq;a 

;dlaIKfha ÈhqKqj;a iu. u f;dr;=re ilia lr .ekSu iy yqjudre lr .ekSu 

b;d myiq lreKla ù we;'

o;a; ilia lr f;dr;=re njg m;a lsÍug;a" tAjd .nvd lr .ekSug;a 

yqjudre lr .ekSug;a  ;dlaIKh úúOdldrfhka fhdod .efka' fuh f;dr;=re yd 

ikaksfõok ;dlaIKh kï fõ' 

 1'4      f;dr;=re yd ikaksfõok ;dlaIKfha fhojqï

wo jk úg lafIa;% /il f;dr;=re yd ikaksfõok ;dlaIKh fhojqï 

olakg ,eìh yels w;r ta w;ßka lsysmhla fufia f.dkq lr oelaúh yels h'

rEmh 1'8 - f;dr;=re yd ikaksfõok ;dlaIKfha fhojqï

  l%shdldrlu 

by; (a) - (e) olajd jQ ,laIK i|yd fjk;a WodyrKh ne.ska 

,shkak'
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1'4'1 b - rdcfha fhojqï (e - Government) 

rchla" f;dr;=re yd ikaksfõok ;dlaIKh fhdod .ksñka ;u rfgys 

mqrjeishka" iud.ï" rdcH yd rdcH fkdjk ixúOdk iy fjk;a rgj, rdcHhka 

iu. iïnkaO;d meje;aùu b-rdcHh  (e - Government) f,i oelaúh yels h'

 WÞyrK jYfhka fuu iïnkaO;d i|yd Y%S ,xld rcfha fjí msgqj" rdcH 

f;dr;=re flakaøh" f;dr;=re yd ikaksfõok ;dlaIKh wdh;kh ^ICTA& jeks 

rch yd iïnkaO fjí wvú .; yel' rch yd iïnkaO j lghq;= lr .ekSfï § 

iy rdcH f;dr;=re ,nd .ekSfï § we;s jk wmyiq;d fndfyda ÿrg j<lajd .ekSug 

fï ksid yels ù ;sfí'

³ b - rdcHfha iïnkaO;d (http://www.gov.lk)
   

rEmh 1'9 - b - rdcH iïnkaO;d
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1'4'2 wOHdmk lafIa;%fha fhojqï 

     tod       wo

                                    

fmd;a w;r isr ù f;dr;=re /ia l< ld,h fï jk úg l%u l%ufhka 

wmf.ka ÿria ù hñka mj;S' myiq ia:dkhl myiq wdldrfhka ys¢ñka ´kE u 

fõ,djl uq¿‍ f,dj u oel .ekSfï yd wOHhkh lsÍfï jdikdj fï jk úg 

Tng;a ,eî we;' ta f;dr;=re yd ikaksfõok ;dlaIKfha ÈhqKqj ksid h' 

f;dr;=re yd ikaksfõok ;dlaIKh Tnf.a wOHdmkhg Wojq jk wdldr 

fndfyduhla we;;a bka iuyrla fufia f.dkq lr olsuq'

 

1' YS% ,xld rcfha fjí msgqj" rdcH f;dr;=re flakaøh" f;dr;=re yd 

     ikaksfõok ;dlaIK wdh;kh (ICTA ) jeks rchg iïnkaO fjí  

 wvú yd iïnkaO jkak'  tu.ska rfÜ mqrjeishka jk Tng ,nd .; 

 yels f;dr;=re iy m%fhdack 5la ,ehsia;= .; lrkak'

2' my; rgj,aj,ska ,nd .; yels b- rdcH fiajdjka 5la wka;¾cd,fha  

  fidhd tAjd ,ehsia;=.; lrkak'

       WÞ - uef,aishdj" isx.mamqrej" tx.,ka;h

  l%shdldrlu 

  

rEmh 1'10 - wOHdmkh i|yd f;dr;=re yd ikaksfõok ;dlaIKh
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a)  mka;s ldurfha § 
mka;s ldurfha § mß.Klh iy wka;¾cd, myiqlï úúOdldrfhka 

wOHdmkh i|yd fhdod .kq ,nhs' bka iuyrla my; ±lafõ'

• mß.Kl wdY%s; iu¾mk (Presentations) 
Ndú;h

• mÍlaIK iys; ùäfhda o¾Yk 

• mß.Kl weiqfrka ks¾udK lsÍu ^msx;+r 

iy ùäfhda ilia lsÍï&

• iÕrd" ,sms" f,aLk ilia lsÍu iy uqøKh 

lsÍu     

• wOHdmksl l%Svd Ndú;h

• CD-ROM  udOHfhka f;dr;=re wOHhkh

• wka;¾cd,h Tiafia wOHdmksl f;dr;=re /ia lsÍu

b) ´kE u ;ekl § ´kE u fõ,djl § wOHdmkh ,eîu 
Tng mß.Klhla iy wka;¾cd, myiqlï 

we;akï" ksjfia isg fyda fjk;a myiq ia:dkhl 

§ fyda wjYH fõ,djl § wOHdmkh  ,nd .ekSug  

mq¿‍jk' WÞyrK f,i - 

• www.schoolnet.lk
• keKi, (nenasala.lk) 
• b-;lai,dj 

(www.e-thaksalawa.moe.gov.lk/)
• úÿ ux fm; (www.vidumanpetha.com)

jeks fjí wvú Wmfhda.S lr .ksñka 

wOHdmkh jeä ÈhqKq lr .ekSu i|yd ;udg ßis fõ.fhka iajhx wOHhkfha 

fh§ug Tng mq¿‍jk' tfia u ksjfia isg u wka;¾cd,h fhdod .ksñka .=rejrfhl= 

yd iïnkaO ùug (Web Based Training (WBT) yd Web Based Learning) ;=<ska 

jeä ÿr wOHdmkh ,eîug Tng yelshdjla ,eî we;' tu.ska .ukd.uk wmyiqj 

wjuùu" ld,h b;sß ùu iy úvdj wju ùu jeks jdis /ila ,efí' 

rEmh 1'12 - ´kEu ia:dkhl § 

´kEu wjia:djl § wOHdmkh

 

• by; olajd we;s fjí wvúj,g msúfikak' tu fjí wvú ;=<ska  

   Tnf.a wOHdmkh i`oyd fhdod .; yels wx. ,ehsia;= .; lrkak'

•  BBC Bitesize (www.bbc.co.uk/education) ys we;s úoHdj" f;dr;=re 

  yd ikaksfõok ;dlaIKh" .Ks;h jeks úIhhka wOHhkh lr  

   tys idïm%Þhsl bf.kqï l%uj,g idfmalaI j we;s jdis 3la ,ehsia;= .; 

  lrkak'

  l%shdldrlu 

rEmh 1'11 - mka;s 

ldurfha § mß.Klh
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c)  b.ekaùu i|yd .=rejrhdg wdOdrlhla ùu

.=rejrhdg mdif,a § b.ekaùï wdOdrlhla 

f,i f;dr;=re yd ikaksfõok ;dlaIKh fhdod 

.ekSug yels fõ' 

• úia;r lr §ug wmyiq mdvï i|yd rEm igyka" 

iÔùlrK iy ùäfhda o¾Yk fmkaùu' 

• bf,lafg%dksla iu¾mk (Presentations) fhdod 

.ksñka úIhhg wdl¾IKhla we;s lsÍu iy  

mejreï ,nd §u'

• mß.Klh fhdod .ksñka mdvï igyka ilia lsÍu' 

• wka;¾cd,h u.ska úIhkag wod< f;dr;=re ,nd .ekSu' 

d)  bf.kq‍ï l<ukdlrKh

 mdi,a wOHdmk l<ukdlrKh iy Wiia wOHdmk l<ukdlrKh i|yd 

bf.kqï l<ukdlrK moaO;shla (Learning Management System - LMS) fhdod 

.ekSu fndfyda rgj, olakg we;' fuu moaO;shla yd iïnkaO ùug wka;¾cd, 

myiqlï ;sìh hq;= w;r mdi, fyda wdh;kh fyda i;= fjí wvúfha ,shdmÈxÑ úh 

hq;= h' 

 my; rEmfha ±lafjk mßÈ bf.kqï l<uKdlrK moaO;s u.ska YsIHhkag 

yd .=rejrekag fiajd /ila ,nd .; yels h'

 

 

rEmh 1'13 - .=rejrhdg b.ekaùï 

wdOdrlhla f,i

rEmh  1'14 -  bf.kqï l<ukdlrK moaO;sh
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bf.kqï l<ukdlrK moaO;shl we;s myiqlï;

YsIHhdg mdie,a l<uKdldß;ajhg

mdif,a §" ksjfia § fyda myiq ia:dkhl § 

isg wjYH fõ,djl § (anywhere any time) 
bf.kqï tall yd iïnkaO ùfï yelshdj

.=Kd;aul bf.kqï tall moaO;shg tl;= 

lsÍug yelsùu

mdi,a mejreï ksjfia § ksu lr tie‚ka 

Wvq.; ^Upload& lsÍfï yelshdj

 mejreï wëlaIKh iy m%;sM, oelaùu

ixjdo uKavmhla ^Forum& yd iïnkaO ùu 

u.ska .eg¨ bÈßm;a lsÍfï" woyia oelaùfï 

yd ms<s;=re ,nd .ekSfï yelshdj

YsIH" .=re iy mdi,a f;dr;=re 

l<ukdlrKh iy hdj;ald,Sk lsÍfï 

yelshdj

ùäfhda o¾Yk u.ska úIh iu.dó 

l%shdldrlï yd iïnkaO ùfï yelshdj

ixjdo uKavmhla ^Forum& yd iïnkaO ùu 

u.ska woyia oelaùu" ms<s;=re ,nd .ekSfï 

yelshdj'

ld, mßÉfþo fjka lr oelaùug" iajhxl%Sh 

iSkq moaO;shla Ndú; lsÍu

foudmshkag orejkaf.a wOHdmk m%.;sh  

ksjfia isg u oek .; yels ùu

b - ;emE, u.ska foujqmshka" mdi,a ixj¾Ok 

iñ;sh iy mdi,a m%cdjg wjYH f;dr;=re 

heùu iy f;dr;=re ,nd .ekSfï myiqj'

e) ieug u Wiia wOHdmkhg <Õd ùfï yelshdj
f;dr;=re yd ikaksfõok ;dlaIKfha ÈhqKqj;a 

iu. u ´kE u rgl isg" ;ukag leu;s wdldrfha 

wOHdmk wdh;khla yd iïnkaO ùu ;=<ska idfmalaIj 

wvq úhoulska Wiia mdGud,djla yeoEÍug Tng;a yels 

h' fuh ud¾.ia: ÿria: wOHdmkh ^Online Distance 
Learning& f,iska ye¢kafõ'

ÿria: wOHdmkfha .;s ,laIK

• kuHYS,s ld, rduqjla ;=< myiq ia:dkhl isg wOHdmkh yeoEÍug we;s 

yelshdj 

• mdGud,d ,shdmÈxÑfha § ,nd fok wxls; mqia;ld, iïnkaO;dj

• ud¾..; (online) mejreï iy m%Yakdj,s

• ud¾..; .=rejrfhl= yd iïnkaO ùfï myiqlï 

• WmfoaYk fiajd myiqlï ,nd .ekSug we;s yelshdj

rEmh 1'15 - 
 ÿria: wOHdmkhg
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1'4'3 fi!LH lafIa;%fha fhojqï 

fi!LH lafIa;%fha § Ndú; jk kùk ;dlaIKfhka hq;a WmlrK ksid 

fndfyda ld¾hhka myiq ù we;' bka lsysmhla kï"

rEmh 1'16 - kùk fi!LH WmlrK

Y,Hl¾u i|yd fhdÞ 

.kakd ùäfhda oiq‍ka 

,nd .; yels leurd 

iys; WmlrK 

ffjoHjreka iy 

fyÈhka mq‍yq‍Kq‍ lsÍu 

i|yd fhdÞ .kakd 

kùk WmlrK

f;dr;=re iy ffjoH 

jd¾;d iq‍/lSu yd tAjd 

uq‍øKh i|yd fhdÞ 

.kakd mß.Kl wdY%s; 

Wml%u

wmf.a fi!LH /ljrKfha § f;dr;=re yd ikaksfõok ;dlaIKh Ndú; 

jk wjia:d fndfyduhla we;' bka wjia:d lsysmhla fufia olsuq'

1' ffjoH mÍlaIK i|yd f;dr;=re yd ikaksfõok ;dlaIKh Ndú;h

frda. y÷kd .ekSug iy m%;sldr ,nd §ug iu;a b;d ÈhqKq ;dlaIKfhka 

hqla; hkaf;%damlrK úYd, m%udKhla fï jk úg ksmojd we;' fuu.ska frda.h 

W;aikak ùug fmr frda.h y÷kd .ekSug o iqÿiq m%;sldr i|yd fhduq ùug o yelss 

ù we;' bka iuyrla fufia h:
WodyrK 1 - mß.Kl.; wdlaIl YÍr ia;r tlaiaf¾ hka;%h 

        (CAT - Computerized Axial Tomography Machine) 
fuu hka;%h 

u.ska YÍrfha wNHka;r 

fldgia fjka fjka 

jYfhka ;%sudK f,i rEm 

.; l< yels h' frda. 

;;a;ajhka y÷kd .ekSu 

i|yd fuh fndfyda 

WmldÍ fõ' 
  

rEmh 1'17 - CAT hka;%h rEmh 1'18 - ;%sudK f,i 

PdhdrEm
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WodyrK 2 - pq‍ïnl wkq‍kdo  uQ¾;k  hka;%h 

              (MRI - Magnetic Resonance Imaging Machine)                                                
 f¾äfhda ;rx. 

iy m%n, pqïnl 

wkqkdo ^fodaxldr& 

u.ska YÍrfha wNHka;r  

fldgiaj, iúia;rd;aul 

rEm igyka ,nd .ekSu 

fuu hka;%h u.ska isÿ 

fõ' frda. y÷kd .ekSfï 

§ fuka u m%;sldr ;SrKh 

lsÍfï § o fuu rEm 

WmldÍ fõ'

WodyrK 3 - úoHq‍;a ;ka;= f¾Çh hka;%h - (ECG - Electrocardiogram Machine)
  yDo iamkaokh 

ksÍlaIKh lsÍu i|yd 

fuu hka;%h fhdod 

.efka' yDofha isg YÍrfha 

wfkl=;a bkaøshhka 

fj; reêrh iemhSfï 

§ yDofha  we;s jk 

úoHq;a iamkaokhg wkqj 

ksmojk ;rx. m%ia;dßl 

lvodishl igyka ùu 

fuys § isÿ fõ'

WodyrK 4 - yDofrda. ;sr .ekaùfï hka;% -(Cardiac Screening Machine)
     yDofha l%shdldß;ajh 

mß.Kl ;srhl oelaùu 

fuu hka;%h u`.ska isÿ 

fõ' yDofha reêr kd, 

isyska ùu jeks úúO 

wdidok ;;a;ajhka  

y`ÿkd .ekSug yels 

ùfuka wjYH m%;sldr 

i|yd fhduq lsÍug fï 

ksid myiq fõ'

rEmh 1'19 - MRI hka;%h rEmh 1'20 - iúia;ruh PdhdrEm

rEmh 1'21 - ECG 
hka;%h

rEmh 1'22 - 
ECG igyk

rEmh 1'23 - yDo frda. ;sr 

.ekaùfï hka;%h
rEmh 1'24 - yDo frda. ;sr 

.ekaùfï igyk
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WodyrK 5 - úoHq‍;a ksl¾mr f¾LK hka;%h  

        (EEG - Electro - Encephalography)
     fud<fha 

l%shdldß;ajh igyka 

lsÍu i|yd fuu 

WmlrKh fhdod .kq 

,nhs' ysia ln,g w,jk 

,nk" m%udKfhka  

l=vd" f,day ;eá ^úoHq;a 

w.%& u.ska fud<fhka 

ksl=;a lrkq ,nk 

úoHq;a iamkaok .%yKh 

lr fud<fha l%shdldß;ajh rEmjdyskS ;srhl igyka lrkq ,nhs' frda.shd wjÈfhka 

fuka u ksod isák úg o fuu hka;%h u.ska wjYH igyka ,nd fohs' 

WodyrK 6 - reêrfha iSks mÍlaId lsÍfï WmlrKh 

                (Blood sugar testing machine)
 reêrfha iSks mÍlaIdj 

i|yd fhdod .kakd fuu WmlrKh 

u.ska reêr idïm,h mÍlaId 

lr reêrfha we;s iSks ;;a;ajh 

fmkakqï lrhs'

WodyrK 7 - reêr mSvkh uksk hka;%h 

           (Blood Pressure Testing Machine ) 
  w;a m<|kdjlg iudk 

fuu hka;%h frda.shd úfõlS j 

fuka u l%shdldÍ j isák úg o 

me<| isàfuka wjia:djg wkqj 

reêr mSvkfha fjkia ùu uek 

.; yels h' 

rEmh 1'25 - EEG hka;%h rEmh 1'26 - EEG igyk

rEmh 1'27 - reêrfha iSks 

mÍlaIdj

rEmh 1'28 - reêr mSvkh 

mÍlaIdj
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2' ÿria: fi!LH /ljrKh (Telemedicine)

 f;dr;=re yd ikaksfõok ;dlaIKh fhdod .ksñka frday,lska msg; 

ia:dkhl isák frda.sfhl= ksÍlaIKh lsÍu fyda frda.shd wi, isák fi!LH 

fiajlfhl=f.ka fyda ffjoHjrfhl= u.ska m%;sldr lsÍu ÿria: fi!LH  

/ljrKh (Telemedicine) fõ' frday,a úfYaI{ uOHia:dkhl isák úfYaI{ 

ffjoHjreka f.a yd frda.shd wi, isák fyÈhka fyda ffjoHjreka yd ine¢hdjla 

mokï lr .;a ikaksfõok cd,hla jk fuhska Tng we;s jdis /ils' bka lsysmhla 

fufia oelaúh yels hs'

WodyrK 1 - ÿria: fi!LH Wjgeka 

  (Remote Clinical Care)                                                                           

 frda.shl=g m%Odk frday,la yd iïnkaO ùug 

fkdyels jQ wjia:djl ^k.rfhka neyer  m%foaYhl 

§" .=jka hdkdjl § fyda .uka kejl §& tu ia:dkfha 

isák frday,a mqyqKqj ,enQ fi!LH ks<Odßfhl= 

úiska ikaksfõok cd,hg iïnkaO fjñka frday,a 

úfYaI{jrfhl=f.a Wmfoia wkqj yÈis m%;sldr ,nd § 

frday, fj; heùu'

rEmh  1'29 - ÿria: fi!LH  /ljrKh

frda.shdf.a ksji

yÈis fi!LH 

wdrlaIK

frda.shd wëlaIKh

 i;aldr tallh

frday,a f;dr;=re 

cd,h

uQ,ia:dkh

^frday,a úfYaI{ uOHia:dkh& 

ÿria: mq‍yq‍Kq‍j

ÿria: ffY,l¾u
.=jka hdkdj$ 

.ukakeõ

ÿIalr m<d;a 

frday,

.s,ka r:h

ÿria: idhksl 

Wjgeka 

rEmh 1'30 - yÈis fi!LH 

Wjgeka
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WodyrK 2 - ksjfia isg wëlaIKh  

frda.shd ksjfia r|jd Tyqf.a$wehf.a 

;;a;ajh mÍlaId lsÍu i|yd wka;¾ine¢ 

mÍlaIK hka;%hla (Linked Home Monitoring 
System) fhdod .ekSu iy m%;sldr wjYH jQ úg 

frday,a .; lsÍug wjYH ikaksfõok myiqlï 

we;s lsÍu'

 

WodyrK 3 - Wmfoia ,nd .ekSu 

  úfYaI{ ffjoHjrhd frdayf,a 

fkdue;s wjia:dj, § oeä i;aldr tallhg 

wjYH Wmfoia úfYaI{ ffjoHjrhdf.ka ,nd 

.ekSug yels ùu'

                                                                     

WodyrK 4 - ÿria: Y,Hl¾u 

 úfYaI{ ffjoHjreka fkdue;s 

frday,l ffjoHjrekayg yÈis Y,Hl¾uhla 

lsÍug wjYH wjia:djl § ikaksfõok cd,hg 

iïnkaO fjñka úfYaI{ ffjoHjrfhl=f.a 

^msgrgl fyda k.rno isák& Wmfoia wkqj 

Y,H ffjoHjrfhl= úiska Y,Hl¾uh lsÍug 

yels ùu'

      

WodyrK 5 - ÿria: mq‍yq‍Kq‍j   

 frday,a ld¾h uKav, mqyqKqfõ § b;d  

wdikak;u mqyqKq uOHia:dkhl ikaksfõok 

cd, iïnkaO;dj fhdod .ksñka fjk;a rgl 

fyda k.rhl isák iïm;a Þhlfhl=f.ka  

úfYaI{ Wmfoia iy mqyqKqj ,nd .ekSug yels 

ùu'

rEmh 1'31 - ksjfia isg u frda.h 

wëlaIKh lsÍu

rEmh 1'32 - Wmfoia ,nd .ekSu

rEmh 1'33 - ÿria: Y,Hl¾u

rEmh 1'34 - ÿria: mqyqKqj
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1'4'4 lDIs l¾udka;fha fhojqï 
      

 lDIs l¾udka;h ;=<  o kj fmr<shla we;s lsÍug f;dr;=re yd ikaksfõok 

;dlaIKh iu;a ù  we;' f.dú;efka § o" i;aj md,kfha § o" ëjr l¾udka;fha § 

o f;dr;=re yd ikaksfõok ;dlaIKfha fhÿï fndfyduhla olakg we;' 

1' f.dú;ekg f;dr;=re yd ikaksfõok ;dlaIKh
;udf.a ld,h yd Y%uh fndfyda f,i jeh lrñka f.dú;eka l< f.dúhd 

i|yd b;d kùk ;dlaIKfhka hq;= iajhxl%Sh hka;% iQ;% rdYshla ksmojd we;' 

fuu.ska f.dúhdf.a ld¾h myiq ùu muKla u fkdj b;d Wiia ;;a;ajfha fnda. 

fjf<|fmd<g ksl=;a lsÍfï yelshdj o Tyqg ,eî we;'

ÈhqKq rgj,a fuka u ÈhqKq fjñka mj;sk rgj,a o f.dú;eka i|yd fhdod 

.kq ,nk tjeks hka;% iQ;% lsysmhla my; ±lafõ'

WodyrK 1

ld,.=K  ñKq‍ï hka;%

fuu.ska ld,.=Kh" j¾Idm;kh" iq<x 

ÈYdj wd§ ;;a;ajhka fmkakqï lrkq ,nhs' ta 

wkqj fnda. j.djg iy wiajkq fk<Sug  iqÿiq 

ld, jljdkqj ;SrKh lsÍug yels jkq we;'

WodyrK 2

iajhxl%Sh lDñ md,k hka;%h                                     

 fuu hka;%h u.ska j.dj,g lDñkaaf.ka jk ydks j<ld .; yels h' lDñka 

isák ÈYdj yd j¾Okh jk wdldrh mß.Kl ;srfhka kSÍlaIKh lsÍug fuu.ska 

yelshdj ,efí'

rEmh 1'35 - ld,.=K ñKqï hka;%h

rEmh 1'36 - iajhxl%Sh lDñ md,k hka;%h



19fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs18

WodyrK 3 

j.d ìfuys ;;a;ajh 

uksk hka;%h

fuu hka;%h u.ska 

j.d ìfuys ;;a;ajh 

^f;;ukh" ire ksire 

nj& mÍlaId lr fnda. 

i|yd iqÿiq nj ;SrKh lrkq ,nhs'

WodyrK 4

iajhxl%Sh c, iemhq‍u (Drip irrigation)                                   
 iajhxl%Sh j l%shd 

lrk fuu hka;%h wm 

úiska ,nd fokq  ,nk 

o;a;j,g wkqj l%shd 

lrñka j.d ìug wjYH 

c,h md,khlska hq;= j 

imhkq ,efí' tu ksid 

wkjYH c, mßfNdackh 

iy c,h fkdue;s 

ùfuka f.dú;eka úkdY 

ù hdu j<lajd .; yels ù ;sfí'

WodyrK 5

iajhxl%Sh j,a me< bj;alrKh

j.d ìul fnda. w;r tyd fuyd 

.uka  lrñka ,nd § we;s Wmfoiaj,g wkqj 

fnda. iy j,a me< fjka lr  y÷kd f.k 

j,a me< .,jd bj;a lsÍu i|yd fuu hka;%h  

m%fhdackhg .efka' 

WodyrK 6

frdfnda  ;dlaIKfhka 
me< isgq‍ùu

úYd, j.d ìul 

me< tyd fuyd f.k 

hdug;a me< w;r we;s 

mr;rh taldldÍ f,i 

mj;ajd f.k isgùug;a 

fuu frdfnda hka;% fhdod 

.kq ,nhs'

rEmh 1'37 - j.d ìfuys ;;a;ajh uksk hka;%h

rEmh 1'38 - iajhxl%Sh c, iemhqï moaO;s

rEmh 1'39 - iajhxl%Sh j,a me< 

bj;alrKh

rEmh 1'40 - frdfnda ;dlaIKfhka me< isgqùu
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WodyrK 7

frdfnda  ;dlaIKfhka wiajkq‍ fk<Su
ksÍlaIKh  u.ska fnda.fha 

;;a;ajh mÍlaId lsÍu iy tu.ska 

jd¾;d ,nd .ekSug o" úYd, j.d ìul 

wiajkq fk<Sfï wmyiq;d u.yrjd 

.ekSu  i|yd o fhdod .kakd frdfnda 

hka;% we;' 

WodyrK 8

yß;d.dr (Greenhouses) 
fNda. j.dfõ 

§ f.dúhdg ;u 

njfnda. iajdNdúl  

jHikhkaf.ka ^;o 

wõj" jeiai" WIaK;ajh" 

iS;," lDóka" jix.; 

wdÈfhka& wdrlaId 

lr .ekSu i|yd 

fyd| úi÷ula f,i  

yß;d.dr ye¢kaúh yels 

h' yß;d.dr md,kh 

i|yd f;dr;=re yd ikaksfõok ;dlaIKh fhdod .ekSfuka j.djkag iqÿiq f,i 

wd¾ø;dj" wdf,dalh" c,h iy jd;h md,kh lrkq ,efí' b;d Wiia ;;a;ajfha 

ÿ¾,N fnda. ksIamdok fjf<| fmd<g tlalsÍug fï ksid yels ù ;sfí'

1'4'5 i;a;aj f.dúfmd< i`oyd fhojqï

WodyrK 1

.=jka úÿ,s ix{d ye÷kq‍ï  

WmlrKh 

 i;=ka .Kkh lsÍu" y÷kd 

.ekSu iy isákd m%foaYh oek 

.ekSu i|yd i;=kaf.a YÍrfha .=jka 

úÿ,s ix{d ye÷kqï (RFID-Radio 
Frequency Identification Device) 
WmlrKh iú lrkq ,nhs'

rEmh 1'41 -  frdfnda ;dlaIKfhka wiajkq 

fk<Su

rEmh 1'42 - yß;d.dr (Greenhouses)

rEmh 1'43 - .=jka úÿ,s ix× ye÷kqï WmlrK 

(RFID-Radio Frequency Identification Device)
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WodyrK 2

;;a;aj md,kh

iajhxl%Sh j 

l%shd;aul jk fuu 

hka;%h t<fokqkaf.a 

fi!LH mÍlaIdj" lsß ,nd 

.ekSu" lsßj, ;;a;aj 

mÍlaIdj i|yd fhdod .kq 

,nhs'

WodyrK 3

wdrlaIdj i|yd 

fidr i;=rkaf.ka o fjk;a 

Wmøjj,ska o f.dúfmd< wdrlaId lr 

.ekSu i|yd mshejQ mßm: rEmjdyskS 

leurd (Closed Circuit TV (CCTV)) 
fhdod .kq  ,efí' fkd/yeka ̂wireless& 
;dlaIKh u.ska iïnkaO lr we;s úg  

msgia;r ia:dkhl isg jqjo f.dúfmd< 

ksÍlaIKh l< yels h'

WodyrK 4                                                                

f.dúm< l<ukdlrKh                                                              

 f.dú uy;d ;u f.dúfmd< ms<sn| j jd¾;d ;nd    

.ekSug;a" ,dN w,dN .Kkh i|yd;a" fiajlhskaf.a jegqma 

ms<sn| f;dr;=re .nvd lr ;nd .ekSug;a iqÿiq fhojqï 

iys; tyd fuyd f.k hd yels mrs.Kl ^Laptop, Tablet 
PC, Smart Phone& fhdod .kshss' fuu.ska wka;¾cd,hg 

iïnkaO ù fj<|fmd< ;;a;ajh ksÍlaIKh lsÍug;a" 

f;dr;=re yqjudre lsÍug;a ld,Sk f;dr;=re ,nd .ekSug;a 

yels ù ;sfí'

1'4'6 ëjr l¾udka;fha § 

ëjr l¾udka;fha § 

fhdod .kq ,nk fuu ixfõol 

WmlrK uiqka isák m%foaY 

y÷kd .ekSfuka wk;=re j tu 

f;dr;=re ikaksfõok ;dlaIK 

l%u Ndú;fhka ëjr hd;%dj, 

we;s mß.Kl fj; ,nd fohs'

rEmh 1'44 - iajhxl%Sh j lsß ,nd .ekSu iy ;;a;aj mÍlaIdj

rEmh 1'45 - mshejQ mßm: rEmjdyskS leurd

 (Closed Circuit TV (CCTV)

rEmh 1'46 - mß.Kl 

Ndú;fhka f.dúm< 

l<ukdlrKh

rEmh 1'47 - ixfõol WmlrK rEmh 1'48 - f;dr;=re 

ikaksfõokh lsÍu
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1'4'7 l¾udka; iy jHdmdr i`oyd fhojqï 

b;d Wiia ;;a;ajfha ksIaamdok ìys lsÍug;a" ñksia Y%uh wju f,i 

fhdod .ksñka úhou wvq lr .ekSug;a l¾udka; iy jHdmdr i|yd f;dr;=re yd 

ikaksfõok ;dlaIKh fhdod .efka' fuu.ska mdßfNda.slhdg Wiia ;;a;ajfha 

ksIamdok wvq uqo,lg ,nd.; yels ù ;sfí'

l¾udka; i|yd f;dr;=re yd ikaksfõok ;dlaIKh fhdod .ekSu fufia olsuq'

tod l¾udka; i|yd fiajlhska úYd, msßilf.a Y%uh wjYH jQ kuq;a fï 

jk úg kùk ;dlaIKfhka ksmojd we;s frdfnda hka;%" ksIamdokh i|yd fhdod 

.kq ,nhs' frdfnda hka;% Ndú;fhka ,efnk jdis iuyrla my; mßos fõ'

24 mefhys u fiajh" fjfyi fkdùu" ld¾hlaIu nj" ksrjoH;dj iy msßisÿ nj

 ksIamdokfha § frdfnda ;dlaIKh fhdod .kakd wjia:d lsysmhla my; rEm 

igyka u.ska ±lafõ' 

rEmh 1'49 - l¾udka; i`oyd f;dr;=re yd ikaksfõok ;dlaIKh fhdod .ekSu 

wotod

rEmh 1'50 - mß.Kl ksIamdokh

rEmh 1'53 - jdyk ksIamdokh

rEmh 1'52 - NdKav weisÍu

rEmh 1'55 - fnda;,a msrùu

rEmh 1'51-  weiqreï ksIamdok

rEmh 1'54 - NdKav f,an,a lsÍu
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WodyrK 1

ùäfhda iïuka;%K

jHdmdr i|yd f;dr;=re yd 

ikaksfõok ;dlaIKh Ndú; lsÍu 

u.ska jHdmdr lghq;= myiq lr 

.ekSug yels nj my; i`oyka o¾Yk 

u.ska meyeÈ,s fõ'

ùäfhda iïuka;%K ^Video 
Conferencing) l%uh Ndú; lsÍu ksid  

úúO m%foaYj, isák jHdmdr idudðlhska iu. ixjdo meje;aùfï myiqj ,eî we;' 

fuu.ska iïuka;%K i|yd úfYaI ia:dkhla wjYH fkdfõ' .ukd.ukh i|yd .; 

jk ld,h" Y%uh iy úhou wju lr .ekSug mq¿‍jk'

WodyrK 2

udkj iïm;a l<ukdlrKh

fiajlhskaf.a meñŒu igyka 

lsÍu i|yd fhdod .kakd weÕss,s i,l=Kq 

iqmsßlailh ^Finger Print Scanner& 
iy ldâ m;a lshjkh ^Card Reader& 
u.ska wdh;kfha idudðl;ajh y÷kd 

.ekSu" meñKSu yd msgùu" ksjerÈ 

j igyka ùu" Bg wkqrEm j jegqma 

ieliSu" iqÿiqlï" ksjdvq .ekSï wd§ 

wfkl=;a úia;r we;=<;a lr ;eîu 

ksid wdh;k mßmd,kh myiq fõ'

 weÕs,s i,l=Kq iqmsßlailh iy ldâ m;a lshjkh jHdmdrhkays muKla 

fkdj fï jk úg fndfyda rdcH wdh;khkays o Ndú; lrkq ,nhs'  

WodyrK 3

b-nexl= moaO;s (e-Banking System) 
 b-nexl= moaO;s ksid jHdmdßlhskag fuka 

u wmg o b;d myiqfjka nexl= yd .kqfokq lsÍfï 

yelshdj ,eî ;sfí' tkï"

³  iajhxl%Sh fg,¾ hka;%h ^ATM& u.ska ´kE u 

fõ,djl ´kE u ia:dkhl § uqo,a ,nd .ekSfï 

yelshdj'

³  wka;¾cd,h yd iïnkaO ù we;s neúka Y%S ,xldj 

;=< muKla fkdj fjk;a rgl isg fyda .kqfokq 

lsÍfï yelshdj' 

³  b ¡ nexl= moaO;sh ;=< ,shdmÈxÑ ù we;s úg myiq 

ia:dkhl isg Tnf.a cx.u mß.Klfhka" ÿrl:kfhka ì,am;a f.ùu" nexl= 

w;r uqo,a yqjudrej" .sKqu mÍlaId lsÍu wdÈfhys yelshdj' 

rEmh 1'57 - we`.s,s i,l=Kq 

iqmsßlailh
  (Finger Print Scanner)

rEmh 1'58 - ldâm;a 

lshjkh

  (Card reader)

rEmh 1'56 - ùäfhda iïuka;%Kh  

(video Conferencing)

rEmh 1'59 - b--nexl= moaO;sh 

  (e-Banking System)
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WodyrK 4

ud¾..; idmamq‍ ijdßh (Online Shopping)
 bf,lafg%dksl fjf<|du fkdfyd;a 

ud¾..; idmamq ijdßh ^Online Shopping& hkq 

wka;¾cd,h Tiafia furg fyda msgrgl we;s 

fjf<| wdh;k úiska NdKav fyda fiajd iemhSu;a"  

mdßfNda.slhka úiska NdKav fyda fiajd ñ, § 

.ekSu;a h' mdßfNda.slhd úiska f;dard .kakd 

,o fjf<| wdh;khlska Tyqg fyda wehg leu;s 

wdldrfha NdKavhla fyda fiajdjla myiq ia:dkhl 

isg weKjqï lr f.kajd .; yels h' fuys we;s jdis fufia oelaúh yels h' 

• ´kE u rgl" wka;¾cd,fha we;s fjf<| wdh;khla f;dard .ekSug yels h' 

• 24 mefhys u újD; j ;sîu' 

• myiq ia:dkhl isg NdKav ksÍlaIKh lr weKjqï lsÍfï yelshdj'

• yr ldâ m;a u.sska uqo,a f.ùfï myiqj'

• NdKavh fyda fiajdj ksjig u ,nd .ekSfï myiqj' tneúka .uka úvdj"

    ld,h hkdÈh b;sß lr .ekSug yelsùu' 

1'4'8 .ukd.ukh i|yd f;dr;=re yd ikaksfõok ;dlaIKh

iajhxl%Sh md,k moaO;s

ud¾. ;onoh j<lajñka .ukd.ukh myiq lsÍu i|yd ks¾udKh lr we;s 

moaO;s lsysmhla fufia oelaúh yels h'

WodyrK 1

² mshejQ mßm: rEmjdyskS  

  leurd (Closed Circuit  
      TV (CCTV)) 
 jdyk ;onoh" yÈis 

wk;=re iy kS;s úfrdaë 

l%shdjka ksÍlaIKh lrñka 

iqÿiq wdldrfha l%shdud¾. 

.ekSug fï ksid yelshdj ,eî we;' 

WodyrK 2

 ² úÿ,s ix{d ,dïmq‍ (Traffic Light Control 
System)

iajhxl%Sh j l%shd;aul jk fuu 

moaO;sh k.r uxikaêj, olakg we;'  

fuu.ska jdyk iy mÈlhska yiqrejñka yÈis 

wk;=re wju lr .; yels ù we;'

rEmh 1'61 - mshejQ mßm: rEmjdyskS leurd  

Closed Circuit TV (CCTV)

rEmh 1'60 - ud¾..; idmamq ijdßh 

(Online Shopping)

rEmh 1'62 - úÿ,s ix{d ,dïmq  

(Traffic Light Control System)
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WodyrK 3

 ²  ye÷kq‍ï ixfla; l%uh

     jdyk keje;aùfï 

wx.Khg msúiSfï wjir 

m;la jdykfha iúlr we;' 

jdyk keje;aùfï wx.Khg 

msúiSfï fodrgqfjyss ia:dms; 

moaO;sh u.ska mÍlaId lr tu 

ia:dkfha ,shdmÈxÑ ù we;s 

wxlhla kï muKla f.aÜgqj 

újD; lr fohs' tfia u tu 

ia:dkh wjysr fkdjk f,i 

mÍlaId lsÍu o iajhxl%Sh j 

l%shd;aul fõ' 

   

by; oelajQ WodyrKj,g wu;r j l¾udka; iy jHdmdr i`oyd 

f;dr;=re yd ikaksfõok ;dlaIKh Ndú; lrk wjia:d 3la .fõIKh 

lr jd¾;djla ilikak'

l%shdldrlu 

1'4'9 úfkdaodiajdoh i|yd fhoùï 

 j¾;udkfha § b;du l,n,ldÍ" wúfõlS Ôú; .; lrk ñksidg f;dr;=re 

yd ikaksfõok ;dlaIKh u.ska u|lg fyda wiajeis,a,la ,nd .ekSug yels  

WmlrK ksmojd we;' tjeks WmlrK u.ska"

³  taldldÍ nj ke;s lsÍug ix.S;hg ijka §u'

³  wka;¾cd,hg iïnkaO ù w;miq jQ rEmjdyskS jevigykla fyda leu;s 

Ñ;%mghla keröu'

³  iudc cd, yd iïnkaO ùfuka l,lska yuq fkdjQ fyda msgrgl isák kEoEhska 

iy ñ;=rka w;r f;dr;=re yqjudre lsÍu'

³  by< ;dlaIKfhka ksmojd we;s rEmjdyskS u.ska iqmeyeÈ,s oiqka iys;  

jevigyka keröu'

³  orejka úfõlS j isákd úg Tjqka ksjfia isg u wka;¾cd,h u`.ska fyda 

mß.Klfha ia:dms; wOHdmksl fyda úfkdao l%Svd yd iïnkaO ùu'

³  wka;¾cd,hg iïnkaO ù b-fmd;a m;a lshùu'

³  is;a .kakd ia:dk iy wjia:d leurd.; lsÍu" tjd mß.Klfha iq/lSu wdÈh 

i|yd fhoùug yels ùu'

rEmh 1'63 - ye÷kqï ixfla; l%uh
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 mß.Kl ;dlaIKfha fhÿï ish,a, Tng mß.Kl wdY%s; j we;' kuq;a 

tÈfko Ôú;fha Tn fkd±kqju fndfyda mß.Kl moaO;s Ndú; jk ia:dk we;' 

kjk fudag¾ r:hl l=vd mß.Kl moaO;s iuQyhla mj;S'

 1'5   f;dr;=re yd ikaksfõok ;dlaIKfha wksis m%;sM,
 

 f;dr;=re yd ikaksfõok ;dlaIKh Tnf.a ld¾hhka myiq lrkjd muKla 

fkdj Tnf.a Ôú;hg ióm;u ñ;=rd njg o m;aù we;' Tn fï ñ;=rd wksis f,i 

weiqre lsÍfuka Tng muKla fkdj uq¿‍ uy;a iudchg u wjev isÿjk nj u;hhs'  

bka iuyrla my; ±lafõ'

 � weíneysùu -  mdi,a orejl= fuka u fjk;a mqoa.,fhl= o m%udKh blaujd 

mß.Klh Ndú; lsÍfuka iy mß.Kl l%Svd lsÍfuka wOHdmk lghq;= u. 

yeÍ hdu iy úúO wmyiq;d  ^wlaIs wdndO" fldkafoa wudre" ysfia lelal=u 

wd§h& we;s úu' 

 � iudccd, ;=<ska fkd.e<fmk ñ;=rkaf.a weiqrg m;aùu'

 � wka;¾cd,h úêu;a f,i Ndú; fkdlSÍfuka mß.Kl ffjri ksid mß.Klh 

l%shd úrys; ùu fyda mß.Klhg ydks meñKùu'

 � wka;¾cd,fha fkd.e<fmk fjí msgq yd iïnkaO ùu ksid udkisl úlD;s;d 

we;s ùfuka ;udg o iudchg o wjevla isÿ ùu' 

 � fm!oa.,sl;ajhg ydks jk f,i msx;+r iy ùäfhda mg úlD;s lr ksmoùu

 � nqoaêuh foam, fidrd .ekSu - uDÿldx. fyda l,d ks¾udK wkjirfhka msgm;a 

lsÍu yd fnÞ yeÍu'

rEmh 1'64 - úfkdaodiajdoh i`oyd f;dr;=re yd ikaksfõok ;dlaIKh

iudc cd, 

(Social network)
iïnkaO;d

ix.S;hg ijka §u 

yd Ñ;%mg keröu ^äðg,a& mska;+r rduq

mß.Kl lS%vd

f;dr;=re ;dlaIK 

Ndú;fhka Ñ;%mg 

keröu

äðg,a ;dlaIKfhka hq;= 

rEmjdySkS keröu

b - mqj;am;a iy       

b - fmd;am;a lshùu 

wka;¾cd,fhka .S; 

nd.ekSu (Download) iy 

ijka §u

leurd Ndú;fhka 

mska;+r ,nd .ekSu

úfkdaodiajdoh 

iy úfõlh 

i`oyd 
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 � YdÍßl l%shdldß;ajh wvqùfuka ia:q,Ndjh we;sùu'

 � yqfol,d nj

 fujeks fya;+ ksid f;dr;=re yd ikaksfõok ;dlaIKh ñksidg wjevla 

isÿ lrk nj fndfyda fofkl=f.a u;h ù we;' tfy;a tu.ska ks¾udKh jQ moaO;s 

ñksidf.a fndfyda ld¾hhka myiq lrkd nj wms bf.k .;suq' tneúka f;dr;=re 

yd ikaksfõok ;dlaIKh m%fhdackj;a f,i fhdod .ekSu wmf.a hq;=luls' 

 1'6      mß.Klfha mßKduh

o;a; f;dr;=re njg m;alr .ekSug wmg iyh jkafka mß.Klh nj fï 

jk úg Tng jegfykakg we;ehs is;uq' j¾;udkfha § iajhxl%Sh j l%shd;aul jk 

fndfyduhla mß.Kl moaO;s we;;a mß.Klh o ñksid fuka u úúO hq. miq 

lrñka fuu ÈhqKq hq.h fj; meñK we;'

mß.Klfha wdrïNh jQfha" .Kkh myiq lsÍu i|yd WmlrKhla ksmoùuhs' 

fï fya;=fjka wjqreÿ 5000lg muK fmr § wenlih (Abacus) kï WmlrKh 

ks¾udKh úh' 

 miq ld,fha § fndfydaa WmlrK iy hka;% 

ks¾udKh jQ w;r bka lsysmhla fufia olajuq'

 ² 1642 § Blaise Pascal úiska Adding Machine 
keue;s WmlrKh ksmojk ,È' fuh 

f,dj m<uq jk hdka;%sl .‚; l¾u lrk 

WmlrKh f,i ie,fla'

 ² 1674 Gottfried Wilhelm Von Leibnitz úiska 

Pascal f.a fuu WmlrKh jeäÈhqKq lr 

we;' fuu jeäÈhqKq lsÍu;a iu. u fn§u" .=KlsÍu wdÈh jvd myiqfjka 

lr.; yels úh'

 ² Joseph Jacquard kï m%xY cd;sl úoHd{hd isÿrem;a l%uh (Punch Card 
System) u.ska l%shdlrkq ,nk frÈúhk hka;%hla ks¾udKh lf<a h'

 ² Charles Babbage - isÿrem;a moaO;sh (Punch Card System) ixl,amh Ndú; 

lr Analytical Engine kï WmlrKh ks¾udKh lf<A h' fuu WmlrKfha 

wdÞkh" ilia lsÍu" m%;sÞkh iy wdphkh hk ixl,am fhdÞ ;snq‚' fudyqf.a 

fuu ixl,am mß.Klfha ÈhqKqjg bjy,a ùu ksid fudyq mß.Klfha mshd 

f,i y÷kajkq ,nhs'

 ² Tyqf.a fuu hka;%h i|yd mß.Kl jevigyka ilia lsÍug W;aidy ork 

,o wevd T.iagd ,õf,aia f,dj m%:u mß.Kl jevigyka Ys,amsksh f,i 

ye¢kafõ'

 ² Howard Aiken kï mqoa.,hd úiska yd¾jâ úYajúoHd,fha ;u i.hka iu. 

yd IBM iud.fï iyh we;s j iajhxlrK wkql%óh md,k .Kl hka;%h 

(Automatic Sequence Control Calculator) hk WmlrKh 1944 § ksmojk 

,È' fuh MARK I f,i kï flß‚'

 rEmh 1'65 - wenlih ABACUS
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mß.Klfha mßKduh ms<sn| f;dr;=re fidhd ixlaIsma; jd¾;djla 

lKavdhï jYfhka tla ù" ilikak'

l%shdldrlu 

idrdxYh

 ² fjka fjka jYfhka .;a úg f;dr;=rla ,nd §ug wiu;a rEm" b,lalï" 

i,l=Kq fyda jpk o;a; f,i ye¢kafõ'

 ² o;a; ilia lsÍfuka f;dr;=re ,nd .; yels fõ' f;dr;=re ;SrK .ekSu i|yd 

WmldÍ fõ'

 ² mß.Klh moaO;shls'

 ² o;a; ilia lsÍu i|yd mß.Kl yd mß.Kl .; WmlrK Ndú; flf¾'

 ² o;a; ,nd §u wdodkh f,i;a" f;dr;=re ,nd .ekSu m%;sodkh f,i;a ye¢kafjhs'

 ² f;dr;=rej, .=Kd;aul nj ^wod, nj" wx.iïmQ¾K nj" ksrjoH;dj" ld,Sk 

nj" msßjeh wju ùu jeks ,laIK& jeo.;a fõ'

 ² o;a; wdodkh" ilia lsÍu iy f;dr;=re m%;sodkh moaO;shl ixrpl fõ'

 ² ilia lr .;a f;dr;=re yqjudre lsÍu i|yd ;dlaIKh Wmfhda.S lr .kq 

,nhs' fuh f;dr;=re yd ikaksfõok ;dlaIKh kï fõ' 

 ² f;dr;=re yd ikaksfõok ;dlaIKfha fhojqï u.ska ñksidf.a ld¾hhka myiq 

ù we;' fuu fhojqï rdYshla we;' tkï b-rdcHh" wOHdmkh" fi!LHh" lDIs 

l¾udka;h" jHdmdr" .ukd.ukh úfkdaodiajdoh wdÈh hs'

 ² mß.Kl ixl,am wdrïNh wjqreÿ 5000lg muK fmr § isÿ jqj;a iajhxl%Sh 

wjêfha isg mß.Klfha mßKduh mrïmrd lsysmhlg fnod oelaúh yels h'
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2
mß.Klh y`ÿkd .ksuq'

fuu mdvu yeoEÍfuka Tng"

²   mß.Klfha ,laIK

²   mß.Kl j¾.SlrKh

²   mß.Kl moaO;sfha l%shdj,sh iy tys Wmdx.

²   mß.Klfha uQ,sl fldgia

²   mß.Klhl we;s flfjks

²   mß.Kl cd,

 ms<sn`o j ukd wjfndaOhla ,nd .ekSug yels jkq we;'

    2'1  mß.Klhla hkq l=ula o?
 

 ñksidf.a úúO ld¾hhka myiq lsÍu i|yd moaO;s fhdod .kakd nj wms 

m<uq mßÉfþofha § wjfndaO lr .;suq' tfia kï" 

—mßYS,lhd úiska wdodkh lrkq ,nk fyda moaO;sh úiska /ialr .kq ,nk o;a; 

,nd f.k tu o;a; mßYS,lhd úiska § we;s Wmfoiaj,g wkqj ilia lrñka 

Tyqg$wehg wjYH wdldrfha f;dr;=re m%;sodkh lrk" úÿ,s n,fhka l%shd;aul 

jk WmlrKhla˜ f,i mß.Klh ye¢kaúh yels h'
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mß.Klfhys we;s úfYaI ,laIK ksid th wmg w;HjYH wx.hla njg m;a 

ù we;' bka lsysmhla fufia oelaúh yels h:

fõ.h 
(Speed)

´kE u wdldrfha .Kkh lsÍula i|yd 

mß.Klhg .; jkafka b;d u flá 

ld,hls' ;;amrhl § ñ,shkhlg;a 

jvd jeä m%udKhlska Wmfoia l%shd;aul 

lsÍfï yelshdj mß.Klhg we;'

ksrjoH;dj (Accuracy) ksjerÈ Wmfoia yd o;a;j,g wkqj 

ksjerÈ f;dr;=re ,nd fok nj iaÓr j 

u lsj yels h'

ld¾hlaIu;dj

(Efficiency)
mß.Klhg fjfyila oefkkafka 

ke;' 24 mefhys u tl u wdldrhg 

l%shd lrñka ksjerÈ f;dr;=re ,nd §fï 

yelshdj mß.Klhg we;'

nyqld¾h nj 

^Versatility&
úúO jQ ld¾hhka i|yd fhoúh yels 

ùu mß.Klfha we;s úfYaI ,laIKhls' 

iq/lSfï yd kej; ,nd .ekSfï  

yelshdj 

^Saving and Retrieving&

mß.Klfha o;a; .nvd lrkq ,nk w;r  

tallhla ;=< úYd, jYfhka f;dr;=re 

/ia lr ;nd .ekSfï yelshdj o    

iq/ls f;dr;=re wjYH úfgl b;d 

blaukska ,nd .ekSfï yelshdj o we;'

    mß.Klfha úfYaI ,laIK

    2'2  mß.Kl j¾.SlrKh

tla wjia:djl § Tnf.a ,sms f,aLk ilik mß.Klh ;j;a wjia:djl 

§ l¾udka; Yd,djl hka;% iQ;% yeisrùu fuka u fjk;a wjia:djl § Tnf.a 

frda.S ;;a;aj mÍlaId lr .ekSug o Wmldr lrk nj m<uq mßÉfþofha § Tn 

jgyd .kakg we;'  tfia kï mß.Klh iEu úgl § u tl u fN!;sl iajrEmhla 

fkd.kakd nj Tng jegfykakg we;' 
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 tu ksid wm úiska Ndú; lrkq ,nk mß.Kl" j¾. lsysmhlg fnod 

oelaúh yels h' úúO j¾.SlrK mj;skq ,nk w;r mß.Klfha m%udKhg wkqj yd 

Ndú;d lrkq ,nk ;dlaIKhg wkqj j¾. lsÍu bka iuyrla fõ' ^rEmh 2'1&

rEmh 2'1 - mß.Kl j¾.

mß.Klh j¾.SlrKh

fN!;sl m%udKhg wkqj ;dlaIKhg wkqj

 

    2'2'1 fN!;sl m%udKh wkqj mß.Kl j¾. lsÍu
 

 fuu j¾.SlrKfha § iqmsß mß.Kl" uyd mß.Kl" uOH mß.Kl yd 

fm!oa.,sl mß.Kl jYfhka j¾. 04lg fjka l< yel'

(i)   iqmsß mß.Kl (Super Computers) 
 fuu mß.Kl b;d n, iïmkak 

fõ' fuys§ n, iïmkak hkqfjka 

woyiajkafka ksYaÑ; ld, iSudjl§ l< 

yels ld¾h m%udKh hs' úoHd;aul iy 

bxðfkare lghq;= i|yd o b;d ixlS¾K 

jQ .‚;uh .eg¨ úi£u i|yd o fhdod 

.efkk fuu mß.Kl m%udKfhkaa 

úYd, h" ñ, wêl h' ^rEmh 2'2& tfia 

u ÿ¾,N h' fuu mß.Kl kdid jeks 

wdh;k fuka u úYd, jHdmdr iy hqO 

yuqod lghq;= i|yd fhdod .kq ,nhs'

 

(ii)  uyd mß.Kl (Mainframe Computers)  
 fïjd iqmsß mß.Klj,g jvd fN!;sl m%udKfhka n,fhka iy ñf,ka wvq 

h' uyd mß.Kl ;dlaIKh hkq" mßYS,lhska úYd, m%udKhla" m¾hka; (Terminals)
úYd, m%udKhla fhdod .ksñka tla mß.Klhlg iïnkaO fjñka o;a; iy 

f;dr;=re yqjudre lr .ekSu" ;ekam;a lsÍu iy kej; ,nd .ekSuhss' ^rEmh 2'3" 

2'4& úYd, fjf<| jHdmdrj, o b fj<|dfï § o uyd mß.Kl ;dlaIKh fhdod 

.kq ,nk w;r wka;¾cd,h Ndú; lrñka .kqfokq lsÍu isÿ fõ' úYd, m%udKfha 

fjf<| wdh;kj, fujeks mß.Kl wog;a Ndú; fõ'  

rEmh 2'2 - iqmsß mß.Kl
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(iii)  uOH mß.Kl (Mini Computers) 
1960 oYlfha ks¾udKh lrk ,o uOH mß.Kl uyd mß.Klj,g jvd 

fN!;sl m%udKfhka" n,fhka iy ñf,ka wvq fmdÿ ld¾h mß.Kl f,i o 

ye¢kafõ' mdõÉÑh myiq h' mßYS,lhska lsysm fofkl= úiska m¾hka; (Terminals)
lsysmhla u.ska uOH mß.Klh yd iïnkaO fjñka o;a; yd f;dr;=re yqjudre lr 

.kq ,efí' ^rEmh 2'5" 2'6& uOH m%udKfha jeks wdh;kj," nexl= moaO;s ;=< fuh 

fhdod .kS'

  rEmh 2'6 - uOH mß.Kl (Mini Computers)
rEmh 2'5 - uOH mß.Kl ieleiau

m¾hka; Terminals

zzuydZZ iy zzuOHZZ hk 

jpk ±kg Ndú;fhka bj;a 

ù we;s w;r fiajdÞhl 
(server) mß.Kl f,i 

fïjd j¾;udkfha § 

ye¢kafõ'

rEmh 2'3 - uyd mß.Kl (Mainframe computers)

m¾hka;

Terminals

m¾hka;

Terminals

        uyd mß.Kl

Mainframe computer

rEmh 2'4 - uyd mß.Kl ieleiau
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(iv)   laIqø mß.Kl (Micro Computers) 
 fuh l=vd mß.Klhls' fm!oa.,sl 

m%fhdackh i|yd fhdod .kq ,nk fuu 

mß.Kl wvq Odß;djla iys; u;lhkaf.ka 

fuka u" m%udKfhka o" fõ.fhka o"  ñf,ka 

o" wvq h' tfia u úÿ,s mßfNdackh o wvq h'

 fïi" Wl=,a (Laptop) mß.Kl iy 

wf;a f.k hd yels (Hand held) mß.Kl  
fuu j¾.hg wh;a fõ'

2'2'2 ks¾udK ;dlaIKhg wkqj j¾. lsÍu 
 

mß.Klh l%shd lsÍu i|yd fhdod .kakd ;dlaIKhg wkqj tajd j¾. lrkq 

,nhs' tkï"

(I)   m%;siu mß.Kl (Analog Computers)
mßirfha isÿ jk fjkia ùï ^fõ.h" 

fjda,aàh;dj" mSvkh" WIaK;ajh& jeks m%;siu 

ix{d (Analog signals) y÷kd .ksñka ta wkqj 

l%shd;aul jk mß.Kl m%;siu mß.Kl 

f,i y÷kajkq ,nhs' ^rEmh 2'8& fõ.udml"  

ixfõol iys; ud¾. ,dïmq"  ld,.=K ñKqï 

hka;%h wdÈh fï i|yd WodyrK f,i oelaúh 

yels h'

(II)  ixLHdxl mß.Kl (Digital Computers)
 wm úiska tÈfkod Ôú;fha § mßyrKh 

lrkq ,nk mß.Kl ixLHdxl mß.Kl  

fõ'  fuu mß.Kl ixLHdxl ix{d (Digital 
signals) y÷kd .ksñka l%shd lrhsss' ^rEmh 2'9&

(III)  ñY% mß.Kl (Hybrid Computers)
m%;siu mß.Kl (Analog Computers) iy ixLHdxl mß.Kl (Digital 

Computers) hk foj¾.fhys u iïñY%Khla f,i ñY% mß.Kl ye¢kaúh yels 

h' yDofha l%shdldÍ;ajh ksÍlaIKh lsÍu i|yd frdayf,a § fhdod .kq ,nk ECG 
hka;%h  ñY% mß.Klhls' m%;siu ix{djla jk yDofha l%shdldÍ;ajh y÷kd .ksñka 

th ixLHd; ix{djla f,i mßj¾;kh lr tu ix{d uqøKh lsÍu fuu hka;%h 

u`.ska isÿ lrkq ,nhs'

rEmh 2'8 - m%;siu ix{d

rEmh 2'9 - ixLHdxl ix{d

rEmh 2'7 - fm!oa.,sl mß.Kl
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 2'3      mß.Kl moaO;sfha l%shdj,sh
 

 mß.Kl moaO;shl ld¾hh jkafka o;a; wdodkh lr .ekSu;a" tajd ilia 

lsÍu iy iq/lSu;a" wjYH jQ úg wjYH f;dr;=re m%;sodkh lsÍu;a nj wms bf.k 

.;suq' mß.Kl moaO;shl l%shdldß;ajh i|yd o úúO Wml%u (Devices) tlsfkl 

yd iïnkaO fjñka l%shdlrkq ,nhs' tu l%shdj,sh iy moaO;shl ks¾udKh fufia 

olsuq' ^rEmh 2'10&

rEmh 2'10 - mß.Kl moaO;shl ieliqu 

wdodk Wml%uhla u.ska o by; wdldrhg o;a; iy Wmfoia m%d:ñl u;lh 

fj; ,nd fohs' bka miq fuu o;a; ilia lsÍu i|yd uOH ieliqï tallh fj; 

fhduq fõ' uOH ieliqï tallh úiska ilia lrk ,o o;a; iy Wmfoia" f;dr;=re 

f,i kej; fhduq jkafka m%d:ñl u;lh fj; h' tys § m%;sodk Wml%uhla u.ska 

tu f;dr;=re m%;sodkh lrkq ,nhs' tfia u tu f;dr;=re ;ekam;a lsÍu i|yd 

oaú;Shsl u;lh fj; fhduqùu o oaú;Shsl u;lfhys we;s f;dr;=re wjYH jQ úg 

kej; m%d:ñl u;lh yryd m%;sodkh ùu o isÿ fõ' md,k tallh úiska mß.Kl 

moaO;shl we;s ish¨ Wml%u fj; md,k ix{d ksl=;a lrkq ,nhs' mß.Kl u;lfha 

o;a; yd Wmfoia we;=,;a fõ' mß.Kl jevigyka l%shd;aul lsÍfï § fuu o;a; 

yd Wmfoia uOH ieliqï tAllhg f.k tkq ,nhs'

by; igyfka fldgia w;r o;a; yd Wmfoia .e,Su lv brlska olajd we;s 

w;r md,k tAllh u.ska wfkl=;a fldgia fj; ksl=;a lrkq ,nk m%Odk md,k 

ix× ;ks brlska olajd we;'
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 2'4  mß.Klfha m%Odk fN!;sl ix>gl
  (Basic Physical Components of a Computer)

mß.Kl moaO;sfha l%shdldß;ajh i|yd w;HjYH Wmdx. lsysmhla we;' 

2'4'1 wdodk Wml%u (Input Devices)

mß.Kl moaO;sh fj; o;a; ,nd fokafka wdodk Wml%u u.sks' fujeks 

wdodk Wml%u úYd, ixLHdjla we;' bka lsysmhla fufia oelaúh yels h'

(») h;=re mqjrej (Keyboard)
mß.Klh fj; o;a; wdodkh lrkq ,nk m%p,s; u Wml%uh h;=re mqjrej 

f,i oelaúh yels h' tys ie,eiau idïm%odhsl h;=re ,shkhl fuka jk kuq;a     

w;sf¾l l%shdldrlï i|yd w;sf¾l h;=re fhdod ks¾udKh lr we;' ^rEmh 2'11&

idudkHfhkaa h;=re mqjrej m%udK follska hqla; fõ' tkï h;=re 101$102 

isg h;=re 104 fyda 108 m%udKhka h' h;=re mqjrefjys we;s h;=rej, l%shdldß;ajh 

fufia h'

(»») ±laùfï Wml%u (Pointing Devices)
 ² WodyrK 1 - - uQislh (Mouse) ²

mß.Kl ;srfhys Èiafjk wx. 

oelaùu (pointing) i|yd jQ ckm%s%h u Wml%uh 

uQislh fõ' uQislh hï lsis wx.hla u; 

la,sla lsÍfï § tu o;a;hla f,i  wdodkh 

fõ' ^rEmh 2'12& uQislfhys jï fnd;a;u  

iy ol=Kq fnd;a;u hkqfjka fnd;a;ï  

rEmh 2'11 - h;=re mqjrej

Typing keys - wl=re ,sùu 

i`oyd fhdod .kakd h;=re

Function keys - iqúfYaI jQ l%shd i`oyd 

muKla fhdod .efka

Numeric keys - b,lalï h;=re 

,shkh i`oyd fhdod .kakd

h;=re 

Control keys - l¾irh yd mß.Kl 

;srh md,kh lrk h;=re

Special 
keys - 

úfYAI jQ 

l%shdjka 

i`oyd jQ h;=re

rEmh 2'12 - uQislh

jï 

fnd;a;u

frdaoh

ol=Kq 

fnd;a;u
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foj¾.hla iy ;srh u; Èiajk 

by< my< ;,a¨ lsÍu i|yd 

frdaohla we;' tfia u Wl=¿ 
(Laptop)  mß.Kl i|yd"  

oelaùfï Wml%uh f,i iam¾Y 

mEvh (Touch Pad) fyda uQislh 

fhdod .efka'

 ² WodyrK 2 -- - iam¾Y ixfõ§ 

;srh (Touch screen)
kj;u mß.Kl iy 

cx.u ÿrl:kj, wdodk iy 

m%%;sodk Wmdx.h jkafka iam¾Y 

ixfõ§ ;srhhs' ^rEmh 2'14& fuu 

;srh iam¾Y lsÍu u.ska o;a; 

wdodkh lsÍu isÿfõ' fuh o 

oelaùfï Wmdx.hls' fuys ;srh 

wdodk iy m%;sodk hk folu 

i|yd fhdod .efka'

 ² WodyrK 3 - - fufyhqï háh 
      (Joy Stick)

fufyhqï háh o uQislh 

fuka u mß.Kl ;srh u; 

l¾irh .uka lrùu i|yd fhdod 

.efkk oelaùfï Wml%uhls' 

fuh mß.Kl l%Svd i|yd fhdod 

.kq ,nhs' ^rEmh 2'15&

 ² WodyrK 4 -  - wdf,dal mEk (Light pen)
wdf,dal mEk ;j;a 

oelaùfï Wml%uhls. mß.Kl 

;srfha we;s fukq whs;u oelaùug 

fyda ;srh u; we£ug fyda ,sùug 

fuh fhdod .efka' ^rEmh 2'16& 

fuh fmkqfuka idudkH mEkla 

fuks' fuh mß.Kl wdY%s; 

ks¾udK CAD  (Computer Aided 
Designing) j, § nyq,j fhdod 

.kq ,nhs'

rEmh 2'14 - iam¾Y ixfõ§ ;srh

rEmh 2'15 - fufyhqï háh

rEmh 2'16 - wdf,dal mEk

iam¾Y mEvh

rEmh 2'13 - iam¾Y mEvh
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(iii)  rEm iy ùäfhda wdodkh lsÍfï Wml%u 
        (Imaging and Video Input Devices)

 ² WodyrK 1 -- äðg,a leurdj (Digital 
Camera) 

 äðg,a leurdj PdhdrEm iy ùäfhda 

o¾Yk mß.Klh fj; wdodkh lsÍu i|yd  

fhdod .kq ,nk wdodk Wml%uhls' äðg,a 

leurdfjys m%;sodk Wml%uhla jk ;srhla o 

iys; fõ' ^rEmh 2'17&

 ² WodyrK 2 - - fjí leurdj (Webcam)
 wka;¾cd,h ;=<sska mß.Klh yd 

iïnkaO ù isák wfhl= o¾Ykh lr .ekSu 

fyda ùäfhda o¾Yk ,nd .ekSu i|yd fjí 

leurdj Wmfhda.S lr .kq ,nhs' ^rEmh 2'18& 

fuu Wml%uh Wl=¿ mß.Klhg hdfldg iE¥ 

;srhg (Monitor) by<ska fmkakqï flfrk 

w;r wfkl=;a mß.Kl i|yd ndysr j iïnkaO 

lr .; yels h'

 ² WodyrK 3 - - mshejQ mßm: rEmjdyskS leurd 

    (Closed  Circuit TV  CCTV) 
 mshejQ mßm: rEmjdyskS leurd u.ska 

rEm fyda ùäfhda o¾Yk fyda .%yKh lr 

tu o;a; ta Wmdx.h yd iïnkaO fldg we;s 

mß.Klhg wdodkh lsÍu lrkq ,nhs' ^rEmh 

2'19& fuu Wml%u ud¾. kS;s Í;s wdrlaId lr  

.ekSu i|yd fuka u ia:dkSh wdrlaIdj i|yd o 

fnfyúka fhdod .efka' 

(iv)  iqmsßlail  (Scanners)
 ² WodyrK 1 - - me;,s ;, iqmsßlailh 

    (Flatbed Scanners)
 me;,s ;, iqmsßlailh Pdhd msgm;a 

hka;%h yd iudkj l%shdlrk wdodk Wml%uhls' 

thg fhduq lrkq ,nk m%Njh ^rEmhla fyda 

f,aLkhla& Wml%u ;=< wvx.= f,ai¾ lsrK 

u.ska .%yKh lr ixLHdxl o;a; wdldrhg  

mßj¾;kh lr ;ekam;a lsÍu i|yd mß.Klhg  

wdodkh lrkq ,nhs' ^rEmh 2'20& rEmh 2'20 - me;,s ;, iqmsßlailh

rEmh 2'17 - äðg,a leurdj 

rEmh 2'18 - fjí leurdj

fjí leurdj

rEmh 2'19 - mshejQ mßm:  

rEmjdyskS leurd
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 ² WodyrK 2 - - ;Sre fla; lshjkh 
     (Bar Code Reader)
 fuu Wml%uh u.ska fndfyda 

NdKavj, olakg we;s ;Sre fla;h (Bar 
Code) lshùu isÿ lrkq ,nhss'  ^rEmh 2'21& 

tu ;Sre fla;h wlaIrdxl (alphanumeric) 
w.hla njg mßj¾;kh lr Bg iïnkaO lr 

we;s mß.Klh fj; wdodkh lrkq ,nhs'

 ² WodyrK 3 - - pqïnl ;Ska; wkq,laIK lshjkh  (Magnetic Ink Character 
Reader - MICR)

 fuu Wml%uh olakg we;af;a nexl= 

wdY%s; j h' fplam;l we;s ksrjoH;dj 

mÍlaId lsÍu i|yd fuu Wml%uh fhdod 

.efka' fplamf;ys my; fldgfiys we;s wxl 

lshjd tys wvx.= f;dr;=re ^nexl= fla;h" 

nexl= .sKqï wxlh& mß.Klh fj; wdodkh 

lrkq ,nhs' ^rEmh 2'22&

 ² WodyrK 4 - - m%ldY wlaIr ixcdkk 

Wml%uh  (Optical Character Recognition - OCR Device)
 msgq fndfyda .Kklska  hq;= jQ f,aLk 

b;d flá ld,hlska iqmsßlaId (Scan) lr 

mß.Kl .; lsÍu iy mß.Kl .; lrk 

,o f,aLkh ixialrKh lsÍu i|yd m%ldY 

wlaIr ixcdkkh fhdod .efka' ^rEmh 2'23& 

fuh mqia;ld,j, iy rdcH  wdh;kj, nyq, 

f,i fhdod .kq ,nk wdodk Wml%uhls'

 ² WodyrK 5 - - m%ldY i,l=Kq ixcdkk Wml%uh (Optical Mark Recognition -  
OMR Device) 

 m%ldY i,l=Kq ixcdkkh" i,l=Kq 

y÷kd .ekSu  i|yd fhdod .efkk wdodk 

Wml%uhls' mEfkka fyda mekai,fhka 

i,l=Kq lrk ,o fmdaru" úNd. nyqjrK 

W;a;r m;% wdÈh ,l=Kq lsÍu i|yd nyq, 

j fhdod .kq ,nk fuu iqmsßlailh u.ska 

fmr ksYaph lrk ,o ia:dkj, we;s i,l=Kq 

lshjd i,l=K tys we;s njg mß.Klh fj; 

o;a; wdodkh lrkq ,nhs' ^rEmh 2'24&

rEmh 2'21 - ;Sre fla; lshjkh

rEmh 2'22 - pqïnl ;Ska;  wkq,laIK 

lshjkh

rEmh 2'23 - m%ldY wlaIr ixcdkkh 

rEmh 2'24 - m%ldY i,l=Kq ixcdkkh 
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 ² WodyrK 6 - - Khm;a fyda yrm;a lshjkh$ iajhxl%Sh fg,¾ hka;%h 

    (Automated Teller Machine - ATM)
   nexl= l%ufhys tla wx.hla jk fuu 

Wml%uh u.ska Khm;a fyda yrm;a u.ska  .KqfoKq 

lsÍu myiq lr we;' ^rEmh 2'25& fuys we;s Khm;a 

yrm;a lshjk ^Card reader& Wml%uh fj; fhduq 

lrk Khm;a fyda yrm;a lshjd tys we;s wxl 

mÍlaId lr wka;¾cd,h Tiafia thg wod< nexl= 

.sKqu yd iïnkaO mß.Klh fj; o;a; wdodkh 

lsÍfuka .kqfoKqj i|yd fhda.H;dj mÍlaId 

flf¾' fuys m%;sodk Wml%uhla f,i ;srhla o 

iúlr we;'

(v)  uhsfl%dfmdakh (Microphone)
mß.Klhg Yíoh wdodkh lsÍu i|yd 

fhdod .efkk Wmdx.h uhsfl%dfmdakhhs' 

^rEmh 2'26&

  2'4'2 m%;sodk Wml%u (Output Devices)

mß.Kl moaO;sh úiska ilia lrk ,o f;dr;=re wmg ,nd fok wdldr 

lsysmhla we;' bka iuyrla kï"

(i)     uDÿ msgm; (Soft Copy)
(ii)    oDV msgm; (Hard Copy)
(iii)   Yío (Sound)

(i)  uDÿ msgm;a (Soft Copy)
 uDÿ msgm;a hkq ;srh u; keröu i|yd muKla f;dr;=re m%;sodkh lr 

.ekSu fõ' uDÿ msgm;a wdldrhg f;dr;=re m%;sodkh lrkq ,nk Wml%u /ila 

mj;sk w;r bka WodyrK lsysmhla my; ±lafõ' 

² WodyrK 1 - - mß.Kl ;srh (Monitor/ Screen)
 uDÿ msgm;a wdldrhg f;dr;=re m%;sodkh lrkq ,nk m%Odk u Wml%uh 

jkafka mß.Kl ;srhhs' fuh oDYH m%o¾Yk tallh (Visual Display Unit) hkqfjka 

o ye¢kafõ' mß.Kl ;sr j¾. lsysmhla we;' tkï"

A  - lef;dav lsrK k<h iys; ;srh 

      (Cathode Ray Tube (CRT)  Monitor)
 uq,a hq.fha isg fï olajd m%;sodk Wml%uh 

f,i fhdod .kq ,nk fuu ;sr j¾.h m%udKfhka 

úYd, jk w;r jeä úÿ,s mßfNdackhlska hqla;hs'  

^rEmh 2'27& tu ksid th l%u l%ufhka mdúÉÑfhka 

neyer j  hk nj fmfka' 

rEmh 2'25 - iajhxl%Sh fg,¾ hka;%h

rEmh 2'26 - uhsfl%dfmdakh

rEmh 2'27 - lef;dav lsrK   

      k<h iys; ;srh

lef;dav lsrK k<h
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B  -  øj iaMál m%o¾Ylh 

      (Liquid Crystal Display - LCD)

fuu mß.Kl ;srh me;,s m%o¾Yl 

;dlaIKhg wkqj ksmojd we;' fuu Wml%uh 

kuH iq¨ O%ejK folla w;rg  iaMál $m<sÕ= 

ødjKh tla lrñka ksmojd we;' ^rEmh 

2'28& fuh me;,s núka hqla; ksid;a úÿ,s 

mßfNdackh wvq ksid;a ckm%sh ù we;'

C  -  wdf,dal úfudapl Èfhdav 

(Light Emitting Diode - LED) 
  

øj iaMál m%o¾Ylfhys Ndú; 

lrkq ,nk iaMál$m<sÕ= ødjKh fjkqjg  

wdf,dalh úysÿjk Èfhdav fhdod ks¾udKh 

lr we;s LED mß.Kl ;srh ^rEmh 2'29& jvd 

§ma;sh wjYH jk fmdÿ ia:dkhkays ix{d" 

m%o¾Yl mqjre" fjf<| kdu mqjre wdÈh 

i|yd Ndú; flf¾' wdf,dal úfudapl Èfhdav 

;dlaIKh wo jk úg m%p,s; udOHhla njg 

m;aù we;af;a b;d wvq úÿ,s mßfNdackh ksidhs'

  
 ² WodyrK 2 - - nyq udOH 

m%lafIamlh$m%fclagrh 

      (Multimedia Projector)
 tl jr lsysm fofkl=g kerôh yels 

f,i mq¿,a ;srhlg f;dr;=re m%;sodkh 

lr .ekSug wjYH jQ úg fhdod .kakd 

Wml%uh nyq udOH m%lafIamlhhs' .=rejrhdg  

b.ekajqï udOHhla f,i fhdod .; yels 

iu¾mk (Presentations) fmkaùug o" jHdmdr 

/iaùï meje;aùfï § o" úfkdaoh i|yd ùäfhda 

o¾Yk keröug o fhdod .kq ,nk fuu 

Wml%uh mß.Kl moaO;shg iïnkaO lsÍfuka 

mq¿,a ;srhla u;g wjYH f;dr;=re m%;sodkh 

lr .; yelshs'

rEmh 2'29 - wdf,dal úfudapl 

Èfhdav

 rEmh 2'30 - nyq udOH m%lafIamlh   

rEmh 2'28 - øj iaMál m%o¾Ykh
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(ii)  oDV msgm;a (Hard Copy) 
 iam¾Y l< yels mß.Kl m%;sodk oDV msgm;a f,i oelaúh yelshs' oDv 

msgm;a wdldrhg m%;sodkh lrk Wml%u /ila uqøK hka;% f,i mj;S'

 uqøK hka;% (Printers) 

m%Odk jYfhka uqøK hka;% j¾. follg fnÈh yel'

1'  ix>Ügk uqøK hka;%h  (Impact Printers)
uqøK ;dlaIKfha § ix>Ügk uqøK hka;% m%d:ñl .Khg wh;a fõ' fuys 

hdka;%sl  Wml%uh jkafka uqøKfha ysi (Head) lvodish u; .eàu ;=<ska uqøKh 

isÿ ùuhs' fuu ix>Ügkh ksid th l%shd;aul ùfï § f>daIdldÍ jqj;a tajdfhys 

Ndú; lrkq ,nk ;Ska; ßnka (Ink ribbon) ñ, wêl fkdjk neúka b;d ,dNodhS 

fõ' uqøs; msgm;a ;nd .kakd nexl=" .nvd" wdÈfhys fuu hka;% Ndú; lrkq ,nhs' 

ix>Ügk uqøK hka;% lsysmhla fufia olsuq'

 ² WodyrK 1 - ;s;a kHdi uqølh 

    (Dot Matrix/Printer)
 fuu uqølfha ysi (head) 
fyda bÈlgq jeks ;=vq u.ska ;Ska; 

iys; ßnkh u; .efgñka l=vd ;s;a 

wdldrfhka lvodish u; uqøKh 

flf¾' ^rEmh 2'31&

uqøK hka;%

Printers

1' ix>Ügk uqøK hka;%

(Impact Printers)

	 WodyrK (

	f,ai¾ ;dlaIKh iys; uqøK hka;%h (Leser Printer)
	;Ska; úÿï uqøK hka;%h (Bubble Printer/Ink Jet 

Printer)
	;dm uqølh (Thermal Printer)

	 WodyrK (

	;s;a kHdi uqølh

 (Dot Matrix Printer)
	fma<s uqølh

 (Line Printer)

2' ix>Ügk fkdjk uqøK hka;%

(Non Impact Printers)

rEmh 2'31 - ;s;a kHdi uqølh
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 ² WodyrK 2  -- fma<ss uqølh  (Line Printer)
 jrlg tla fma<ssh ne.ska uqøKh lrk fuu 

uqølh fõ.j;a uqølhls' fõ.j;a fma<s uqølhlg 

úkdähg fma<s 3000 muK uqøKh lsÍfï yelshdj 

we;' ^rEmh 2'32&

2'  ix>Ügkh fkdjk uqøK hka;%h 

       (Non Impact Printers)
fuu uqøK hka;%h yd fhdod .kq ,nk 

lvodish ix>Ügkh ùula fkdjk neúka 

f>daIdldÍ fkdfõ' ,nd fok m%;sodk b;d meyeÈ,s núka hqla; kuq;a fuu uqølh 

i|yd fhdod .kq ,nk udOHhka ̂ ldá%c& ñ, wêl neúka mdúÉÑh ,dNodhS fkdfõ' 

tjeks ix>Ügkh fkdjk uqøK hka;% lsysmhla fufia oelaúh yelsh'

 ² WodyrK 1 - f,ai¾ ;dlaIKh iys; uqøK hka;%h (Laser Printers)
f,ai¾ uqølfha §" lvÞish u;g ldá%chla ^Cartridge& ;=< we;s úh<s ;Ska; 

l=vq (Toner) m;s; ùu ;=<ska uqøKh isÿlrkq ,nhs' ^rEmh 2'33&'

l¿ j¾Kh fuka u úúO j¾K iys; fgdak¾ (Toner) we;s neúka 

meyeÈ,s" .=Kd;aul rEm iy f,aLk m%;sodkh lr .ekSug iqÿiq u Wmdx.h f,ai¾ 

uqølhhs'

  

rEmh 2'32 - fma<s uqølh

rEmh 2'34 - ldá%chla rEmh 2'33 - f,ai¾ uqøK hka;%h 
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 ² WodyrK 2 - ;Ska; úÿï uqøK hka;%h 

    (Bubble/Ink Jet Printer) 
 

 ² ;dm uqølh (Thermal Printer) 

 

²     WodyrK 4 -- ,l=KqqlrKh (Plotter)   
 

 mß.Klh wdY%s; ie,iqï 

ks¾udKlrKfha § ^.Dy 

ks¾udK ie,iqï" k.r ie,iqï" 

kdúl hd;%d  ie,iqï jeks& 

nyq, j fhdod .kq ,nk fuu  

m%;sodk Wml%uh u`.sska  

lvodish u; mEkla tyd 

fuyd .uka lrjñka ie,eiau   

m%;sodkh lrkq ,nhs'
 

(»»») Yíoh (Sound) 

Yíoh m%;sodkh lrkq 

,nk Wml%u kdol fyj;a 

iamSlr f,i oelaúh yels h' 

fmdÿfõ fyda fmdoa.,sl j fyda 

kdoh m%;sodkh lr .; yels 

f,i kdol Wml%u we;' 

 fuu uqølfha § ldá%chla (Cartridge)  ;=<  

n÷kaj, nyd we;s øj ;;a;ajfha ;Ska; (Liquid Ink) 
l=vd isÿre (Nozzles) ;=<sska lvodishg ú§u u.ska 

uqøKh isÿ lrhs'

rEmh 2'38 - iamSlr iy biankqj

rEmh 2'36 - ;dm uqølh

rEmh 2'37 - ,l=KqqlrKh 

rEmh 2'35 - ;Ska; úÿï uqøK 

hka;%h 

WodyrK 3 - ;dm uqqølh (Thermal Printer)
fuu uqqølh fhdod .ksñka f,aLkh  

lvodish u; uqøKh lrkq ,nhs' fjf<| jHdmdr" 

iajhxl%Sh fg,¾ hka;%h wdÈfhys ßisÜ m;a ksl=;a 

lsÍu iy f,an,a uqøKh i|yd nyq, j fhdod .efka' 
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2'4'3 uOH ieliqï tallh (Central Processing Unit - CPU)

mß.Kl moaO;sfha uQ,sl wx.h jkafka uOH ieliqï tallhhs' 

mß.Klfha fud<h f,i y÷kajkq ,nk uOH ieliqï tallh úOdkj,g wkqj 

l%shd;aul jk w;r  fufyhqï moaO;sh ^Operating System& iy fhojqï uDÿldx. 

^Application Software& l%shd;aul lrkakd o fõ' uOH ieliqï tallh m%Odk 

jYfhka fldgia ;=klska iukaú; fõ' tajdfhys l%shdldß;ajh fufia h: 

1' wxl .‚;uh yd ;d¾lsl tallh        

^Arithmetic and Logical Unit -ALU&

ish¨u j¾.fha wxl .‚;uh yd ;d¾lsl 

l%shd isÿ lrhs'

2  md,k tallh ^Control Unit - CU& mß.Kl moaO;sfha ish¨u Wml%u md,kh 

lrhs'

3    frðia;r 

   ^Registers&
wxl .‚;uh yd ;d¾lsl tallh ;=<  

l%shd;aul fjñka mj;sk l%shdj,s i|yd 

wjYH jQ o;a; iy l%shdj,sfha m%;sM, 

;djld,sl j r|jd ;nd .kS'

      uOH ieliqï tAllfha m%Odk fldgia

uOH ieliqï tAllfha fõ.h iy n,h

  uOH ieliqï tAllfha fõ.h uksk tallh y¾Üia ^Hertz - Hz& jk w;r 

tu fõ.h fu.dy¾Üia ^Megahertz - MHz& fyda .s.dy¾Üia ^Gigahertz - GHz& hk 

tallj,ska o ukskq ,nhs' 

2'4'4  mß.Kl u;l (Computer Memory)

o;a; yd f;dr;=re wdphk lsÍfï yelshdjla mß.Klh i;= nj wms bf.k 

.;suq' úúO mß.Kl u;l ^Computer Memory& tfia;a ke;akï wdphk Wml%u 

^Storage Devices& o;a; yd f;dr;=re wdphkh lr .ekSu i|yd fhdod .kakd 

w;r tu u;lj, l%shdldÍ;ajh úúOdldr h' mß.Kl u;l my; wdldrfhka 

j¾.SlrKh l< yels h' ^rEmh 2'39&

  

  

  

  

  

  

  

 

 

fndfyda úg iiïNdù msúiqï u;lh (RAM) m%Odk u;lh f,i ye¢kafjk 

wjia:d we;'

mß.Kl u;lh

Computer Memory

m%Odk u;lh

Main Memory
oaú;Shsl u;lh

Secondary Memory

iiïNdù msúiqï u;lh
RandomAccess Memory (RAM)

mGk ud;% u;lh

Read Only Memory (ROM)
rEmh 2'39 - mß.Kl u;l 



49fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs48

 (»)  m%d:ñl u;lh (Primary Memory)
 uOH ieliqï tAllhg fl,ska u m%fõY úh yels u;lh m%d:ñl wdphkh 

^Primary Storage& f,i o ye¢kafõ' m%d:ñl u;lh j¾. ;=kls' 

∗   iiïNdù msúiqï u;lh Random Access Memory ^RAM&

 iiïNdù msúiqï u;lfhys ^rEmh 2'40& 

ld¾hjkqfha  ilia lsÍug fhduq lrk f;la o;a;  

;djld,sl j r|jd ;nd .ekSuhs' tys r|jd .kakd 

o;a;" mß.Klh l%shd úrys; l< úg ^Switch 
off& u;lfhka bj;a fõ' mß.Klfha úÿ,s n,h 

fkdue;s úg (Power off) o;a; uelShk neúka  

fuu u;lh kYH u;lh ^Volatile Memory& 
f,iska ye¢kafõ' tfia u f;dr;=re m%;sodkh 

lsÍu" ;ekam;a lsÍu iy kej; ,nd .ekSu i|yd 

oaú;Shsl u;lh fj; fhduq lrkafka o iiïNdù msúiqï u;lh Tiafia h' óg miqj 

idlÉPd lrkq ,nk mGk ud;% u;lhg idfmalaIj  lshùfï iy ,sùfï myiqlï 

2u we;'

∗   mGk ud;% u;lh - 

    Read Only Memory ^ROM&

 mGk ud;% u;lfha we;s o;a; mß.Klfhys 

úÿ,s n,h fkdue;s úg (Power off) uelS fkdhk 

neúka iEu úg u fkdfjkia j mj;S' tu ksid 

th kYH fkdjk u;lhls ^Non-volatile Memory&' 
mß.Klfha uQ,sl l%shdj,shg wjYH o;a; iy úOdk 

;ekam;a lr we;af;a mGk ud;% u;lh ;=< h' 

 nfhdia fkdfyd;a uQ,sl wdodk m%;sodk 

moaO;s ^BIOS - Basic Input Output System& úOdk 

jk fïjd mß.Kl ksIamdok wdh;k  úiska mGk ud;% u;lfha l=vd bvl ;ekam;a 

lr mß.Kl ujq mqjrejg iú lr we;' ^rEmh 2'41&

∗ jdrl u;lh - Cache Memory
 jdrl u;lh wfkl=;a u;lj,g jvd m%udKfhka l=vd jqj;a b;d fõ.j;a 

fõ' fuh uOH ieliqï tall u;lh ^CPU Memory& f,i o ye¢kafõ' uOH 

ieliqï tallh ^CPU& iy m%d:ñl u;lh ^Primary memory& w;r w;rueÈhd 

f,i fuh ks;r Ndú; jk o;a; r|jd ;nd .kS' ^rEmh 2'42&

  uOH ieliqï tallh m%:ufhka o;a; iy úOdk ;sfí oehs jdrl u;lh 

^Cache memory& ;=< mÍlaId lr n,d ilihs'  fuu l%shdj,sh ksid uOH ieliqï 

tallfha fõ.h jeä fõ' kuq;a o;a; iy úOdk jdrl u;lfhys fkdue;s úg 

m%d:ñl u;lh fj;ska o;a; iy úOdk ,nd .ksñka tajd jdrl u;lh ;=< ;ekam;a 

lrñka uOH ieliqï tallh fj; fhduq lrhs' jdrl u;lfhys úÿ,s n,h fkdue;s 

úg o;a; uelShk neúka kYH u;l (Volatile Memory) j¾.hg wh;a fõ' 

rEmh 2'40 - iiïNdù msúiqï u;lh

rEmh 2'41 - mGk ud;% u;lh
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(»»)  oaú;Shsl u;lh (Secondary Memory)
 oaú;Shsl u;lh fkdfyd;a oaú;Shsl wdphkh ^Secondary Storage& o;a; yd 

f;dr;=re iaÒr j u ;ekam;a lrkq ,nk Wml%u fõ' fuh ndysr wdphkh ̂ External 
Storage& f,iska o ye¢kafõ' we;=<;ska mß.Kl moaO;shg iïnkaO lrkq ,nk 

wdphk Wml%u fuka u ndysßka mß.Klhg iïnkaO l< yels jQ o tyd fuyd 

f.k hd yels jQ o oaú;Shsl wdphk Wml%u we;' úÿ,s n,h fkdue;s úg o;a; uelS 

fkdhk neúka oaù;Sl u;lh kYH fkdjk (non-volatile) .Khg wh;a fõ' fïjd 

j¾. lsysmhlg fjka l< yels h' ^rEmh 2'43&

1' pqïnl udOH Wml%u - (Magnetic Media Devices) 
 pqïnl udOH Wml%u pqïnl wdfrdamKhla we;s lsÍu ;=<ska o;a; ;ekam;a 

lrkq ,nhs'

 • WodyrK 1 - oDV ;eáh (Hard disk)
 o;a; iy f;dr;=re ;ekam;a lsÍu i|yd fhdod .kq ,nk m%p,s; udOHh 

jk oDV ;eá idudkHfhka olakg we;af;a mß.Klh ;=< h' tfy;a ndysfrka 

mß.Klhg iïnkaO lrkq ,nk oDV ;eá o we;'  Èfkka Èk ÈhqKq jk ;dlaIKh 

ksid úYd, Odß;djlska hq;= jQ oDV ;eá nyq, j olakg we;' oDV ;eáfhys we;s 

o;a; iy f;dr;=re lshùug iy ta u; ,sùug mßYS,lhdg yels h' tu ksid fuu 

udOHh lshùfï iy ,Sùfï u;l ̂ read/ write memory& f,i ye¢kafõ' oDV ;eáfha 

rEmh 2'42 - jdrl u;lh

3'  jdrl u;lh ;=< o;a; 

fkdue;s kï m%d:ñl 

u;lh fj; fhduq fõ'

4'  m%d:ñl u;lfhka o;a; 

jdrl u;lh fj; fhduq 

lrhs' tys ;ekam;a lr  

ilikh fj; fhduq lrhs'

1' o;a; ;sfí ±hs jdrl 

u;lh ;=<  mßlaId lr 

n,hs'

2' o;a; ;sfí kï tAjd  

ilikh fj; fhduq lrhs' 

ld,h b;sß fõ'

m%d:ñl u;lh

 (Primary memory) 

jdrl u;lh 

Cache Memory

uOH ieliqï tallh

(CPU)

rEmh 2'43 - oaú;Shsl u;lh
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Odß;dj 250 GB - 4TB w;r m%udKhla 

jk kuq;a ;dlaIKfha ÈhqKqj;a iu. fuu 

m%udKhka Èfkka Èk fjkia fõ'

oDV ;eáh ks¾udKh ù we;af;a wx. 

lsysmhla tl;= ùfuks'

1' ;eáh (Platter) - fuh f,dayuh" 

we¨ñkshï fyda msÕka ueá (ceramic) 
j,ska ks¾udKh jQ ;eáhla jk w;r 

fuys me;s foflys u o;a; pqïNl    

lafIaa;% Ndú;fhka ;ekam;a lsÍfï 

yelshdjla we;' oDV ;eáhl ma,eg¾ 

lsysmhla ;sìh yels h'

2' iamskav,h (Spindle) - ma,egrh r|jd 

;nd .ksñka th lrljhs'

3' YS¾Ilh (Head) - ma,egrfha we;s 

pqïnl o;a; lshùu iy ma,egrh 

u; ,sùu YS¾Ilh u.ska isÿfõ' tla 

ma,egrhla i|yd by<ska iy my<ska 

YS¾Il folla we;' 

4' welapqfõg¾ ndyqj (Actuator arm)  - 
YS¾Ilh tyd fuyd lrkafka fuu 

ndyqfjks' ma,egrfha ´kE u ia:dkhl 

o;a; ,sùug iy lshùug yels jkafka 

fï ksid h' 

5' úÿ,s iïnkaOlh (Power connector) - 
oDV ;eáfhys l%shdldß;ajh i|yd wjYH 

úÿ,sh i|yd iïnkaO lrhs'

6' IDE iïnkaOlh (IDE Connector) - 
ma,egrh fj; o;a; yqjudre lrhs'

7' welapqfõg¾ (Actuator) - fuhg 

iïnkaO ndyqj tyd fuyd lrk úoHq;a 

wx.hla jk fuh fudagrhla u.ska l%shd 

lrhs'

WÞyrK 2 - pqïnl máh (Magnetic Tape) 
 ,sùfï iy lshùfï fõ.h wvq 

jk w;r by< Odß;djlska hq;= neúka 

o;a; iy f;dr;=re wdrlaId lr ;nd .ekSu 

i|yd muKla u fhdod .efka' fuh nyq,j 

Ndú;hg .efkkafka i¾j¾ mß.Kl j, 

o;a; yd f;dr;=re Wmia: (back up) lsÍug h'

rEmh 2'44 - oDv ;eáh

rEmh 2'45 - pqïnl máh

;eá lsysmhla 

iys; oDV

 ;eáhla 

ndysr oDV

    ;eá 

lsysmhla

  clip art  - pic or a H/D Tnf.a .=re;=udf.a iyh we;sj Ndú;fhka 

  bj;a lrk ,o oDv ;eáhla fidhd.; yelskï uh újD; lr  

  wNHka;r fldgia ksÍlaIKh lrkak'
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2'   m%ldY udOH Wml%u (Optical media devices)
o;a; wxlsl f,i ;eáj, .nvd lr we;s w;r f,ai¾ lsrk uÕska o;a; 

lshùu yd ,sùu isÿjk neúka m%ldY udOH f,i ye¢kafõ' ,nhs' o;a; iy f;dr;=re 
tyd fuyd f.k hdu i|yd nyq, jYfhka fhdod .kq ,nk fuu m%ldY ;eá j¾. 
lsysmhla we;' bka iuyrla my;ska ±lafõ'

Wml%uh

Device
j¾.h 

Type
Odß;dj 

Size
rEmh 
Image

ixhqla; ;eá

CD-ROM
^Compact Disc - Read Only 
Memory&

,shd we;s o;a; iy f;dr;=re 

lshùug muKla fhdod .efka'

650 -  900    
MB

CD-R
^Compact Disc-Write once&

tla jrla muKla iïmQ¾K 

Odß;dj msfrk ;=re o;a; yd 

f;dr;=re ,súh yels h' bka 

miq lshùug muKla fhdod 

.efka' 

CD-RW(Compact Disc 
Re-Writable)

,shk ,o o;a; uld kej; 

,sùfï yelshdj we;'

650 - 900 
MB

ixLHdxl nyqúO ;eá

DVD - ROM
Digital Versatile Disc - 
Read Only Memory

,shd we;s o;a; iy f;dr;=re 

lshùug muKla fhdod  

.efka'

 

4.7 - 9.4 
GB

DVD-R
(Digital Versatile Disc - 
Write Once)

iïmQ¾K Odß;dj msfrk ;=re 

tla jrla muKla o;a; yd 

f;dr;=re ,súh yels h' bka 

miq lshùug muKhs'

DVD-RW
(Digital Versatile Disc - 
Rewritable)

jrla ,shk ,o o;a; uld 

oud lsysm jdrhla o;a; yd 

f;dr;=re ,súh yels h' 

íÆf¾ ;eá 

Blue-ray Disc (BD)  R
(Recordable)

tlajrla f;dr;=re ,súh 

yelsh' bkamiq lshùug 

muKhs'

 
25 - 128 
GB

Blue-ray RE
(Recordable Erasable)

jrla ,shk ,o o;a; j,g 

wu;rj kej; kej;;a oyia 

jdrhla iïmQ¾K Odß;dj

mssfrk;=re o;a; tl;= l< 

yels h' 

Blue -ray 3D
3D ùäfhda má.; lsÍug 

fhdÞ.kS'
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∗   >k ;;a;ajfha Wml%u (Solid state  devices)
 tyd fuyd .uka fkdlrk ^Solid& wx.j,ska hqla; jk neúka fuu Wml%u 

>k ;;a;ajfha Wml%u f,i ye¢kafõ' fuu Wml%u o;a; iy f;dr;=re lshùug 

iy ,sùug Ndú; flf¾' 

WodyrK 1

•  USB iefk,s Odjlh (USB flash drive)
 myiqfjka tyd fuyd f.k hd yels ksid;a"  

fõ.j;a o;a; yeisrùfï yelshdj ksid;a USB  

iefk,s Wml%uhla ù we;' 

WodyrK 2

• u;l ldâm;a (Memory card) 
 USB iefk,s Odjlhg iudk 

l%shdldß;ajhla we;' tfy;aa mß.Klhg 

iïnkaO lsÍfï ;dlaIKh fjkia jk w;r 

m%udKfhka o l=vd h' äðg,a leurd" cx.u 

ÿrl;k iy mß.Kl l%Svd Wml%uhka wdÈfhys 

o fhdod .efka' 

Wod - wdrlaId iys; wxls; ldâ (SD Card - 
Secure Digital Card)

rEmh 2'46 -USB *a,EIa Odjlh 

rEmh 2'47 - u;l ldâm;a

  

 l%shdldrlï

1' pqïNl uOH" m%ldY udOH yd >k ;;;aajfha udOHj, jdis wjdis 

,shd olajkak'

2' Tnf.a .=re;=udf.a iyh we;sj Ndú;fhka bj;a lrk ,o oDv  

;eáhla fidhd.; yelskï th újD; lr wNHka;r fldgia 

ksÍlaIKh lrkak'
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2'5 mß.Klhl flfjks (Computer Ports)
 

 mß.Klh iy mß.Kl Wmdx. fyda fjk;a mß.Kl tlsfkl iïnkaO 

lrk w;=re uqyqK;a flfjks f,i oelaúh yels h' ̂ rEmh 2'48& mß.Klhl flfjks  

msysgd we;af;a mß.Klfha msgqmiska fyda bÈßmiska h' flfjks y÷kd .ekSu i|yd  

ixfla; olajd we;' ish¨u flfjks  ujq mqjrejg ̂ motherboard& iïnkaO lr we;'

1. PS/2 flfjks - 

 h;=re mqjrej iy uQislh mß.Kl moaO;shg 

iïnkaO lsÍu i|yd fhdod .efka' oï 

meye;s j¾Klh iys; flfjksh h;=re 

mqjrej i|yd;a fld< meye;s j¾Klh iys; 

flfjksh uQislh i|yd;a fõ' ^rEmh 2'50& 

tfy;a j¾;udkfha §  h;=re mqjrej iy 

uQislh mß.Kl moaO;shg iïnkaO lsÍu 

i|yd nyq, j fhdod .kq ,nkafka USB  
flfjkshhs' 

2' iudka;r flfjksh (Parallel Port) - uqøK 

hka;%h mß.Kl moaO;shg iïnkaO lsÍu 

i|yd iudka;r flfjksh Ndú; fõ' fuh újr 

25 lska iukaú; h' ^rEmh 2'51&  j¾;udkfha  

fndfyduhla uqøK hka;% mß.Kl 

moaO;shg iïnkaO lsÍu i|yd fhdod  

.kq ,nkafka USB flfjkshhs' 

rEmh 2'47 - u;l ldâm;a

1.PS/2 flfjks 5' Yío Wmdx. flfjks

2' iudka;r flfjks 6. USB flfjks

3. HDMI flfjks 7.Video flfjks

4. RJ 45 flfjks    8' fY%a‚.; flfjks

rEmh 2'49 - flfjks ujq mqjrejg iïnkaO lr we;s wdldrh

rEmh 2'50 - PS$2 flfjks

 rEmh 2'48 - flfjks (Ports)

rEmh 2'51 - iudka;r flfjksh
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3' HDMI flfjksh - úfYaIfhka ,emafgdma 

mß.Klj, olakg ,efnk HDMI flfjksh 

^rEmh 2'52& mß.Kl ;srh ^Monitor&" nyqudOH 

m%lafIamlh" äðg,a rEmjdyskS hka;% iy äðg,a 

Yío jdyskS hka;% iïnkaO lsÍu i|yd fhdod 

.kq ,nhs'

4' cd,lrK flfjksh - RJ 45 fuu flfjksh 

^rEmh 2'53& u.ska" mß.Kl cd,hl we;s 

mß.Kl" cd, ux yiqrej ^Network  Router& 
cd, iaúphg ^Network Switch& iïnkaO lrkq 

,nhs' 

5' Yío Wmdx. flfjks (Audio Port/ Jack) -   
uhsl%f*dak" iamSlr iy bia nkqj (Head Phone) 
jeks Y%jH udOH mß.Kl moaO;shg iïnkaO 

lsÍu i|yd fhdod .kq ,nhs' ^rEmh 2'54&

  ks,a mdg - Yío wdÞkh (Line In) 
  fld< mdg - iamSlr /Yío m%;sÞkh (Line Out, 

 Head Phone)
  frdai mdg - uhsl%f*daka (Microphone)

6' úYaj fY%a‚.; nia flfjksh 

 (USB - Universal Serial Bus Port)  - 
j¾;udkfha § wdodk iy m%;sodk Wmdx. 

fndfydauhla u mß.Klhg iïnkaO lrkq 

,nkafka USB flfjksh u.ska h' ^rEmh 2'55& 

7' ùäfhda flfjksh (Video Port) - .%e*sla flfjksh 

^graphic port& f,iska o y÷kajkq ,nk ùäfhda 

flfjksh mß.Kl ;srh fyda nyqudOH 

m%lafIamlh ^multimedia projector& mß.Kl 

moaO;shg iïnkaO lsÍu i|yd fhdod .kq ,nhs' 

fuh újr 15 lska iukaú; h' ^rEmh 2'56&

rEmh 2'52 - HDMI flfjksh

rEmh 2'53 - cd,lrK flfjksh

rEmh 2'54 - Yío Wmdx. flfjks

rEmh 2'55 - úYaj fY%a‚.; nia 

flfjksh

rEmh 2'56 - ùäfhda flfjksh
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8' fYa%Ks.; flfjksh (Serial Port) -   
mß.Klhla wka;¾cd,g iïnkaO lsÍu 

i|yd fhdod .kq ,nk fudavuh ^modem& 

mß.Klhg iïnkaO lsÍug fhdod .efka' 

j¾;udkfha fuu fljksh fjkqjg USB 
flfjksh fhdod .efka' ^rEmh 2'57&

  Tn Ndú; lrk mß.Klhl we;s flfjks ksÍlaIKh lr tAjd   

  y÷kd .kak'

 l%shdldrlu

  

  

 2'5   o;a; ikaksfõokh (Data Communication) 
 

 o;a; iy f;dr;=re iïfma%IKh ^yqjudre& lr .ekSu o;a; ikaksfõokh 

f,iska ye¢kaúh yelsh' 

 WÞyrK f,i mß.Kl folla fyda lsysmhla w;f¾ o mß.Klhla iy 

uqøK hka;%hla jeks WmlrKhla w;f¾ o o;a; iïfm%aIKh isÿ úh yel'  
fuu o;a; iïfma%IKh i|yd m%Njh yd .%dylhd w;r w;r iïnkaO;djla 

f.dvk.d ;sìh hq;= h' tu iïnkaO;dj cd,.; lsÍu f,i ye¢kafõ'

 2'5'1   o;a; ikaksfõokh i|yd wjYH uQ,sl wx.   
                      

o;a; ikaksfõokh i|yd wjYH uQ,sl wx. my; ±lafõ'

 

     rEmh 2'58

^i& o;a; m%Njh - o;a; iïfma%IKh lrkakd 

^ii& iïfm%aIK udOH - o;a; iïfma%IKh lsÍug fhdod .kakd udOH ^ÿrl:k        

    /yeka (wired)" /yeka rys; (wireless)
^iii& o;a; .%dylhd - o;a;h ,nkakd 

rEmh 2'52 - HDMI flfjksh
rEmh 2'57 - fYa%Ks.; flfjksh

rEmh 2'56 - ùäfhda flfjksh
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 2'5'2 o;a; iïfma%IK úê (Data Transmission Modes)  

 moaO;shlska ;j;a moaO;shlg o;a; iïfm%aIKh l%u lsysmhlska úh yels h' 

tajd kï"

 1&  talm:  (Simplex Mode)
 talm: (Simplex) o;a; iïfma%IKfha § o;a; .uka lrkafka o;a; m%Njfha 

isg o;a; .%dylhd fj; mu‚' rEmjdyskS o¾Yk keröu" .=jka úÿ,shg ijka §u 

WodyrK f,i oelaúh yels h' 

rEmh 2'59

o;a; m%Njh o;a; .%dylhd
 

            

2&  w¾O oaúm:  (Half- duplex Mode)
w¾O oaúm: úêl%ufha § o;a; iïfma%IKh jkafka jrlg tla ÈYdjlg mu‚' tkï 

m%Njfha isg .%dylhd fj;g o;a; iïfma%IKh ùu wjika jQ úg muKla .%dylhdg m%Njh 

fj;g o;a; iïfma%IKh l< yels h' wka;¾cd,h fjdals fgdals ta i`oyd WÞyrK fõ'

o;a; m%Njh fyda o;a; .%dylhd o;a; .%dylhd fyda o;a;  m%Njh

udOHh

Medium

 rEmh 2'60 - fjdals fgdals   

 (Walki talki)

3&  mQ¾K oaúm: (Full Duplex Mode)

mQ¾K oaúm: (full duplex) úêl%ufha § tl úg foÈYdjg u o;a; iïfma%IKh 

fõ' ÿrl:k ixjdo fuu úêl%uhg WodyrKhls'

o;a; m%Njh fyda o;a; .%dylhd o;a; .%dylhd fyda o;a;  m%Njh
udOHh

Medium

rEmh 2'61

 2'5'3 o;a; iïfma%IK udOH (Data Transmission Media)  
 moaO;s w;r iïnkaO;djla f.dv kexùu i|yd jeo.;a jk ;j;a tla  

wx.hla jkafka iïfma%IKh i|yd fhdod .kq ,nk udOHhhs' iïfma%IK udOHhka 

foj¾.hls' tkï" j¾. follg kshuq udOHh yd kshuq fkdjk udOHh f,i  

j¾.SlrKh l< yel' my; rEmh 2'62 fuu foj¾.hg wh;a udOH WÞyrK  

lsysmhla olajd we;'
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3&  mQ¾K oaúm: (Full Duplex Mode)

mQ¾K oaúm: (full duplex) úêl%ufha § tl úg foÈYdjg u o;a; iïfma%IKh 

fõ' ÿrl:k ixjdo fuu úêl%uhg WodyrKhls'

o;a; m%Njh fyda o;a; .%dylhd o;a; .%dylhd fyda o;a;  m%Njh
udOHh

Medium

rEmh 2'61

2'5'3 o;a; iïfma%IK udOH (Data Transmission Media)  
 moaO;s w;r iïnkaO;djla f.dv kexùu i|yd jeo.;a jk ;j;a tla  

wx.hla jkafka iïfma%IKh i|yd fhdod .kq ,nk udOHhhs' iïfma%IK udOHhka 

foj¾.hls' tkï" j¾. follg kshuq udOHh yd kshuq fkdjk udOHh f,i  

j¾.SlrKh l< yel' my; rEmh 2'62 fuu foj¾.hg wh;a udOH WÞyrK  

lsysmhla olajd we;'

rEmh 2'62 - o;a; iïfma%IK udOHhka 
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^i& kshuq  udOH (Guided / Wired)
o;a; iïfma%IKh i|yd fhdod .kakd udOHh fN!;sl udOHhla ^physical 

medium& kï th kshuq udOHhla f,i oelaúh yels h'

• WÞyrK 1 - weUrE lïì hq., (Twisted pair) - 
tlg weUrE ;U lïì hq., o;a; iïfma%IKh 

i|yd fhdod .efka' fïjd wdldr folls'

1' fkdjeiqKq weUrE lïì hq., - (Unshielded 
Twisted Pair - UTP) - ÿrl:k iïnkaO;d 

i|yd fhdod .kakd tlg weUrE ;U lïì hq., 

fkdjeiqKq weUrE lïì hq., f,i oelafõ' fïjd 

b;d kuHYS,s jk w;r ,dNodhS fõ' tfy;aa §¾> 

ÿrlg o;a; iïfma%IKh wjysr lrhs' óg¾ 100l 

Wmßu ÿrlg o;a; iïfm%aIKh i|yd iqÿiq fõ'

2' jeiqKq weUrE lïì hq., (Shielded Twisted Pair 
- STP) -  nßka yd úhoñka wêl kuq;a jeiqKq 

weUrE lïì hq., o;a; iïfma%IK ;;a;ajh 

j¾Okh lsÍu iy wdrlaId lsÍu isÿ lrhs'

• WÞyrK 2 - iulaIl flan,h (Coaxial cable)    
ikakdhl flan, hq.,lska iukaú; iulaIl 

flan,fhys ;U lïì oe,la wdldrhg jQ msg; 

flan,h" uOH flan,h jgd úoHq;a pqïnl;ajhla 

we;s lrkq ,nhs' ^rEmh 2'65& fuu flan,a 

hq.,h ma,diaála wdrlaIKhlska fjka lr 

we;' rEmjdyskS wekafgkd" CCTV flan, 

f,i fhdod .kakd fuu flan, idfmalaIj 

ñf,ka wêl h' 

• WÞyrK 3 - m%ldY ;ka;= - (Fiber optic)  
fuu flan,h o ikakdhl flan, hq.,lska 

iukaú; h' uOHia:h ^core& ùÿre nghla 

o ta jgd isyska ùÿre ;ka;= o ^cladding& 

fuu flan,a hq.,h fjka lsÍug ma,diaála 

wdjrKhla ^Jacket& o we;' ^rEmh 2'66& fuu  

udOHfhys we;s úfYaI;ajh jkafka o;a; 

iïfma%IKfha § wdf,dalh mrdj¾;kh fjñka  

iïfma%IKh ùuhs' fuh rYañ jl%SlrKh f,i 

ye¢kaúh yels h' kùk ÿrl:k cd,j, Ndú; 

fõ' fïjd idfmalaI j ñf,ka wêl fõ' oekg 

mj;sk fõ.j;a u o;a; iïfm%aIK kshuq 

udOHhhs' 

rEmh 2'63 - fkdjeiqKq weUrE 

     lïì hq.,

rEmh 2'64 - jeiKq weUrE 

     lïì hq.,

rEmh 2'65 - iulaIl flan,h

  

rEmh 2'66 - m%ldY ;ka;=
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^ii& kshuq fkdjk udOHh (Unguided/Wireless) 
 fN!;sl udOH fhdod .ekSulska 

f;dr j jd;h yryd ix{d f,i o;a; 

iïfma%IKh lsÍu kshuq fkdjk udOHh 

f,i yeÈkafõ' 

• WÞyrK 1 - .=jka úÿ,s ;rx. (Radio 
waves) o;a; iïfma%IKh i|yd .=jka úÿ,s 

;rx. udOH fhdod .efka' jhs *hs (Wifi) 
iy íÆgQ;a (Bluetooth) .=jka úÿ,s ;rx. 

u; l%shdlsÍï i|yd WodyrK fõ'

• WÞyrK 2 - laIqø ;rx. (Microwaves) 
laIqø ;rx. iïfma%IKfha § o;a; .uka 

lrkafka tla f¾Ldjlg h' ^rEmh 2'68& 

tu ksid iïfma%IK uOHia:dk tlsfkldg 

o¾Ykh úh hq;=hs' uOHia:dk w;r ÿr ;SrKh 

lsÍfï § m%foaYfha N+ úIu;dj i,ld n,kq 

,efí' pkaøsld iïfma%IKfha o (Satellite 
Communication) laIqø ;rx. wdldrhg o;a; 

iïfm%aIKh jk w;r tajd iïfma%IKh 

jkafka o  iïfma%I m%;spdrl ^transponders& 
wdldrhghs' ^rEmh 2'69& ls'ó' 36000 by< 

wyfia r|jd we;s pkaøsld uOHia:dk úiska 

fmdf<dj u; msysgqjd we;s pkaøsld l=¨Kq 

yryd iïfma%IKh jk o;a; .%yKh lr 

.ksñka wjYH l=¨K fj; m%;siïfma%IKh 

lrkq ,nhs' pkaøsld iïfma%IKh u.ska ´kE 

u ÿrlg o;a; iïfma%IKh lr .; 

yels h' wkA;¾cd,fha ikaksfõokh 

i`oyd fuh Ndú; fõ'

• WÞyrK 3 - wfOdarla; lsrK   
   (Infrared)  

rEmjdyskS ÿria: md,lj, fuka u     

/yeka rys; h;=re mqjre iy uQisl 

md,kh i|yd  wfOdarla; lsrK  o;a; iïfma%IK udOHh f,i fhdod .kq ,nhs'

rEmh 2'68 - laIqø ;rx.

rEmh 2'69 - pkaøsld iïfma%IKh

rEmh 2'67 - .=jka úÿ,s ;rx.

rEmh 2'70 - wfOdarla; lsrK

  

 l%shdldrlu

1' ;U lïì Ndú; jk /yeka iy m%ldY ;ka;=j, jdis yd wjdis 

,shd olajkak'

2' o;a; iïfm%aIKh i|yd Ndú; lrk udOHfha fõ.h" ÿr" ñ, 

hkdÈh ie,ls,a,g f.k wÞ, wjia:djg WÑ; udOH ms<sn| 

idlÉPdjla fufyhjkak'
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2'5'4 mß.Kl cd, iïnkaO lsÍfï Wml%u    
         (Computer network connecting devices)

mß.Kl cd,hla we;s lsÍug mß.Kl folla fyda Bg jeä m%udKhla fyda 

;sìh hq;=h' fuu mß.Kl tlsfkl iïnkaO lsÍu i|yd iïnkaO lsÍfï Wml%u 

fhdod .kq ,nhs'

(i)  cd,lrK w;=re uqyqK;a ldâm; ^Network interface card&
 fuh mß.Klhg iú lr we;' wm úiska by; wjia:djl § bf.k .kakd 

,o o;a; iïfma%IK kshuq  udOHhla ^Guided$Wired& mß.Klhg iïnkaO jkafka 

cd,lrK w;=re uqyqK;a ldâmf;ys ^Network interface card& ^rEmh 2'72& we;s 

cd,lrK flfjkshg ^RJ 45& h' fuu udOHh RJ 45 iïnkaOlhla ^rEmh 2'73& 

^connector& uÕsska flfjkshg iïnkaO lrkq ,efí' 

rEmh 2'72 - cd,lrK w;=re uqyqK;a ldâm; rEmh 2'73- iïnkaOlh

rEmh 2'71
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(ii)  iaúph fyda kdNs - (Switch / Hub) 
mß.Kl folla fyda Bg jeä m%udKhla 

fyda w;r iïnkaO;djla f.dvke.Su i|yd 

ueÈy;alre f,i l%shdlrkafka iaúph fyda 

kdNshhs' ^rEmh 2'74& fï iïnkaO;dj i|yd 

kshuq udOHhla ^Guided$Wired& fhdod .efkk 

w;r tla fl,jrla mß.Klfhys we;s cd,lrK 

flfjkshg o ^RJ 45&" wfkla fl,jr iaúph 

fyda kdNsfhys we;s flfjkshlg o iïnkaO 

lrkq ,nhs'

iaúpfhys iy kdNsfhys we;s fjkialï lsysmhla"

m%Odk;u fjki jkafka yqjudre fõ.hhs' mß.Kl cd,fhys we;s mß.Kl 

w;r f;dr;=re yqjudrefõ § kdNsh yqjudre lrkq ,nk f;dr;=re ish¨u mß.Kl 

fj; fhduq flfrk w;r iaúph f;dr;=re fhduq lrkafka wod< mß.Klh fj; 

mu‚' fuys § kdNsh úiska wkjYH ;onohla we;s lrkq ,nhs'

f;dr;=re yqjudrefõ § kdNs l%shd;aul lrkafka  w¾O oaúm: ^half duplex& 
úê l%uhg jk w;r iaúph mQ¾K oaúm: ^Full duplex& úê l%uh fhdod .efka'

(iii) jhs- *hs - (Wireless Fidelity - Wi-Fi)  
wo jk úg mß.Kl cd,lrKfha 

ckm%sh u udOHhla njg m;aù we;af;a  

jhs-*hs ^Wi-Fi& ;dlaIKhhs' fï i|yd  

Wi-Fi (Access Point) Ndú; lrkq ,efí' 

fuu.ssska b;d fõ.j;a mß.Kl cd, 

iïnkaO;djla we;s lsÍug yelsfõ' cx.u 

ÿrl:k yd Wl=¨ mß.Kl i|yd fõ.j;a 

wka;¾cd, iïnkaO;djla we;s lsÍug o fuh 

iu;a h'

(iv) ux yiqrej (Router)
 mß.Kl cd, folla fyda Bg jeä 

ixLHdjl iïnkaO;dj we;s lsÍug fhdod 

.kakd Wml%uh ud¾.lhhs ^Router&' f;dr;=re 

iïfma%IKh i|yd iqÿiq ud¾.h ;SrKh lrkq 

,nkafka ux yiqrej u.sks'

rEmh 2'74 - iaúph fyda kdNs

rEmh 2'75 - jhs- *hs / access points 

rEmh 2'76 - ux yiqrej 
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(v) fudvuh (Modem) - 
 mß.Kl  cd,hl we;s mß.Kl fyda 

ksfjiaj, Ndú; lrkq ,nk fm!oa.,sl  

mß.Klhla ÿrl:k ud¾.hla yryd wka;¾cd,h 

yd iïnkaO lsÍug fhdod .kakd Wmdx.h 

fudvuhhs' fudvuh o;a; mßj¾;lfhl= f,i 

l%shd lrhs' tkï mß.Klfhys we;s wxls; (Digital) 
o;a; yd f;dr;=re ÿrl:k ud¾.fha iïfm%aIKh 

l< yels m%;siu ^Analog& ix{d f,i o ÿrl:k 

ud¾.fha tk m%;siu ix{d f,i mj;sk o;a; yd 

f;dr;=re kej; mß.Klhg wjYH wxls; ix{d 

njg m;alrhs' fïjd ms<sfj,ska MOdulation iy 

DEModulation hkqfjka ye¢kafjk w;r MODEM 

hk jpkh fuu jpk foflys tl;=jls' fudvï 

j¾. lsysmhls' tkï wka;¾ fudvuh ^Internal&"  
ndysr fudvï ̂External& iy flan,a  rys; ̂Wireless& 
fudvï hkqfjks' fudvuh kùk ux yiqrej 

(Router) ;=< iúlr we;'

(vi) .sksmjqr (Firewall)
 .sksmjqr mß.Kl 

cd, wdrlaIl moaO;shls' 

wka;¾cd,h iy mß.Kl 

cd, w;r o;a; iy 

f;dr;=re iïfma%IKh 

md,kh lsÍug wjYH 

úêúOdk fuys wvx.= h' .sks 

mjqr (Firewall) ia:dmkh 

lrkq ,nkafka wka;¾cd,h iy mß.Kl cd,hla w;r wdrlaIl ndOlhla f,ig 

h' fuh uDÿldx. wdldrfhka fuka u oDVdx. wdldrfhka o fj<|fmdf<ka ñ<§ 

.; yels h' tu.ska mß.Kl w;r o;a; yqjudrefõ § wdrlaIdj ,nd foa'

MOdulation - DEModulation

rEmh 2'78 - ndysr fudvuh 

rEmh 2'77 - wka;¾ fudvuh 

rEmh 2'79 - flan,a rys; fudvuh 

.sks mjqr

wka;¾cd,h

mß.Kl cd, 

o;a; yd

f;dr;=re  

rEmh 2'80 - .sks mjqr

(Firewall)
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  mß.Kl fufyhqï moaO;shl we;s uDÿldx. .sks mjqr .ek Tnf.a  

  .=re;=ud .=re;=ó yuqù mÍlaId lr n,kak' 

 l%shdldrlu

  

 2'5'5 fiajd,dNS$fiajdÞhl cd, (Client/ Server network)

rEmh 2'81 - fiajd,dNS$ fiajdfhdað; cd, 

mß.Kl cd,hl fiajdÞhl ^Server& mß.Klh o thg iïnkaO mß.Kl 

fiajd,dNS ^Client& mß.Kl o mj;S' cd, fufyhqï moaO;shla ^Network Operating 
System& ia:dms; lrkq ,nkafka fiajdÞhl ̂ Server& mß.Klhg h' wka;¾cd,fhka 

fyda m%foaYSh cd,hlska o;a; fyda f;dr;=re b,a¨ï lrkakd fiajd,dNsfhl= (Client)
f,io o;a; yd f;dr;=re imhkakd fiajdÞhl (Server) f,i o y|kajkq ,nhs' 

2'5'6 mß.Kl cd, j¾.

• mß.Kl cd, ^Computer network&
mß.Kl cd, N+ñfha msysàu yd Ndú;d lrkakdf.a wjYH;djh wkqj       

j¾.SlrKh l< yels h'

rEmh 2'82 - mß.Kl cd,
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(i) ia:dkSh m%foaY cd,  Local Area Network (LAN)
 tla f.dvke.s,a,l ldurhla ;=< fyda 

ldur lsysmhla iïnkaO lrñka ia:dms; lrkq ,nk  

mß.Kl cd,hla ia:dkSh m%foaY cd,hla ^LAN& 

f,iska ye¢kafõ' ^rEmh 2'83& mdi,la ;=< fyda  

úYajúoHd,hla   ;=<"   l=vd    m%udKfha     jHdmdrhla    ;=<     fyda  

ld¾hd,hla ;=< we;s lrkq ,nk cd,hla WodyrK 

f,iska oelaúh yelsh'

(ii) mqrjr m%foaY cd, 
(Metropolitan Area Network 
- MAN)

  ls'ó 16la fyda Bg 

wvq m%foaYhla wdjrKh jk 

wdldrfhka ia:dk .; lr we;s" 

ia:dkSh m%foaY cd, ̂LAN& lsysmhl   

tl;=jla mqrjr m%foaY cd,hla 

^MAN& f,i ye¢kaúh yels h' 

nexl= cd," YdLd iys; wdh;k 

cd," YdLd iys; úYajúoHd, cd,  

WodyrK f,iska oelaúh yels h'

iii)  mq¿,a m%foaY cd, (Wide Area Network - WAN)  
    b;d mq¿,a m%foaYhla wdjrKh jk mßoafoka 

ks¾udKh flreKq cd," mq¿,a m%foaY cd,  ^WAN& 

f,iska oelafõ' ̂ rEmh 2'85& rgla  ;=<  fuka u rglska  

msgg o  we;s lrkq ,nk cd, iïnkaO;dj mq¿,a 

m%foaY cd, kï fõ' fï i|yd fyd|u WodyrKh 

wka;¾cd,hhs'

LAN, MAN yd WAN i`oyd WodyrK fol ne.ska ,shkak'

 l%shdldrlu

rEmh 2'83 - ia:dkSh m%foaY cd,

rEmh 2'85 - mq¿,a m%foaY cd,

rEmh 2'84 - mqrjr m%foaY cd,
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2'5'7 cd, ia:, úoHdj (Network Topology)

cd,hla ;=< mß.Kl iïnkaO;dj ie,iqï lsÍu iy cd, .; lrk wdldrh cd, 

ia:, úoHdj f,iska oelaúh yels h' úúOdldr cd, ia:, úoHd we;' tkï"

i) ;re wdldrhg cd, .; lsÍu 

      (Star Topology) 
fuh idudkHfhka oelsh yels 

ie,eiauls' kdNsh fyda iaúph flakaøh fldg 

f.k thg mß.Kl iïnkaO lrkq ,nhs' 

^rEmh 2'86&

ii) nihl wdldrhg cd, .; lsÍu 
      (Bus Topology)

m%Odk flan,hla yryd ish¨u 

iïnkaO;d we;s lrñka cd, .; lsÍu 

fuf,i oelaúh yels h' ^rEmh 2'87& 

fuu flan,h fld÷kdráh  ^Backbone&  
f,i ye¢kafjkafka tys isÿ jk ´kE u 

wl%ñl;djla cd,fha we;s mß.Kl ish,a,g 

u n,mdk neúks' cd,lrKfha § fuu 

ie,iqu b;d myiq jk w;r flan, wvq 

m%udKhla jeh jk kuq;a iïnkaO l< yels 

mß.Kl m%udKh iSñ;h'

Ring Topology)

mß.Kl ia:dk .; lr we;af;a 

uqoaol$j<,a,l wdldrhg flan,a u.ska  

tlsfkld iïnkaO lrñka h' ´kE u 

o;a;hla fyda f;dr;=rla fuu cd,h ;=< 

ljdldr j .uka lrhs' tla mß.Klhl 

fyda flan,hl wl%ñl;djla iïmQ¾K 

cd,fha u ì| jeàug fya;= úh yels h'

rEmh 2'87 

nihl wdldrhg cd, .; lsÍu

rEmh 2'86 

;re wdldrhg cd, .; lsÍu

iii) uqoaol$j<,a,l wdldrhg cd, .; lsÍu (Ring Topology)

rEmh 2'88 - uqoaola$j<,a,la 

wdldrhg cd, .; lsÍu
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iv) rela$.il wdldrhg cd, .; lsÍu  

      (Tree Topology)
 ;re wdldrfha ̂Star Topology& cd, .; lsÍï 

lsysmhla nia wdldrfha cd, .; lsÍulg tl;= lsÍu 

rela ie,eiaula f,i oelafõ' fuys we;s jdishla  

jkafka tla tla cd, fjka fjka jYfhka md,kh 

lsÍfï myiqjhs' 

v) oe,la wdldrhg cd, .; lsÍu (Mesh Topology)
         cd,fha we;s ish¨u mß.Kl tlsfkl 

yd iïnkaO lsÍu fuf,i y÷kajkq ,nhs'  

^rEmh 2'90& ixlS¾K iïnkaO;djla neúka md,kh 

wmyiq fuka u msßjeh o wêl h' fuys we;s 

úfYaI;ajh tla mß.Kl cd,hla ì| jegqk o" cd, 

iïnkaO ùug ud¾. lSmhla we;s neúka tu ud¾. 

yryd iïnkaO;dj /£ mej;Suhs' wka;¾cd,h ;=< 

úúO wdldrfha cd, .; lsÍï olakg ,efí' fuh 

ixlS¾K cd, .; lsÍula jqj o fndfyda úg ±,la 

wdldrhg cd, .; lsÍu (Mesh) ±lsh yels h'

2'5'8 cd,lrKfha jdis 

o;a; iy f;dr;=re mß.Kl w;r 

yqjudre lsÍug yels ùu 

cd,lrKfha we;s m%Odk;u jdish 

jkafka b;d myiqfjka iy fõ.fhka 

mß.Kl w;r o;a; iy f;dr;=re   

yqjudre lr .ekSfï yelshdjhs' tfia 

u tu o;a; fyda f;dr;=re fiajd Þhl 

mß.Klhl ;ekam;a lsÍu ;=<ska tu 

cd,h yd iïnkaO ù isák fiajd,dNSkag 

tl u fõ,djl § f;dr;=re ,nd .; 

yels h' 

rEmh 2'89 - rela $.il 

wdldrhg cd, .; lsÍu

rEmh 2'90 - 

oe,la wdldrhg cd, .; lsÍu 
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wvq bvl o;a; .nvd lsÍu

wkjYH wdldrhg tl u o;a;h mß.Kl 

lsysmhl ;ekam;a fkdùfuka ;ekam;a 

lsÍfï bv m%udKh o b;=re fõ'

iïm;a fmdÿfõ mßyrKh lsÍu uqøK hka;%h" iqmsßlailh ^scanner&" 
fudvuh ^modem& wd§ Wmdx. mß.Kl 

cd,hla yd iïnkaO lsÍu ;=<sska tu 

cd,hg iïnkaO ù isák fiajd,dNSkag  

;u mß.Klh iy tu oDVdx. yd 

iïnkaO lsÍfï myiqj we;s fõ'

uOH.; uDÿldx. md,kh lsÍfï 

yelshdj

fmdÿfõ Ndú; l< yels uDÿldx. tla 

tla mß.Klhg fjka fjka jYfhka 

ia:dms; lsÍfï § wkjYH f,i ld,h 

iy uqo,a jeh fõ' tu uDÿldx. fiajd 

odhl mß.Klhl ;ekam;a lsÍu ;=<ska 

cd,h yd iïnkaO ù isák fiajd,dNSkag 

tu uDÿldx. Ndú; l< yels h'

 ´kEu ;ekl § ´kEu fõ,djl § 

iïnkaO ùfï yelshdj 

wka;¾cd,hg iïnkaO ùu ;=<ska 

mßYS,lhdg ´kE u ;ekl § ´kEu 

fõ,djl § ;ukaf.a f,aLk yd o;a; 

iu. iïnkaO úh yels h'

wdrlaIdj fiajdodhl ^Server& mß.Klhlg 

iïnkaO úh yels jkafka wjir ,;a  

fiajd,dNSkag ^Client& muKla neúka tys 

o;a; iy f;dr;=re ;ekam;a lsÍu jvd;a  

wdrlaIs; fõ'

 úoHq;a ;emE, mß.Kl w;r b;d myiqfjka f;dr;=re  

yqjudre  lr.; yels l%uhla jkafka 

úoHq;a ;emE,hss'
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2'5'9 cd,lrKfha wjdis 

o;a; i|yd wvq wdrlaIdj cd,lrKfha tla m%Odk wjdishla  

jkafka o;a; wdrlaId lr .ekSfï  

wmyiqjhs' cd,fha we;s ́ kE  u mß.Klhla 

u.ska o;a; .nvdjg fkdfyd;a fiajd  

Þhl mß.Klhlg iïnkaO úh yels ùu 

ksid mß.Kl Ndú;d lr wkjirfhka 

o;a; ,nd.kakkaf.ka wdrlaId lr 

.ekSfï wmyiqj'

cd, ì|jeàu iuyr cd, ie,iqï l%uj, § tla 

mß.Klhl fyda flan,hl ì|jeàu 

cd,fha we;s  wfkl=;a mß.Klj, 

l%shdldß;ajhg n,mdhs'

ffjri mß.Kl cd,fha we;s tla  

mß.Klhlg fyda mß.Kl ffjri  

we;=¿ùfuka wfkla mß.Klj,g o th 

me;sr hdug we;s yelshdj'

mß.Kl fodaI m%Odk mß.Klfha fodaI fyda ì|jeàu 

ksid wfkl=;a mß.Kl o l%shd úrys; 

ùug we;s bv lv'

mqyqKq wjYH;d cd,hla md,kh lsÍu úfYaI mqyqKqjla 

<;a mqoA.,fhl= wjYH fõ'
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² mß.Klhla hkq" 

∗ mßYS,lhd úiska wdodkh lrkq ,nk fyda moaO;sh úiska /ialr .kq 

,nk fyda o;a; ,nd f.k tu o;a; mßYS,lhd úiska § we;s Wmfoiaj,g 

wkqj ilia lrñka Tyqg$wehg wjYH wdldrfha f;dr;=re m%;sodkh lrk" 

úÿ,s n,fhka l%shd;aul jk WmlrKhla f,i ye¢kaúh yels h'

² mß.Klfha úfYaI ,laIK jkafka ilia lsÍfï fõ.h" ksrjoH;dj$ 

úYajdijka; nj" ld¾hlaIu;dj$WfoHda.su;a nj" nyqld¾h nj" ;ekam;a lsÍfï 

yd kej; ,nd .ekSfï yelshdj hs'                   

² mß.Kl j¾.SlrK" 

 ∗  m%udKhg wkqj j¾. lsÍu ( iqmsß mß.Kl " uyd mß.Kl" uOH mß.Kl"  

   laIqø mß.Kl 

 ∗ ks¾udK ;dlaIKhg wkqj j¾. lsÍu ( m%;siu mß.Kl" ixLHdxl  

    mß.Kl" ñY% mß.Kl

² mß.Kl moaO;shl Wml%u 

 ∗ wdodk Wml%u 

 ∗ m%;sodk Wml%u 

 ∗ uOH ieliqï tallh( wxl .‚;uh yd ;d¾lsl tallh" md,k tallh"  

   u;l frðia;r 

 ∗ m%d:ñl u;lh$m%Odk u;lh 

 ∗ oaú;Shsl u;lh

 mß.Klfha m%Odk fN!;sl ix>gl  (Physical Components of a Computer)
∗ moaO;s tallh - System Unit" h;=re mqjrej -Keyboard" uQislh - Mouse"                     
  mß.Kl ;srh (Monitor/ Screen)

² ndysr Wml%u mß.Klhlg iïnkaO lrkq ,nkafka flfjks u.ska h'

² o;a; ikaksfõokh i|yd wjYH uQ,sl wx. jkafka o;a; m%Njh" iïfma%IK 

udOHh" o;a;h iy .%dylhd h'

² o;a; iïfma%IK úê (Modes)
 ∗ talm:  (Simplex - Mode)
 ∗ w¾O oaúm: (Half- duplex Mode)
 ∗ mQ¾K oaúm: (Full Duplex Mode)

idrdxYh
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 ² o;a; iïfma%IK udOHhka (Data Transmission Medium)

  ∗ kshuq  udOH Guided" kshuq fkdjk udOH Unguided/ Wireless jYfhka  

  fldgia folls'

² mß.Klhla ;j;a mß.Klhla yd iïnkaO lsÍfï Wml%u we;'

² mß.Kl cd, j¾. LAN, MAN,  WAN h'

• mß.Kl iïnkaO lsÍfï ie,eiau cd, ia:, úoHdj kï fõ' 

Star Topology - ;re wdldrhg cd, .; lsÍu 
Bus Topology - nihl wdldrhg cd, .; lsÍu  
Ring Topology - uqoaola/ j<,a,la wdldrhg cd, .; lsÍu

Tree Topology - rela .il wdldrhg cd, .; lsÍu

Mesh Topology - ±,la wdldrhg cd, .; lsÍu

• cd,lrKfha jdis fuka u wjdis o we;' 
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3
mß.Kl moaO;sfha o;a; 

ksrEmKhg Ndú; lrk l%u

fuu mdvu yeoEÍfuka Tng" 

² mß.Kl o;a; ksrEmKh"

² oYuh" oaúuh" wIaguh yd IâoYuh ixLHd moaO;s"

² ixLHdjl jeä u yd wvq u fjfiis ia:dkSh w.h"

² oYuh ixLHd oaúuh" wIaguh yd IâoYuh ixLHd njg mßj¾;kh"

² oaúuh" wIaguh" IâoYuh yd oYuh ixLHd w;r mßj¾;kh"

² o;a; wdphk Odß;dj"

² mß.Klj, Ndú; flfrk fla; l%u'

  ms<sn`o j ukd wjfndaOhla ,nd .ekSug yels jkq we;'

 3'1 mß.Kl o;a; ksrEmKh

pdkl  (  wxck" Thdg fï b,a¨ï m;%h mß.Klh Ndú;fhka ilia lr   

 fokak mq¿jka o@  

wxck (  mq¿jka" uu th lr, fokakï' tfykï Thd fïl lshjkakflda'   

 Tkak tfykï wms h;=re,shkh lruq ' “Application …..” 
pdkl    ( wxck" h;=re mqjrefjys “A” h;=r ;o l<du th mß.Klh y`ÿkd   

  .kafk fldfydu o@ 

iór ( wms ta .ek wfma .=re;=udf.ka wyuq' 

cks;d ( i¾" fldfydu o h;=re mqjrefõ “A” wl=r ;o l,du th 

     mß.Klfha ksrEmKh jkafka @

.=re;=ud ( <uhs" my; oelafjk rEmh n,kak' ^rEmh 3.1)
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rEmh 3'1 - mß.Klfhys “A” wlaIrh ksrEmKfhys mshjr

.=re;=ud    (     fï mshjr wkqj ''A'' wl=r mß.KlfhA Èiajk wdldrh meyeos,s 

      we;s fkao@

iór$cks;d   (     fndfydu ia;+;shs i¾
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3'1'1 ixLHd moaO;sh

mß.Klh Ndú; lrñka wm wl=re fyda jpk h;=re ,shkh lsÍfï § 

mß.Klh u.ska tu wl=re fyda jpk thg f;areï .; yels ixLHd f,i ksrEmKh 

lr .kS' mß.Klhg f;areï .; yels fuu ixLHd iuQyh zzixLHd moaO;shZZ la 

f,i ye¢kafjk w;r ixLHd moaO;sfha  ''digits'' kñka ye|skafjk iSñ; b,lalï 

ixLHdjlska iukaú; h' fuu ixLHdj, jákdlu tAjd ixLHdj ;=< msysgk ia:dkh 

u; r|d mj;S' 

f,dj m%:u .Kl hka;%h f,i ie,flk wenlih ys o ixLHd moaO;s 

ixl,amh ;snqKq w;r" th wo mß.Klh olajd ÈhqKq ù we;' 

mß.Klfhys o;a; ksrEmKh i|yd fhdÞ.kakd ixLHd moaO;s my; wdldr fõ'

     ixLHd moaO;sh 

     (Number System)
mdoh

     (Base Value)
Ndú; lrk b,lalï yd wldrd§ wkq,laIK 

(Number and Alphabetic  character used)

1' oaùuh (Binary ) 2 0,1

2' wIaguh (Octal) 8 0,1,2,3,4,5,6,7

3' oYuh (Decimal) 10 0,1,2,3,4,5,6,7,8,9

4' IâoYuh (Hexa - decimal) 16 0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F

3'1'2 mß.Klfha o;a; ksrEmKh i`oyd oaúuh ixLHd Ndú;h

mß.Klfha o;a; ksrEmKh lrkafka ix{d 

wjia:d folla u.sks' fuu ixLHd wjia:d i`oyd fjd,aàh 

uÜgï folla mj;s' bka tlla by< fjd,aàh uÜgu zz1ZZ 

wjia:dj (State) f,i o wfkl my< fjd,aàh uÜgu zz0ZZ 

wjia:dj (State) f,i o ksrEmKh fõ' fuh bf,lafg%daksl 

mßm:j, ''on'' yd ''off'' hk wjia:d folg iudkh' zz1ZZ 

iy zz0ZZ ix{d weiqfrka ´kEu o;a;hla mß.Klfhka 

ksrEmKh l< yels h' 

my; 3'3 rEmfha oelafjk wdldrhg  oaú;Shsl wdphkfha wka;¾.; o;a;hla 

m%Odk u;lh lrd hdfï § ;a tys isg uOH ieliqï tallhg .uka lsÍfï § ;a 

oaúuh fla;hlg mßj¾;kh fõ' 

j.=j 3'1 -- ixLHd moaO;sfhys Ndú; lrk b,lalï yd wldrd§ wkq,laIK 

oaú;Shsl u;lfha isg 

m%Odk u;lhg o;a; 

msgm;a lsÍu

m%Odk u;lh

^iiïNdú m%fõY u;lh&

m%Odk u;lfha isg uOH 

ieliqï tallhg o;a; 

heùu

ieliqï tallh;eá Odjlh

rEmh  3'3 - oaú;Shsl wdphkfha isg uOH ieliqï tallhg o;a; .uka lrk wdldrh

rEmh 3'2 - úoHq;a mßm:hl 

iaúp
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mß.Klfha j¾K i`oyd oaúuh ixLHd Ndú;jk wjia:d i,ld n,uq' r;=" 

fld< iy ks,a j¾Kj, tlsfklg fjkia m%udKhkaf.ka iEÿKq j¾K 

ixfhdackhlska ´kE u j¾Khla iE§ we;' 

fuu uQ,sl j¾K 

Red, Green, Blue (RGB) 
f,i ksrEmKh l< yels 

w;r iEu j¾Khl u w.h 

0 isg 255 w;r fõ'

WodyrKhla f,i mß.Klh 

u`.ska ms<sfh, lrk ,o 

f,aLkhl miqìï j¾Kh 

i`oyd ;o oï ^Dark Purple& 
j¾Kh fh§ug wjYH kï 

wm tu mKsúvh mß.Klhg 

osh hq;af;a “135, 31, 120” 
f,i h'     ^rEmh 3'4&  fuu 

w.hhka u.ska by; j¾Khg wod< j¾K ixfhdackh oYuh ixLHd f,i ksrEmKh 

fõ' 135, 31  yd 120  g wod< oaúuh ixLHd 10000111
2 "
11111

2
 yd 1111000

2
 fõ'

3'2 oYuh" oaúuh" wIaguh yd IâoYuh ixLHd moaO;s

3'2'1 oYuh ixLHd moaO;sh (Decimal Number System)

              iEu ixLHd moaO;shla u iE§ we;af;a tallh (Unit), ixLHdj (Number) 
yd mdoh (Base or Radix) u;hs'

tallh (Unit)
tallhla hkq ;ks jia;=jls' WodyrK f,i wU f.ähla" remsh,la yd 

Èkhla tallhla f,i .; yels h'

ixLHdj (Number)
ixLHdjla hkq tallhla fyda m%udKhla (Quantity) ksrEmKh lrk 

ixfla;hls'

mdoh (Base or Radix)
 ixLHd moaO;shl Ndú; flfrk ixfla; .Kk tu ixLHd moaO;sfha mdoh 

f,i ye`Èkafõ' ´kEu ixLHd moaO;shl mdoh oYuh ixLHdxl j,ska m%ldY flf¾'

0 isg 9 olajd ixLHdxl iys; oYuh ixLHd moaO;sh  (Decimal Number 
System) Ndú;fhka .Kkh lsÍï isÿ lsÍug wms <ud ld,fha isg bf.k .;af;uq' 

tneúka" oYuh ixLHdj, mdol jákdlu i|yka fkdlrk kuq;a wfkl=;a 

ixLHdj, mdol jákdlu fhÈh hq;=h' oYuh ixLHd moaO;sfha ixLHdxl my; 

j.=fõ oelafõ' ^j.=j 3'2&

rEmh - 3'4 -- mß.Klfha j¾K ksrEmKh
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j.=j  3'2 - oYuh ixLHd moaO;sfha ixLHdxl

ixLHd moaO;sh oYuh fyj;a oyfha mdofha ixLHd moaO;sh

mdoh 10

Ndú; jk ixLHdxl 0" 1" 2" 3" 4" 5" 6" 7" 8" 9

  

oYuh ixLHdxl moaO;sfha  wka;¾.; ixLHdjla iE§ we;s wdldrh wOHhkh lruq'

WodyrK  (-

25 hk ixLHdj iE§ we;s wdldrh i,ld n,uq' 

25 iE§ we;af;a 20 yd 5 ys tl;=fjks' 

25 = 20 +  5
= ^2 « 10&  ¬  ^5 « 1& 

= ^2 « 101& ¬ ^5 « 100&

 fuu 100" 101" 102" ''' jeks ia:dkSh w.hka oYuh ixLHd moaO;sfha nr idOl 

(Weighting Factors) f,i ye`Èkafõ' fuu ixLHdj .Kl rduqjl (rEmh 3.5)         
ksrEmKh l< yels h' 

oyfiA

tajd

1000
103

ishfha 

tajd

100
102

tfla 

tajd

1
100

oi oyfia  

tajd

10 000
104 

oyfha

tajd

10
101

rEmh 3'5 - oYuh ixLHd ksrEmKh

fuh my; oelafjk wdldrhg o oelaúh yels h'

 

2  5

5 «100  =   5
2 «101  = 20
  25
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WodyrK

ó<Õg oYu ixLHdjla iE§ we;s wdldrh i,ld n,uq' ta i`oyd WodyrKhla f,i 

302'75 .ksuq'

3 0 2   ' 7 5 -  -  oYuh ixLHdj

 102 101 100 10-1 10-2 - nr idOlh 

 = 300 + 0 + 2 + 0.7 + 0.05
 = 302.75

10
5

100

= (3«102) ¬ (0«101) ¬ (2«100) ¬(7«10-1) ¬ (5« 10-2 )
= 300 + 0 + 2 + 7 + 

 

302.75

5 «10-2 = 0.05
7 «10-1 =   0.7
2 «100  = 2
0 « 101 =  0
3 « 102 =   300

302 .75

3'2'1 oaúuh ixLHd moaO;sh (Binary Number System)
mß.Klhg o;a; iy Wmfoia f,i ixLHd fh§fï § wm Ndú; lrkafka  

oYuh ixLHd moaO;sh jqj;a mß.Klh úiska tu o;a; 0 yd 1 f,i mßj¾;kh lr 

.kS' fuu 0 yd 1 hk ixLHdxl  iys; ixLHd moaO;sh oaúuh ixLHd moaO;shhs' 

rEmh 3'6  úoHq;a mßm:h'

oaúuh ixLHd moaO;sfha ixLHdxl my; j.=fõ oelafõ' ^j.=j 3'3&
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j.=j  3'3 -¡ oaúuh ixLHd moaO;sfha ixLHdxl

ixLHd moaO;sh oaúuh fyj;a fofla mdofha ixLHd 

moaO;sh

mdoh 2

Ndú; jk ixLHdxl 0" 1

WodyrK f,i  11101101
2
 i,luq'

1 1 1 0 1 -  1 0 1
2
 -  oaúuh ixLHdj

 

27 26 25 24 23 22 21 20 - nr idOlh 

20" 21" 22" 23 '''''''hk w.hhka oaúuh ixLHd moaO;sfha nr idOl f,i ye`Èkafõ'

1 1 0 01 11 1

27 26 25 24 23 22 21 20

fuu ixLHdj 3'7 - rEmfha mßÈ fofla mdofha .Kl rduqjl ksrEmKh l< yels h'

yeg 

y;f¾ 

tajd

 

64

26

;sia 

fofla 

tajd

32

25

odyifha 

tajd

16

24

wfÜ

tajd

8

23

y;f¾

tajd

4

22

fofla 

tajd

2

21

tfla

tajd

1

20

tlish 

úis 

wfÜ 

tajd 

128

27

rEmh 3'7 - oaúuh ixLHd ksrEmKh

mß.Kl ;dlaIKfha § oaúuh ixLHd moaO;sh b;d jeo.;a jk w;r 

th mß.Klfha uQ,sl ñkqï tallh jk ìgqj (bit) ks¾udKhg odhl fõ' fuu  

ixLHd moaO;sfha ±lsh yels l=vdu w.h 0 o úYd,u w.h  1 o fõ' tu w.hka  

ìgqjla (Bit) B inaryDig it   f,i ye`Èkafõ'
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3'2'3 wIaguh ixLHd moaO;sh (Octal Number System)
0" 1" 2" 3" 4" 5" 6" 7 hk ixLHdxl wgla Ndú; jk ixLHd moaO;sh wfÜ 

mdofha  ixLHd moaO;sh fyj;a wIaguh ixLHd moaO;sh f,i ye`Èkafõ'  

j.=j 3'4 -- wIaguh ixLH moaO;shl ixLHdxl

ixLHd moaO;sh wIaguh fyj;a wfÜ mdofha ixLHd moaO;sh

mdoh 8

Ndú; jk ixLHdxl 0" 1" 2" 3" 4" 5" 6" 7

WodyrK f,i 236
8
 i,luq'

2 3 6  -  wIaguh ixLHdj

 

82 81 80  - nr idOlh 

80" 81" 82" 83''''''hk w.hka wIaguh ixLHd moaO;sfha nr idOl f,i ye`Èkafõ' fuu 

ixLHdj my; mßÈ wfÜ mdofha .Kl rduqjl ksrEmKh l< yels h' ^rEmh 3'8&

mkaish 

fod<fya

tajd

512

83

wfÜ

tajd

8

81

yeg 

y;f¾

tajd

64

82

tfla 

tajd

1

80

ydroyia 

wkQyfha 

tajd

4096

84

   rEmh 3'8 - wfÜ mdofha ixLHd ksrEmKh

3'2'4 IâoYuh ixLHd moaO;sh (Hexa-Decimal Number System)

mß.Klh oaúuh ixLHd Ndú; lrk w;r fuh ñksidg lshùug wiSre 

ld¾hhls' tneúka oaúuh ixLHdj,g jvd myiqfjka fhÈh yels IâoYuh ixLHd 

moaO;sh Ndú; lrkq ,nhs' idudkHfhka w;a foflys weÕs,s oyh Ndú;fhka .Kka 

lsÍu isÿlrkafka kï fudfyd;lg is;kak Tfí w;a foflys weÕs,s oyihla we;s 

nj' túg Tng .Kka lsÍu i`oyd ixLHdxl 16 la Ndú; l< yels h' IâoYuh 

ixLHd moaO;sfha 0 isg 9 olajd ixLHdxl oyhla o wfkla ixLHdxl yh i`oyd A, B, 
C, D, E yd F hk ixfla; o  fhdod.efka' fuys § 10" 11" 12" 13" 14 yd 15 ksrEmKhg 
A, B, C, D, E yd F hk wkq,lAIK fhfoa ^j.=j 3'5&'



79fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs78

j.=j  3'5 - oYuh yd Iâ-oYuh ixLHd ixikaokh

            

Iâ oYuh ixLHd moaO;sfha ixLHdxl my; j.=fõ oelafõ' ^j.=j  3'6&

      j.=j  3'6 -  IâoYuh ixLHd moaO;sfha ixLHdxl 

ixLHd moaO;sh IâoYuh fyj;a odifha mdofha ixLHd moaO;sh

mdoh 16

Ndú;jk ixLHdxl 0" 1" 2" 3" 4" 5" 6" 7" 8" 9" A, B, C, D, E, F,
              

oyifha mdofha ixLHd moaO;shl úYd,;u ixLHdxlh jk F oaúuh 

wdldrfhka m%ldY lsÍfï § ìgq 4 lska oelaúh yels h' fï wkqj  ìgq  4lska hq;a 

oaúuh ixLHdjla fjkqjg oyifha mdofha ixLHd moaO;sfhys ixLHdxlhla Ndú; 

l< yels h' mß.Klfha memory addresses ksrEmKh lsÍug IâoYuh ixLHd 

Ndú; flf¾'

rEmh 3'4 ys fmkajd ÿka ;o oï mdg j¾Khg wod< j “ #871F78 ” fla;hla 

Tng ±lsh yels h' fuys § j¾Kfha w.h wdrïN jkafka “#” ixfla;fhks' fuu 

w.h mß.Klfha § IâoYuh ixLHdj,ska oelafõ' tfia kï by; WodyrKfha 

;o oï mdg j¾Kfha fla;h “ #871F78 ” fõ' fuys R,G,B w.hka 0 isg 255 
olajd oYuh ixLHdj,ska oelaúh yels h' ´kE u j¾Khl jákdlu bÈßfha “#” 
fyda  “&H” (ampersand) ixfla;h fhdod we;akï th IâoYuh ixLHdjls' my; 

j.=fjka (j.=j 3.7) oelafjkafka ;o oï mdg j¾Kfha IâoYuh w.h yd RGB 

w.hka h'
j.=j  3'7 - ;o oï mdg j¾Kfhys Iâ-oYuh w.h

j¾Kfha 

ku

j¾Kh IâoYuh 

w.h

R G B

;o oï mdg #  871F78
&H 871F78

135 31 120

WodyrK f,i 15E16 i,luq' 

1 5 E16  -  IâoYuh ixLHdj

 

162 161 160  - nr idOlh 
  

162 161 160

15E 16

oYuh ixLHdj 

IâoYuh ixLHdxlh

0 1

0 1 2 3

2 3 4

4

6

6

8

8

10

A

11

B

12

C

13

D

14

E

15

F

5

5

7

7

9

9
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 fuys 160, 161,162, 163 ''' hk w.hka IâoYuh ixLHd moaO;sfha nr idOl 

(Hexadecimal Weighting factors) f,i ye`Èkafõ' fuu ixLHdj my; mßÈ oyifha 

mdofha .Kl rduqjl ksrEmKh l< yels h' (rEmh 3.9)

tfla 

tajd

1
160

odifha

tajd

16
161

foish

mkia 

yfha  

tajd

256
162

ydroyia 

wkQyfha 

tajd

4096
163

  rEmh 3.9 - oyifha mdofha ixLHd ksrEmKh

oYuh" oaúuh yd wIaguh yd IâoYuh ixLHd w;r iïnkaOh 

oYuh oaúuh wIaguh IâoYuh

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

0
1

10
11

100
101
110
111

1000
1001
1010
1011
1100
1101
1110
1111

10000
10001
10010
10011
10100
10101
10110
10111
11000

0
1
2
3
4
5
6
7
10
11
12
13
14
15
16
17
20
21
22
23
24
25
26
27
30

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F
10
11
12
13
14
15
16
17
18

80, 160

81

161

20

21

23

24

j.=j 3'8 - oYuh" oaúuh yd wIaguh yd IâoYuh ixLHd w;r iïnkaOh
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3'3 ixLHdjl jeäu yd wvqu fjfiis ia:dkSh w.h 
     

 oYu iys; ixLHdj, § yd mQ¾K ixLHdj, § jeäu yd wvqu fjfiis ia:dkSh 

w.h ,nd .kakd wdldr follss' hï lsis mQ¾K ixLHdjla jfï isg ol=Kg lshùfï 

§ ol=Kq fl<jßka u msysá w.h wvqu fjfiis w.h jk w;r jï fl<jßka u msysá 

Y=kH fkdjk w.h jeäu fjfiis w.h fõ' ^ rEmh 3'10&

 

jeäu 

fjfiis 

w.h wvqu

fjfiis 

w.h

rEmh 3'10 - ixLHdjl jeä u yd wvq u fjfiis ia:dkSh w.h

oYu ixLHdj, § oYu ;s;g ol=Kq miska wE;ska msysá Y=kH fkdjk w.h 

wvq u fjfiis w.h jk w;r oYu ;s;g jï miska wE;ska u msysá Y=kH fkdjk 

w.h jeäu fjfiis w.h fõ'

3'3'1 jeäu fjfiis ixLHdxlh (MSD - Most Significant  Digit) iy wvqu 
        fjfiis ixLHdxlh (LSD - Least Significant Digit)

mQ¾K ixLHdjl fyda oYu iys; ixLHdjl jeäu yd wvqu fjfiis ixLHdxlh 

my; j.==fjys ^j.=j 3'9& ±lafõ'

j.=j 3'9 - ixLHdjl jeäu yd wvqu fjfiis ia:dkSh w.h

ixLHdj MSD LSD
329 3 9

1237.0 1 7
58.32 5 2
0.0975 9 5

0.4 4 4

 jeäu yd wvqu fjfiis ixLHdxlh oaúuh" wIaguh yd IâoYuh ixLHdj, 

fiùfï § oYuh ixLHd moaO;sh i`oyd wkq.ukh l< l%uhu j,x.= fõ'
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my; oelafjk ixLHdj, jeäu fjfiis ixLHdxlh yd wvqu fjfiis 

ixLHdxlh fidhkak'

(i). 5687010  (ii). 154.0110  (iii). 23.0808 (iv). AD 23916    
(v). 0.001102 

 l%shdldrlu

3'3'2 jeäu fjfiis ìgqj (MSB – Most Significant Bit) yd wvqu 
        fjfiiss ìgqj (LSB – Least Significant Bit)

jeäu yd wvqu fjfiis ìgqj ;SrKh lsÍfï § oaúuh ixLHd moaO;sh i`oyd 

muKlaa Ndú; flf¾' oYu iys; oaúuh ixLHdj, § yd mQ¾K oaúuh ixLHdj, § 

fuh ,nd .kafka wdldr follsks'

hï lsis mQ¾K ixLHdjla jfï isg ol=Kg lshùfï § ol=Kq fl<jßkau 

msysá w.h wvqu fjfiis ìgqj jk w;r jï fl<jßka u msysá Y=kH fkdjk w.h 

jeäu fjfiis ìgqj fõ' oaúuh oYu ixLHdj, § oYu ;s;g ol=Kq miska wE;ska u 

msysá Y=kH fkdjk w.h wvqu fjfiis ìgqj jk w;r oYu ;s;g jï miska wE;ska 

u msysá Y=kH fkdjk w.h jeäu fjfiis ìgqj fõ'

j.=j 3'10  - ixLHdjl jeäu yd wvqu fjfiis ìgqj

oaúuh ixLHdj MSB LSB
1001 1 = (23) 1 = (20)

011.101 1 = (21) 1 = (2-3)

my; oelafjk ixLHdj, jeäu fjfiis ìgqj yd wvqu fjfiis ìgqj 

fidhkak'

(i) 10002 (ii) 0111012 (iii) 0.110012 (iv) 1.00102 

(v) 0.001102 

 l%shdldrlu
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3'4 oYuh ixLHd" oaúuh" wIaguh yd IâoYuh  ixLHd  
njg mßj¾;kh

3'4'1 oyfha mdofha ^oYuh& ixLHd fjk;a mdohl ixLHd njg   
mßj¾;kh

wm mß.Klhg ,nd fok o;a; ish,a, mß.Klh úiska oaúuh ixLHd 

moaO;sfha ixLHdxl jk 0 yd 1 f,iska ,nd .efka' tneúka oyfha  mdofha ixLHdjla  

fjk;a mdohlg mßj¾;kh lsÍu jeo.;a fõ' fuys § oYuh ixLHdjla oaúuh 

ixLHdjlg;a" wIaguh ixLHdjlg;a yd IâoYuh ixLHdjlg;a mßj¾;kh lsÍu 

fï ;=<ska idlÉPd flf¾'

3'4'2 oYuh ixLHd" oaúuh ixLHd njg mßj¾;kh 

          oYuh ixLHdjla oaúuh ixLHdjla njg mßj¾;kh lsÍfï § oYuh ixLHdj 

,íêh Y=kH jk ;=re foflka fnod fYaIh ol=Kq mi ,shd oelaúh yels h' miq j 

igyka lrk ,o fYaI ish,a, w. isg uq,g igyka lr fYaI weiqfrka ixLHdj 

,súh yels h' 

  WodyrK

12
10 
ixLHdj oaúuh ixLHdjlg yerùu"

 ¾ m<uq j fuu ixLHdj 2 ka fnod fYaIh ,shkak'

  2 12
  2 6

  2 3
  2 1

0

0

0
1
1

,íêh

fYaIh

¾ fojkq j ,enqKq fYaI ish,a, w. isg uq,g igyka lrkak'

  12
10
 = 11002  
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 WodyrK

46
10
 oaúuh ixLHdjlg yerùu'

0

0

1
1
1

1

  2 46
  2 23

  2 11
  2 5

0

2
1

  2
  2

4610 = 1011102

my; oelafjk oYuh ixLHd oaúuh ixLHdj,g yrjkak'

(i) 15510   (ii) 47210 (iii)116310  

 l%shdldrlu

3'4'3 oYuh ixLHd" wIaguh ixLHd njg mßj¾;kh 

fuys § ,íêh ìkaÿj jk f;la fok ,o ixLHdj 8 ka fnod ,efnk fYaI 

w. isg uq,g ,shkak'

  WodyrK

158
10
ixLHdj wIaguh ixLHdjlg yerùu'

 ¾ m<uq j fuu ixLHdj 8 ka fnod fYaI ,shkak'

  

  8 158
  8 19

  8 2
0

6
3
2

,íêh

fYaIh

 ¾ fojkq j ,enqKq fYaI ish,a, w. isg uq,g igyka lrkak'

 
158

10
= 236

8
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my; oelafjk oYuh ixLHd wIaguh ixLHdj,g yrjkak'

(i). 15510 (ii). 47210 (iii). 116310  

 l%shdldrlu

3'4'4 oYuh ixLHd" IâoYuh ixLHd njg mßj¾;kh 

fuys § ,íêh Y=kH jk f;la 16 ka fnod fYaI w. isg uq,g ,shkak'

WodyrK

38
10
 ixLHdj IâoYuh ixLHdjlg yerùu

 ¾ m<uq j fuu ixLHdj 16 ka fnod fYaI ,shkak' 

           

16 38
16 2

0
6
2

,íêh

fYaIh

 ¾ fojkq j ,enqKq fYaI ish,a, w. isg uq,g igyka lrkak'

 
3810  = 2616

WodyrK

47
10 
ixLHdj Iâ oYuh ixLHdjlg yerùu'

4710  = 2F16

16 47
16 2

0
15
2

F
2

my; oelafjk oYuh ixLHd Iâ oYuh ixLHdj,g yrjkak'

(i).25610 (ii). 47810 (iii). 196310 

 l%shdldrlu
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3'5  oaúuh" wIaguh" IâoYuh yd oYuh ixLHd w;r    
 mßj¾;kh

wms óg l,sska oYuh ixLHd ^mdoh oyh&" oaúuh" wIaguh yd IâoYuh       

ixLHd njg mßj¾;kh lf<uq' ±ka oaúuh ixLHd" Iâ oYuh ixLHd njg;a" wIaguh 

ixLHd" oYuh ixLHd njg;a" IâoYuh ixLHd oYuh ixLHd njg;a mßj¾;kh 

lrk wdldrh i,ld n,uq' ^rEmh 3'11&

oYuh 

^mdoh 10&

oaúuh 

^mdoh 2&

Iâ oYuh 

^mdoh 16&

wIaguh

^mdoh 8&

3'11 - ixLHd moaO;s w;r mßj¾;kh 

3'5'1 oaúuh ixLHd" oYuh ixLHd njg mßj¾;kh

WodyrK

1101
2
 ixLHdj  oYuh ixLHdjlg yerùu

1 1 0 1    

 

23 22 21 20 

11012 = (1«23) ¬  (1«22) ¬ (0«21) ¬ (0«20)
 =  (1«8) ¬ (1«4)  ¬ (0«2) ¬ (1«1)
 =  8 ¬ 4  ¬ 0 ¬ 1 

11012= 1310 

 
21101  

13

821
421
020
121

3

2

1

0

=×

=×

=×

=×

 

102 131101 =  
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3'5'2 wIaguh ixLHd" oYuh ixLHd njg mßj¾;kh

WodyrK

1275
8
ixLHdj  oYuh ixLHdjlg yerùu

83 82 81 80

my; oelafjk wIaguh ixLHd oYuh ixLHdj,g yrjkak'

(i) 2308  (ii) 7458 (iii) 20658   

 l%shdldrlu

my; oelafjk oaúuh ixLHd oYuh ixLHdj,g yrjkak'

(i).1012  (ii). 1110101102 (iii).10100101112 

 l%shdldrlu
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3'5'3 Iâ oYuh ixLHd"  oYuh ixLHd njg mßj¾;kh

WodyrK

32916 ixLHdj  oYuh ixLHdjlg yerùu

161 160162

WodyrK

AB2
16 
ixLHdj  oYuh ixLHdjlg yerùu'

162 161 160

my; oelafjk Iâ oYuh ixLHd oYuh ixLHdj,g yrjkak'

(i) 1A16  (ii) 7EF (iii) A4916

 l%shdldrlu
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3'5'4 oaúuh ixLHd" wIaguh ixLHd njg mßj¾;kh

wIaguh ixLHd moaO;sfha Ndú;jk ixLHdxl  jk 0" 1" 2" 3" 4" 5" 6"  yd 

7 w;ßka úYd,;u ixLHdxlh jkqfha 7 h' wmg 7 ixLHdxlh 111
2 
f,i oaúuh         

ixLHdjlska oelaúh yels h' fï wkqj wIaguh ixLHd moaO;sfha úYd,;u ixLHdxlh 

jk 7 ìgq 3 lska hq;= oaúuh ixLHdjlska ksrEmKh l< yels h' fï wkaoug wIaguh 

ixLHd moaO;sfha ish¨ u ixLHdxl ìgq 3 lska hq;= oaúuh ixLHdjlska oelaúh yelsh'  

wfÜ mdofha ixLHd moaO;sfha Ndú; jk ixLHdxlj,g wkqrEm oaúuh ixLHd my; 

j.=fõ oelafõ' ^j.=j 3'11&

j.=j  3'11 - wIaguh ixLHdxl" oYuh yd oaúuh ixLHd u.ska oelaùu'

oYuh ixLHdj wIaguh ixLHdj oaúuh ixLHdj

0
1
2
3
4
5
6
7

0
1
2
3
4
5 
6
7

000
001
010
011
100
101
110
111

 

 by; j.=j wkqj" wIaguh ixLHdjla oaúuh ixLHdjlska oelaùfï § ìgq  

;=kla Ndú; fõ' (8 = 23)
   wms oaúuh ixLHdjla wIaguh ixLHdjla njg mßj¾;kh lrk wdldrh 

n,uq'

WodyrK

1011101
2 
ixLHdj wIaguh ixLHdjlg yerùu'

 ¾ m<uq j ol=Kq me;af;a fl<jf¾ isg jï fl<jr olajd ìgq 3 ne.ska fjka 

lrkak' jï fl<jf¾ jQ wjidk ldKavhg ìgq ;=kla ke;s kï 0 fhdod th 

iïmQ¾K lrkak'

 ¾ tu tla tla ldKavhg wh;a wIaguh ixLHdj fjka fjka j ,shkak' 

 ¾ bka miq tu ldKav wIaguh ixLHdxlhla weiqfrka ,shd olajkak'

 ¾ tu ixLHdxl jï fl<jf¾ isg ol=Kq fl<jr olajd ms<sfj<ska ,shkak'
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0 0 0 0

0 0 0 0

1 1 1 1 1

111 11

10111012 = 1358

my; oelafjk oaúuh ixLHd wIaguh ixLHdj,g yrjkak'

(i).100110012  (ii). 1111001112 (iii). 101010101102  

 l%shdldrlu

3'5'5 oaúuh ixLHd" IâoYuh ixLHd njg mßj¾;kh

Iâ oYuh ixLHd moaO;sfha Ndú; jk ixfla; w;ßka “F” u.ska ksrEms; 

w.h tys jeä u ixLHd;aul w.hla iys; ixLHdjhs' th 1111
2
 f,i ìgq y;rlska 

hq;a oaúuh ixLHdjlska oelaúh yels h' fuf,i IâoYuh ixLHd moaO;sfha ish¨ 

u ixLHdxl ìgq y;rlska hq;= oaúuh ixLHdjlska oelaúh yelsh' IâoYuh ixLHd 

moaO;sfha Ndú; jk ixLHdxlj,g wkqrEm oaúuh ixLHd my; j.=fõ oelafõ' 

^j.=j 3'12&                                                                                    
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     j.=j  3'12 - IâoYuh ixLHdxl" oYuh yd oaúuh ixLHd u.ska oelaùu'

by; j.=j ^j.=j 3'12& wkqj" Iâ oYuh ixLHdjla oaúuh ixLHdjlska 

oelaùfï § ìgq y;rla Ndú; fõ' ^16 = 24&

WodyrK

10110
2 
ixLHdj  IâoYuh ixLHdjlg yerùu'

 y m<uq j ol=Kq me;af;a fl<jf¾ isg jï fl<jr olajd ìgq y;f¾ ldKavj,g 

fjka lrkak'

 y tu tla tla lKavj,g wh;a IâoYuh ixLHd fjka fjka j ,shkak'

 y tu ixLHd jï fl<jf¾ isg ol=Kq fl<jr olajd ms<sfj<ska ,shd mdoh i`oyka 

lrkak'

IâoYu
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0 0 0 1 1

1

0 1

1

0

000 00 1

WodyrK

10111011100
2
 ixLHdj  IâoYuh ixLHdjlg yerùu'

0 1 1 1 1 1

1 1 1 1 1 1 1

1 10

00 0

0 0 0

0

IâoYu

0

5

my; oelafjk oaúuh ixLHd Iâ oYuh ixLHdj,g yrjkak'

(i). 110110102  (ii). 111110011012 (iii). 100111000112
 

 l%shdldrlu



93fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs92

3'5'6 wIaguh ixLHd" oaúuh ixLHd njg mßj¾;kh

by; wIaguh ixLHdjla oaúuh ixLHdjlska oelaùfï § ixLHdxl ;=klska 

oelaúh yels nj wms bf.k .;suq' 

fï wkqj wIaguh ixLHdfõ iEu ixLHdxlhla u fofla mdohg yrjd ixLHdxl 

;=klska ,súh hq;=hs'

WodyrK

4578 ixLHdj  oaúuh ixLHdjlg yerùu'

 y m<uq j wIaguh ixLHdfjys iEu ixLHdxlhla u ìgq ;=klska ,shkak'

 y fojkq j tu ìgq ish,a, tlg ,shd wIaguh ixLHdjg wod< oaúuh ixLHdj 

,shkak' 

4578  = 1001011112

4
100

5
101

    7
111

my; oelafjk wIaguh ixLHd oaúuh ixLHdj,g yrjkak'

(i). 108  (ii). 2458 (iii). 7068 

 l%shdldrlu

3'5'7 wIaguh ixLHd" Iâ oYuh ixLHd njg mßj¾;kh   

fuys §  wIaguh ixLHdj m<uq j oaúuh ixLHdjla f,i olajd miq j th 

Iâ oYuh ixLHdjla njg yerúh hq;=hs'

WodyrK

10578 ixLHdj Iâ oYuh ixLHdjlg yerùu'

 y m<uq j wIaguh ixLHdfjys iEu ixLHdxlhla u ìgq ;=klska ,shkak'

 y ,efnk oaúuh ixLHdfjys ol=fKa isg jug fjka lrkak'

 y tla tla ldKavj,g wod< IâoYuh ixLHdj ,shkak' 
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7501
001  000  101   111

   

00 1 0 0 0 1 0 1111

     2        2        15
     2        2         F

 

10578  = 22F16

my; oelafjk wIaguh ixLHd IâoYuh ixLHdj,g yrjkak'

(i).3208  (ii). 4758 (iii).16738 

 l%shdldrlu

3'5'8 IâoYuh ixLHd" oaúuh ixLHd njg mßj¾;kh

 IâoYuh ixLHdjl ́ kE u ixfla;hla ìgq y;rlska hq;a oaúuh ixLHdjlska 

,súh yels nj Tn óg fmr bf.k .;af;ys h' tfia kï Iâ  oYuh ixLHdjla 

oaúuh ixLHdjlg yrjk úg tu ixLHdfõ iEu ixLHdxlhla u ìgq y;rlska hq;a 

oaúuh ixLHdjlska oelaúh hq;=hs'

WodyrK

74
16
 ixLHdj  oaúuh ixLHdjlg yerùu'

 
7416  = 11101002

7 4 
0111 0100

2AE
16 
ixLHdj oaúuh ixLHdjlg yerùu'

2 A  E
0010 1 010 1110

2AE16 = 10101011102
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my; oelafjk IâoYuh ixLHd oaúuh ixLHdj,g yrjkak'

(i) 7816 (ii) B2C16 (iii) 4DEF16  

 l%shdldrlu

3'5'9 IâoYuh ixLHd" wIaguh ixLHd njg mßj¾;kh

fuys § o IâoYuh ixLHdj m<uq j oaúuh ixLHdjla f,i olajd miq j th 

wIaguh  ixLHdjla njg yerúh hq;=hs'

WodyrK

23A
16
 ixLHdj  wIaguh ixLHdjlg yerùu'

2 3  A
0010 0011 1010

001 0 0 0 1 1 1 010

1  7  2 0

23A16 = 10728

my; oelafjk IâoYuh ixLHd wIaguh ixLHdj,g yrjkak'

(i).32016 (ii). A7B16 (iii). 10ED16  

 l%shdldrlu



97fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs96

1. “ 23 y ”  hk ixLHdj i,lkak' fuys y f,i olajd we;af;a ixLHd 

moaO;sfha mdohhs'

“ 23 y   ” ixLHdj Tn bf.k .;a ixLHd moaO;s w;=ßka l=uk  ixLHduh 

moaO;shg fyda moaO;sj,g wh;a úh yels o@

2' 83
10 

hk oYuh ixLHdj" oaúuh ixLHdjlg mßj¾;kh lrkak' Tfí .Kkh 

lsÍï fmkajkak'

3' 10110111
2 
hk oaúuh ixLHdj" wIaguh ixLHdjlg mßj¾;kh lrkak' Tfí 

.Kkh lsÍï fmkajkak'

4' 23D
16 
hk IâoYuh  ixLHdj" oaúuh  ixLHdjlg mßj¾;kh lrkak'

5' my; j.=fjys ysia;eka mqrjkak' 

  j.=j 3'13 - j¾K lsysmhla iy Bg wkqrEm RGB w.hhka iy IâoYuh    

     w.h

   j¾Kfha ku j¾Kh IâoYuh 

w.h

R 

 

G B

;o oï #  871F78 135 31 120

,d frdai  255 182 193

wyia ks, 50 153 204

    fld< 0 255 0

     ly  255 238 0

 l%shdldrlu
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 3'6 o;a; wdphk Odß;dj (Data Storage Capacity)
mß.Klfha o;a; .nvdlr ;eîfï § ta i|yd hï lsis bvla wjYH fõ' 

o;a; wdphk Odß;dj ìgq (bits),  nhsg (byte), lsf,da nhsg (kilobytes), fu.d 

nhsg  (Megabytes), .s.d nhsg (Gigabytes),  fgrd nhsg (Terabytes) yd fmgd nhsg 

(Petabytes) jeks tall u.ska ukskq ,nhs' tlsfklg fjkia o;a; wdphk Odß;d 

l=vd tallfha isg úYd, tallh olajd wkqms<sfj<g ksjerÈ j ieliSug;a tajd w;r 

iïnkaOh w¾: oelaùug;a Tng yels úh hq;=hs'

3'6'1  o;a; wdphkh (Data Storage) uekSu ioyd Ndú; flfrk 
tall

ìgqj (bit)
mß.Klfha o;a; ;ekam;a lsÍug Ndú; flfrk l=vdu tallh ìgqjhs (bit). fuh 

B inaryDig it  hk jpkfhka ks¾udKh ù we;' 0 yd 1hk oaúuh ixLHdxl 

fol ìgqjhs'

nhsgh (byte)
  ìgq  8 la nhsghla (1 byte) f,i olajhs' 

ksn,h (nibble)
 ksn,h (Nibble) hk tallh  ìgqj yd nhsgh ;rï nyq, j Ndú; fkdfõ' 

nhsghlska yß wvla fyj;a ìgq 4 la ksn,a (Nibble) tlla f,i ye`Èkafõ' 

lsf,da nhsgh (kilobyte)
 fuh nhsg 1024  (1024 = 210) lska hqla; fõ' lsf,da nhsg (kilobyte) hkak 

KB  fyda kbyte f,i ,shkq ,efí'  

fu.d nhsgh (Megabyte)
 fuh lsf,da nhsg 1024 (1024 = 210) lska fyj;a nhsg 1048576 hqla; fõ' 

fu.d nhsg (Megabyte) hkak MB fyda mbyte  f,i ,shkq ,efí' 

.s.d nhsgh  (Gigabyte)
 fu.d nhsg 1024 (1024 MB)lska .s.d nhsghla iEfoa' .s.d nhsg (gigabyte) 
hkak GB fyda gbyte f,i ,shkq ,efí'  Gb f,i ,sùu idjoH jk w;r bka woyia 

flfrkafka gigabit hkakh' 

fgrd nhsgh (Terabyte) 
   .s.d nhsg 1024 (1024 GB) lska fgrd nhsghla iEfoa' fuh TB f,i 

olajkq ,efí' 

fmgd nhsgh (Petabyte)
   fgrd nhsg 1024 (1024 TB)  lska fmgd nhsghla iEfoa'
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o;a; wdphk Odß;dj ukskq ,nk tall w;r iïnkaO;dj 

my; oelafõ'

8 bits    =  1 byte
4 bits    =  1 nibble
1024  bytes  =  1 kilobyte (KB)

     1024  kilobytes =  1 Megabyte (MB)
     1024  Megabytes =  1 Gigabyte (GB)
     1024  Gigabytes =  1 Terabyte (TB)  
     1024  Terabytes =  1 Petabyte (PB) 

ksßlaIKh 

oDv ;eá ksIamdokh lrk úg 1024 hk w.h 1000 f,i i,lk wjia:d 

we;' 

 by; tall ms<sn`o wjfndaOhla ,nd .ekSu i`oyd my; WodyrK i,ld 

n,kak' (j.=j 3.14) 
j.=j 3'14 Odß;dj uksk tall msgq yd wlaIr jYfhka oelaùu

ku (Name) ixlaIsma;h 
(Abbreviation)

wdikak 

jYfhka 

nhsg

(Approx. 
Bytes)

ksjerÈ nhsg 

.Kk

(Exact Bytes)

wdikak 

jYfhka 

wlaIr msgq 
(A4) .Kk

(Approx. Text 
Pages)

nhsg (Byte) B tl 1 wlaIr 1

lsf,da nhsg 

(Kilobyte)
KB(or K) oyi 1,024

 

1
2

msgq 

fu.d nhsg 

(Megabyte)
MB ñ,shkh 1,048,576 msgq 500

.s.d nhsg 

(Gigabyte)
GB ì,shkh 1,073,741,824 msgq 500,000

fgrd nhsg 

(Terabyte)
TB á%,shkh 1,099,511,627,776 msgq  

500,000,000
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3'6'2 Wmdx.j, o;a; Odß;dj (Capacities of Data Storage)

      úúO wdphk Wmdx.j,g tlsfklg fjkia Odß;djka we;' fuu Wmdx.j,ska 

flfrk ld¾hhka o tlsfklg fjkia h' wms tlsfklg fjkia wdphk Wmdx. 

Odß;dj ms<sno j fuys § wOHhkh lruq' (rEmh 3.12)

frðia;r u;lh (Register Memory) 

1kB

ksys; /ixÑ; u;lh (Cache memory) 

3 MB – 32MB

ix.;/ ixhqla; ;eáh (Compact Disk (CD)  
650- --- 900 MB

ixLHdxl nyqúO ;eáh (Digital Versatile Disc) 
4.7 - 9 GB

iiïNdù  m%fõY u;lh (Random Access 
Memory 

01- - 64 GB

mGk ud;% u;lh (Read Only  Memory    
(ROM)       

iefk,s u;lh (Flash Memory)

1 - 64GB   

oDV ;eáh (Hard Disk)  

100 GB  -   6 TB

pqïNl máh Magnetic Tape

1TB  - 185 TB 

o

;a

;

Od

ß

;d

j

l=vdhs (Small)

úYd,hs (Large)

rEmh 3'12 - wdphk Wmdx. Odß;dj

o;a; lshùfï § yd ,sùfï § fuu Wmdx.j,g m%fõY ùug .; jk  fõ,d-

jka ^m%fõY fõ.& fjkia fõ' tAjd ms<sn`o j Tng my; rEmfhka jgyd .; yel' 

^rEmh 3'13& 
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3'6'3 o;a; m%fõY lr .ekSfï fõ.h ( Data Access speed)

o
;a
; 

m%
fõ
Y

l
r 

.e
kS
fï

fõ
.
h

fyñka (Slow)

fõ.j;a (Fast)
frðia;r u;lh 

(Register Memory)
kssys; u;lh

(Cache  Memory)
iiïNdù m%fõY u;lh

 (Random Access  Memory)
mGk ud;% u;lh

(Read Only Memory)
iefk,s u;lh

(Flash Memory)
oDV ;eáh

(Hard Disc)
ixLHdxl nyqúO ;eáh

(Digital Versatile Disc - DVD)
ix.; /ixhqla; ;eáh

 (Compact Disk (CD) )
 pqïnl máh 

 (Magnetic Tape)

rEmh 3'13 o;a; m%fõY lr .ekSfï fõ.h

3'6'4 ìgq tlla i`oyd jehjk uqo,  (Cost per unit storage)

wdphk Wmdx.j, o;a; .nvd lr ;nd .ekSfï § ìgq tlla  i`oyd jeh jk 

uqo, tla tla Wmdx.h ioyd fjkia fõ' WodyrKhla f,i frðiaa;r u;lh yd 

ixÑ; u;lh i`oyd jvd jeä úhoula oeÍug isÿ fõ' my; rEm igyfkys fïjd 

ixikaokd;aul j olajd we;' (rEmh 3.14)
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 frðia;r u;lh 

 (RegisterMemory)
 kssys; / ixÑ;  u;lh

 (CACHE  MEMORY)
 iiïNdù m%fõY u;lh

 (RANDOM ACCESS  MEMORY)
 mGk ud;% u;lh

 (READ ONLY MEMORY)
 pqïnl máh 

 (Magnetic Tape)
 iefk,s u;lh

 (Flash Memory)
 oDV ;eáh

 (HARD DISC)
 ixLHdxl nyqúO ;eáh

 (Digital Versatile Disc - DVD)
 ix.; /ixhqla; ;eáh

 (Compact Disk CD)

ì
gq

t
l
la

i
`o
yd
je
h
j
k

uq
o
,

wvq (Low)

jeä (High)

rEmh 3'14 ìgq tlla i`oyd jeh jk uqo,
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3'7 mß.Klj, Ndú; lrk fla; l%u (Coding Systems )
      

 rEmh 3'15 mß.Klhg Tn we;=¿ lrk o;a; yd mß.Kl o;a; ksrEmKh 

rEmfha (rEmh 3'15)  oelafjk wdldrhg Tn mß.Klhg hï o;a;hla 

we;=¿ l<úg mß.Klh u.ska th 0 yd 1 ka ieÿk úúO rgdj,g mßj¾;kh 

lr.kS' fï wkqj wm h;=re ,shkh lrk ixLHdxl (numeric), wlaIr (alphabetic) 
úfYaI ixfla; (Special Characters) rEm yd Yío  mß.Klfha wNHka;r wdphk 

Wmdx.j, ;ekam;a lsÍfï§ oaúuh fla; Ndú;d lrhs'

      Tn mdvu wdrïNfha § h;=re mqjrej Ndú;fhka  “ A” wlaIrh  we;=,a 

l<úg fuu “ A” wlaIrh mßj¾;kh jk oaúuh fla;h jk 1000001 ìgq rgdj 

“ A” wlaIrhg wod< fla;hhs' fuys wka;¾.; ìgq m%udKh 7 la fõ' kuq;a iEu 

o;a;hlau ksrEmKh lsÍug ìgq rgdjlska iEÿkq ixfhdackhla Ndú;djk w;r tla 

tla fla;hka ioyd fuu ìgq m%udKh fjkia fõ' fuys§ úúO fla; l%uhka mj;sk 

w;r tajd my; my; oelafõ'

1. BCD  Binary Coded Decimal
2. ASCII  American Standards Code for Information Interchange
3. EBCDIC  Extended Binary Coded Decimal Interchange Code
4. Unicode

3.7.1 BCD - Binary Coded Decimal

          mß.Kl Ndú;d l< uq,a ld,fha § fuu fla; l%uh fhdod.;a w;r fï 

l%uh u.ska tla ixLHdxlhla ìgq y;rlska ksrEmkh lrhs' fuh oYuh ixLHdxl 

ksrEmKh ioyd muKla Ndú;d lrhs' fï u.ska ixfla; 16 la (24 = 16) ksrEmKh 

l<yels w;r 0 isg 9 olajd jQ ixLHdxl oyhg wod< BCD fla; my; j.=fõ 

oelafõ' ^j.=j 3'15& 
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j.=j  3'15 - oYuh ixLHd yd BCD w.h

oYuh w.h BCD w.h

0

1

2

3

4

5

6

7

8

9

0000

0001

0010

0011

0100

0101

0110

0111

1000

1001

WodyrK

37
10 
ixLHdj  BCD  fla; l%ufhka oelaùu'

  3  7
10

0011 0111

37
10 =  00110111 

my; oelafjk oYuh ixLHdjkag wod< BCD w.hka  ,shd olajkak'

(i). 302  (ii). 2136 (iii). 17295

 l%shdldrlu

3.7.2 ASCII (American Standards Code for Information  
              interchange)   
            

 wdrïNfha § fuu fla; l%ufha§  mß.Klhg ,ndfok o;a;h mß.Klh 

úiska ìgq 7lska hq;a oaúuh ixLHdjlska ksrEmKh lrhss' fuu fla; l%uh Ndú;fhka 

wkq ,laIK 128 la ksrEmKh l< yels h'

mß.Kl ikaksfõok WmlrK jeks oE mdG (text) ksrEmKh lsÍu i`oyd ASCII 
Ndú; lrhs' ^Wm.%ka:h - j.=j 3'17& 

           fuu  weials fla; l%uh ANSI  (American National Standards Institute) 
wdh;kh u.skaa ilia lr iïu; lr we;' 
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WodyrK
 

 y wlaIruh o;a;  (Text)  

 School  hk jpkh h;=re mqjrej Ndú;fhka mß.Klhg we;=¿ l< úg 

mß.Klh th f;areï .kakd wdldrh ,shd olajkak' (Wm .%ka:h -j.=j 3'17 Ndú; 

lrkak')
 � m<uq j ixfla;j,g wod< oYuh ixLHd ,shkak'

 S  -   83 c  -  99      h -  104     o -  111      l   -  108
 � fuu tla tla w.hg wod< oaúuh ixLHdj ,shkak'

 S  - 1010011  c – 1100011  h  -  1101000   o -  1101111 
 l - 1101100

 � wod< fla;h ,shd olajkak'

               S c h o o l
          101001111000111101000110111111011111101100

    

ICT  hkakg wod< weials fla;h oaúuh ixLHdjla f,i  ,shkak' 

 l%shdldrlu

3.7.3 EBCDIC (Extended  Binary Coded Decimal  Interchange   
         Code) 
         

weials fla; l%uh Ndú;fhka wmg ,súh yelafla wkq,laIK 128 la muKla 

jk w;r" EBCDIC fla; l%ufhka wkq,laIK 256 la ,súh yels h' fuys § tla 

ixfla;hla ìgq wglska iEÿKq oaúuh ixLHdjlska ,súh yels h' tneúka fuu fla; 

l%uh Ndú;fhka wkq ,laIK 256 la ksrEmKh l< yels h' fuu fla; l%uh IBM 
Main frame mß.Klj, Ndú; úh' fuu fla; l%ufha § úYd, (Capital) bx.S%is 

wlaIr 26 i`oyd tlsfklg fjkia EBCDIC fla; o l=vd (Simple) wlaIr i`oyd o 

tlsfklg fjkia EBCDIC fla; we;s nj my; j.=fjka meyeÈ,s fõ' 
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j.=j 3'16 bx.%Sis fydaäfha úYd, yd l=vd wlaIr ioyd jQ EBCDIC w.hka

Uppercase Lowercase

A

B

C

D

Character In Binary
EBCDIC

1100 0001

1100 0010

1100 0100

1100 0101

In Hexa 
Decimal

In Hexa 
Decimal

C1

C2

C4

C3

Character

a

b

c

d

EBCDIC
In Binary

1000 0001

1000 0010

1000 0011

1000 0100

81

82

83

84
 

3'7'4 hqksfla; l%uh  (Unicode)

        mß.Klj, o;a; ksrEmKh ioyd Ndú; jk weials fla; l%uh fhdod 

.ksñka úúO jQ wkq,laIK 128 la muKla o, EBCDIC fla; l%uh fhdod .ksñka 

wkq,laIK 256 la o" ,nd .; yels h' kuq;a isxy," cmka" Ök yd fou< jeks 

NdIdj, wkq,laIK 256 lg jvd jeä neúka fuu fla; l%u Ndú; l< fkdyels h'  

tneúka ìgq 16 lska hq;a tlsfklg fjkia ixfla; 65536 la (216 = 65536 ) ksrEmKh 

l< yels m%ñ;shlg wkql+, j ilia lrk ,o fla; l%uh hqksfla;h (Unicode) 
f,i y÷kajd fokq ,eî h'

                my; rEmfha (rEmh 3.16 ) oelafjk mßÈ isxy," fou< NdIdj, wlaIr 

ksrEmKhg;a úfYaI ixfla; yd rEm ksrEmKhg;a hqksfla; Ndú; l< yels h'
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rEmh 3'16 - hqksfla; Ndú; flfrk wjia:d

óg wu;r j rEmuh o;a; yd Yíouh o;a; ksrEmKhg;a hqksfla; Ndú; 

l< yels h' ^rEmh 3'17 yd rEmh 3'18&   

WodyrK

 y rEmuh o;a;  (Picture and graphic data) 
my; rEmfha oelafjkafka (rEmh 3.17) b;d iómj Èia jk yd w;sYhska 

úYd, l< rEmhla fyda PdhdrEmhls' PdhdrEmhla úYd, fldgqj,ska iEÿKq úúO 

j¾K j,ska jQ ;s;aj,ska iukaÑ; fõ' fuf,i mska;+r" Ñ;%mg rduq" Ñ;% yd p,k 

rduq jeks mß.Kl Ñ;%uh o;a; úúO j¾Kj,ska hqla; fõ' my; rEmfha oelafjk 

mska;+rh tlsfklg fjkia j¾K rdYshlska iukaÑ; fõ' 
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rEmh 3'17  mska;+rhl wka;¾.; j¾K yd Bg wkqrEm oaúuh w.hhka

            

 y Yíouh o;a; (Sound)

my; rEmfha (rEmh 3'18) oelafjk mßÈ iamSlrhlska ksl=;a jk Yío 

idudkHfhkaa m%;siu ;rx.hla f,i ksrEmKh fõ' kuq;a mß.Klfha ish¨ o;a; 

ixLHdxl o;a; jk w;r nhsgj,ska ielfia' fuf,i m%;siu o;a;hla f,iska 

Yíohla ixLHdxl o;a;hla njg mßj¾;kh fõ' fuf,i Yíohla o 0 yd 1 ka 

iEÿKq ìgq rgdjlska ksrEmKh fõ' 

3 Sec1 Sec

1

0

(3, 1)
=
0011 0001

m%;siu wdldrhg Yío ;rx.hla 

ixLHdxl o;a; f,i mßj¾;kh

rEmh 3'18  m%;siu o;a;hla jk Yíouh o;a; ixLHdxl o;a; f,i mßj¾;kh

2 Sec
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 fuu hqksfla; l%uh u.ska cd;Hka;r j Ndú; jk ish¨ u NdIdj, 

wkq,laIK y`ÿkajd fok wdldrhg fla; fjka lsÍï lrkq ,eî h' fï i`oyd uQ,sl 

jQ wdh;k jkafka cd;Hka;r iïu; wdh;kh (International Standard Institution) 
yd “ Unicode Consortium” hk wdh;k folhs' wka;¾cd, fjí wvú" mqj;am;a 

ks¾udKh ioyd Unicode  nyq, j fhdod .efka'  ^Wm.%ka:h - j.=j 3'17)
fuys§"

 ´kEu  mß.Klhla fyda fufyhqï moaO;shlg fmdÿjk fia tla tla wxl" 

wl=re fyda wkq,CIk i`oyd unique wxlhla ,efn;s'

 1' “A” wkq,laIKh ASCII  fla; l%ufha § 1000001 u.ska  

    ksrEmKh fõ kï “F”  wkq,laIKh ksrEmKh flfrk 

     ASCII  fla;h  l=ula o@

 2' BCD ( Binary  Coded Decimal) j,ska ksrEms; úYd, u 

     ixLHdxlh l=ula o@

3' IâoYul ixLHdj ksfhdackh lsÍug wjYH wju ìgq .Kk lSh o@

4' 1----000010
2
  u.ska ASCII ys  “B”  ksrEmKh flf¾ kï" “L” u.ska ksrEmKh 

flfrk ASCII  fla;h  l=ula o@

5' mß.Klj, Ndú; flfrk fla; l%u fudkjd o@ tajd Ndú; lsÍug we;s 

wjYH;dj myod fokak'

 l%shdldrlu

 � o;a; ksrEmKhg Ndú; flfrk  ixLHd moaO;s

ixLHd moaO;s

oaúuh

wIaguh

oYuh

IâoYuh

ixLHd moaO;sh mdoh ixLHdxl

2

8

16

10

0, 1
0, 1, 2, 3, 4, 5, 6, 7
0, 1, 2, 3, 4, 5, 6, 7, 8, 9
0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, 
C, D, E, F

 

idrdxYh
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Wm.%ka:h (Appendix)
wkq,laIKj,g wod< ASCII  yd EBCDIC fla; iy wod< oYuh" wIaguh yd 

Iâ-oYuh ixLHd

j.=j  3'71  wlaIrj,g wod< ASCII  yd EBCDIC w.h  

Decimal Hex Octal EBCDIC 
Character

ASCII
Character

Decimal Hex Octal EBCDIC 
Character

ASCII 
Character

00 00 000 NUL NUL 128 80 200
001 01 001 SOH SOH 129 81 201 a
002 02 002 STX STX 130 82 202 b
003 03 003 ETX ETX 131 83 203 c
004 04 004 PF EOT 132 84 204 d
005 05 005 HT ENQ 133 85 205 e
006 06 006 LC ACK 134 86 206 f
007 07 007 DEL BEL 135 87 207 g
008 08 010 BS 136 88 210 h
009 09 011 HT 137 89 211 i
010 0A 012 SMM LF 138 8A 212
011 0B 013 VT VT 139 8B 213
012 0C 014 FF FF 140 8C 214
013 0D 015 CR CR 141 8D 215
014 0E 016 SO SO 142 8E 216
015 0F 017 SI SI 143 8F 217
016 10 020 DLE DLE 144 90 220
017 11 021 DC1 DCI 145 91 221 j
018 12 022 DC2 DC2 146 92 222 k
019 13 023 TM DC3 147 93 223 l

 � mß.Klj, Ndú; flfrk fla; l%u

fla; l%uh Ndú;jk ìgq .Kk

BCD   -  Binary Coded Decimal 4

ASCII    -  American Standard Code 
for Information Interchange 
Code

7

EBCDIC- Extended Binary Coded 
Decimal Interchange Code

8

Unicode 16



111fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs110

020 14 024 RES DC4 148 94 224 m
021 15 025 NL NAK 149 95 225 n
022 16 026 BS SYN 150 96 226 o
023 17 027 IL ETB 151 97 227 p
024 18 030 CAN CAN 152 98 230 q
025 19 031 EM EM 153 99 231 r
026 1A 032 CC SUB 154 9A 232
027 1B 033 CU1 ESC 155 9B 233
028 1C 034 IFS FS 156 9C 234
029 1D 035 IGS GS 157 9D 235
030 1E 036 IRS RS 158 9E 236
031 1F 037 IUS US 159 9F 237
032 20 040 DS Space 160 A0 240
033 21 041 SOS ! 161 A1 241
034 22 042 FS " 162 A2 242 s
035 23 043 # 163 A3 243 t
036 24 044 BYP $ 164 A4 244 u
037 25 045 LF % 165 A5 245 v
038 26 046 ETB & 166 A6 246 w
039 27 047 ESC ' 167 A7 247 x
040 28 050 ( 168 A8 250 y
041 29 051 ) 169 A9 251 z
042 2A 052 SM * 170 AA 252
043 2B 053 CU2 + 171 AB 253
044 2C 054 , 172 AC 254
045 2D 055 ENQ - 173 AD 255 [
046 2E 056 ACK . 174 AE 256
047 2F 057 BEL / 175 AF 257
048 30 060 0 176 B0 260
049 31 061 1 177 B1 261
050 32 062 SYN 2 178 B2 262
051 33 063 3 179 B3 263
052 34 064 PN 4 180 B4 264
053 35 065 RS 5 181 B5 265
054 36 066 UC 6 182 B6 266
055 37 067 EOT 7 183 B7 267
056 38 070 8 184 B8 270
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057 39 071 9 185 B9 271
058 3A 072 : 186 BA 272
059 3B 073 CU3 ; 187 BB 273
060 3C 074 DC4 < 188 BC 274
061 3D 075 NAK = 189 BD 275 ]
062 3E 076 > 190 BE 276
063 3F 077 SUB ? 191 BF 277
064 40 100 Space @ 192 CO 300 {
065 41 101 A 193 C1 301 A
066 42 102 B 194 C2 302 B
067 43 103 C 195 C3 303 C
068 44 104 D 196 C4 304 D
069 45 105 E 197 C5 305 E
070 46 106 F 198 C6 306 F
071 47 107 G 199 C7 307 G
072 48 110 H 200 C8 310 H
073 49 111 I 201 C9 311 I
074 4A 112 CENT J 202 CA 312
075 4B 113 . K 203 CB 313
076 4C 114 < L 204 CC 314
077 4D 115 ( M 205 CD 315
078 4E 116 + N 206 CE 316
079 4F 117 | O 207 CF 317
080 50 120 & P 208 D0 320 }
081 51 121 Q 209 D1 321 J
082 52 122 R 210 D2 322 K
083 53 123 S 211 D3 323 L
084 54 124 T 212 D4 324 M
085 55 125 U 213 D5 325 N

086 56 126 V 214 D6 326 O
087 57 127 W 215 D7 327 P
088 58 130 X 216 D8 330 Q
089 59 131 Y 217 D9 331 R
090 5A 132 ! Z 218 DA 332
091 5B 133 $ [ 219 DB 333
092 5C 134 * \ 220 DC 334



113fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs112

093 5D 135 ) ] 221 DD 335
094 5E 136 ; ^ 222 DE 336
095 5F 137 _ 223 DF 337
096 60 140 - ` 224 E0 340
097 61 141 / a 225 E1 341
098 62 142 b 226 E2 342 S
099 63 143 c 227 E3 343 T
100 64 144 d 228 E4 344 U
101 65 145 e 229 E5 345 V
102 66 146 f 230 E6 346 W
103 67 147 g 231 E7 347 X
104 68 150 h 232 E8 350 Y
105 69 151 i 233 E9 351 Z
106 6A 152 j 234 EA 352
107 6B 153 , k 235 EB 353
108 6C 154 % l 236 EC 354
109 6D 155 _ m 237 ED 355
110 6E 156 > n 238 EE 356
111 6F 157 ? o 239 EF 357
112 70 160 p 240 F0 360 0
113 71 161 q 241 F1 361 1
114 72 162 r 242 F2 362 2
115 73 163 s 243 F3 363 3
116 74 164 t 244 F4 364 4
117 75 165 u 245 F5 365 5
118 76 166 v 246 F6 366 6
119 77 167 w 247 F7 367 7
120 78 170 x 248 F8 370 8
121 79 171 y 249 F9 371 9
122 7A 172 : z 250 FA 372
123 7B 173 # { 251 FB 373
124 7C 174 @ | 252 FC 374
125 7D 175 ` } 253 FD 375
126 7E 176 = ~ 254 FE 376
127 7F 177 " DEL 255 FF 377



113fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs112

isxy," fou< wlaIrj,g wod< hqksfla;
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j.=j  3'18 -  isxy, hqksfla;
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4 ;d¾lsl oajdr iu. nQ,Sh ùc ;¾lh  

fuu mßÉfþoh yeoEÍfuka Tng"

²   bf,lafg%dksl úoHdfõ Ndú; jk ix{d uÜgï"

²   uQ,sl ;d¾lsl oajdr iy ixhqla; ;d¾lsl oajdr ixfla;"

²   nQ,Sh m%ldYk yd i;H;d j.= weiqfrka oelaùu"

²   ixhqla; ;¾l oajdr uQ,sl ;d¾lsl oajdr weiqfrka ks¾udKh lsÍu"

²   nQ,Sh m%ldYkj,g wod< ixLHdxl mßm:hka we£u"

²   ixLHdxl mßm:j,g wod< nQ,Sh m%ldYk ,shd Bg wod< i;H;d j.= 

    f.dvke.Su"

²   ix.Dys; mßm:"

²   ;d¾lsl oajdrj, m%dfhda.sl fh§ï

    ms<sn| j wjfndaOhla ,nd .ekSug yels jkq we;'

 4'1      ye¢kaùu

tÈfkod Ôú;fhaa § Ôúka w;r ikaksfõokh úúOdldrfhka isÿ 

fõ' wE; w;S;fha § fhdod .;a ikaksfõok l%uhla jk wKfnr .eiSu 

;=<ska ñksidg mKsúv ksl=;a lrk nj hk ix{dj ksl=;a lrhs' ;j o ÿïßh 

ia:dkhl kj;ajd we;s ÿïßhl .uka wdrïNh i`oyd ÿïßh kshdul k<djla Yío 

fldg fld<mdg fldähla fid,jd ix{djla ksl=;a lrhs' ÿïßfhys .uk wdrïN-

hg ix{d myfkys fld<mdg n,anh oe,aù ;sìh hq;= w;r r;=mdg n,anh oe,afõ 

kï ÿïßh keje;aúh hq;= h' 

uqo,a fiamamqjla újD; lsÍu i|yd h;=re folla Ndú; flf¾ kï tu fodr 

újD; lsÍug h;=re fol u wjYH fõ' 

Tn ldrhl .ukla hdug m%:u ldrhg ke. fodrj,a ksjerÈ j jeish hq;= h' 

fuys § ldrfha tla fodrla fyda ksjerÈ j jeiS fkdue;s kï ta ms<sn`oj jdykfha 

n,anhla oe,aù fyda y`vla ksl=;a fydA ù ßheÿreg ix{djla ksl=;a lrhs' fodrj,a 

ish,a, jeiqKq miq j fuu ix{d ksl=;a ùu kj;sk w;r jdykh .uk weröug 

kï fuu fodrj,a y;r u ksjerÈ j jeish hq;= h' ;j o Tn ldrhl wiqfka jdä 

ù wdik máh me<|sh hq;= h' tfia fkdue;s kï ta nj ldrh ix{djla ksl=;a lr 

oekqï fohs' fufia idudkH Ôú;fha § wm ix{d Ndú;d lrkakd fiau mß.Klh 

o ix{d Wmfhda.S lr .kS'
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rEmh 4'1 ----------- - uQ,sl ;d¾lsl oajdr iïnkaê; mßm:h

 4'2      ;d¾lsl oajdr

oaúuh ixLHd wkqidrfhka hï hï ;¾l ;;a;aj f.dv kexùug;a ta wkqj 

hï hï ;SrK .ekSug;a yels jk mßm: ;d¾lsl mßm: (Logic Circuits) f,i 

ye`Èkafõ' mß.Klhla iE§ we;af;a ixlS¾K ixLHdxl mßm: rdYshl tl;=fjks' 

fuu bf,lafg%dksl mßm: ks¾udKh fldg we;af;a ;d¾lsl oajdr keue;s uQ,sl 

;d¾lsl mßm: rdYshla wjYH mßÈ tlsfklg iïnkaO lsÍfuks'

udOH ieliqï tAllh iE§ we;af;a ;d¾lsl oajdr w;súYd, ixLHdjla tl;= 

ùfuks' 4'1 rEmfha ±lafjkafka o AND, OR iy NOT hk uQ,sl ;d¾lsl oajdr 

iïnkaO ù iEÿk mßm:hls' 

 

 ;d¾lsl oajdrhla u.ska isÿ flfrkafka th fj; wdodkh flfrk wdodkhla 

fyda wdodk lsysmhla i,ld ne,Sfuka miq wod< m%;sodkhla ,nd §uhs'

 ;d¾lsl oajdr ksmoùfï ;dlaIKsl l%u .Kkdjla we;s w;r tys wNHka;r  

mßm:h g%dkaisiagr" vfhdav iy m%;sfrdaO wd§ wx.j,ska iukaú; fõ'

 ;d¾lsl oajdr mßm: Ndú; jk wdldrh wkqj fldgia follg fjka l< 

yel'

 

 1' uQ,sl ;d¾lsl oajdr (Basic Logic Gates)
 

 2' ixhqla; ;d¾lsl oajdr (Combinational Logic Gates)    



117fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs116

 4'3     uQ,sl ;d¾lsl oajdr

uQ,sl ;d¾lsl oajdr j¾. ;=kls' tkï"

1. AND oajdrh (AND  gate)   

2. OR oajdrh  (OR  gate)

3. NOT oajdrh (NOT gate)

4.3.1  AND oajdrh

AND  ;¾lh f;areï .ekSug my; WodyrK i,ld n,uq' 

• Tnf.a mß.Kl úoHd.drfha fodr h;=re oud jid bífnla o oud we;akï th 

weÍug kï fodf¾ h;=r o" bíndf.a h;=r o wjYH fõ' fuu h;=re fol u Ndú; 

lf<d;a muKla fodr újD; l< yel' fodf¾ h;=r fyda bì h;=r muKla Ndú; 

l< fyd;a fodr weßh fkdyel' ;j o h;=re fkdue;s kï fodr weßh fkdyel'

• AND fufyhqu f;areï .ekSug my; oelafjk ir, fY%aKs.; úoHq;a mßm:h   

i,ld n,uq' 

rEmh 4'2 - A yd B wdodk foflys ;¾lk   

wjia:dj 0 jQ úg úoHq;a mßm:h

Q

rEmh 4'4 - AND ;d¾lsl oajdrhg 

;=,H úoHq;a mßm:h

rEmh 4'3 - A yd B wdodk foflys ;¾lk  

     wjia:dj 1 jQ úg úoHq;a mßm:h 

Q

Q
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A B Q
0 0 0
0 1 0
1 0 0
1 1 1

j.=j 4'2 - AND ;¾l oajdrhg 

wod< i;H;d j.=j  

fuys A yd B iaúÉÑ folla yd Q n,anhla ir, fldaI folla iu. fY%aKs.; j 

iïnkaO fldg we;' iaúÉÑ fol wdodk f,i o n,anh m%;sodkh f,i o .ksuq'   

 fuys § A iaúÉÑh yd B iaúÉÑh hk fol u ixjD; j we;s wjia:dfõ §  

muKla n,anh oe,afõ' A iaúÉÑh muKla fyda B iaúÉÑh muKla fyda ixjD;j 

we;s wjia:dfõ § n,anh fkdoe,afõ' ;j o iaúÉÑ fol u újD; j we;s wjia:dfõ § 

o n,anh fkdoe,afõ'  

 iaúÉÑ újD; j we;s wjia:dj fyda n,anh ksù we;s wjia:dj ;¾l “0” 
u.ska o (rEmh 4'2) tla tla iaúÉÑh ixjD; j we;s wjia:dj fyda n,anh oe,afjk 

wjia:dj ;¾l “ 1ZZ u.ska o (rEmh 4'3) oelajQ úg" AND ;¾l oajdrhl wdodk yd 

m%;sodk w;r iïnkaO;d my; j.=fjys oelafõ' (j.=j 4'1)

 fuys Q =1 jkafka A iy B wdodk fol u 

;¾l “1” wjia:dfõ mj;sk úg muKs' wdodk fol 

u ;¾l “0” wjia:dfõ mj;sk úg o tla wdodkhla 

;¾l     “1”o wfkla wdodkh ;¾l “0” o wjia:d-

fõ mj;sk úg o Q =  0 fõ' fuu j.=j AND ;¾l 

oajdrhg wod< i;H;d j.=j (Truth Table) f,i 

ye`Èkafõ' (j.=j 4'2&

 fuu oajdrhg wdodk folla we;s neúka j.=fõ wjia:d y;rla ^2
2
 = 4& la 

fmkakqï lrhs'

 AND oajdrhl ;¾lkh jkafka “ A iy B ” (A AND B) hkak h' fuh 

ksrEmkh lsÍug nQ,shdkq wxlkh Ndú; lrk w;r th A.B f,i oelafõ' 

        AND oajdrhg wod< nQ,Sh ùc m%ldYkh yd AND oajdrfha ixfla;h my; 

oelafõ'

j.=j 4'1 ----- AND  g ;=,H úoHq;a mßm:fhys n,anfha iajNdjh

             A              B            Q

újD; újD; fkdoe,afõ

újD;        ixjD; fkdoe,afõ

ixjD; újD; fkdoe,afõ

ixjD; ixjD; oe,afõ

ksÍlaIKh 

 AND oajdrhl m%;sodkh 0 ùug kï wju jYfhka 

tla wdodkhla j;a 0 úh hq;= h' 
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fuu AND ;d¾lsl oajdrhg wju jYfhka wdodk folla mj;sk w;r wdodk 

follg jvd iys; AND ;d¾lsl oajdr mj;S' wdodk ;=kla iys; AND ;d¾lsl  

oajdrhla my; oelafõ'      

A

B
Q = A.B

rEmh 4'5 - AND ;d¾lsl oajdrhg wod< 

nQ,Sh ùc m%ldYkh  yd ixfla;h

   l%shdldrlu 

1.  A, B  yd  C  f,i wdodk ;=kla § we;s úg  Q kï m%;sodkh ,nd  

 .ekSug wod< AND ;d¾lsl oajdrh my; oelafõ' (rEmh 4'6)

fuu AND ;d¾lsl oajdrh my; mßm:hg ;=,H fõ' (rEmh 4'7)

  A

  B      Q
   C

»' fuys A yd B wdodk jk AND ;d¾lsl oajdrfha m%;sodkh jk P ,shd olajkak'

»». P yd C wdodk jk AND  ;d¾lsl oajdrfha m%;sodkh jk Q ,shd olajkak'

»»»' fuu Q ys w.h by; A, B  yd  C  wdodk ;=kla iys; AND ;d¾lsl oajdrfha 

m%;sodkhg iudk fõ'

    tu ksid fuu mßm:hg wod< nQ,Sh m%ldYkh kï"

       Q = A.B.C
    by; mßm:hg wod< i;H;d j.=fõ wjia:d 8 la we;' fuys wdodk 3 la we;s 

neúka i;H;d j.=fõ wjia:d 8 la ^2
3
 = 8& we;' 

A
B
C

Q = A.B.C 

rEmh 4'7 - wdodk ;=kla iys; AND ;d¾lsl oajdrhg ;=,H ;d¾lsl mßm:h

P

rEmh 4'6 - wdodk ;=kla iys; AND ;d¾lsl oajdrh
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    fuu mßm:fhys n,anh oe,afjkafka  A iaúÉÑh fyda  B iaúÉÑh (A  fyda 

B ) fyda  A yd B iaúÉÑ fol u fyda jid we;s úg muKs' fuh my; mßÈ j.=jl 

^j.=j 4'4& oelaúh yels h'

     

2' my; j.=fõ ysia;eka mqrjkak' Tng óg fmr bf.k .;a wdodk 2 lg wod< 

   AND oajdrfha i;H;d j.=j (j.=j 4'3) weiqfrka A.B ;Srh iïmQ¾K l< yel'  

   miq j A.B.C iïmQ¾K lrkak'

4.3.2  OR  oajdrh (OR gate)

OR  ;¾lh f;areï .ekSug my; WodyrK i,ld n,uq'

• fodr fofla nia r:hl .uka .kakd u.sfhl=g bÈßmi fyda miqmi fodrgqfjka 

nei hd yels h'

• ;u ksjig <`.dùug mdrj,a lsysmhla we;akï tu ´kE u mdrlska Tyqg ;u 

ksjig <`.dùug yel'

• my; oelafjk ir, úoHq;a mßm:h i,ld n,uq' ^rEmh 4.8 yd 4.9)
        

 fuys A yd B iaúÉp folla yd Q n,anhla ir, fldaI folla iu.  

iudka;r.; j iïnkaO fldg we;' iaúÉÑ fol wdodk f,i o n,anh m%;sodkh 

f,i o .ksuq'

A B C A.B   Q=A.B.C
0 0 0   0 ......
0 0 1 ......   0
0 1 0   0 ......
0 1 1 ...... ......
1 0 0   0   0
1 0 1 ...... ......
1 1 0 ......   0
1 1 1 ...... ......

j.=j 4'3 - wdodk ;=kla iys; AND ;¾lk oajdrhg wod< i;H;d j.=j  

rEmh 4'8 - wdodk foflys tla ;¾lk

  wjia:djla 1 jQ úg úoHq;a mßm:h

rEmh 4'9 -- wdodk foflys ;¾lk

 wjia:dj 0 jQ úg úoHq;a mßm:h 
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        tla tla iaúÉÑh ixjD; j we;s wjia:dj fyda n,anh oe,afjk wjia:dj ̂ rEmh 

4'8& ;¾l “1”  u.ska o  iaúÉÑhla újD; j we;s wjia:dj fyda n,anh ksù we;s  

wjia:dj ^rEmh 4'9& ;¾l “0”  u.ska o oelajQ úg" th my; mßÈ j.=fjys oelafõ' 

fuu j.=j OR ;¾l oajdrhg wod< i;H;d j.=j (Truth Table) f,i ye`Èkafõ' 

^j.=j 4'5&

 by; OR ;d¾lsl oajdrfha wdodk fol u 0 jQ úg ieu úg u m%;sodkh 0 

fõ' ;j o wdodk follg jvd jeä OR ;d¾lsl oajdrhl tu wdodk ish,a, 0 jQ 

úg ieu úg u m%;sodkh 0 fõ'

 by; j.=fõ ^j.=j 4'5& Q=1 jkafka A=1 fyda B = 1 fyda A = B =1 fyda jQ 

úg h' fuu j.=j OR ;¾l oajdrhg wod< i;H;d j.=j f,i ye`Èkafõ' 

 fuu fufyhqu nQ,Sh ùc .Ks;fhys ixfla;d;aul j olajkafka “A + B” 
f,i h' fuh Tn .Ks;fha § ixLHd tl;= lsÍu i`oyd Ndú; lrk tl;= lsÍfï 

.Ks; l¾uh fkdfõ' ;j o Ok ixLHdjla oelaùug Ndú; flfrk Ok ,l=K o 

fkdfõ' tkï th WÉpdrKh lrkafka “ A fyda  B”  ke;fyd;a  “ A OR  B” f,i h' 

A B Q
0 0 0
0 1 1
1 0 1
1 1 1

j.=j 4'5 -- OR ;¾l oajdrhg wod< i;H;d j.=j  

ksßlaIKh 

 OR oajdrhl m%;sodkh 1 ùug kï wju jYfhka tla  

wdodkhla j;a 1 úh hq;= h'

 

     A           B           Q
 újD; újD; fkdoe,afõ

 újD; ixjD; oe,afõ

ixjD; újD; oe,afõ

ixjD; ixjD; oe,afõ

j.=j 4'4 -- OR  oajdrhg ;=,H úoHq;a mßm:fhys n,anfha iajNdjh
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OR oajdrhg wod< nQ,Sh ùc m%ldYkh yd mßm: ixfla;h my; ̂ rEmh 4'10& oelafõ' 

4.3.3  NOT  oajdrh 

NOT ;d¾lsl oajdrh .ek i,lk úg wkqmQrl ix{dj ms<sn`o j oek .; 

hq;= h' wdodkh flfrk ;¾l ix{dj y`ÿkdf.k tys wkqmQrl ix{dj m%;sodkh 

lsÍu NOT oajdrhl ld¾hhs' fuys § ;¾l ix{d foflka ´kE u tlla wfkflys 

wkqmQrlh (Complement)  f,i ye`Èkafõ' tkï “ 0 ” ys wkqmQrlh “1” jk w;r  

“1” ys wkqmQrlh “0” fõ' 

wdodkh flfrk ;d¾lsl w.fhys wkqmQrlh m%;sodkh f,i ,nd .ekSu 

i`oyd fhdokq ,nk bf,lafg%dksl Wmdx.h NOT oajdrhhs' my; oelafjk mßm:h 

i,ld n,uq' ^rEmh 4'12&

A

B
Q =A+B

rEmh 4'10 -- OR ;d¾lsl oajdrhg wod< nQ,Sh ùc m%ldYkh yd ixfla;h

A, B  yd  C  f,i wdodk ;=kla § we;s úg Q kï m%;sodkh ,nd .ekSug 

wod<  OR  ;d¾lsl mßm:h my; oelafõ' ^rEmh 4'11&

   

 1' thg wod< nQ,Sh m%ldYkh ,shkak'

 2' by; m%;sodkh ,nd.ekSug wod< i;H;d j.=j f.dvk.kak'

 (      iudkhs)

rEmh 4'11 -- wdodk ;=kla iys; OR ;d¾lsl oajdrh

A
B
C

Q

A
B

C
Q

   l%shdldrlu 

R

rEmh 4'12 -- NOT ;d¾lsl oajdrhg ;=,H úoHq;a mßm:h 

QA
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 fuys A iaúÉÑh ixjD; j we;s úg n,anh yryd Odrdjla .,d fkdhk 

neúka th fkdoe,afõ' tfy;a A iaúÉÑh újD; j we;s úg n,anh oe,afõ' fuys 

m%odkh A jk úg iy A ys wkqmQrlh tys m%;sodkhhs' NOT fufyhqug wod< nQ,Sh 

m%ldYkh iy mßm: ixfla;h my; oelafõ' ^rEmh 4'13&

NOT  oajdrhg wod< i;H;d j.=j my; oelafõ' ^j.=j 4'6&

  

 4'4      ixhqla; ;d¾lsl oajdr
                                               

 ixLHdxl mß.Klh" .Kl hka;%h" frÈ fidaok hka;%h" Ëqø ;rx. 

Wÿk" cx.u ÿrl:k" kùk rEmjdyskS" ixLHdxl Trf,daiq iy jdhq iólrK wd§ 

WmlrKj, l%shdldß;ajh r`od mj;skafka ;d¾lsl oajdrj, l%shdj u; h' wjYH 

ixlS¾K ;¾lk ,efnk mßÈ úúO ;d¾lsl oajdr ixhqla; lsÍfuka ;kd .;a mßm: 

tajdfha fhdod we;' uQ,sl ;d¾lsl oajdr Ndú;fhka fuu ixhqla; ;d¾lsl oajdr 

ks¾udKh l< yel'

4.4.1   NOR  oajdrh 
 OR  fufyhqfuys wkqmQrl fufyhqu fyj;a NOT OR fufyhqu oelafjk 

;d¾lsl oajdrh NOR oajdrh f,i yeÈkafõ' fuys §" OR oajdrhl m%;sÞkh NOT 

oajdrhla fj; fhduq lrhs' tkï" OR iy NOT oajdr folla ixhqla; lsÍu NOR 

oajdrhlg iudk fõ' fuh my; mßÈ oelaúh yel' ^rEmh 4'14&

rEmh 4'13 -- NOT ;d¾lsl oajdrhg wod< nQ,Sh ùc m%ldYkh yd ixfla;h

A Q = A

A Q
0 1
1 0

j.=j 4'6 -- NOT ;¾l oajdrhg wod< i;H;d j.=j  

A

B
 Q = BA+

Q1=A+B

rEmh 4'14 -- NOR ;d¾lsl oajdrhg ;=,H ;d¾lsl mßm:h
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uQ,sl i;H;d j.= weiqfrka fuhg wod< i;H;d j.=j my; mßÈ f.dvke.sh yel' 

^j.=j 4'7&

A B   Q1 = A+B Q = A+B
0 0 0 1
0 1 1 0
1 0 1 0
1 1 1 0

j.=j 4'7 -- uQ,sl i;H;d j.= weiqfrka NOR ;¾l oajdrhg wod< i;H;d j.=j  

rEmh 4'14 -- NOR ;d¾lsl oajdrhg wod< nQ,Sh m%ldYkh iy ixfla;h

ksßlaIKh 

by; NOR ;d¾lsl oajdrfha m%;sodkh 1 ùu i`oyd wdodk folu 

0 úh hq;= h' ;j o wdodk follg jvd jeä NOR ;d¾lsl 

oajdrhl tu wdodk ish,a, 0 jQ úg ieu úg u m%;sodkh 1 fõ' 

 fï wkqj NOR oajdrh tlsfkl iu. fY%aKs.; j iïnkaO fldg we;s OR 
yd NOT oajdr follg ;=,H fõ' NOR oajdrhg wod< nQ,Sh m%ldYkh iy ;d¾lsl 

mßm: ixfla;h my; oelafõ' ^rEmh 4'15&

fuhg wod< ;d¾lsl mßm:h yd i;H;d j.=j my; oelafõ' ^j.=j 4'8&

 

A

B
Q = BA+

A B Q
0 0 1
0 1 0
1 0 0
1 1 0

j.=j 4'8 -- NOR ;d¾lsl oajdrhg wod< i;H;d j.=j 

rEmh 4'15 -- NOR ;d¾lsl oajdrhg wod< nQ,Sh m%ldYkh iy ixfla;h
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A, B  yd  C  f,i wdodk ;=kla § we;s úg  Q kï m%;sodkh ,nd  

.ekSug wod< ;d¾lsl mßm:h my; oelafõ' ^rEmh 4'16&

 

 1' thg wod< nQ,Sh m%ldYkh ,shkak'

 2' by; m%;sodkh ,nd .ekSug wod< i;H;d j.=j f.dvk.kak'

rEmh 4'16 -- wdodk ;=kla iys; NOR ;d¾lsl oajdrh

A
B

C

A
B
C

Q  = A+B+C
Q  = A+B+C

   l%shdldrlu

4.4.2  NAND  oajdrh ( NAND  gate)

• NAND fufyhqu f;areï .ekSug fuys oelafjk 

ir, úoHq;a mßm:h i,ld n,uq' ^rEmh 4'17& 

fuys A yd B iaúÉÑ folla  yd Q n,anhla ir, 

fldaIhla iu. iïnkaO fldg we;' iaúÉÑ fol 

wdodk f,i o n,anh m%;sodkh f,i o .ksuq'                                          

fuys § A iaúÉÑh yd B iaúÉÑh hk fol u ixjD; 

j we;s wjia:dfõ § muKla n,anh fkdoe,afõ'  wka 

iEu wjia:djl u n,anh ±,afõ' 

  NAND  fufyhqfuys wkqmQrl fufyhqu  

fyj;a NOT  AND fufyhqu oelafjk ;d¾lsl oajdrh  
NAND  oajdrh f,i ye`Èkafõ' fuys § isÿ jkafka AND oajdrhl m%;sodkh NOT  
oajdrhlg fY%aKs.; j iïnkaO lsÍu h' th my; mßÈ oelaúh yel' ^rEmh 4'18&

A

B

rEmh 4'18 -- NAND ;d¾lsl oajdrhg ;=,H ;d¾lsl mßm:h

rEmh 4'17 - NAND ;d¾lsl 

oajdrhg ;=,H úoHq;a mßm:h 

A B

Q

Q = A.B
Q1 = A.B
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rEmh 4'19 - NAND ;d¾lsl oajdrhg wod< nQ,Sh m%ldYkh iy ixfla;h

A

B
Q = A.B

uQ,sl oajdr j,g wod< i;H;d j.= weiqfrka fuu ;¾lhg wod< i;H;d 

j.=j my; mßÈ f.dvke.sh yel' ^j.=j 4'9&

fuh ksrEmKh lrk nQ,Sh ixfla;h yd nQ,Sh m%ldYkh my; mßÈ oelaúh yel' 

^rEmh 4'19&

NAND ;d¾lsl oajdrfha i;H;d j.=j my; oelafõ' ^j.=j 4'10&

A B Q1 = A.B Q = A.B
0 0 0 1
0 1 0 1
1 0 0 1
1 1 1 0

j.=j 4'9 -- uQ,sl i;H;d j.= weiqfrka NAND ;¾l oajdrhg wod< 

i;H;d j.=j  

A B Q = A.B
0 0 1
0 1 1
1 0 1
1 1 0

j.=j 4'10 -- NAND  ;d¾lsl oajdrhg wod< i;H;d j.=j 

NAND ;d¾lsl oajdrhl wdÞk fol 1 jQ úg ieu úg u 

m%;sÞkh 0 fõ' 

ksßlaIKh 
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A, B  yd  C  f,i wdodk ;=kla § we;s úg Q kï m%;sodkh ,nd .ekSug 

wod< ;d¾lsl mßm:h my; oelafõ' ^rEmh 4'20&

1' thg wod< nQ,Sh m%ldYkh ,shkak'

2' by; m%;sodkh ,nd .ekSug wod< i;H;d j.=j f.dvk.kak'

rEmh 4'20 -- wdodk ;=kla iys; NAND ;d¾lsl oajdrh

Q = A.B.C
Q = A.B.C

   l%shdldrlu 

 4'5      nq,Sh m%ldYkhg wod< ;d¾lsl mßm: ks¾udKh

Q = A.(A +B)+B hk nQ,Sh ùc m%ldYkh ,nd .ekSu i|yd ;d¾lsl oajdrj,ska hq;a 

mßm:hla ks¾udKh lruq'

fuu mßm:fhys wdodk folla we;' tkï A yd B h' by; nQ,Sh m%ldYkhg wod< 

;d¾lsl mßm:h my; oelafõ' ^rEmh 4'21&    

rEmh 4'21 -- Q = A.(A+B)+B hk nQ,Sh ùc m%ldYkhg wod< mßm:h

A

B
Q = A.(A+B)+B

A
A

A+B

B

A.( A+B )

B

A
B
C

A

B

C
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1' my; nQ,Sh m%ldYkj,g wod< ixLHdxl mßm:h we| wod< i;H;d 

j.= f.dvk.kak'

      (a)  A+A.B
         (b)  A.(A+B)
         (c)  (A+B).(A.C)

     2' my; ixLHdxl mßm:j,g wod< nQ,Sh m%ldYk ,shd Bg wod< 

     i;H;d j.= f.dvk.kak'

     

 (a).

(b).

(c)

A

B
Q

A
B

Q

A

B
Q

C

   l%shdldrlu 
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(d).

(e)

(f)

A B C

Q

A
B
C

Q

A
B

Q

Tn fuu mßÉfþofha § bf.k .;a ;d¾lsl mßm: ish,a, Multimedia 
Logic (MM Logic) uDÿldx.h Ndú;fhka we| tys wdodkhkag w.hhka 

§ l%shdldß;ajh ksÍlaIKh lrkak'

( http://www.softronix.com/logic.html )

    l%shdldrlu 
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 4'6     ix.Dys; mßm: (Integrated Circuits)

bf,lafg%dksl mßm:hla f.dvke.Sfï § wjYH Wmdx.hla f,i ix.Dys; 

mßm:hla fyj;a whs'iS' tlla ye¢kaúh yel' ;j o ixlS¾K bf,lafg%dksl mßm:hla 

úúO mßm: fldgiaj,ska hqla; h' WodyrK f,i kQ;k rEmjdyskS hka;%hl 

mßm:hla" cx.u ÿrl:khl mßm:hla ie,l=j fyd;a tys mßm: fldgia rdYshla 

we;' ix.Dys; mßm:hla hkq g%dkaisiagr (Transistors), m%;sfrdaOl (Resistors), 
Odß;%l (Capacitors) yd vfhdav (Diodes) jeks Wmdx.hkaf.ka ieÿï ,;a hï 

ksYaÑ; l%shdjla fjkqfjka u ksmojqKq mßm: úfYaIhls' tla mßm: fldgila 

iïmQ¾Kfhka tla wiqrKhla ;=< l=vd m%udKfhka ksmoúh yels ;dlaIKsl l%u 

oeka Ndú; fõ' tu ;dlaIKh WmfhdA.s fldgf.k ksmojd we;s ix.Dys; mßm: 

fõ'

rEmh 4'23 ys oelafjk mßÈ Ëqø ilikh ;d¾lsl oajdr Ndú; jk wkql,s; 

mßm: rdYshlska iE§ we;'

fuu wkql,s; mßm: ;=< ;d¾lsl oajdr mßm: wka;¾.; h' WodyrKhla 

f,i rEmfha 4'22 ys oelafjkafka AND oajdr Ndú; jk ;d¾lsl wkql,s; mßm:hls' 

fuf,i iEu ;d¾lsl oajdrhla u wka;¾.; jk fia ks¾udKh jQ ix.Dys; mßm: 

we;'

fuu wkql,s; mßm:fhys ^rEmh 4'22& 1, 2,  4, 5, 9, 10, 12 yd 13 hk ;=vq 

(Pins) wdodkhka fõ' fuys 3, 6, 8 yd 11 hk ;=vq m%;sodk fõ' ;j o rEmh 4'24 ys 

oelafjkafka ;=vq 14 la iys; ix.Dys; mßm:hl ndysr fmkquhs'

rEmh 4'22 -- AND oajdr iys; 

;d¾lsl wkql,s; mßm:h

rEmh 4'23 -- wkql,s; mßm:hl ndysr fmkqu
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 4'7     ;d¾lsl oajdrj, m%dfhda.sl fhojqï

WodyrK -1

ksjil wk;=re weÕùu ms<sn`o ix{d moaO;sh (Home Alarm System)     

         my; mßm:fhka oelafjkafka ksjil fidr i;=re lrorhla we;s ùul § 

ta nj ksfjia ysñhdg yeÕùug Ndú; flfrk ix{d moaO;shls' fuh OR ;d¾lsl 

oajdr Ndú; lrñka ks¾udKh lr we;' fuys § fuu mßm:h ksjfiys cfka, 

folla o" bÈßmi iy miqmi fodr o wdrlaId lrhs' fuys ´kEu cfka,hla fyda 

fodrla újD; l< úg wk;=re ix{d y`v ksl=;a fõ' fuu mßm:h m%dfhda.sl j  

ks¾udKfha § cfka, iy fodrj,a ksrEmKh lrk ;d¾lsl oajdr ixfõol j,g 
(Sensors) iïnkaO fõ' fuu mßm:fha § cfk,a fodrj,a újD; j we;s wjia:dfõ" 

wÞ< wdÞkh 1 f,i o ixjD; wjia:dfõ wdokh 0 f,i o f.k we;' rEmh 4'28 ys 

oelafjk mßÈ fuys wdodk ish,a, “0” jQ úg wk;=re weÕùula isÿ fkdfõ' tkï 

    

    

   l%shdldrlu 

 1' my; § we;s wkql,s; mßm:h (IC) (rEmh 4'24) i,lkak' 

by; mßm:fhys 1,2 iy 3 hk ;=vq ie,l+ úg ;=vq 2 = 0 iy  3 = 0 jkafka kï 

;=vq 1 l=ula úh hq;= o@

2' my; § we;s wkql,s; mßm:fha (IC) ^rEmh 4'25& 1, 2 iy 3 hk ;=vq      

   ie,l+ úg ;=vq 1 = 1 iy 2 = 1 jkafka kï ;=vq 3 l=ula úh hq;= o@

rEmh 4'24 -- NOR ;d¾lsl wkql,s; mßm:h

14

1

13 12 11 10 9 8

2  3 4 5  6  7

rEmh 4'25 -- NAND ;d¾lsl wkql,s; mßm:h

14 13 12 11 10 9 8

2  3  4  5  6  71
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fuu wjia:dfõ § cfka,hla fyda fodrla fyda ish,a, u fyda ixjD; j mj;S' kuq;a 

tla wdodkhl w.h “1” fyda wdodk lsysmhl w.h “1” fyda wdodk ish,af,a u w.h 
“1” jQ úg wk;=re weÕùula isÿ flf¾' tkï i;=rl= úiska tla cfka,hla fyda 

fodrla fyda lsysmhla fyda újD; l< úg wk;=re ix{d ksl=;a lrhs' WodyrKhla 

f,i rEmh 4'28 ys oelafjkafka m<uq cfka,h lsis hï mqoa.,hl= úiska újD; l< 

miq ta ms<sn`o j f.ysñhdg wk;=re wÕjk whqre h' fuf,i ix{d moaO;sh u.ska 

wk;=re yÕjk wjia:d j.=j 4'12 ys oelafõ'   

 

rEmh 4'26 -- ksjil wk;=re weÕùu ms<sno ix{d moaO;sh

wk;=re ix{dj

cfka,h 1 ixfõolh

cfka,h 2 ixfõolh

bÈß fÞr ixfõolh

miqmi fÞr ixfõolh

0

0

0

0

0

0
0

rEmh 4'27 -- ksjil wk;=re weÕùu ms<sno ix{d moaO;sh u.ska wk;=re 

             ye`.ùula fkdlrk wjia:dj 

cfka,h 1 ixfõolh

cfka,h 2 ixfõolh

bÈß fÞr ixfõolh

miqmi fÞr ixfõolh

1

0

0

0

1

0
1

rEmh 4'28 -- ksjil wk;=re weÕùu i|yd ix{d moaO;sh Ndú; jk whqre

cfka,h 1 ixfõolh

cfka,h 2 ixfõolh

bÈß fÞr ixfõolh

miqmi fÞr ixfõolh
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cfka,h 1 cfka,h 2 bÈßmi   

fodr

miqmi 

fodr

           wjia:dj

0 0 0 0 0

0 0 0 1 1

0 0 1 0 1

0 0 1 1 1

0 1 0 0 1

0 1 0 1 1

0 1 1 0 1

0 1 1 1 1

1 0 0 0 1

1 0 0 1 1

1 0 1 0 1

1 0 1 1 1

1 1 0 0 1

1 1 0 1 1

1 1 1 0 1

1 1 1 1 1

WodyrK 2 

ùÈ ,dïmqj,ska isÿ jk úÿ,s kdia;sh wju ùu i`oyd ks¾udKh jQ mßm:h

kj ksmehqïlrefjl= úiska ùÈ ,dïmqj,ska isÿ jk úÿ,s kdia;sh wju 

lr .ekSug (system to control street lights) ;d¾lsl oajdr Ndú;fhka ks¾udKh 

lrk ,o mßm:hla rEmh 4'29 u.ska oelafõ' fuh wdf,dal ixfõolhla (dark/
light sensor), ld, .Klhla (timer) yd hdka;%sl iaúÉphla (manual switch) Ndú; 

lrñka ks¾udKh lr we;' 

wjia:djka  (Status) 
újD; = 0
ixjD; = 1
wk;=re wÕjk wjia:dj = 1
wk;=re fkdwÕjk wjia:dj = 0
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 fuys § ùÈ ,dïmqj oe,afjk wjia:d lsysmhla fmkakqï lrhs' tkï"

∗ hdka;%sl iaúÉph muKla ixjD; j we;s wjia:dj 

∗ mßm:fha ld, .Klfha wdodkh 1 yd wjg mßirh w÷re wjia:dj

4'7'2'1  hdka;%sl iaúÉph muKla ixjD; j we;s wjia:dj 

hdka;%sl iaúÉph ixjD; j we;súg tys wdodkh 1 jk w;r újD; wjia:dfõ 

§ wdodkh 0 fõ' wdodkh 1 jk wjia:dfõ ,dïmqj ±,afõ'  

4'7'2'2  mßm:fha ld, .Klfha wdodkh 1 yd wjg mßirh w÷re wjia:dj

ld, .Klfhys fõ,dj fmr ieliQ fõ,dj,a folla w;r mrdifha we;s 

kï wdodkh 1 ;a ke;skï 0 ;a fõ' tkï miajre 6'00 yd fmrjre 6'00 f,i fmr 

ilid we;akï wdodkh 1 f,i;a fmrjre 6'00 isg miajre 6'00 olajd w;r we;s 

ld,fha § wdodkh 0 ;a fõ' ;j o wdf,dal ixfõolh fmr ieliQ w.hlg fyda 

Bg jvd wdf,dalh we;s wjia:dfõ § 1 ;a w÷re wjia:dfõ § 0 ;a fõ' fuys § 

ld,.Klfha wdodkh 1;a wdf,dal ixfõolfha w.h 0 ;a jQ úg ùÈ ,dïmqj oe,afõ'  

fuys§ mßirh jeys w÷rlg ,la ù ;snqK fyd;a wdf,dal ixfõolfha w.h 0 jqj;a 

ld,>klfhys igyka fõ,dj miajre 6'00 yd fmrjre 6'00 ;a w;r fkdfõ kï 

ùÈ ,dïmqj fkdoe,afõ'

ùÈ ,dïmqj

rEmh 4'29 -- ùÈ ,dïmqj,ska isÿ jk úÿ,s kdia;sh wju ùu i`oyd jQ 

                  mßm:h

hdka;%sl iaúph

ld, .Klh

wdf,dal ixfõolh
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   l%shdldrlu 

fudag¾ r: Wmdx. ksIamdok wdh;khla úiska fudag¾ r:fha tkaðu 

l%shd;aul j fkdue;s úgl § r:fha p,khla fyda ùÿrejlg ydkshla 

isÿ jQ úgl wk;=re ix{djla ksl=;a jk fudag¾ r: wdrlaIl mßm:hla 

ksIamdokh fldg we;' fï i`oyd fudag¾ r:fha tkaðu ls%hd;aul j 

mj;sk úg § muKla m%;sodkh 1 jk ixfõolhla" ùÿre j,g ydks 

jQ úg muKla m%;sodkh 1 jk ixfõolhla yd r:fha p,kh jk 

wjiA:dj, § muKla m%;sodkh 1 jk ixfõolhla Ndú; lr we;'

fuu mßm:h uQ,sl oajdr ;=klska ks¾udKh ù we;' bka tlla NOT oajdrhla jk 

w;r wfkla oajdr fol ysia fldgq foflys wka;¾.; l< hq;= h' ta i`oyd iqÿiq 

;d¾lsl oajdr ljf¾ o@

tu oajdr Ndú;fhka mßm:h kej; we| olajkak'

................

tkaðka ixfõolh

ùÿre ydks ixfõolh

p,k ixfõolh

wk;=re ix{dj................
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  ;d¾lsl oajdr       ixfla;h    nQ,Sh m%ldYkh      i;H;d j.=j

OR Q = A+B

AND Q = A.B

NOT Q = A

NOR Q = A+B

NAND Q = A.B

A
B

Q

Q
A
B

QA

A
B

Q

Q
A
B

A B Q
0 0 0
0 1 1
1 0 1
1 1 1

A B Q
0 0 0
0 1 0
1 0 0
1 1 1

A Q
0 1
1 0

A B Q
0 0 1
0 1 0
1 0 0
1 1 0

A B  Q
0 0 1
0 1 1
1 0 1
1 1 0

idrdxYh
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5
fufyhqï moaO;s

fuu mdvu yeoEÍfuka Tng" 

²   fufyhqï moaO;shl wjYH;dj 

²   fufyhqï moaO;shl l%shdldß;ajh

²   fufyhqï moaO;sj, w;=reuqyqK;a 

²   fufyhqï moaO;shl ld¾hNdrh

²   fufyhqï moaO;s j¾. 

²   fufyhqï moaO;sj, jdis

²   fufyhqï moaO;shl Wmfhda.S;d jevigyka

²   Odjl" f*da,av¾ iy f.dkq

 ms<sn`o j ukd wjfndaOhla ,nd .ekSug yels jkq we;'

 5'1    fufyhqï moaO;s y`ÿkajd §u

mß.Klhla oDVdx. (Hardware)" iaÓrdx. (Firmware) iy uDÿldx. 

(Software) hk wx.j,ska iukaú; fõ' 

 oDVdx. (Hardware) hkq ksYaÑ; yevhla iys;" wmg iam¾Y l< yels" 

mß.Klhl fN!;sl fldgia fõ' ta wkqj h;=re mqjrej" uQislh" ixo¾Ylh" oDV 

;eáh" kdolh iy  uqøK hka;%h hkq oDVdx. i|yd WodyrK lsysmhls'

 iaÓrdx. (Firmware) hkq mGk ud;%  u;lfhys ̂ ROM& ia:dms;" mß.Klfha 

uQ,sl l%shd;aul ^BOOT& ùug wod< Wmfoia fõ'   mßYS,lhd ;srh u; olsk m%:u 

Ñ;%l fyda joka m%;sodkh lrkq ,nkafka o iaÓrdx. úisks'
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mß.Klfha wdrïNl l%shdldß;ajh isÿ jk whqre

 ² mßYS,l úiska mß.Klhg úÿ,s n,h iemhSu;a iu. u  uOH ieliqï tallh 

^CPU& u.ska uQ,sl wdodk m%;sodk moaO;sh ^Basic Input Output System-BIOS& 

m%fõYkh flf¾'

 ² m<uq j Power-On Self Test ^POST& jevigyk Odjkh fõ' fuys wdrïNl 

mshjr jYfhka CMOS ^Complementary Metal Oxide Semiconductor& u;lh 

wkqj ish¨ u oDVdx. mÍlaId lr n,d tajd kshñ; mßÈ l%shd;aul jk njg 

;yjqre lr .kshs'

 ² bka miq mß.Kl ksIamdok iud.u u.ska imhd we;s Wmfoia wvx.= bootstrap 
loader kï jQ iaÓrdx.hg wkqj POST jevigyfkka y÷kd .;a boot sequence 
ys m<uq wdphk Wml%ufhys ^boot drive& Master Boot Record  ^MBR& lshjhs' 

 ² wjidkfha  boot drive ys we;=<;a fufyhqï moaO;sh iiïNdù m%fõY u;lhg 

^RAM& m%fõYkh lr .kshs'

 ² bka miq mß.Klfha md,kh iïmQ¾Kfhka u fufyhqï moaO;sh u.ska ,nd 

f.k mßYS,lhdg w;=reuqyqK;la ^User Interface& ,nd fohs'

 fuu iïmQ¾K l%shdj,sh booting f,i y`ÿkajkq ,nk w;r tys w¾:h 

fufyhqï moaO;shla mß.Klfha iiïNdù m%fõY u;lhg ^m%Odk u;lhg& m%fõY 

lr .ekSuhs'

 uDÿldx. (Software) hkq mß.Klh ;=<sska hï lsis ld¾hhla bgq lr .ekSug 

fokq ,nk Wmfoia iuQyhls' uDÿldx. j¾. lsysmhla we;' tajd fufia fjka lr 

oelaúh yels h'

rEmh -5.1 - uDÿldx. j¾.

uDÿldx. (Software)

moaO;s uDÿldx. 
(System Software)

fhÿï uDÿldx. 
(Application Software)

a) fufyhqï moaO;s

(Operating System)
b) Wmfhda.s;d     

   uDÿldx. 
(Utility Software)

   c) NdId mßj¾;l 

(Language Translators)

tfiïí,rh (Assembler)
iïmdol      (Compiler)
w¾:úkHdil  (Interprter)

Wod - 
-joka ieliSu  (Word Processing)
me;=reïm;a  (Spread Sheets)
o;a; iuqodh  (Database)
mß.Kl lS%vd (Computer Games)
fjí w;ßlaiq (Web Browsers)
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5'1'1 moaO;s uDÿldx. (System Software)

1& moaO;s uDÿldx. (System Software&------- - moaO;s uDÿldx. m%Odk jYfhka j¾. 

;=klg fnÈh yels h' tkï"  

a)' fufyhqï moaO;s ^Operating System& --------- mß.Klfha ia:dms; wfkl=;a 

uDÿldx. iy oDVdx. l<ukdlrKh lrñka mßYS,lhdg mß.Klh 

Ndú; lsÍug wjldYh ,nd fokafka fufyhqï moaO;sh u.sks' moaO;s 

uDÿldx. yd fhojqï f,i mj;sk uDÿldx. oDVdx. iu. ia;r jYfhka  

iïnkaO jk wdldrh my; rEmh 5'2 fmkakqï flf¾' 

  

  

b)' Wmfhda.s;d uDÿldx. ^Utility Software& -mß.Klfha ia:dms; wfkl=;a 

uDÿldx. úYaf,aIKh lsÍu iy mß.Klh kv;a;= lsÍu jeks l%shdjka 

i|yd Woõ lsÍug ks¾udKh lr we;' Wmfhda.s;d uDÿldx." fhÿï 

uDÿldx. j,ska fjkia jkafka" ixlS¾K;ajfhka iy l%shdldß;ajfhka 

h' Wmfhda.S;d uDÿldx. mß.Klfha iïm;a l,ukdlrKh lsÍug 

iyh fõ' kuq;a fhÿï uDÿldx. Bg iïmQ¾Kfhka fjkia jQ úúO 

ld¾hhka isÿ lrhs' úúO jQ ld¾hh i|yd úúO Wmfhda.s;d uDÿldx. 

ks¾udKh lr we;' bka iuyrla kï"  

1&  m%;s jhsri uDÿldx. (Anti virus Software) - ffjria wdidok j,ska   

 mß.Klh wdrlaId lr .ekSu'

2& ;eá wdlD;slrKh (Disk formatting) - f.dkq yd f*da,avr   

 ;ekam;a lsÍug iqÿiq wdldrhg ;eáh ieliSu'

rEmh -5.2 -- oDVdx." moaO;s uDÿldx." fhÿï uDÿldx.
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c)'   NdId mßj¾;l ^Language Translators) 
 mß.Kl jevigykla ^uDÿldx.& iE§ we;af;a Wmfoia iuQyhla tl;= 

ùfuks' fuu Wmfoia ,sh ù we;af;a ñksia NdIdj,g ióm Wiia 

uÜgfï NdIdj,sks' (High Level Language) fïjd mß.Klhg y÷kd 

.; yels mß.Kl NdId j,g (Machine Language) tkï zz1ZZ iy zz0ZZ 

j,g mßj¾;kh lrkq ,nkafka NdId mßj¾;l u.sks' tfiïí,rh 
(Assembler), iïmdol ^Compiler)" w¾:úkHdil ^Interpreter& hkdÈh 

fï i|yd WodyrK fõ'

5'1'2 fhÿï uDÿldx. (Application Software)

 fhÿï uDÿldx. (Application Software& --------- fufyhqï moaO;shla ^Operating 
System& u; muKla l%shd;aul jk fhÿï uDÿldx. mßYS,lhdf.a mß.Kl 

wdY%s; l%shdldrlï ^,sms f,aLk ieliSu" .‚; l¾u" o;a; /ia lsÍu iy tajd 

yeisrùu" mß.Kl l%Svd wdÈh& i|yd fhdod .kq ,nhs'

 ² Wod-(--------- joka ieliSu ̂Word Processing& me;=reïm;a (Spread Sheets& 
o;a; iuqodh (Database& mß.Kl l%Svd ^Computer games)" fjí 

w;ßlaiq ^Web Browsers)      
        

5'1'3  fufyhqï moaO;shl wjYH;dj

 mßYS,lhd iy mß.Kl oDVdx. w;r iïnkaO;dj we;s lrkq ,nk  

uDÿldx.h fufyhqï moaO;shhs' fufyhqï moaO;s uDÿldx. u.ska úúO fhÿï 

uDÿldx. mß.Klhg ia:dmkh lsÍu iy l%shd;aul lsÍu i|yd wjYH jk úOdk 

imhk w;r th wdodk Wmdx. ^input devices)" m%;sodk Wmdx. ^output devices) iy 

mß.Kl u;l ^computer memory& l<ukdlrKh lrkakd fuka u mß.Klfha 

ia:dms; wfkl=;a uDÿldx. yiqrjkakd o fjhs' tfiakï iuia; mß.Kl moaO;sh 

u yeisrùu fufyhqï moaO;sh u.ska isÿ lrk nj fuu.ska meyeÈ,s fjhs' 
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5'1'4  úúO fufyhqï moaO;s

1. Windows fufyhqï moaO;s 
Microsoft iud.u úiska ksmojkq ,en we;s fuu Windows fufyhqï moaO;s" 

m%ldYk ysñlï iys;" uqo,a f.jd ,nd .; hq;= moaO;s uDÿldx.hls' f,dj mqrd b;d 

ckm%sh ù we;s Windows fufyhqï moaO;sh úúO ixialrKj,ska ,nd .; yels h'

WodyrK 
Windows XP, Windows Vista, Windows 7, Windows 8
 óg wu;r j cx.u ÿrl:k" geí,Ü mß.Kl jeks WmlrKj,  

ls%hdldß;ajh isÿ lsÍug MS Windows Mobile f,i fufyhqï moaO;shla y`ÿkajd § 

we;' tfia u fiajd Þhl (server) mß.Klj, ls%hdldß;ajh i|yd (server) fufyhqï 

moaO;sh f,i MS Windows Server kñka fufyhqï moaO;shla ksmojd we;' 

2. Mac fufyhqï moaO;sh

Apple iud.u úiska ksmojd we;s Mac OS kï jQ fufyhqï moaO;sh  Apple 
Macintosh mß.Klj, Ndú;d flf¾'

mßYS,lhd (Human User)

oDVdx. (Hardware)

fufyhqï moaO;sh (Operating System) 

fhÿï uDÿldx. 

(Application Software)

wfkl=;a moaO;s uDÿldx. 

(Other System Software)

 rEmh -- 5.3- mßYS,lhd yd mß.Klh w;r iïnkaO;dj 
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 fuu fufyhqï moaO;sh m%ldYk ysñlï iys; uqo,a f.jd ,nd .; hq;= 

moaO;s uDÿldx.hls' fuu fufyhqï moaO;sh Apple iud.u úiska ksmojk ,o 

mß.Klj, muKla ia:dmkh l< yels h'

3. Ubuntu fufyhqï moaO;sh

Linux fufyhqï moaO;sh mdol lr .ksñka Ubuntu fufyhqï moaO;sh 

ksmojd we;' fuu fufyhqï moaO;sh iïmQ¾Kfhka u fkdñf,a ,nd .; yels h' 

újD; fufyhqï moaO;shla ^Free and Open Source) f,i ye`Èkafjk fuh http://
www.ubuntu.com/download fjí wvúh u.ska fkdñf,a nd.; l< yels h'

4. Android fufyhqï moaO;sh
Google iud.u úiska Android fufyhqï moaO;sh ksmojkq ,en we;' cx.u 

Wmdx. i|yd úfYaIfhka fhdod .kq ,nk fufyhqï moaO;shla f,i Android 
y÷kajd Èh yels h' fuh o iïmQ¾Kfhka u fkdñf,a ,nd fok fufyhqï moaO;shls'

5. Hanthana Linux fufyhqï moaO;sh 

Linnux fufyhqï moaO;sh mdol lrf.k ksmo jQ fyda www.hanthana.org 
u.ska fkdñ,fha nd .; yels uDÿldx.hls'

5'1'5  fufyhqï moaO;s j¾.SlrKh

fufyhqï moaO;shl m%Odk;u ld¾hNdrh jkqfha mß.Kl hka;%h 

ls%hd;aul l< fudfydf;a isg u ls%hd úrys; lrk wjia:dj olajd u mß.Kl 

hka;%fha oDVdx. Wmßu jYfhka fhdod .ksñka mßYS,lhdg wjYH fhojqï uDÿldx. 

ls%hd;aul lsÍug wjYH mßirh f.dvk.d §uhs' fufyhqï moaO;sj, ls%hdldß;ajh 

wkqj tajd my; whqßka j¾.SlrKh lr we;'

1' tAl mßYS,l   (Single user)
2'  nyq mßYS,l    (Multi user)
3'  nyq ld¾h   (Multi tasking)
4'  ;;H ld,   (Real time)

1' tAl mßYS,l (Single user) fufyhqï moaO;s

tla jrlg tla mßYS,lfhl= iïnkaOfhka fiajd imhk fufyhqï 

moaO;shla tAl mßYS,l fufyhqï moaO;shla fõ' 

WodyrK - MS DOS fufyhqï moaO;sh
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2' nyq mßYS,l (Multi user) fufyhqï moaO;s

 fndfyda mßYS,lhkag tl jr mß.Kl hka;%hla fj; m%fõY ù lghq;= 

lsÍug myiqlï i,ik fufyhqï moaO;shla nyq mßYS,l fufyhqï moaO;sh f,i 

yeÈkafõ' uyd mß.Kl (Mainframe) jeks tl jr mßYS,lhska úYd, msßilg 

lghq;= l< yels mß.Kl hka;%j,g nyq mßYS,l fufyhqï moaO;s ia:dmkh lrkq 

,efí'

WodyrK - Linux, Windows server

3' nyqld¾h (Multi tasking) fufyhqï moaO;s
tl jr ld¾h lsysmhla isÿ l< yels fufyhqï moaO;s nyqld¾h fufyhqï 

moaO;s f,i ye`Èkafõ' fujeks fufyhqï moaO;s ;=<ska ;ks mßYS,lfhl=g nyqld¾h-

hka isÿ lr .ekSug yelshdj we;' 

--WodyrK - Windows 7, Windows 8, Ubuntu , Mac OS
4' ;;H ld, (Real time) fufyhqï moaO;sh

wdodk ,nd ÿka ú.i u lsisÿ m%udohlska f;dr j m%;spdr olajk fufyhqï 

moaO;shls' iajhxl%Sh j md,kh jk hka;%j, fndfyda úg fuu ;;H ld, fufyhqï 

moaO;s ls%hd;aul fõ' úoHd;aul WmlrK fyda Bg iudk l=vd WmlrKj, 

l%shdldß;ajh md,kh i|yd fhdÞ .kS' fuu fufyhqï moaO;s hï iqúfYaIS l%shdjla 

i|yd úfYaIkh ù we;'

WodyrK - .Kl hka;%" ATM hka;%

5'1'6  fufyhqï moaO;shl fiajd

mß.Kl fufyhqï moaO;shl ld¾h Ndrh

fufyhqï moaO;sh uDÿldx.hlaa jk w;r tu.ska oDVdx. yd fjk;a uDÿldx. 

l,ukdlrKh lrhs' tu.ska wfkl=;a uDÿldx. i|yd fiajdjka ,nd fokq ,nhs' 

mß.Kl fufyhqï moaO;shla úiska bgq lrkq ,nk m%Odk ld¾h folla y÷kd 

.ekSug yels h' tajd kï (

i)   mß.Kl moaO;shl jQ oDVdx. md,kh lsÍu

ii)  ñ;%YS,S mßYS,l w;=reuqyqK;la ,nd §u

i) mß.Kl moaO;shl jq oDVdx. md,kh lsÍu

fufyhqï moaO;s u.sska my; oelafjk l<ukdlrK ld¾h yryd mß.Kl 

moaO;sfha jQ oDVdx. md,kh lsÍu isÿ lrhs'

1' l%shdj,s l<ukdlrKh  Process Management
2' u;l l<ukdlrKh       Memory Management
3' Wmdx. l<ukdlrKh       Device Management
4' f.dkq l<ukdlrKh       File Management
5' wdrlaIK l<ukdlrKh    Security Management
6' mß.Kl cd, l<ukdlrKh  Network Management
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 mß.Klfha § fuu ld¾h l%shd;aul jk wdldrh iy tajd w;r jQ  

iïnkaOh my; rEm igyfkka oel .; yels h'

     rEmh 5.4 - fufyhqï moaO;sfha l<ukdlrK ld¾h

wms oeka fuu l<ukdlrK ld¾h my ms<sn| j úia;r úuid n,uq'

1' l%shdj,s l<ukdlrKh Process Management 
mß.Klhla Ndú; lrñka wm úiska úúO jQ ld¾h bgq lr .kq ,nk nj 

Tn okafkys h' WodyrKhla jYfhka ,smshla uqøK hka;%fhka uqøKh lr .ekSu 

ms<sn| j is;a fhduq lrkak' ,smshla uqøKh lsÍu tla ld¾hhla f,iska wmg 

fmkqK o" mß.Klfha § fuu ld¾hh isÿ lrkqfha l=vd l=vd ld¾h rdYshlg fnod 

.ksñka h' fufyhqï moaO;sj, § fuu l=vd ld¾hhla l%shdj,shla f,iska  y÷kajuq'

 

rEmh 5.5 - P1 - P7 olajd jQ ld¾h (process) l%shdj,s l,ukdlrKh
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mß.Klfha l%shd;aul fjñka mj;sk mß.Kl jevigykla fyda 

jevigykl fldgila fyda l%shdj,shla f,iska ir, j y÷kajd Èh yels h' 

mß.Klfha § iEu ld¾hhla u l%shdj,s tlla fyda lsysmhla fyda yryd bgq flf¾' 

l%shdj,s i|yd wjYH lrk wdldrfhka uOH ieliqï tallfha ld,h fjka 

lr .ekSu" u;lh fjka lr .ekSu iy wod< l%shdj,s i|yd wdodk- m%;sodk tall 

fjka lr .ekSu jeks iïm;a l<ukdlrK ld¾h fufyhqï moaO;sfha l%shdj,s 

l<ukdlrKfha § isÿ flf¾' 

tfia u l%shdj,s ish,a, kshñ; wdldrfhka fm< .eiSug lghq;= lsÍu;a 

^tkï ls%hdj,s wjYH mßÈ tlla miq mi tlla isák f,iska ilia lsÍu;a& l%shdj,s 

l<ukdlrKh hgf;a § fufyhqï moaO;sh úiska bgq lrkq ,efí' WodyrKhla 

f,iska ,smshla uqøKh lrk w;r;=r § hï fohla h;=re mqjrefjka ghsma lsÍu 

ms<sn| j i,ld n,kak' fuys § uq,ska u mß.Klh úiska isÿ l< hq;af;a l=ula 

oehs ;SrKh l< hq;= h' fuu ld¾h fol u tl jr isÿ jk f,iska wmg fmkqK 

o mß.Klfha § fuu ld¾h fol isÿ lrkqfha l%shdj,s folla f,isks' tfia u wm 

úiska uqøKh lrkq ,nk ,smsfhys hula ghsma lrkafka kï ;;a;ajh fln÷ o@ 

wm uqøKh i|yd wod< wK lsÍu ,nd §fuka miq j ,smshg tla lrkq ,nk foaj,a 

uqøK hka;%%fhka uqøKh jkjd o@ tfia jkafka keye fkao@ tkï mß.Klh úiska 

wod< ld¾h tkï l%shdj,s ksYaÑ; ms<sfj<lg wkqj l<ukdlrKh lrkq Tng oel 

.ekSug mq¿jk' 

2' u;l l<ukdlrKh  Memory Management
mß.Klh l%shd;aul ùfï § u;lh ^úfYaIfhka u wms fuys § l;d 

lrkafka m%d:ñl u;lh tkï iiïNdù m%fõY u;lh .ekhs& úYd, ld¾hhla 

bgq lrkq olskag mq¿jk' wdodkh lrkq ,nk ish¨ o;a; uOH ieliqï tallh 

fj; .uka lrk f;la r|jd ;nd .kafka o ilia lrkq ,enQ o;a; tkï f;dr;=re 

m%;sodk tall fj; fhduq lrk f;la r|jd ;nd .kafka o u;lh ;=<hs' fï 

ksid u;lh úêu;a j l<ukdlrKh lsÍu mß.Klfha ukd l%shdldÍ;ajh i|yd 

w;HjYH h' l%shdj,s i|yd u;lh fjkqfjka we;s úh yels .egqï j<ld,ñka 

l%shdj,s i|yd wjYH lrk u;lh fjka lr §u;a tu l%shdj,s wjidkfha § u;lh 

ksoyia lsÍug wjYH lghq;= isÿ lsÍu;a u;l l<ukdlrKfha § isÿ fõ'

   
   rEmh 5.6 - u;l l<ukdlrKh
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 u;l l<ukdlrKh i|yd fufyhqï moaO;s u.ska úúO jq Wml%u fhdod 

.kakd w;r fufyhqï moaO;s u.sska mß.Klfha jQ m%d:ñl u;lh (Primary Memory 
-iiïNdù m%fõY$msúiqï u;lh (Random Access Memory -RAM) fuka u oaú;Shsl 

u;lh (Secondary Memory) hk u;l wdldr fol u l<ukdlrK lsÍug lghq;= 

lrk neõ wm u;l ;nd .; hq;= h'

 ,smshla uqøKh lsÍu i|yd wK lsÍfuka miq j thg hula tla lsÍu ms<sn|j 

i,ld n,kak' fuys § ,smsh uqøKh isÿ jk w;r;=r § wm úiska ,smshg tla lrkq 

,nk foaj,a uqøK hka;%fhka uqøKh jkjdo@ tfia jkafka ke;' uqøKh i|yd 

wjYH lrk wK lsÍu ,nd ÿka úg uqøKh úh hq;= oE mß.Klfhys iiïNdù  

u;lhg fhduq lrk w;r uqøKh lrkafka tfia iiïNdù m%fõY u;lhg tla 

lrk ,o foaj,a muKls' bka miq j wm úiska ,smshg tla lrkq ,nk foaj,a uqøK 

hka;%fhka uqøKh jkafka ke;'

3' Wmdx. l<ukdlrKh Device Management
 mß.Kl moaO;shl fndfyda m¾hka; Wmdx. (peripheral devices) Ndú; 

lrk nj Tn okafkys h' fuu ish¨ Wmdx. md,kh lsÍfï j.lSu orkafka o  

fufyhqï moaO;shhs' Wmdx. md,kh i|yd oDVdx. fldgia jk Wmdx. md,l 

(device controllers) o uDÿldx. fldgia md,kh i|yd Odjl$t,jqï jevigyka 

(device drivers) o fhdod .efka'

rEmh 5.7 - Wmdx. l<ukdlrKh

Tnf.a mß.Klfha iiïNdù m%fõY$msúiqï u;lfha (Random 
Access Memory -RAM tflys& m%udKh o¾Ykh lrk ^fidhd 

.kakd& wdldrh olajkak' Tnf.a mß.Klfha iiïNdù m%fõY$msúiqï  

u;lfha (Random Access Memory -RAM tflys& m%udKh o igyka  

             lrkak'

l%shdldrlu 
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WodyrKhla f,iska Tn úiska ñ, § .kq ,nk uqøK hka;%hla Tnf.a 

mß.Klfhys ksjerÈ j l%shd;aul ùug kï ta i|yd kshñ; Odjl$t,jqï 

jevigyk (device driver) fufyhqï moaO;sfhys kshñ; wdldrfhka ia:dmkh l< 

hq;= h' tfia fkdjqK úg § uqøs; msgm;a ,nd .ekSug yels jqj o uqøK hka;%fha jQ 

kùk myiqlïj,ska Tng ksis m%fhdackhla ^Wod - iajhxl%Sh j lvodisfha fomi u 

uqøKh lsÍu jeks myiqlï& ,nd .ekSug fkdyels jkq we;'

j¾;udkfha § fndfyda Wmdx. iú l< ú.i l%shd;aul jk wdldrfhka 

(plug and play) ilia lr we;s w;r Bg wod< Odjl$t,jqï jevigyka (device 
driver) fufyhqï moaO;sh úiska iajhxl%Sh j ia:dmkh lr .kq olakg yels h' fï 

ksid j¾;udkfha § fndfyda wjia:dj, § wmg fuu Odjl$t,jqï jevigyka 
(device driver) ia:dmkh lsßu ms<sn| j lror ùug wjYH fkdjkq we;'

4' f.dkq l<ukdlrKh File Management
 mß.Klfha o;a; ;ekam;a lsÍug f.dkq Ndú; lrk nj;a tajd úêu;a 

j l<ukdlrKh lsÍug f*da,avr fhdod .kakd nj;a Tn fï jk úg okafkys 

h' f.dkq l<ukdlrKh i|yd lghq;= lsÍu;a fufyhqï moaO;sfha ld¾hhls' 

       rEmh 5.8 -  f.dkq l<ukdlrKh 

 

 fufyhqï moaO;s u.sska f.dkq l<ukdlrKh i|yd my; i|yka fiajd isÿ 

lrkq oelsh yels h'

 Tn mß.Klhg kj uqøK hka;%hla (printer& iúl< úg fufyhqï 

moaO;sh u.ska tys Odjl$t,jqï jevigyk (device driver& iajhxl%Sh j 

ia:dmkh lr .kS' tfia fkdue;s wjia:dj, wm úiska th ia:dmkh 

lr .; hq;= h' kj uqøK hka;%h i|yd wod< Odjl$t,jqï jevigyk  

Tn Ndú; lrk fufyhqï moaO;sh ;=< ia:dmkh (install) lrk wdldrh  

     igyka lrkak'

l%shdldrlu 
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•  kj f.dkq ilia lsÍu iy tajd ksis f,i ia:dk.; lsÍu

•  wkjYH f.dkq uld oeóu

•  wjYH mßÈ f*da,avr ilia lsÍu iy wkjYH tajd uld oeóu

•  f.dkqj, yd f*da,avrj, kï fjkia lsÍu 

•  f.dkq yd f*da,avr msysá ia:dk fjkia lsÍu

•  wjYH jQ wjia:dj, § wjYH lrk f.dkq Wmia: lsÍu

   rEmh 5.9 - f.dkq l<ukdlrKh

f.dkq l<ukdlrKfha § fufyhqï moaO;sh u.sska f.dkq Wm ,laIK" 

f.dkq fufyhqï" f.dkq m%fõY$msúiqï wjir iy f.dkq moaO;s hk lreKq ms<sn|j 

o ie,sls,su;a jkq oelsh yels h'

1' f.dkq$f*da,avr i;= j fndfyda Wm,laIK mj;S' Tnf.a fufyhqï  

   moaO;sfha f.dkqjla$f*da,avrhla f;dard f.k tys Wm,laIK fidhd  

    n,k wdldrh igyka lr olakg ,efnk Wm,laIK o igyka lrkak'

2' my; oelafjk f.dkq wdldr Ndú; lrk fufyhqï moaO;s fudkjdoehs fidhd 

   n,d igyka lrkak'

• FAT16 
• FAT32
• NTFS
• ext4
• ReiserFS

3' fufyhqï moaO;s ;,fha § f.dkqj,g m%fõY ùu ̂ msúiSu& i|yd fhdod .kakd my; 

     wdldr fol fláfhka úia;r lrkak' meyeÈ,s lsÍï i|yd Tng my; rEm igyk 

  Ndú; l< yels h'

• wkql%ñl m%fõYh$msúiqu Sequential Access 
• iiïNdù m%fõYh$msúiqu Random Access

l%shdldrlu 
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5' wdrlaIK l<ukdlrK  Security Management
mß.Klhla fj; úúOdldrfha ;¾ck we;s jkq oelsh yels h' WodyrKhla 

f,iska mß.Kl ffjri jeks wksIag uDÿldx.j,ska mß.Klfha uDÿ l%shdldß;ajh 

flfrys úúO jQ n,mEï we;s lrkq fmkajd Èh yels h' tfia u mß.Klh fj;g 

wkjirfhka we;=¿ jkakka úiska mß.Klfha jQ o;a;" f;dr;=re jeks foa uld 

oeóu" úkdY lr oeóu jeks ld¾hhka o mß.Kl moaO;shlg uqyqK §ug isÿ jk 

;j;a ;¾ckhls'

fujeks ;¾ckj,ska mß.Kl moaO;shla wdrlaId lsÍfï j.lSu orkqfha 

o fufyhqï moaO;shhs' fï i|yd mß.Kl fufyhqï moaO;s úiska úúOdldrfha 

Wml%u Ndú; flf¾' 

6' mß.Kl cd,lrK l<ukdlrKh  Network Management
fndfyda fufyhqï moaO;s úúO jQ cd,lrK kshudj,s i|yd iyh fohs' 

cd,h ;=, mj;sk mß.Kl" uqøK hka;%" iqmÍlaIk hka;% wdÈ oDVdx. iy f.dkq 

jYfhka mj;sk uDÿldx. wdÈ iïm;a /yeka iys; j fyda /yeka rys; j yjqf,a 

Ndú; lsÍug myiqlï i,ihs'

cd,h ;=< ÿria: j mß.Kl fj; m%fõY ùu i|yd o fufyhqï moaO;sh 

Wmldr fõ' fï i|yd ir, ikaksfõokfha isg nyq udOH wdldrfha ikaksfõok 

myiqlï mß.Kl cd,hla ;=,ska ,nd fohs' wo jk úg cd, ;=<ska ÿria: j isg 

ikaksfõok n,h Wmßu f,i m%fhdackhg .kq ,efí' fuu ixl,amh j,dl=¨ 

mß.Kkh  (cloud computing) ;=<ska úoHdudk fõ'

  1' fufyhqï moaO;s u.ska wkjir m%fõYh j<lajd .ekSu fyda md,kh 

    lsÍu i|yd fhdod .kakd Wml%u fudkjd oehs ,ehsia;=.; lr tajd 

     fláfhka úia;r lrkak'

  2' fufyhqï moaO;shlg ;ks j ndysßka meñfKk mß.Kl ffjri jeks  

   wksIag uDÿldx.j,ska we;s lrk Wmøj ish,a, u md,kh lsßug  

             fkdyels h' fï i|yd ndysr ̂ f;jk md¾Yajfha& uDÿldx.j, iyh ,nd  

         .kakjd oelsh yels h' fufyhqï moaO;shlg ;ks j md,kh lsÍug  

        wmyiq ndysr ;¾ck yd tajd md,kh i|yd Ndú; lrk uDÿldx.  

       fudkjd oehs ,ehsia;=.; lrkak'

l%shdldrlu 

    lsÍu i|yd fhdod .kakd Wml%u fudkjd oehs ,ehsia;=.; lr tajd

     fláfhka úia;r lrkak'

  2' fufyhqï moaO;shlg ;ks j ndysßka meñfKk mß.Kl ffjri jeks 

rEmh 5.10  - wkql%ñl yd iiïNdù m%fõYh
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      rEmh 5.11 - mß.Kl cd, l<ukdlrKh

ñ;%YS,S mßYS,l w;=reuqyqK;la ,nd §u
mß.Klh iu. jev lghq;= lsÍug w;=reuqyqK;la wjYH flf¾' fufyhqï 

moaO;s u.ska wjYH lrkq ,nk l%shd myiqfjka yd ir, j bgq lr .eksug wjYH 

lrk wK lsÍï ^úOdk& iy Wmfoia ,nd §u i|yd ñ;%YS,S w;=reuqyqK;la wm 

fj; ,nd fohs' fuu w;=reuqyqK; Ndú; lrñka wjYH lrk ish¨ l%shd ixlS¾K 

l%shdoduhlg fkdf.dia myiqfjka u bgq lr .ekSug yels h'

w;=reuqyqK;a ms<sn| j l;d lsÍfï § wmg m%Odk jYfhka wdldr foll 

w;=re uqyqK;a oel .ekSug yels fõ'

1' úOdk fma,s w;=reuqyqK;a (CLI -Command Line Interfaces)
2' Ñ;%l mßYS,l w;=reuqyqK;a (GUI -Graphical User Interfaces) 

by; lreKq fol ms<sn| j úia;rd;aul j úuid n,uq' 

1' úOdk fma,s w;=reuqyqK;a (CLI -Command Line Interfaces) iys; fufyhqï 

   moaO;s

wdrïNl wjêfha § ks¾udKh lrkq ,enq ish¨ mß.Kl fufyhqï moaO;sj, 

olakg ,enqfKa úOdk fma,s w;=reuqyqK;a jk w;r fuys wod< wK lsÍï iy 

Wmfoia we;=<;a lsÍu i|yd fm%arlhla (prompt) olakg ,eìKs' wjYH lrk ish¨ 

wK lsÍï iy Wmfoia fuu fm%arlh u; h;=re,shkh l< hq;= úh' tfia u wod< 

wK lsÍfï ldrl Í;sh (syntax) ksjerÈ j wkq.ukh l< hq;= h'

úOdkh

m%;sodkh

CursorCommand
Prompt

rEmh - 5.12 - úOdk fma<s w;=re uqyqK;
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2' Ñ;%l mßYS,l w;=reuqyqK;a (GUI -Graphical User Interfaces) iys;  

      fufyhqï moaO;s

j¾;udkfha Ndú; lrk ish¨ mß.Kl fufyhqï moaO;sj, w;=reuqyqK; 

ilia fjkafka Ñ;%l mdol lr .ksñks' mßYS,lhskag myiqfjka uQislh u.sska fyda 

w;eÕs,s Ndú; lrñka wjYH lrk l%shd bgq lr .ekSug fïjdfha § yelshdj mj;S' 

fuu.sska b;d u myiqfjka fufyhqï moaO;sh Ndú; lrñka wjYH lrk lghq;= 

bgq lr .; yels h'

Ñ;%l mßYS,l w;=reuqyqK;a iys; fufyhqï moaO;s [Operating Systems with 
Graphical User Interfaces (GUI)] ks¾udKh lsÍfï § m%Odk ixrpl (componets)
y;rla Ndú; lrñka ñ;%YS,S mßirhla ilia lr § we;' tu ixrpl (componets) 
i;r WIMP f,i fláfhka ye¢kafõ' WIMP hkqfjka woyia lrkafka"

1' ljq¿          Windows
2' ksrEml$whslk  Icons
3' fukq          Menus
4' olajkh          Pointer         hkakhs'

      rEmh 5.13 - Ñ;%l mßYS,l w;=re uqyqK;

  1' Tn Ndú; lrk fufyhqï moaO;sfha úOdk fma,s w;=reuqyqK; ,nd 

     .kakd wdldrh igyka lrkak'

  2' Tn Ndú; lrk fufyhqï moaO;sfha úOdk fma,s w;=reuqyqKf;ys  

        Ndú; l< yels wK lsÍï lsysmhla igyka lr tajdhska bgq lrkq ,nk 

            fiajd igyka lrkak'

l%shdldrlu 

fukq olajkh

whslk

ljq¿
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fufyhqï moaO;sj, mj;sk Wmfhda.s;d jevigyka
fufyhqï moaO;shla u.ska mß.Klfha l%shdldÍ;ajh mj;ajdf.k hdu 

i|yd fndfyda ld¾h isÿ lrk nj Tn oeka okafkys h' mß.Klfha iqug 

l%shdldÍ;ajh mj;ajdf.k hdu i|yd fuka u iuyr wjia:dj, § we;s jk Wmøj 

j,ska mß.Klh wdrlaId lr.ekSug;a fufyhqï moaO;sh ;=< fndfyda Wmfhda.s;d 

jevigyka we;=<;a lr ;sfnkq olakg yels h' w;S;fha § fndfyda Wmfhda.s;d 

jevigyka fjk u ñ,§ f.k mß.Klfha ia:dmkh l< hq;= jqj;a wo jk úg 

fndfyda Wmfhda.s;d jevigyka fufyhqï moaO;sh ;=<g wka;¾.; lr ;sfnkq 

olakg ,efí'

fufyhqï moaO;sh ;=< fndfyda Wmfhda.s;d jevigyka oelsh yels h'

• Wmia: uDÿldx. - f.dkq msgm;a lsÍug yd oDv;eáj, Wmia: ,nd .ekSug

• ;eá iqmÍlaIkh- - ;eáj, fodaI iys; m%foaY mÍlaId lsÍfï uDÿldx.

• ;eá m%;sNd.SlrKh - ;eáfha ksoyiaj mj;sk l=vd m%foaY tlalr úYd, ksoyia 

m%foaYhla iE§fuka ;eáh ixúOdkh lsÍu'

• f.dkq$o;a; ixfldapkh - jeä wdphk Odß;djla iys; f.dkq ixfldapkh lr 

wvq Odß;djhla iys; f.dkq njg mßj¾;kh lsÍu

• ld¾hh l<ukdlre (Task Manager) u.ska  mß.Klh ;=, l%shd;aul jk 

l%uf,aLk iy l%shdj,Ska ms<sn| f;dr;=re iemhSu" mß.Klfha idudkH 

;;ajhka fmkakqï lsÍu'

• moaO;s fodaI ksYaph lsÍfï fuj,ï- mß.Klhl fyda mß.Kl cd,hl we;s 

uDÿldx. yd oDvdx. j, fodaI y÷kd.ekSu'

  1' Tn Ndú; lrk fufyhqï moaO;sfha f;dard .;a ̂ fjkia wdldrfha& ljq¿ 

    foll olakg we;s wxf.damdx. kï lrkak'

  2' Tnf.a fufyhqï moaO;sfha jev;,fhys olakg ,efnk whslk ish,a,  

    kï lrkak'

3' Tn Ndú; lrk fufyhqï moaO;sfha ir, jevigyka foll olakg ,efnk    

  fukq foll olakg ,efnk wjia:d ^úl,am& Ndú; lrk wdldrh úia;r  

   lrkak'

4' Tn Ndú; lrk fufyhqï moaO;sfha ^uQisl& olajkfha úúO yev;, olakg    

    mq¿jka' ̂ uQisl& olajkfha iajrEm lsysmhla olajkak' ̂ uQisl& olajkfha yev;,h  

   wjYH wdldrfhka fjkia lr .kafka flfia oehs olajkak'

5' fufyhqï moaO;shla iu. lghq;= lsÍfï § uQislh iuÕ ikaikaokh lsÍfï oS  

   w;eÕs,s ^iam¾Y ixfõoS Wml%u& Ndú; lsÍfï jdis iy wjdis igyka lrkak'

l%shdldrlu 
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• m%;sjhsri uDÿldx. -oafõY iy.; uDÿldx. y÷kd.ekSu" bj;alsÍu u.ska 

mß.Kl wdrlaId lsÍu'

• o;a; fyda f.dkq msgm;a lsÍu$lemSu yd we,ùu i|yd fláld,Skj ;eïm;a lr 

;nd .ekSu Clipboard u.sska isÿfõ'

• o;a; iuuqyq¾;lrK uDÿldx. u.sska m%Nj wdphkfha isg b,lal.; wdpkh 

w;r ix.;;djh mj;ajd .ekSu'

• ;eá fn§u i|yd jQ uDÿldx. u.ska ;ks Odjlhla ;d¾lsl Odjl lsysmhlg 

fjka lsÍug myiqlï i,ihs'

• mß.Kl l%shd;aulj Ndú; fkdjk wjia:dj, § ;sr wdrlaIKh i|yd 
Screensavers Ndú;h'

• mß.Klj, ia:dmkh lrk ,o uDÿldx.j, úia;rd;aul f;dr;=re iy 

iïnkaO lrk ,o oDvdx. ms<sn| úia;r iemhSu system profilers u.sska isÿlrhs'

• mß.Kl cd,j, iïnkaO;djh úYaf,aIKh lsÍu" o;a; yqjudrej mÍlaId lsÍu 

i|yd cd, Wmfhda.S;d uDÿldx. fhdod .ekSu'

fuys § wm úiska my; i|yka Wmfhda.s;d jevigyka lsysmh ms<sn| j 

muKla i,ld nef,kq we;'

•  mx.= fn§u   Disk Partitioning
•  wdlD;slrKh  Disk Formatting
•  m%;sNd.SlrKh Defragmentation

mx.= fn§u Partitioning 
mx.=jla hkq l=ula o@  

 idudkHfhka fndfyda wjia:dj, § mß.Klhl fN!;sl jYfhka  

mj;skafka tla oDV ;eáhls' tfy;a th ;d¾lsl j fldgia lsysmhlg fnod fjka 

lr .ekSu isÿflf¾' fufia oDV ;eáhla wjYH mßÈ fldgiaj,g fnod fjka lsßu 

oDV ;eáh mx.= lsÍu (partitioning) f,iska ye|skafõ'

 oDV ;eáhla mx.=j,g fjka lsÍu mß.Klhla úkHdi.; (configure) lrk 

m<uq wjia:dfõ § isÿ l< hq;= ld¾hhls' tfia u hï fya;=jla ksid wu;r oDV 

;eáhla mß.Klhg tla lrkafka kï fyda ;sfnk oDV ;eáh bj;a lr kj oDV 

;eáhla tla lrkafka kï fyda tu wjia:dj, § o wmg tu oDV ;eáh mx.=j,g 

fnod fjka lsÍug isÿfõ'

 tfia u fï jk úg isÿ lr we;s mx.= fn§u fjkia lsÍug wjYH jkafka 

kï ta wjia:dfõ § o mx.= fn§fï l%shdj,sh fj; fhduq jkq we;' flfia jqj o 

mx.= fnod we;s oDV ;eáhla kej; jrla mx.= fn§ulg ,la l< úg § wod< oDV  

;eáfha jQ ish¨ o;a; úkdY jkq we;' fï ksid tjka wjia:dj, § wjYH lrkq 

,nk o;a;j, Wmia: msgm;la (backup copy) ,nd .ekSug lghq;= lsÍug u;l 

;nd .; hq;= h'
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my; rEm igyfkka Tng oDV ;eáhla mx.= fn§ug fmr yd miq mj;sk 

wdldrh oel .; yels h'

        rEmh 5.14 - oDV ;eáhla mx.= fn§ug fmr yd miq 

mx.= fn§u wjYH jkafka wehs@  

 oDV ;eáhla fldgiaj,g tfia;a fkdue;s kï mx.=j,g fnod fjka lr  

.ekSug úúO jQ fya;= mj;S' bka m%Odk fya;= lsysmhla my; mßÈ h'

• mß.Klfha ;ekam;a lrkq ,nk foaj,a fjka fjka j ;ekam;a lr .ekSug  

^Wod - uDÿldx. tla mx.=jl o fjka fjka jQ o;a; fjka fjka jQ mx.=j, o 

;ekam;a lsÍug&

• mß.Klfha fufyhqï moaO;s tllg jvd ia:dmkh lsÍug ^Wod - tl u  

mß.Klfha Windows iy Ubuntu fufyhqï moaO;s folu ia:dmkh lsÍug 

wjYH ùu'&

• fufyhqï moaO;sfha jQ wjYH;d iïmQ¾K lsÍug ^Wod - iuyr wjia:dj, § 

fufyhqï moaO;sfha ld¾h i|yd oDV ;eáfha wu;r mx.=jla fjka lr ;eîug 

wksjd¾hfhka u isÿùu fmkajd Èh yels h'&

 oDV ;eáhla mx.=j,g fn¥ úg wmg ta tla tla mx.=j fjka fjka jq Odjl 

f,iska oel .ekSug ,efnkq we;' Windows mßirfha§ fuu Odjl kï lsÍu C 
wlaIrfhka wdrïN lrñka bÈßhg lr f.k hkq we;' tkï m<uq mx.=j m<uq 

Odjlh f,iska i,lk w;r th C Odjlh f,iska kï lrkq we;' fojk mx.= D 
Odjlh wdÈ jYfhka bÈßhg lrf.k hkq we;'

igyk ( Windows mßirfha § mß.Klhg iú lr we;s ixLHdxl nyqúO ;eá 

Odjl" iefK,s u;l tall wdÈh mß.Klh y÷kd .kafka Odjl f,iska jk w;r 

tajd kï lsÍu i|yd C wlaIrfhka miq j ^odV ;eá mx.= i|yd wdfoaY lsÍfuka 

wk;=rej& ;sfnk bx.%Sis wlaIrhla wdfoaY lrkq we;' 
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Linux mßirfha § oDV ;eáfha mx.=" ixLHdxl nyqúO ;eá" iefK,s u;l 

tall wd§ ish,a, f*da,avr (Linux ys oS fïjd y÷kajkafka äfrlagß f,isks& f,iska 

wdfoaY lr .ekSu isÿ lrhs' fï ksid Linux mßirfha § C, D wd§ f,iska kï lrkq 

,nk Odjl oel .ekSug fkdyels h'

wdlD;slrKh Disk Formatting 
oDV ;eáhla mx.= fn§ug ,la l< o tys tla jr u o;a; ;ekam;a l< 

fkdyels h' tu mx.= ish,a, wm úiska fjka fjka j wdlD;slrKh (format) l< 

hq;= h'

 yeviùu u.sska oDV ;eáhla fyda kuH ;eáhla fyda iefK,s u;l 

tallhla fyda wod< fufyhqï moaO;sfha Ndú; lrkq ,nk f.dkq wdlD;shla Ndú; 

lrñka o;a; ;ekam;a lsÍug yels wdldrhg m;a lsÍu isÿ lrhs'

j¾;udkfha fjf<|fmdf<ys jQ fndfyda iefK,s u;l tall fmr yevijd 

we;s w;r (pre-formatted) fl,ska u Ndú;hg .ekSug yelshdj mj;S'

wjYH;dj mßÈ Ndú; lrk ,o oDV ;eáhla fyda kuH ;eáhla fyda iefK,s 

u;l tallhla fyda kej; kej;;a wdlD;slrKh isÿ l< yels h' kuq;a fuys § 

isys ;nd .; hq;= lreK jkafka wdlD;slrKh ùfï § ;eáfha jQ ish¨ o;a; úkdY 

ù hk njhs' tkï wod< ;eáfha hï jeo.;a f.dkq we;akï wdlD;slrKh ùug 

fmr tajdfha Wmia: msgm;a (backup copies) ,nd .ekSug wm lghq;= l< hq;= h'

mx.= fn§u yd wdlD;slrKh wjik wmg oDV ;eá o;a; ;ekam;a lsÍu 

i|yd Ndú; lsÍug wjia:dj ie,fikq we;'

flfia jqj o wm úiska mß.Klhlg m%:u jrg fufyhqï moaO;shla 

ia:dmkh lsÍfï § mx.= fn§u yd yeviùu isÿ lsÍu isÿ l< hq;= w;r bka miq 

j mx.= fn§u iy oDV ;eáh wdlD;slrKh b;d u l,d;=rlska isÿ lrkq ,nk 

l%shdjls' 

my; rEm igyfkka mx.= fnok ,o oDV ;eáhla wdlD;slrKh jQ miq 

mj;sk wdldrh oel .; yels h'

      rEmh 5.15 - oDV ;eáhla mx.= fnoSug fmr yd mx.= fnoSug miq yd wdlD;slrKh jQ miq
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m%;sNd.SlrKh (Defragmentation)
m%;sNd.SlrKh ms<sn| j wmg l;d ny lsÍug isÿ jkafka Windows mßirh 

;=< § h' f.dkqjla oDV ;eáhl fyda iefK,s u;l tallh ;ekam;a lsÍfï § iuyr 

wjia:dj, § ^úfYaIfhka u f.dkqj m%udKfhka úYd,j;a u& th tl È.g ;ekam;a 

ùu isÿ fkdùug bv lv mj;S' fufia f.dkqfõ fldgia ;eáfha úúO ia:dkj, 

;ekam;a ùu LKavkh f,iska ye|skafõ'

      rEmh 5.16 - ;eáhl f.dkq ;ekam;a j we;s wdldrh

úfYaIfhka u f.dkq ks;r ks;r ixialrKh lsÍu ksid f.dkqfõ m%udKh 

úYd, ùu fya;=fjka wod< f.dkq i|yd tl È.g bv ,nd .ekSug wmyiq ùu 

fya;=fjka f.dkqj fldgiaj,g fnod fjka lr ;eáfha fjka fjka ia:dkj, 

;ekam;a lsÍug fufyhqï moaO;sh l%shd lrkq we;' f.dkq uld oeóu ksid ;eáj, 

ysia jk bvlv kj f.dkq i|yd Ndú; lsÍug W;aidy oeÍu o LKavkh i|yd 

fya;= fõ'

LKavkh fya;=fjka f.dkqjla lshùug W;aidy lsÍfï § tys fldgia tl 

È.g ^tl <Õ& fkdmsysàu ksid lshùu i|yd jeä ld,hla .;ùu isÿ fõ' fuh 

mß.Klfha ld¾hlaIu;dj my< oeóug fya;= jkq we;'

mß.Klfha ld¾hlaIu;dfõ my< hdula ksÍlaIKh lsÍug ,enqK fyd;a 

th LKavkh ksid isÿúh yels w;r ^mß.Klfha ld¾hlau;dj my< oeóug fya;= 

rdYshla mj;sk w;r fuh tla fya;=jla muKs& fï i|yd .; yels fyd| u mshjr 

jkafka oDV ;eáh m%;sNd.SlrKh i|yd mshjr .ekSuhs'

                rEmh 5.17
flfia jqj o Linux mdol fufyhqï moaO;sj, § f.dkq ;ekam;a lsÍu 

isÿ lrkqfha fjkia wdldrhlsks' fuys § f.dkq ;ekam;a lsÍfï§ f.dkq tl <Õ 

;ekam;a fkdlr iEu f.dkqjla i|yd u wu;r jeä bvla fjka lr .ksñka B<Õ 

f.dkqj Bg wE;ska ;ekam;a lsÍug lghq;= lrhs' fï ksid uq,a f.dkqfõ m%udKh 

úYd, jqj;a th tl È.g ;ekam;a lr .ekSug i|yd m%udKj;a bvla mj;S' fï 

ksid Linux mdol fufyhqï moaO;sj, § LKavkh isÿùug we;af;a wvq bvls' 

tfia u hï fya;=jla ksid f.dkqfõ Odß;dj j¾Okh ùu wod< f.dkqj i|yd 

fjkalr we;s bvlvg jvd úYd, jkafka kï tu wjia:dfõ § wod< f.dkqj fjk;a 

ia:dkhlg ú;eka lsÍug Linux mdol fufyhqï moaO;s ls%hd lrhs' fï ksid Linux 
mdol fufyhqï moaO;sj, § m%;sNd.SlrKh i|yd wu;r Wmfhda.S jevigykl 

wjYH;djla we;s fkdfõ' 

m%;sNd.SlrKhg 

fmr
m%;sNd.SlrKhg 

miq
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 5'2    f.dkq moaO;s y`ÿkajd §u

mß.Klh"  úYd, o;a; m%udKhlaa  ;ekam;a  lsÍug  iy tu ;ekam;a l< 

o;a; b;d u flá ld,hla ;=< kej; ,nd .ekSug myiqlï i,ik hka;%hls' 

fufia ;ekam;a lrkq ,nk o;a; wkkH;dj y÷kd .; yels jk mßÈ thg f.dkq 

kduhla ,nd Èh hq;= h' tfukau mß.Klh ;=< l%shd;aul jk fufyhqï moaO;shg 

iy fhojqï uDÿldx.j,g wod< úYd, f.dkq m%udKhla úúO f.dkq kdu hgf;a 

wdphk udOHh ;=< mj;s' fuf,i mß.Klj, mj;sk iEu f.dkqjla u fldgia 

follska iukaú; fõ' f.dkq kduh iy È.=j ^extension& f,i fldgia folla 

mej;sh o fufyhqï moaO;sh u.ska f.dkqfõ È.=j mßYS,lhdg o¾Ykh fkdjk 

whqßka mj;ajd f.k hhs'

5'2'1  f.dkqjl È.=j n,d .ekSu

Start  Control Panel  Folder Options View  Hide Extensions for 
known File types ^5'11 rEmh n,kak&  yß ,l=K bj;a  lrkak  OK úOdk 

fnd;a;u l%shd;aul lrkak' 

 

rEmh 5'18 - f.dkqjl úia;r
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 bka miq ´kE u f*da,avrhla u; fojrla la,sla (double click) lrkak' túg 

tu f*da,avr ;=< we;s f.dkqj, È.=j n,d .ekSug yels fõ' 

f.dkq kduh
f.dkq kduh iy È.-----=j 

fjka lrk i,l=K ^'&È.-=j

rEmh 5.19 - - f.dkqjl È.=j n,d .ekSu i|yd ieliSfï ljq¿j

igyk ( f.dkqjl È.=j wkqj fufyhqï moaO;sh f.dkqfõ j¾.h (File Type) 
y÷kd .kshs'

 

 úúO j¾.fha f.dkqfõ È.=jka (File extension) mj;sk w;r bka lsysmhla 

my; ±lafõ'

            f.dkqfõ È.=j                f.dkq j¾.h

                 exe Executable
docx Word
xlsx Excel
pptx PowerPoint
accdb Access

fufyhqï moaO;shla u.sska f.dkqjla iïnkaOfhka mj;ajd f.k hkq ,nk 

wu;r lreKq

f.dkqjla ;ekam;a lrk wjia:dfõ § wm úiska f.dkqjg kduhla iy 

;ekam;a jk ia:dkhla imhkq ,nhs' óg wu;r j f.dkqjla iïnkaO o;a; 

.Kkdjla mj;ajd .kq ,efí' 

 ² f.dkqfõ j¾.h (Type of file)
 ² f.dkqfõ m%udKh (Size of the File)
 ² f.dkqj ;ekam;a l< Èkh iy fj,dj (Saved Date and Time)
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fuu o;a;" f.dkqj u; oaú la,sla lsÍu u.ska ,efnk Properties  má;a; u; 

la,sla lsÍfuka ,efnk ljq¿fjka n,d .; yels h'

rEmh 5.20 - - f.dkqjl úia;r n,d .ekSu

f.dkqfõ m%udKh

f.dkqj ;ekam;a j we;s 

ia:dkh

f.dkqj ;ekam;a l< 

Èkh iy fõ,dj

f.dkqj ;ekam;a ùug 

wdphk Odß;dfjka 

fjka lr f.k we;s bv 

m%udKh

f.dkqjla ;ekam;a lsÍfï § ia:dkhla f;dard .ekSu

f.dkqjla ;ekam;a lsÍug leu;s wdphk Odß;djla f;dard .; hq;= h' th 

Odjlhla f,i ye`Èkafõ' oDV ;eáh fn§fuka miq Odjl lsysmhla ±l .ekSug 

yelsjk nj wms ±k .;suq' 

Odjl (Drives)
mß.Kl hka;%hl o;a; ;ekam;a lsÍug oDV ;eáh m%Odk jYfhka Ndú; 

flf¾' th fldgiaj,g fnod fkdue;s kï [C:] Odjlh f,i o" fldgiaj,g 

fnod we;akï fldgia  m%udKh wkqj wkqms<sfj<ska [C:], [D:], [E:] wdÈ jYfhka o 

fmkakqï flf¾' 
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 mß.Klh ;=< CD, DVD iy Blue Ray Disk jeks m%ldY udOH wdphk 

Wml%uhla mj;S kï oDV ;eáfha fldgia m%udKhg idfmalaI j fujeks Odjlhla 

i|yd wlaIrhla mjrkq ,nhs' WodyrKhla f,i oDV ;eáh  fldgia y;rlg fnod 

we;akï tu fldgia y;r [C:], [D:], [E:]iy [F:] f,i fmkakqï flf¾' túg CD, 
DVD fyda Blue Ray Disk Odjlh [G:] wlaIrfhka fmkakqï flf¾'

 fuf,i u mEka Odjlhla (Pen Drive) mß.Klhg iïnkaO l< úg thg 

o wlaIrhla mjrkq ,nhs' WodyrKhla f,i th [K:] f,i olajuq'

 mß.Klhl we;s Odjl .Kk n,d .ekSug Computer kï jQ whslkh 

újD; lrkak' rEmh n,kak' fuys ndysßka iïnkaO flfrk CD, DVD, Blue Ray 
Disk fyda mEka Odjl bj;a l< yels (Removable Storage) Odjl f,i fmkakqï 

flf¾' 

rEmh 5.21 - - Odjl n,d .ekSu

f.dkq ;ekam;a lsÍu i|yd Odjl fhdod .ekqK o idudkHfhka tajd Rcqj 

u ;ekam;a fkdflf¾'

wm úiska isÿ lrkafka Odjlh ;=< f*da,avr ks¾udKh lr tajd ;=< f.dkq 

;ekam;a lsÍuhs' f*da,avr o ks¾udKh lrk úg wkkH kduhla ,nd Èh hq;= h'

f*da,avrhla ks¾udKh lsÍu

1' f*da,avrh ieÈh hq;= Odjlh f;darkak'

2' fukq ;Srefõ File fukqfõ New hgf;a we;s Folder f;darkak' tfia ke;skï  

fuj,ï ;Srefõ New Folder f;darkak'

3' iqÿiq fyda,avr kduhla ,nd fokak'
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f.dkq yd f*da,avr fufyhqï

Odjl ;=< mj;sk f.dkq yd f*da,avr i|yd úúO l%shdldrlï lsÍug isÿ fõ'

1' f.dkq yd f*da,avr msgm;a lsÍu yd we,ùu (Copy & Paste)
2' msgm;a l< hq;= f.dkqj$f*da,avrh f;dard .kak'

3' msgm;a lsÍug Copy úOdkh ,nd fokak' (Edit → Copy fyda Ctrl +C)
4' msgm;a l< hq;= Odjlh fyda f*da,avrh f;dard .kak'

5' Paste úOdkh ,nd fokak' (Edit → Paste fyda Ctrl + V)
f.dkq yd f*da,avr lemSu yd we,ùu (Cut & Paste)

1' lmd we,úh hq;= f.dkqj$f*da,avrh f;dard .kak'

2' lemSug Cut úOdkh ,nd fokak' (Edit → Cut fyda Ctrl+X)
3' lmd we,úh hq;= Odjlh fyda f*da,avrh f;dard .kak'

4' Paste úOdkh ,nd fokak' (Edit → Paste fyda Ctrl + V)
f.dkqj, yd f*da,avrj, ku fjkia lsÍu (Rename)

1' ku fjkia l< hq;= f.dkqj$f*da,avrh f;dard .kak'

2' File fukqfõ Rename úOdkh ,nd fokak'

3' ,nd Èh hq;= ku ghsma lr Enter h;=r l%shd;aul lrkak'

f.dkq yd f*da,avr uelSu (Delete)
1' uelsh hq;= f.dkqj$f*da,avrh f;dard .kak'

2. File fukqfõ Delete úOdkh ,nd fokak$ h;=re mqjrefõ  Delete h;=r  

l%shd;aul lrkak' 

3' túg ,efnk ixjdo fldgqfjka Yes ú Odkh l %shd;aul lrkak'                                

rEmh 5.22 - Delete ixjdo fldgqj
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túg ulk ,o f.dkqj$f*da,avrh Recycle Bin ys ;djld,sl j ;ekam;a fõ'

ulk ,o f.dkq yd f*da,avr kej; ia:dms; lsÍu (Restore)
1. Recycle Bin újD; lrkak'

2. Restore l< hq;= f.dkqj fyda f*da,avrh f;darkak'

3. File fukqfõ Restore úOdkh ,nd fokak'

idrdxYh

• mß.Klhl l%shdldÍ;ajhg fufyhqï moaO;shla wksjd¾h fõ'

• mß.Klhl ia:dmkh l< ish¨ fhÿï uDÿldx. l%shd;aul jkafka fufyhqï 

moaO;sh u; h'

• mßYS,lhdg mß.Klh iu. iïnkaO ùug wjYH myiqlï fufyhqï  

moaO;sfha w;=reuqyqK; u.ska ie,fihs'

 

• úOdk fma<s w;=reuqyqK;lg jvd Ñ;%l mßYS,l w;=reuqyqK;la mßYS,lhdg 

jvd ióm fõ'

² tal mßYS,l"  nyq mßYS,l" nyqld¾h iy ;;H ld, jYfhka fufyhqï 

moaO;ss j¾. lsysmhls'

² tl jr tla mßYS,lfhl=g muKla jev lsÍug myiqlï i,ik fufyhqï 

moaO;shla tal mßYS,l fufyhqï moaO;shla f,i ye¢kafõ'

² tl jr mßYS,lhka jeä msßilg jev lsÍug myiqlï i,ik fufyhqï  

moaO;shla nyq mßYS,l fufyhqï moaO;shla f,i ye¢kafõ'

² tl jr ld¾hhka lsysmhla isÿ lsÍug yelshdj we;s fufyhqï moaO;shla 

nyqld¾h fufyhqï moaO;shla f,i ye¢kafõ'

 

² fufyhqï moaO;shla ;=<sska mß.Klj, ish¨ iïm;a l<ukdlrKh flf¾'

² fufyhqï moaO;shla mß.Klfha ia:dmkh lsÍug m%:ufhka oDV ;eáh 

fldgiaj,g fjka lsÍu;a wdlD;SlrKh lsÍu;a isÿ flf¾'

² f.dkqjla kduhlska iy È.=jlska iukaú; fõ'

² f.dkq ;ekam;a lsÍug f*da,av¾ Ndú; flf¾'

² f.dkq ;ekam;a lsÍug wjYH f*da,av¾ mßYS,l úiska Odjl ;=< ks¾udKh 

lrkq ,efí'
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6 joka ieliSu

 6'1      joka ieliSu  

fujr Tfí mdif,a l,d Wf<, b;d W;al¾Ij;a whqßkaa meje;aúh hq;= nj 

úÿy,am;s;=ud úiska Tn ieug oekqï fok ,È hehs is;kak' l,d Wf<,g wjYH 

,sms f,aLk ilia lsÍu Tn we;=¿ lKavdhug mejÍ we;s ld¾h fõ' ta wkqj"

 ² wdrdOkd m;a ks¾udKh"

 ² foudmshka oekqïj;a lsÍu i|yd ,sms ilia lsÍu" 

 ² iy;sl m;% ks¾udKh"

wdÈ ,sms f,aLk ilia lsÍug wjYH j we;' tajd ukd 

ksudjlska iukaú; úh hq;= h¦ tfia u uqøKh l< hq;= 

h' wjYH f,aLk lgqigyka lr .;a Tn thg fhdod .; 

hq;= udOH ms<sn| woyia úui;s"

zzfï wdrdOkd m;a wms w;a wl=ßka ,shuq"ZZ tA tla wfhl=f.a fhdackdjhs'

fuu tallh yeoEÍfuka Tng" 

² joka ieliSu hkq l=ula o"

² joka ieliqï uDÿldx.hl jdis"

• f,aLkhla ks¾udKh lsÍu"

• yeviùfï l%u"

• f,aLkhg Ñ;%l yev;, iy j.= tl;= lsÍu"

• f.dkq ;ekam;a lsÍu iy újD; lsÍu"

• ;eme,a uqiqj"

• f,aLk uqøKh lsÍu"

• fláux h;=re

 ms<sn| j wjfndaOhla ,nd .ekSug yels jkq we;'
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zzfyd| woyila" ta;a tl u m%udKfha tl u yevfha wl=re ,efnkafk keye" wms 

mqia;ld,fha we;s h;=re,shkh fhdod .ksuqhs"ZZ ;j;a fhdackdjls'

zz,iaik wl=re j¾. .kak;a ́ k" mska;+r ;snqfKd;a ;j;a ,iaikhs" jfÜg fndavrhla 

fhdod .;af;d;a fyd| ksudjla ,efnhs" h;=re,shkhg tjeks foa lrkak neye fka 

o @zzfï i|yd iqÿiq l%uhla Tn fidhd .; hq;= j we;' 

 fufia tÈfkod Ôú;fha § úúO ld¾hhka i|yd ,sms f,aLk nyq, j fhdod 

.kq ,nk w;r tajd úúO wdldrfhka ilia lr .ekSu joka ieliSu fõ' mEkla 

mekai,la Wmfhda. lr .ksñka ,sms f,aLk ilia lsÍfï § wmg w;a ú`Èkakg isÿ jQ 

.eg¨ u.yrjd .ekSug miq l,l § h;=re ,shkh fhdod .kakd ,È'  oE;ska ilia 

jQ ,sms f,aLkj,g jvd meyeÈ,s njla tu.ska ,o kuq;a ,sms f,aLk úÑ;%j;a f,i 

yeviõ .ekaùu ;ekam;a lr ;nd .ekSu" wjYH m%udKfhka uqøKh lr .ekSu 

we;=`M úúO l%shd h;=re,shkh u.ska l< fkd yels úh' 

 ;dlaIKfha oshqKqj;a iu. u wmg odhdo jQ mrs.Klh tA i`oyd jvd;a 

fhda.Hh WmlrKh nj wm ljqre;a mdfya fï jk úg jgyd f.k we;' tu.ska 

joka ieliSfï §" joka ieliqï uDÿldx.hla fhdod .; yels h' fuu uDÿldx.h 

u.ska"

 ² f,aLk ilia lsÍu iy ixialrKh lsÍu (Creating and Editing)
 ² mska;+r jekss jia;+ka tl;= lsÍu ^Insert objects&
 ² iq/lSu iy újD; lsÍu (Saving and retrieving&
 ² fmr oiqk n,d .ekSu iy uqøKh lsÍu ^Print Preview and Printing)
 ² wlaIr úkHdih iy jHdlrK fodaI fiùu iy ksjerÈ lsÍu (Spelling and 

Grammar checking)
² joka fijqu iy fjk;a jpk ta fjkqjg m%;ssia:dmkh lsÍu ^Find and   

replace)
² ;eme,a uqiqj ^Mail Merge)

 jeks myiqlï /ila o imhd we;'

6'1'1  joka ieliqï uDÿldx. 

m%p,s; joka ieliSfï uDÿldx. lsysmhla we;s kuq;a iuyrla uDÿldx. uqo,a 

f.jd ,nd .; hq;= h' Tnf.a myiqj i|yd ksoyiA uDÿldx. (Free and Open Source 
Software-FOSS) wka;¾cd,fhka nd.; yels h'

joka ieliqï uDÿldx. lsysmhla my;ska olajd we;s w;r fjí wvúhg 

msúiSfuka fuu uDÿldx. ms<sn| jeä ÿr úia;r ,nd .; yels h'
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           uDÿldx.fha ku            ksIamdok wdh;kh

AbiWord Source Gear Corporation

FrameMaker Adobe Systems Incorporated
iWork Pages Apple
Kingsoft Office Writer King soft
Libre Office Writer The Document Foundation (Open 

Source)
LyX The LyX Project
Microsoft Office Word Microsoft Corporation
OpenOffice Writer Apache Software foundation 

(Open Source  Software)
Word Perfect Corel

Tnf.a mß.Klfha ia:dms; joka ieliSfï uDÿldx.hla fkdue;s úg 

wka;¾cd,h Ndú; lsÍfuka o Tnf.a f,aLkh ks¾udKh lr .; yels h' fï 

i`oyd Tng Cloud computing  Ndú; lsÍfuka o Tnf.a f,aLkh ks¾udKh lr .; 

yelsh' tu.ska Tng jdis /ila w;afõ' tkï" 

 ² Tnf.a mß.Klfha joka ieliSfï uDÿldx.hla ia:dmkh lsÍug wjYH fkd      

ùu

 ² tA i|yd mß.Kl u;lfha ( Hard disk) ysbvla fjka lsÍug wjYH fkd ùu

 ² Tnf.a f,aLkh iq/lSu i|yd wka;¾cd,fha Tn fjkqfjka bv myiqlï ,eîu

 ² wka;¾cd, myiqlï we;s ´kE u mß.Klhlska Tnf.a f,aLkh újD; lsÍu 

fuka u ixialrKh lsÍu o l< yels ùu 

WÞ - Google Docs,Office 365 Word, Microsoft OneDrive Word

óg wu;r j j¾;udkfha § by< ;dlaIKh fhdod ksmojd we;s cx.u 

ÿrl:k ^Smart Phones& iy ;, mß.Kl ^Tablet PCs& joka ieliSu i|yd fhdod 

.kakd w;r ta i`oyd úfYaIs; jQ joka ieliSfï uDÿldx. fhdod .kq ,nhs' bka 

iuyrla kï

Documents To Go, Google Docs, Kingsoft Office, Polaris Office wdÈh fõ'

Tnf.a wjYH;djg wkqj ,sms f,aLk ilia lr .ekSu i|yd mß.Klh 

wdY%s; j joka ieliqï uDÿldx.hla m%fhdackhg .efkk wdldrh bf.k .ksuq' 

wo nyq, jYfhka fhdod .efkk joka ieliqï uDÿldx. folla joka 

ieliSfï § fhdod .kakd wdldrh fuu tallfha § úia;r lrkq ,nk w;r fjk;a 

fndfyda uDÿldx.j,g fmdÿ jQ ud;Dld lsysmhla iy fuj,ï lsysmhla fuys § 

idlÉPd flfrkq we;'
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6'1'2  joka ieliSfï uDÿldx.hg msúiSu

fuys § Microsoft mdol lrf.k mdvï ud,dj bÈßm;a lr we;'  

   Microsoft Office Word  2010
       Start → All Programs → Microsoft Office → Microsoft Office Word 2010 
                         ^fufyhqï moaO;sh wkqj fjkia úh yels h'&

   Microsoft Office Word 2010  uDÿldx.fha Ñ;%l mßYS,l w;=re uqyqK; rEmh 

6'1ka fmkajd § we;' 

rEmh 6'1 - Microsoft Office Word  2010

1' ud;Dld ;Srej ^Title Bar& rEmh 6'2  - Microsoft Office 2010 ljq¿fjys by<ska u 

olajd we;s ;Srej ud;Dld ;Srejhs' újD; j we;s f,aLkfha kduh fuys oelafõ' 

kj f,aLkhla Document X hkqfjka Èiafjk w;r X hkq f,aLk wxlhhs' 

ljq¿j yl=<d oeófï fnd;a;u ^Minimize&" l=vd lsÍu yd kej; msysgqùfï 

fnd;a;u ^Maximize/Restore&" ljq¿j jid oeófï fnd;a;u ^Close& wdÈh o 

ol=Kq fl<jf¾ msysgd we;'

7' iQu cd,h 
Zoom Control

5' ;;a;aj ;Srej 
    Status Bar

fldaÿj oelaùfï fnd;a;ï

Veiw Ruler Buttons

msgq w;r .uka 

lsÍfï fnd;a;ï

Browse Buttons
±l=ï fnd;a;ï

View Buttons

 2' ßnkh

  Ribbon{

4' ixjdo fldgq mqrkakd

Dialogue Box Launcher

1' ud;Dld ;Srej

   Title Bar

3' blauka m%fõY fuj,ï ;Srej   

    Quick Access Tool Bar

má;s Tabs

6' frda,a lsÍfï ;Srej

     Scroll Bar

rEmh 6'2 - ud;Dld ;Srej
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2' ßnkh ^Ribbon&  - ßnkh Word 2010 ljq¿j, oelsh yels úfYaI ,laIKhls' 

fuys we;s wx. ^File, Home, Insert etc'& má;s ^Tabs& hkqfjka y÷kajkq ,nhs' 

ßnkfha we;s úfYaI ,laIKh jkafka tla tla má;sj,g wod< whs;u ksrEml 

^Icons& f,i oelaùu iy tu.ska tajdfha ld¾hhka meyeÈ,ss ùuhs' mßYS,lhdg 

wjYH wdldrhg fuu má;s ilia lr .ekSug o myiqlï i,id we;' tfia u 

ßnkh lKavdhï lsysmhlg fnod fjka lr we;' ^Clipboard" Font" Paragraph" 
Styles "Editing etc'&

Home ßnkfhys ^rEmh 6'3&  we;s iuyr wx. (

rEmh 6'3 - Home ßnkh

1 2 3 4 5 6 7 8 9 10

17
16 15 1314 12 1118

1.  ;o meye .ekaùu - Bold  
2.  we, lsÍu - Italic   
3.   há br - Underline 
4.   há ,l=K - Subscript  
5.   Wvq ,l=Kq  -Superscript 
6.   wl=re j¾K - Font color  
7.   tfl,a, - Alignments  
8.   fma<s mr;rh - Line spacing
9.   w÷re lsÍu - Shading  

3' blauka m%fõY fuj,ï ;Srej ^Quick Access Tool Bar& rEmh 6'4 - ieu úg u 

ßnkhg by<sska ia:dk .; lr we;s blauka m%fõY fuj,ï ;Srej ßnkhg 

háka fyda ia:dk .; lsÍug yelshdj we;' kj f,aLkhla ,nd .ekSu" f,aLkh  

iq/lSu ^Save& fyda újD; lsÍu" f,dma lsÍu (Undo)" w¨ma lsÍu ^Redo& wdos b;d 

blaukska bgq lr .; hq;= úOdkj,ska iukaú; fuu blauka m%fõY fuj,ï 

;Srej mßYS,lhdf.a wjYH;djg wkqj fjkia lr .; yels h'

rEmh 6'4 - blauka m%fõY fuj,ï ;Srej (Quick Access Tool Bar)

iq/lSu

f,dma  lsÍu

w¨ma lsÍu

10. fndavrh - Border  
11. f;aÍu - Sort  
12. wkqfþokh  - Indentation 
13. wxl lsÍu  -Numbering 
14. nq,Üia - Bullets  
15. bx.%Sis wl=rej, isïm,a" lemsg,a 

    udre lsÍu  - Change case
16. wl=f¾ m%udKh j¾Okh - Grow font  
17. wl=re j¾.fha m%udKh - Font Size   
18. wl=re j¾.h - Font Name  
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4' ixjdo fldgq mqrkakd ^Dialogue Box launcher& rEmh 6'5 - ßnkfha we;s iuyr 

ldKavj, fmkakqï lrkq ,nk fuj,ïj,g wu;r j fjk;a fuj,ï we;s 

nj fmkakqï lrkafka ixjdo fldgq mqrkakd u.sks' lKavdhï kduhg ol=Kq 

miska Èiafjk B;,h u; la,sla lsÍu u.ska wod< ixjdo fldgqj újD; lr .; 

yels h' ixjdo fldgq ^Dialogue Box& újD; lr .ekSfuka ßnkfha Èiafjk 

fuj,ïj,g wu;r j fjk;a fuj,ï fndfyduhla f,aLk ilia lsÍfï § 

fhdod .; yels h'

5' ;;a;aj ;Srej ^Status Bar& rEmh 6'6 - Microsoft Word ljq¿fjys jïmi my<ska  

msysgd we;' fuh f,aLkfha msgq .Kk" jpk .Kk" fhdod .kq ,nk NdIdj" 

oel=ï fnd;a;ï o wdosh n,d .ekSug o f,aLkfha ir, fjkialula lsÍug o 

fhdod .kq ,nhs'

6' frda,a lsÍfï ;Srej ^Scroll Bar& - f,aLkfha by<g my<g .uka lsÍu i|yd 

fhdod .kq ,nhs'

7' hqyquq lsÍu  (ZOOM) rEmh 6'7 - hqyquq lsÍu ^ZOOM& u.ska ;srfha oiqka Èiajk 

f¾Ldfjka m%udKh wvqjeä l< yels h' fuys § f,aLkhg lsisÿ fjkila 

fkdjk w;r h;=re,shkh lrkakdf.a leue;a;g wkqj fjkia l< yel' hqyquq 

lsÍu fidaÿm;a mÍlaId lsÍfï § f,aLkfha ksudj n,d .ekSug fhdod .efka'

 

 fuys úia;r lr fkdue;s fuj,ï oek .ekSu i|yd uQisl o¾Ylh ^Mouse 
Pointer& tu fuj,u u;g f.k hñka fuj,ï bÕsh ̂ Tool Tip& m%fhdackhg .kak'

(Font) ldKavfha we;s ixjdo fldgq 

mqrkakd la,sla lsÍfuka újD; jk wl=re 

j¾. ixjdo fldgqj rEmh 6'5 

rEmh 6'5 - wl=re j¾. ixjdo fldgqj

 rEmh 6'7 - hqyquq lsÍu

 rEmh 6'6 - ;;a;aj ;Srej 



169fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs168

 LibreOffice Writer 4.1

Start → All Programs → LibreOffice Writer ^fufyhqï moaO;sh wkqj fjkia úh 

yels h'&

LibreOffice Writer  uDÿldx.fha Ñ;%l mßYS,l w;=re uqyqK;" 6'8 rEmh u.ska 

fmkajd we;'

 '  

1' ud;Dld ;Srej ^Title Bar& rEmh 6'9 olajd we;' - LibreOffice Writer ljq¿fjys 

by<sska u olajd we;s ;Srej ud;Dld ;Srejhs' újD; j we;s f,aLkfha kduh 

fuys oelafõ' kj f,aLkhla kï Untitled  X  hkqfjka Èiafjk w;r X  hkq 

f,aLk wxlhhs' 

 

2' fukq ;Srej ^Menu Bar& -  fukq ;Srej" ud;Dld ;Srejg my<ska msysgd we;' tys 

we;s wx. ms<sfj<sska File, Edit, View, Insert, Format, Tables, Tools, Window, 
Help fõ' fukq ;Srefjys tla wx.hla f;dard .;a úg thg wod< wkqfukqj 

(Submenu& újD; jk w;r tys wx. wjYH;djg wkqj f;dard .; yels h'

 rEmh 6'8 - LibreOffice Writer

2' fukq ;Srej    

Menu Bar 4' yeviõ fuj,ï ;Srej

    Formatting Tool Bar
3' iïu; fuj,ï 

;Srej

Standard Tool Bar

5' ;;a;aj ;Srej 
  Status Bar

6' frda,a lsÍfï ;Srej 

       Scroll Bar

7' hqyqquq md,kh

Zoom Control

1' ud;Dld ;Srej

      Title Bar

f,aLk wxlhhs' 

 rEmh 6'9 - ud;Dld ;Srej

 rEmh 6'10 - fukq ;Srej ^Menu Bar&
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² File fukqj f;dard .ekSfuka újD; jk wkqfukqj u.ska kj f,aLkhla ,nd 

.ekSu" f,aLkh iq/lSu fyda újD; lsÍu" f,aLkh jid oeóu wdos úl,am 

iuQyhla oelsh yels h'

² wkqfukqfjys we;s ;s;a ;=k  ‘...’  iys; wkqfukq f;dard .ekSfuka ixjdo fldgq 

újD; lr .; yels h' rEmh 6'11  

² wkqfukqfjys we;s ol=Kq ÈYd .; B;, u`.ska ;j;a wkqfukqjla újD; lr .; 

yels h' rEmh 6'11   

 rEmh 6'11 - wkqfukq

;s;a ;=k

ol=Kq ÈYd.; B;,h

• fuj,ï ;Sre ̂Toolbars& - LibreOffice Writer ljq¿fjys fukq ;Srejg my<ska we;s 

;Sre fuj,ï ;Sre fõ' fuys we;s iïu; fuj,ï ;Srej iy yeviùfï fuj,ï 

;Srej Writer ljq¿j újD; jk wjia:dfõ § oelsh yels w;r wjYH;djg wkqj 

fjk;a fuj,ï ;Sre ,nd .ekSu fyda jid oeóu fyda l< yels h' ta i|yd"View 
fukqj újD; lrñka Toolbars wkqfukqfjys i|yka  wjYH fuj,ï ;Sre kduh 

,l=Kq lsÍfuka fuj,ï ;Sre ,nd .ekSu fyda ,l=K jid oeófuka fuj,ï jid 

oeóu fyda l< yels h'

3' iïu; fuj,ï ;Srej ^Standard Tool Bar& - rEmh 6'12 úOdk ;Srefõ we;=<;a 

úOdk" tkï" Ndú; lsÍfï myiqj fjkqfjka rEml ^Icons& f,iska fuys 

wka;¾.; lr we;'

 rEmh 6'12 - iïu; fuj,ï ;Srej

1 2 53 4 6 7

14 13 12 11 10 9 8
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1'  kj f,aLkhla - New  
6'  j.=j - -Table
7'  Wojq - Help
8'  .e,ßh - Gallery
9'  f,dma  lsÍu - 

Undo
10' we,ùu - Paste

11' lemSu - Cut
12' wlaIr úkHdih  - 

Spelling and grammar
13' uqøKh - Print
14' újD; lsÍu - Open

 

2'  ;ekam;a lsÍu - Save
3'  fmr±lau - Page Preview
4'  msgm;a lsÍu - Copy
5'  w¨ma lsÍu - Redo

4'  yeviùfï fuj,ï ;Srej ̂ Formatting Tool Bar& - rEmh 6' 13 - f,aLkhl we;s 

wl=re yeviùfï § fhdod .; yels yeviùï l%u fndfyduhla fuys oelafõ'  

tkï yeviùfï ;Srefõ we;=<;a úOdk Ndú; lsÍfï myiqj fjkqfjka rEml 

^Icons& f,iska fuys wka;¾.; lr we;' 

 rEmh 6'13 - yeviùfï fuj,ï ;Srej

1 2 53 4 6 7

12 11 10

98

1'  ú,dih fh§u - Apply style 9'  miqìï mdg - Background  
      color

10' wl=re mdg -Font color
11' nq,Üia - Bullets
12' we, lsÍu - Italics

 
2'  wl=re -Font
3'  wl=re m%udKh - Font size
4'  ;o meye .ekaùu - Bold

 

5' ;;a;aj ;Srej ^Status Bar& - Writer ljq`Mfjys jï mi my<ska ;;a;aj ;Srej 

msysgd we;' fuh f,aLkfha msgq .Kk" jpk .Kk" fhdod .kq ,nk NdIdj" 

hqyquq lsÍu wdÈh n,d .ekSug o f,aLkfha ir, fjkialula lsÍug o fhdod 

.kq ,nhs' 

6' frda,a lsÍfï ;Srej ^Scroll Button and Scroll Bar& - f,aLkfha by<g my<g   

.uka lsÍu i|yd fïjd fhdod .kq ,nhs'

7' hqyquq lsÍu ^ZOOM& - hqyquq lsÍu ^ZOOM& u.ska ;srfha oiqka mßudj fjkia 

l< yels h' fuys § f,aLkhg lsisÿ fjkila fkdjk w;r h;=re,shkh 

lrkakdf.a leue;a;g wkqj oiqka mßudj fjkia l< yel' hqyquq lsÍu fidaÿm;a 

mÍlaId lsÍfï § f,aLkfha ksudj n,d .ekSug fhdod .efka'

 fuys úia;r lr fkdue;s fuj,ï oek .ekSu i|yd uQisl o¾Ylh ^Mouse 
Pointer& tu fuj,u u;g f.k hñka fuj,ï bÕsh ^Tool Tip& m%fhdackhg .; 

yels h'

5'  há br - Underline
6'  tfl,a, - Alignment
7'  wxl lsÍu - Numbering
8'  wkqfþokh - Indentation
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 6'2   kj f,aLkhla ilia lsÍfï § jeo.;a jk lreKq  
  lsysmhla i,ld n,uq'

mshjr 1 ¡ - 
     kj msgqjla ,nd .ekSu

joka ieliSfï uDÿldx.h újD; jk wjia:dfõ § kj msgqjla ,nd §u 

iajhxl%Sh j isÿ jqj;a" fjk;a kj ks¾udKhla i|yd kj f,aLkhla ,nd 

.ekSu wm úiska l< hq;a;ls' 

 

    Microsoft Word  i|yd'''
 
   File →New (Ctrl+N) →Blank Document 
   → Create fhdod .kak'

   

mshjr 2 ¡

File→Save (Ctrl+S) f;dard .kak'

• iq/lSug iqÿiq ia:dkhla  (Saving 
Location) Save in ia:dkhka f;dard 

.kak'

•    f,aLkhg iqÿiq kula File name   
     bÈßfhka h;=re,shkh lrkak'

•    Save fnd;a;u la,sla lrkak'

f,aLkh iq/lSu (Save) 
Tn úiska ilia lr .kakd ,o f,aLkh 

iqÿiq kduhla fhdod iqÿiq ia:dkhl 

iq/lSu b;d jeo.;a h' th f,aLkh 

kej; fidhd .ekSug myiq lrhs'

mshjr 3 ¡

iqrlsk ,o f.dkqj fjk;a kula 

fhdod ;ekam;a lsÍu

Tn úiska kula fhdod iq/ls f,aLkh 

^Document&" iq/lSfuka wk;=re j 

f.dkqj ^File& f,i y÷kajkq ,nhs' fuu 

f.dkqj fjk;a kula fhdod fyda fjk;a 

ia:dkhl fyda iq/lsh yels h' túg 

oekg mj;sk kdufhka tla f.dkqjla o 

fojkq j fhdod .kakd kdufhka ;j;a 

f.dkqjla o jYfhka f.dkq folla ,efí' 

fuh f.dkq kdu È.=jla ^file extension& 
iys; j ;ekam;a jk neúka fï u.ska 

f.dkqj fidhd .ekSu myiq lrhs'

f.dkq kï È.=j (file extension)

   MS Word 2007$ 2010  -  .docx
   MS Word 97-2003      -   .doc
   LibreOffice Writer     -   .odt

File→Save as f;dard .kak'

• ;ekam;a lsÍug iqÿiq ia:dkhla              

(Saving Location) Save in ia:dkfhka 

f;dard .kak'

•    f,aLkhg iqÿiq kula File name   
     bÈßfhka h;=re,shkh lrkak'

•    Save fnd;a;u la,sla lrkak'

fï i|yd'''

LibreOffice Writer i`oyd'''

 
 File→New (Ctrl+N)→Text Document  
 fhdod .kak'
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mshjr 4 ¡

f,aLkh jeiSu

Tn úiska ilia lr ;ekam;a lr .kakd ,o 

f,aLkh kej; m%fhdackhg .kakd f;la 

jid oeóu kqjKe;s l%shdjls' wkjYH f,i 

újD; j we;s fhojqï mß.Kl l%shdj,shg 

ndOdjls' tu ksid"

File → Close f;dard .kak'

fï i|yd'''

mshjr 5 ¡

f,aLkh újD; lsÍu

Tng úiska mß.Klfha fyda fjk;a 

udOHhl ;ekam;a lr we;s f.dkqjla 

újD; lsÍug Tng wjYH jkq we;'

File →Open ^Ctrl+O&f;dard .kak'

• Open ixjdo fldgqfõ Look in 
ia:dkfhka f,aLkh ;ekam;a 

l< ia:dkh f;dard .kak'

•  my; ljq¿fjka f,aLkh f;dard 

.kak'

• Open fnd;a;u la,sla lrkak'

fï i|yd'''

mshjr 6 ¡

f,aLkh uqr mohla (Password) fhdod ;ekam;a lsÍu'

Tnf.a f,aLkh wdrlaId iys; j ;nd .ekSug fhdod .; yels 

lÈu Wmdh uqr mohla ^Password& fh§u h' fuh fh§fuka fjk;a 

wfhl=g Tnf.a f,aLkh újD; lsÍug fkdyels jkq we;'          

fï i|yd'''                   

Microsoft Word kï

•  File→Save  f;dard .kak'

•  ;ekam;a lsÍug iqÿiq ia:dkhla        

(Saving Location) Save in ia:dkfhka 

f;dard .kak'

 ² f,aLkhg iqÿiq kula File name   
bÈßfhka h;=re,shkh lrkak'

• Tools f;dard .kak'

• General Option f;dard .kak'

• Password to open fldgqfjys f,aLkh 

újD; lsÍug fhdok uqr moh h;=re 

,shkh lrkak' OK  la,sla lrkak'

•  tu uqrmoh u Re-enter Password to  
open  fldgqfjys h;=re,shkh lr OK  
la,sla lrkak' 

• Save fnd;a;u la,sla lrkak'

LibreOffice Writer kï

• File →Save  f;dard .kak'

•  ;ekam;a lsÍug iqÿiq ia:dkhla 

    ^Saving Location& Save in ia:dkfhka              

     f;dard .kak'

•  f,aLkhg iqÿiq kula File name   
bÈßfhka h;=re,shkh lrkak'

• Save with a Password i,l=Kq fldgqj 

i,l=Kq lrkak'

• Save fnd;a;u la,sla lrkak'

• Set Password ixjdo fldgqfjys 

f,aLkh újD; lsÍug fhdok uqrmoh 

h;=re,shkh lrkak' 

•  tu uqrmoh u fojk fldgqfjys  

h;=re ,shkh lr OK fnd;a;u la,sla 

lrkak'
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l%shdldrlu rEmh  1

  l%shdldrlu

Tn úiska Ndú; lrkq ,nk joka ieliqï uDÿldx.h újD; lr 

.kak' my; § we;s l%shdldrlï lrkak'

1'  l%shdldrlu rEmh 1ys we;s fþoh h;=re,shkh lrkak' tu 

   f,aLkh  ''Assign 1'' kñka Tnf.a f*da,avrfha ;ekam;a lrkak' 

    f,aLkh jid oukak'

2'  ''Assign 1'' f.dkqj újD; lr .kak' tu f.dkqj ''Assign 2" kï 

    f,aLk kduh fhdod —Word 97-2003˜  j¾.fhka ^Save as Type&  
     újD; l< yels f,i fjkia lrñka Tnf.a f*da,avrfha ;ekam;a  

    lrkak' f,aLkh jid oukak'

Word Processor
A word processor, or word processing program does exactly what the name 
implies. It processes words. It also processes paragraphs and entire papers. 
Some examples of word processing programs include Microsoft Word, Word 
perfect (Windows only), Apple Works (Mac only) and Open Office.org.

 6'3      f,aLkhla ilia lsÍu

6'3'1  msgq ieliqu (Page Setup)
 

 kj f,aLkhla ilia lsÍfï § uq,ska u l< hq;af;a f,aLkhg .e<fmk mßÈ 

msgqj ilid .ekSuhs'  

 

   Microsoft Word  i|yd''' 

  Page Layout →Page Setup ldKavh Ndú; 
  lrkak''

LibreOffice Clac i`oyd'''

Format→ Page yd Page ixjdo fldgqj 
Ndú; lrkak'

joka ieliqï uDÿldx.hl olakg ,efnk fmdÿfõ Ndú; l< yels msgq 

ieliqï fuj,ï lsysmhla we;' tkï"

cd;Hka;r iïu;j,g wkqj ilikq ,enQ uqøK lvodis m%udK ^Size $ 
Format& A4, A5, B4, Letter ''' f;dard .; yels h' tfia u mßYS,lhdg wjYH mßÈ 

m%udKh ilia lr .ekSug o myiqlï we;' msgq ieliqfï §" ÈYdk;sh ^Orientation& 
iy msgq iSud ^Margins& f,aLkhg .e<fmk f,i ilia lr .kak'

ÈYdk;sh ^Orientation& j¾. folls' tkï isria ÈYdk;sh ^Portrait&      

iy ;sria ^yria& ÈYdk;sh ^Landscape&   fõ' 
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6'3'2   wl=re $ fþo yeviùu ^Formatting&
 

,smshl fyda f,aLkhl wl=re $fþo h;=re,shkh lsÍug fmr fyda miq j  

yeviùu ^Formatting& l< yels h' yeviùfukaa ,smshlg fyda f,aLkhlg meyeÈ,s 

njla yd is;a .kakd iq¨ ksudjla ,efí' 

wl=re $fþo h;=re,shkh lsÍug miq j yeviùu lrkafka kï" yeviùug 

fmr tu wl=re$fþo f;dard .; hq;= h'  

wl=re$fþo h;=re,shkh lsÍug fmr yeviùu lrkafka kï wjYH yeviõj 

f;dard h;=re,shkh lr B<Õ h;=re,shkhg fmr f;dard .;a yeviõj kj;d oeñh 

hq;= h'

6'3'3  f;aÍfï ^Select& l%u

f,aLkhla wx. lsysmhlska iukaú; úh yels h' tkï wl=re" jpk" yev;," 

Ñ;%l" j.= wdÈ wx. h' tfia u úúO wjia:dj, ys fuu wx.j, ys fjkialï lsÍug 

isÿ jkq we;' túg fjkialug Ndckh lsÍug m%:ufhka tu wx.h f;dard .; hq;= 

h' ta i|yd wkq.ukh l< yels l%u lsysmhla my; oelafõ'

;ks wl=rla fyda 

lsysmhla 

uQislh la,sla lr f.k wl=re yryd weof.k (Drag) 
hkak'

jpkhla uQislh tl úg fojrla jpkh u; la,sla lrkak'

jpk lsysmhla f;dard .ekSug n,dfmdfrd;a;= jk jpk lsysmfhys 

m<uq jk jpkh u; la,sla lr wjidk jpkh f;la 

wÈkak'

jdlHhla jdlHhfha m<uq jk jpkh u; la,sla lr wjidk 

jpkh f;la wÈkak'

fma<sshla iqÿ meye;s ol=Kq ÈYd.; B;,hla fmfkk f;la    

fma<ssfha bÈßhg uQislh f.k hkak' th ÿgq úg jrla 

la,sla lrkak'

fþohla •  fþoh u; tl úg ;=ka jrla uQislh la,sla lrkak'      

tfia ke;fyd;a fþofha m<uq jpkh u; la,sla lr 

wjidk jpkh f;la weof.k hkak'

f,aLkhla •  h;=re,shkfha Ctrl +A tlúg Tnkak'

•  iqÿ meye;s ol=Kq ÈYd.; B;,hla fmfkk f;la     

fma<sfha bÈßhg uQislh f.k hkak' th ÿgq úg 

f;jrla la,sla lrkak'
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6'3'4  wl=re yeviùu ^Text Formatting& 

tys §'''' 

1' wl=rej, m%udKh ^Font Size& 
2' wl=rej, yevh ^Font Style& - wl=re 

;o meye .ekaùu ^Bold&" we, lsÍu  

^Italic&   

3' wl=re há bß we£u ^ Underline&  
4' wl=re j¾.h ^Font& - úúO NdIdj, 

 wl=re j¾. iy ixfla; ,nd.ekSu 

5' wl=rej, j¾Kh ^Font Color&   
    fjkia lsÍu fhdod .; yels h'

Tn Ndú; lrk joka ieliqï uDÿldx.h újD; lr .kak' my; § we;s 

l%shdldrlï lrkak'

1' Tnf.a msgqj fuf,i ilia lr .kak'

m%udKh ^ Size& - A4 ÈYdk;sh ^Orientation& 
- ;sria ^yria&

  msgq iSud ^Margins& -
jfuka iy ol=fKka - 2'' ne.ska 

Wäka iy háka -1.5'' ne.ska

^Page setup) ixjdo fldgqj ^dialog box& újD; lr .ekSfuka fuu ilia  

lsÍï ish,a, u tl úg lr .; yels h'&

l%shdldrlu rEmh 2ys we;s fþo h;=re,shkh lrkak' tu f,aLkh 

''Assign 2'' kñka Tnf.a f*da,avrfha iq/lSu lrkak' f,aLkh jid oukak'

2. 'Assign 2'' f.dkqj újD; lr .kak' tys we;s jpk l%shdldrlu rEmh 3ys fmkajd 

we;s wdldrhg yevijkak' ^fuys § fhdod f.k we;s wl=re j¾.h i|yd Bg 

wdikak;u j¾.hla  fhdod .kak'& bka miq ''Assign 3''kñka Tnf.a f*da,avrfha   

iq/lSu lrkak' f,aLkh jid oukak'

  l%shdldrlu

rEmh 6'14 - yeviùu'

           Microsoft Word ... i|yd  

  Tnf.a wl=re fyda fþo fyda f;daard .kak'

• Home → Font ldKavfha we;s  Tnf.a 

yeviùug wjYH fuj,ï u; la,sla 

lrkak ke;fyd;a 

• Font ixjdo fldgqj ^Dialogue Box& 
újD; lr .kak'

tfia u tl úg fuj,ï lsysmhla fhdod 

.; yels nj ie,ls,A,g .kak'

LibreOffice Writer ... i|yd  

•  Tnf.a wl=re fyda fþo f;dard .kak'

•  yeviùfï fuj,ï ;Srej ^Formatting 
Tool Bar& fhdod .kak'

•  Tnf.a yeviùug  wjYH 

     fuj,u u; la,sla lrkak

      ke;fyd;a

• Format → Character ixjdo fldgqj 

újD; lr .kak'

tfia u tl úg fuj,ï lsysmhla fhdod 

.; yels nj ie,ls,a,g .kak'
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6'3'5  fþo yeviùu ^Paragraph Formatting&  

• tfl,a, lsÍu ^ Alignment& ^rEmh 6'15&        

rEmh  6'15 - fþo yeviùu

l%shdldrlu 

rEmh  2

l%shdldrlu 

rEmh  3

What is a computer?

A computer is an electronic device that manipulates information 
or data. It has the ability to store, retrieve and process data.

You can use a computer to type documents, send email and browse 
the Web. You can also use it to handle spreadsheets, accounting,  
database management, presentations, games and more.

What is a computer?
A computer is an electronic device that manipulates information or 
data. It has the ability to store, retrieve and process data.

You can use a computer to type documents, send email and browse 
the Web. You can also use it to handle spreadsheets, accounting,  
database management, presentations, games and more.
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6' jï me;a;g tfl,a, lsÍu' ^Left Align&   

7' ueog tfl,a, lsÍu'  ^Center Align&   

8' ol=Kq me;a;g tfl,a, lsÍu'  ^Right Align&  

9' fofl<jr iudka;r j tfl,a, lsÍu' ^Justify&'  

²   wkqfþokh lsÍu ^Indentation& 
 ^rEmh 6'16 iy 6'17&

10'  jfuka wkqfþokh ^Left Indentation&  

11'  ol=fKka wkqfþokh ^Right Indentation& 

12'  m<uq fma,sh wkqfþokh ^First Line Indentation&

13'  t,af,k wdldrhg wkqfþokh ^Hanging Indentation&

14.  fma<s mr;rh ^Line spacing& 

15.  fþo mr;rh ^Paragraph spacing& 

 

12

  Computer is an electronic device 
  which accepts data, processes
  and produces desired
  information.

The computer memory refers to the 
storage area of a computer where all 
the data and instructions are stored. 

 The storage capacity of the computer memory 

is expressed in terms of bits and bytes. The more memory 

a computer has, the more memory it can store.

Computer hardware is the collection of physical elements 
 that constitutes a computer system. 
 Computer hardware refers to the physical 
 parts or components of a computer such as 
 the monitor, mouse, keyboard,

10

13
 

11

 

Computer hardware is the collection of physical elements 
that constitutes a computer system. Computer hardware 
refers to the physical parts or components of a computer 
such as the monitor, mouse, keyboard, computer data 
storage, hard drive disk (HDD) etc...

Software is any set of machine-readable instructions 
that directs a computer's processor to perform specific 
operations. A combination of hardware and software 
forms a               

 

 

14

15
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Microsoft Word  i|yd''''''''' 

Tnf.a jpk fyda fþo f;dard .kak'

• Home →Paragraph  ldKavfha we;s 

Tnf.a yeviùug wjYH fuj,u u; 

la,sla lrkak' 

     ke; fyd;a 

• Paragraph ixjdo fldgqj ^Dialogue Box& 
újD; lr .kak' 

•  tys we;s Tng wjYH fuj,u f;dard 

.kak'

• OK la,sla lrkak'

LibreOffice Writer  kï'''''''''

Tnf.a jpk fyda fþo f;daard .kak'

•  yeviùfï fuj,ï ;Srefõ ^Formatting 
Tool Bar& we;s Tnf.a yeviùug  wjYH 

fuj,u u; la,sla lrkak

     ke;fyd;a  

• Format →Paragraph ixjdo fldgqj 

^Dialogue Box& újD; lr .kak

•  tys we;s Tng wjYH fuj,u f;dard 

.kak'

• OK la,sla lrkak'

Tn úiska Ndú; lrkq ,nk joka ieliqï uDÿldx.h újD; lr .kak' 

my; § we;s l%shdldrlï lrkak'

1' Tn úiska ilik ,o"Assign 3" f.dkqj újD; lr .kak' tys we;s fþo 

l%shdldrlu rEmh 4ys fmkajd we;s wdldrhg yevijkak' bka miq "Assign 4" 
kñka Tnf.a f*da,avrfha iq/ls" f,aLkh jid oukak'

2' kej;;a "Assign 3" f.dkqj újD; lrkak' tys we;s fþo l%shdldrlu rEmh 

5 ys fmkajd we;s wdldrhg yevijkak' bka miq "Assign 5" kñka Tnf.a 

f*da,avrfha iqrlskak' f,aLkh jid oukak'

  l%shdldrlu

l%shdldrlu 

rEmh  4

 What is a computer?

 A computer is an electronic device that 
manipulates information or data. It has the 
ability to store, retrieve, and process data.

You can use a computer to type

document, send email, and browse the
web.

You can also use it to handle spreadsheets, 
accounting database, management, 
presentations, games, and more.
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6'3'6 nq,Ü ,ehsia;= iy wxlk ,ehsia;= ^Bullets and Numbering& iy fjk;a 
         yeviùï 

16' nq,Ü ,ehsia;= ^Bullet List& 
17' wxlk ,ehsia;= ^Number List& 
18' nyq uÜgï ,ehsia;= ^Multilevel List& 
19' w÷re lsÍu$ miqìï j¾K .ekaùu

    ^Shading$ Background Color&
20' fndav¾ fh§u ^Border&

l%shdldrlu 

rEmh  5

What is a computer?

A computer is an electronic device that

  manipulates information or

  data. It has the ability

  to store, retrieve,

  and process data.

You can use a computer to type documents
send email and brows the Web.

There are two types of Memory. They are,
1. Primary Memory
 1.1.    ROM
 1.2.    RAM

2. Secondary Memory
 a)    Hard Disk
 b)    Floppy Diskette
 c)    Pen drive
 d)    CD / DVD  

 

Storage
 Capacity 

 Bit
 Nibble
    Byte
    Megabyte
 Gigabyte19

17

16

18

20
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ie'hq' - f;dard .kakd ,o jdlH i|yd paragraph ldKavfhka nq,Ü iy wxlk 

,ehsia;= fhdod .ekSug yels fõ' tfy;a m%Odk ,ehsia;=j wjidkfha nyq uÜgï 

,ehsia;=j ^Multilevel List& wdrïN lsÍu i`oyd"

1' h;=re mqjrefõ Tab h;=r Tnkak'

2' nyq uÜgï ,ehsia;=j wjidkfha § wdmiq m%Odk ,ehsia;=jg iïnkaO ùu   

 i|yd Shift + Tab h;=re Tnkak'

21' w÷re lsÍu$ miqìï j¾K .ekaùu iy fndav¾ fh§u

   LibreOffice Writer  i|yd ''''''''''''

fþohg j¾K i|yd :
• Format→Character→Background 

má;af;ka wjYH j¾Kh f;daard 

.kak'

fndav¾ i|yd :
• Format→Paragraph→Border 

f;dard .kak'

--------------------------------------------

f,aLkhg j¾K fh§u i|yd :
• Format → Page → Background 

má;af;ka wjYH j¾Kh f;dard 

.kak'

fndav¾ i|yd :
• Format→Page→Border má;af;ka 

wjYH fndavrh iy Bg wod< 

j¾Kh f;dard .kak'

f;dard .ekSï wjidkfha § OK l,slaa 

lrkak'

   Microsoft Word i|yd ''''''''''''

 
  fþo $f,aLkh f;darkak'

• Page Layout → Page Background 
    ldKavfha we;s Page Borders f;dard       

    .kak'

• Borders and Shading ixjdo fldgqfjys we;s 
Borders/ Page Border/ Shading fï i|yd 

fhdokak'

• OK la,sla lrkak'
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 6'4     f,aLkhg úÑ;% nj tl;= lsÍu

ilia lr .kakd ,o ,smshla fyda f,aLkhla jvd;a meyeÈ,s njla iy 

úÑ;%j;a njla ,nd §u i|yd tl;= l< yels wx. lsysmhla kï" 

^rEmh 6'20&

1'  yev;, ^Shapes $ Objects& 
2'   Ñ;%l ̂Pictures $ Images$ ClipArt& 
3'  i,l=Kq ^Symbols&
4'  j.= ^Tables&
5'  YS¾Ilh iy mdolh ^Header and  
      Footer&
6'  msgq wxl ^Page Numbers&
7'  ;Sre ^Columns& 
8'  mo rE ^ WordArt$ Fontwork&
 Tfí f,aLkhg by; oelajQ 

wx. fuka u fjk;a  iqÿiq wx. o 

tl;= lr .; yels h'         

 

5 4

7

4

6
3

1

2

5

l%shdldrlu rEmh 6

Tn Ndú; lrk joka ieliqï uDÿldx. 

újD; lrkak' my; § we;s l%shdldrlï 

lrkak'

1' kj msgqjla ,nd .kak' l%shdldrlu rEmh 

6ys olajd we;s wdldrhg nq,Ü ,ehsia;=jla  

ks¾udKh lrkak' bka miq tu f,aLkh 
"Assign 6" kñka Tnf.a f*da,avrfha iq/lSu 

lrkak' f,aLkh jid oukak

2' Tn úiska iqrlsk ,o  "Assign 6" f.dkqj 

újD; lrkak' msgqj jgd fndavrhla fhdokak' 

tfia fjkia lrk ,o f.dkqj ''Save as Type  -  
Word 97 - 2003'' f,i fjkia lrñka  "Assign 
7" kñka iq/lSu lrkak' f,aLkh jid oukak'

Different type of software

 Antivirus
           AVG
           Semantic
           Kaspersky
 E-mail
  Outlook
  Yahoo mail
  Gmail
 Games
  Worlds of Warcraft
  Car race
 Internet browser
  Firefox
  Explore 
  Google
 Operating system
  Windows xp
  Windows 7
  Linux

 

  l%shdldrlu

8
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6'4'1  yev;, ^Shapes& iy Ñ;%l ^Images&  

ilia lrkq ,nk f,aLkh jv - jvd;a meyeÈ,s lsÍug yd úÑ;%j;a lsÍug 

Ñ;%l ^Images& iy yev;, ^Shapes& fhdod .efka' fï i|yd m<uq j Ñ;%lh fyda 

yev;,h wjYH jk ia:dkfha l¾irh ;nd .kak'

6'4'2  Ñ;%lh fyda yev;,h ilia lsÍu  

Tn úiska f,aLkhg we;=<;a lrk ,o Ñ;%lh fyda yev;,h Tng wjYH 

f,i ilid .; yels h' fuys §" tys m%udKh fjkia lsÍu" j¾Kh fjkia lsÍu" 

fndav¾ fh§u iy ia:dkh fjkia lsÍu wdÈ fjkialï /ila lsÍug yels h' ^rEmh 

6'21 & fjkialï lsÍug m%:ufhka Ñ;%lh fyda yev;,h u; la,sla lrñka th 

f;dard .; hq;= h' tfia f;dard .;a úg újD; jk Ñ;%lh fyda yev;,h ilia 

lsÍug iqÿiq fuj,ï ;Srej Wmfhda. lr .ksñka wjYH mßÈ ilia lr .kak' 

yev;,h $ Ñ;%lh 

lrleùu i|yd

yev;,h $ Ñ;%lh 

ia:dkh fjkia lsÍu  

i|yd ^tyd fuyd 

f.khdu i|yd&

yev;,fha$ Ñ;%lfha 

m%udKh fjkia lsÍu 

i|yd

 rEmh 6'20 - Ñ;%lh fyda yev;,h ilia lsÍu    

Microsoft Word  ßnkfhys Ñ;%lh ilia lsÍug fhdod .kakd fuj,ï ;Srej

rEm fuj,u

 Microsoft Word i|yd ...
 Insert má;a; iy tys ßnkh Wmfhda. lr 

.kak'

•  yev;,hla kï 

 Insert → Shape f;dard .kak'

•  tys we;s yev;,hla u; la,sla lr th 

msgqj u; uQislh la,sla lrñka we|

     .kak'

•  Ñ;%lhla kï Insert má;af;ys → 

     Picture$ClipArt f;dard .kak' 

•  leu;s Ñ;%lhla f;dard újD; lr 

.kak'

LibreOffice Writer i|yd ''' 

fukq ;Srefjys Insert má;a; Wmfhda.S lr 

.kak' 

•  yev;,hla kï 

 Insert Object → OLE Object f;dard 

.kak'''''' ke;fyd;a  

 Drawing fuj,ï ;Srefjka yev;,hla 

u; la,sla lr th msgqj u; uQislh la,sla 

lrñka we|.kak'

•  Ñ;%lhla kï Insert→ Picture→ From 
File f;dard .kak' 

•  leu;s Ñ;%lhla f;dard újD; lr.kak'
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6'4'3  i,l=Kq (Symbols)  

f,aLk ilia lsÍfï § úúO i,l=Kq fhdod .ekSug isÿ jkq we;' tfy;a wm 

úiska Ndú; lrkq ,nk h;=re mqjrefjys we;af;a iSñ; i,l=Kq m%udKhls' fuu 

wmyiq;d u`.yrjd .ksñka wmg wjYH jk i,l=Kq fh§u i|yd

Microsoft Word  i`oyd '''

Insert→ Symbol u.ska újD; jk ixjdo 

fldgqfjys we;s i,l=Kq f;dard f.k Insert 
u; la,sla lsÍfuka f,aLkhg we;=<;a

lr .kak'

LibreOffice Writer  kï'''

Insert→ Special Character u.ska újD; 

jk ixjdo fldgqfjys we;s i,l=Kq 

f;dard f.k OK u; la,sla lr f,aLkhg 

we;=<;a lr .kak'

  

6'4'4  YS¾Ilh iy mdolh ^Header and Footer& iy msgq wxl 

  ^Page Numbers&
 

f,aLk yd iÕrd ks¾udKfha § YS¾Ilh iy mdolh fuka u msgq wxlh 

fh§u o b;d jeo.;a h' fï i|yd Insert → Header and Footer iy Page Number 
weiqfrka f,aLkhg fyda  iÕrdjg .e<fmk wdldrhg YS¾Ilh iy mdolh o msgq 

wxlh o we;=<;a lr .kak'

6'4'5  ;Sre ^Column&
mqj;am;a iy iÕrd ks¾udKfha § nyq, f,i fhdod .kq ,nhs' ;Sre ilia 

lsÍu h;=re,shkh lsÍfuka miq j fyda h;=re,shkhg fmr fyda wjYH wdldrhg 

fhdod .; yels h' fï i|yd m<uq j Tn h;=re,shkh l< fþo f;dard .kak'

Microsoft Word  i`oyd '''''''

YS¾Il yd mdol fuj,u

Microsoft Word  i|yd'''

PageLayout→ Columns→ f,aLkhg 

iß,k f,i ;Sre m%udK f;dard .kak' 

LibreOffice Writer  i|yd'''

Formatting → Columns→ f,aLkhg 

iß,k f,i ;Sre m%udK f;dard .kak' 

LibreOffice Writerys Ñ;%lh ilia lsÍug fhdod .kakd fuj,ï ;Srej 
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  l%shdldrlu

1' Tn Ndú; lrk joka ieliqï uDÿldx.h újD; lr .kak' my; 

   § we;s l%shdldrlï lrkak' 

2' kj msgqjla újD; lr .kak' l%shdldrlu rEmh 7 ys olajd we;s  

  fþo f,aLk .; lrkak' bka miq tys olaajd we;s wdldrhg  

   ks¾udKh lrkak' bka miq tu f,aLkh Assign 10 kñka Word  
     Pass kï uqr moh  (Password) fhdÞ Tnf.a f*da,vrfha ;ekam;a  

   lrkak' f,aLkh jid oukak'

Electronic waste (E - waste): what is it 
and how do we get rid of it ?
This term applies to consumer and 

business electronic equipment that is near or 
at the end of its useful life There is no clear 
definition for electronic waste (e - waste) at 
this time, but if you can plug it in an electrical

outlet or it contains circuit boards or 
chips, it is most likely e - waste. These 
products can contain heavy metals like 
cadmium, lead, copper, and chromium 
that can contaminate the environment Do 
NOT dispose of these items in the trash or 
your recycling bins.

Examples of electronic waste include, but not limited to :
 � TVs, computer monitors, Printers, Scanners, Keyboards, mice, cables, circuit boards, 

lamps, clocks, flashlight, calculators, phones, answering machines, digital / video 
cameras, radios, VCRs, DVD players, MP3 and CD players.

 � Kitchen equipment (toasters, coffee makers, microwave evens)
 � Laboratory equipment (hot plates, microscopes, calorimeters)
 � Broken computer monitors, television tubes (CRTs)

Student E - waste Recycling Options

Any laboratory equipment that has the 
possibility of being contaminated with 
chemical, biological, or radioactive 
substances must be cleared through EH&S 
and Departmental Facilities Office before 
disposal. 

If you live on - campus you can dispose of 
your electronic waste easity and conveniently 
by creating a Fix It Ticket or contacting your 
college maintenance office.
If you live off - campus, learn more about the 
Sants Cruz County electronic waste disposal 
program:

Additional information on disposal / recycling of e - waste and other 
regulated items can be found in all college mailrooms, Graduate 
Student Housing Mailroom and the Village Laundry Community room. 
Multibins are blue cabinets built to collect batteries, small electronics, 
printer cartideges, and CDs. They are located in every college mailroom.

l%shdldrlu rEmh 7 
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6'4'6  j.= ^Tables&  

 f,aLk ilia lsÍfï § iuyr f;dr;=re j.= .; lsÍug isÿ fõ' ta i|yd 

l%uj;a f,i j.=jla ilia lr .; hq;= h' Tng wjYH myiqlï joka ieliqï 

uDÿldx. u.ska imhd § we;' rEmh 6'12   tkï"

•  j.=jg wjYH fma<ss ^Row& iy ;Sre ^Columns& we;=< ;a lr .ekSu fyda we|            

     .ekSu

•  wkjYH fma<s iy ;Sre uld oeóu ^Delete Row$ Column&
•  wu;r fma<ss iy ;Sre we;=<;a lsÍu ^Insert Row$ Column&
•  j.=fjys  fldaI mrdihla  ixhqla; fldg tla fldaIhla ,nd .ekSu ^Merge       

 Cell&
•  j.=fjys tla fldaIhla" fldaI lsysmhla njg m;a lsÍu ^Split Cell&
•  j.=jg mdg fh§u fyda ú,dihla ,nd §u 

•  jpk ÈYdk;sh fjkia lsÍu ^Changing Text Direction&
jeks fndfyda myiqlï olakg we;' 

Merge 
Cells

rEmh 6'12 - j.=j

Time Monday     Tuesday  Wednesday Thursday  Friday
                 TIME TABLE

A
B

C

Split 
Cells

Interval

Text Direction

X
ZY

²   j.=j ks¾udKh lr .ekSu i|yd  

  Microsoft Word  i|yd'''

• Insert→Table  fhdod .kak'

•  wjYH m%udKhg fma<s iy ;Sre f;dard 

.kak'       fyda

 Insert →Table ys wjYH m%udKhg 

fma<s iy ;Sre we;=<;a lrkak'

• OK la,sla lrkak'

LibreOffice Writer  i|yd'''

• Table →Insert→Table fhdod .kak'

• Insert →Table ys wjYH m%udKhg fma<s 

iy ;Sre we;=<;a lrkak

• Insert la,sla lrkak'
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²   j.=j ilia lsÍug m%:ufhka j.=j$ fma<s$ ;Sre $ fldgq f;dard .kak' 

²   j.=j ;=< fldgq w;r  tyd fuyd .uka lsÍu i|yd h;=re mqjrefjys B;," Tab
     h;=r fyda ujqia la,sla fhdod .kak'

ks¾udKh lr .;a j.=j ilia lr .ekSu i|yd'''''

Microsoft Word kï'''

 

j.=jla ks¾udKh lsÍfuka wk;=re j th f;dard .;a úg j.= fuj,u ßnkh l%shd;aul fõ' Tn 

úiska f;dard .kakd ,o j.=j$ fma<ss$ ;Sre$ fldgq i|yd wjYH ilia lsÍï i|yd fuys we;s Design 
iy Layout ßnk f;dard .; yels h'

Wod ( ixhqla; lsÍug"

1'  ixhqla; lsÍug n,dfmdfrd;a;= jk fma<ss$ ;Sre$ fldgq f;dard .kak'

2'  Table Tools ys Layout ßnkh u; la,sla lrkak' tys we;s Merge Cells u;            

 la,sla lrkak'

j.= fuj,ï

LibreOffice i`oyd'''

j.=jla ks¾udKh lsÍfuka wk;=rej th f;dard .kak' fukq ;Srefõ Table má;a; la,sla 

lrkak'

tys we;s Delete, Select, Insert, Split, Merge fuj,ï j.=j ilia lsÍu i|yd fhdod .kak'

tfia u Table → Table Properties → Table Format ixjdo fldgqj o  Ndú; lrñka j.=j ilia 

lr .kak'
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1' kj msgqjla ,nd .kak' l%shdldrlu rEmh 8 ys olajd we;s wdldrhg 

  j.=jla ks¾udKh lrkak' 

2' bka miq tu f,aLkh "Assign 11" kñka f*da,avrfha iqrlskak'

   l%shdldrlu

l%shdldrlu rEmh 8

 6'5     fidaÿm;a ne,Su (Proof reading)

6'5'1  wlaIr úkHdih iy jHdlrK fodaI fiùu iy ksjerÈ lsÍu
 

 iajhxl%Sh j wlaIr úkHdih iy jHdlrK fodaI fidhd §u;a" ta fjkqjg 

Ndú; l< yels ksjerÈ jpk yd wdldr fmkajd §u;a fuu.ska isÿ fõ' wlaIr 

úkHdi fodaI iys; jpk r;= mdáka bß we| fmkajhs' jHdlrK fodaI fld< mdáka 

bß we| fmkajhs' h;=re,shkh lr wjika f,aLkhl fujeks fodaI ksjerÈ lr 

.ekSug kï"

mshjr 1 f,aLkfha wdrïNhg l¾irh ^Cursor& f.k hkak'

Microsoft Word  i`oyd'''''

• Review → Spelling and Grammar 
fhdod .kak' 

LibreOffice Writer  i`oyd'''''' 

• Tools → Spelling and Grammar 
fhdod .kak'
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mshjr 2 r;= meyefhka fyda fld< meyefhka we;s jerÈ jpkhg wod< ksjerÈ 

jpkh fyda fhÿu my< fldgqfjka f;dard  Change la,sla lrkak' 

bx.%Sis YíofldaIfha fkdue;s jpk úúO kï ̂ mqoa., kdu" .%du kdu" 

rgj, kï& w;ayer oeóu i|yd Ignore la,sla lrkak'

6'5'2  Yío ksêh  ^Thesaurus&

 ,sms f,aLk ilia lsÍfï § wm fhdod .kakd jpk fjkqjg tu woyi f.k 

fok fjk;a jpk fidhd .ekSug;a tajd wjYH ia:dkhg fhdod .ekSug;a Yío 

ksêh ^Thesaurus) m%fhdackj;a fõ' fï i|yd" 

²  h;=re,shkh lr .;a jpkh f;dard .kak'

 

6'5'3  jpk fiùu iy fjk;a jpk ta fjkqjg m%;sia:dmkh lsÍu
  (Find and Replace)

 

 Tn úiska ilia lrk ,o f,aLkhl wvx.= jpkhla bj;a lr .ekSug isÿ 

ù we;ehs is;kak' Tnf.a f,aLkh msgq .Kkdjlska hq;= jQjls' jpkh fidhd .ekSu 

t;rï myiq lghq;a;la fkdfõ' fï i|yd fiùfï ^Find& myiqlu Tng Ndú; 

lsÍug yels h' fï i|yd

•  l¾irh f,aLkfha uq,g .kak'

Microsoft Word  i|yd'''''''''

Review  → Thesaurus fhdod .kak'

LibreOffice Writer  i|yd''''

• Tools → Language → Thesaurus 
fhdod .kak'

Microsoft Word  i|yd'''''''

• Home →Editing  ldKavfha Find la,sla lrkak'

 
 
•  by; oelafjk wdldrhg újD; jk fuj,ï ;Srefõ Search Document  ia:dkfha 

fiùug wjYH jpkh h;=re,shkh lrkak' 

 
LibreOffice Writer  i|yd'''''''

Edit→ Find la,sla lrkak'

by; oelafjk wdldrhg újD; jk fuj,ï ;Srefõ Find ia:dkfha fiùug wjYH 

jpkh h;=re,shkh lrkak' Find Next la,sla lrkak'

 Find Next 
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•  f,aLkhl wvx.= jpkhla fjkqjg fjk;a jpkhla wdfoaY lsÍu i|yd jpk  

    m%;sia:dmkh lsÍu ^Replace& myiqlu Ndú; fõ' fï i|yd"

•  fiúh hq;= jpkh ,efnk ljq¿fjys Find What ia:dkfha fyda Search for 
     ia:dkfha h;=re,shkh lr Replace $ Replace All  la,sla lrkak' rEmh 6'22   

rEmh 6'21 - jpk fiùu yd jpk fjkqjg m%;sia:dmkh'

 

Tn úiska Ndú; lrkq ,nk joka ieliqï uDÿldx.h újD; lr.kak' 

my; § we;s l%shdldrlï lrkak'

1' l%shdldrlu rEmh 9ys olajd we;s fþoh h;=re,shkh lrkak' bka  

  miq tu f,aLkh ''Assign 12'' kñka f*da,avrfha iqrlskak'

l%shdldrlu rEmh 9

   l%shdldrlu

Microsoft Word  i|yd''''

• Home→Editing  ldKavfha Replace 
la,sla lrkak'

LibreOffice Writer  i|yd''''

• Edit fukqfõ Replace la,sla 

lrkak'
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 2' my; oelafjk f,i f,aLkfha we;s jpkj, wl=re fjkia lrkak'

• Businesses  -   Businasses
• computing  -  camputing
• network      -   natwork
• promises     -  prommises
• resource    -  resourses

3' bka miq wlaIr úkHdih iy jHdlrK fodaI fiùu iy ksjerÈ lsÍu ^Spelling 
    and Grammar& fhdod f.k tu ksjerÈ lsÍu lrkak'

4' jpk fiùu ^Find& myiqlu Ndú; lr my; § we;s jpk fidhkak'

   webmail, information, storage
5' jpk m%;sia:dmkh lsÍu ^Replace& myiqlu Ndú; lr my; § we;s jpk 

m%;sia:dmkh lrkak'

• Business - trade
• Expensive - luxurious
• Connection - relation

6' jpk m%;sia:dmkh lsÍfuka ^Replace& wk;=re j ''Assign 13'' kñka Tnf.a 

f*da,avrfha ;ekam;a lrkak'

 6'6     uqøKh lssÍu (Print)

6'6'1  uqøK fmr oiqk ^Print Preview&

 ilia lr ksu lr .;a f,aLkh uqøKh lsÍug fmr th wmg wjYH f,i 

ilia ù ;sfí o" udhsï bv m%udKj;a o" fhdok ,o fndavrh uqøKh fõ o" wdÈ 

lreKq /ilg úi÷ï ,nd .ekSug uqøK fmr oiqk m%fhdackj;a fõ'

6'6'2  uqøKh lsÍu ^Print&

ksjerÈ j ilia jQ f,aLkh uqøKh lsÍu i|yd fuu fuj,u fhdod .efka' 

fï i|yd"

File → Print f;dard .ekSfuka uqøKh lsÍu ixjdo fldgqj ,efí' 
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Microsoft Office Print rEmh 6'23  iy  6'24   LibreOffice Print
                                         

                

Tn fhdod .kakd joka ieliSfï uDÿldx.hg wkqj újD; jk ixjdo fldgqj 

wdY%fhka"

•  f,aLkh uqøKh i|yd uqølh f;dard .ekSu ^Printer&"
•  uqøKh lrKq ,nkafka f;dard .;a tla msgqjla o" msgq lsysmhla o" iïmQ¾K      

 f,aLkh u o hkak ;SrKh lsÍu ^Current Page" Pages or All&
•  ,nd .kakd msgm;a m%udKh ;SrKh lsÍu ^Copies&
     wd§ myiqlï m%fhdackhg .ksñka f,aLkh uqøKh lr .; yels h'

ie'hq'  word ke;s flfkl=g Tnf.a f,aLkh ''pdf '' f,aLk È.=jg wkqj 

iq/lSfuka th uqøKh jk wdldrh Tng ksÍlaIKh lr .; yels h'  fï i|yd'''

File →  print  →  Microsoft XPS Document fyda Writer Adobe PDF → Print → 
f.dkqjg kula ,nd fokak' →Save 

rEmh 6'22 Microsoft Office Print
rEmh 6'23 LibreOffice Print

Tn ilia lrk ,o f,aLkhla hy¨fjl=g e mail l, hq;= hehs 

is;kak' kuq;a Tnf.a hy¨jdg joka ieliSfï uDÿldx.hla Tyqf.a 

mß.Klfha fkdue;skï by; .eg¨jg .; yels úi÷ï 02la fokak'

   l%shdldrlu   l%shdldrlu
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 6'7     ;eme,a uqiqj (Mail Merge)

ks¾udKh lrk ,o wdrdOkd m;la" iqN me;=ï m;la" ,smshla fyda iy;sl 

m;la lsysm fofkl=g ,eîu i|yd ilia lsÍug ;eme,a uqiqj Ndú; lrkq ,nhs' 

fuu l%shdj,sfha § o;a; iuqodh uDÿldx.h wdY%s; j ;ekam;a lrk ,o o;a; fyda 

Tn úiska ;eme,a uqiqj Ndú; lr ks¾udKh lr ;ekam;a lrk ,o o;a; Wmfhda. 

lr .; yels h' tmuKla fkdj f,an,a iy ;eme,a m;a i|yd ,smsk ks¾udKh lr 

uqøKh lsÍug o yels h'

fuu mdvñka Tng" 

• o;a; m%Njh$ ,smsk ,ehsia;=j ^ Data Source $Address List& ks¾udKh lrk 

wdldrh iy th ;ekam;a lrk wdldrh" 

• o;a; m%Njh wdY%s; kj ,sms" f,an,a iy ;eme,a m;a ks¾udKh lr .kakd 

wdldrh"

• uqøKhg fmr ixialrKh l< yels f,aLk ilia lsÍu" ms<sn| j oekqïj;a 

úh yels h'

;eme,a uqiqj Ndú; lrk wdldrh"

• uq,ska u Tfí f,aLkh h;=re,shkh lrkak'

o;a; m%Njh

(Data Soure)
m%Odk ,smsh

(Master Document)

,smsf,aLk"  ,smsk f,an, 

Letters        Address Label 

....... ....... .......

....... ....... .......
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Microsoft Word i|yd''''''''''

•  mshjr 1' Mailing má;a; f;darkak'

•  mshjr 2' Start Mail Merge → Letter f;darkak'

   o;a; m%Njh (Data Source) ks¾udKh lsÍu fyda f;dard .ekSu i|yd''''

•  mshjr 3' Select Recipient →Type New List f;darkak'

 *ie'hq'  fmr iqrlsk lrk ,o o;a; ,nd .ekSug kï Use Existing list f;darkak'

•  mshjr 4' New address List ljq¿fõ we;s lafIa;% Customize la,sla lsÍu   

  u.ska f,aLkhg .e<fmk wdldrhg fjkia lrkak' tkï" 

 a.   Add ^kj lafIa;%hla i|yd& 

 b'  Delete ^lafIa;%h uldoeóu i|yd&

 c'  Rename ^lafIa;%fhys ku fjkia lsÍu i|yd& Wmfhda. lr .kak'

•  mshjr 5' fjkialï lr OK la,sla lrkak'

•  mshjr 6' wjYH f;dr;=re h;=re,shkh lrkak' fï i|yd"  

 a.  New Entry ^kj ,smskhla i|yd&

 b'  Delete Entry ^,smskhla uld oeóu i|yd&

 c'  Find ^;ekam;a lr we;s ,smskhla fiùu i|yd& Wmfhda. lr .kak'

•  mshjr 7' fjkialï lr OK la,sla lr ;ekam;a lrkak'

•    ,smskh ilia úh hq;= wdldrh ;SrKh lsÍu ^Address Block&' fuh"

 a.  úúO ,smsk ieliqï ^More&
 b'  tu ieliqï Tfí ,smsk yd iei£u ^Match Field& i|yd fhdod .; 

     yels h'

•  mshjr 8' iqÿiq mßÈ fjkialï lr Next fyda OK la,sla lrkak'

•  mshjr 9' iqN me;=ï fma<ssh ^Greeting Line& tla lsÍu i|yd fuu fuj,u fhdod   

                .kak'

•  mshjr 10' iqÿiq mßÈ fjkialï lr Next fyda OK la,sla lrkak'

  ;eme,a uqiq lafIa;% tl;= lsÍu ^Insert Merge Field&'
   fuu.ska Tfí ,smshg wu;r lafIa;% fhdod .ekSug yelshdjla    

  ,efnkq  we;' fï i|yd"

  l¾irh lafIa;%h wjYH ia:dkfha ;nkak" bka miq" 

•  mshjr 11' Insert Merge field la,sla lrñka wjYH lafIa;% ,smshg we;=¿ lr   

  .kak'

  fjka fjka jYfhka ,sms ,nd .ekSu i|yd 

•  mshjr 12' Finish & Merge Edit Individual Documents f;dard .kak'

•  mshjr 13' ilia lr .;a ,sms iqÿiq f,i iq/lSu fyda uqøKh lr .kak'
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LibreOffice Writer i|yd'''''''''

•  mshjr 1' Tool → Mailing Wizard f;darkak'

•  mshjr 2' Select Starting document → Use the current document → Next f;darkak'

•  mshjr 3' Select the document type → Letter → Next ,smsk ,ehsia;=j ̂ Address List&  
               ks¾udKh lsÍu fyda f;dard .ekSu i|yd

•  mshjr 4' Insert Address Block →Select Address List → Create f;darkak'  

    *ie'hq'  fmr ;ekam;a lrk ,o o;a; ,nd .ekSug kï Add f;darkak'

•  mshjr 5' New address List ljq¿fõ we;s lafIa;% Customize la,sla lsÍu u.ska  

  f,aLkh .e<fmk wdldrhg fjkia lrkak' tkï" 

 a.   Add ^kj lafIa;%hla i|yd& 

 b.  Delete ^lafIa;%h uld oeóu i|yd&

 c'  Rename ^lafIa;%fhys ku fjkia lsÍu i|yd& Wmfhda. lr .kak'

•  mshjr 6' fjkialï lr OK la,sla lrkak'

•  mshjr 7' wjYH f;dr;=re h;=re,shkh lrkak' fï i|yd"  

 a.  New ^kj ,smskhla i|yd&

 b'  Delete ^,smskhla uld oeóu i|yd&   

 c'  Find ^;ekam;a lr we;s ,smskhla fiùu i|yd& Wmfhda. lr.kak'

•  mshjr 8' fjkialï lr OK la,sla lr iqÿiq ia:dkhl iqÿiq kula fhdod ;ekam;a  

  lrkak'

•  mshjr 9' kej;;a OK la,sla lrkak'

•  mshjr 10' Insert address block ljq¿fjys we;s 2" 3" 4"  mshjrj, ms<sfj<sska

  wkq.ukh lrkak'

 a.  ,smskh ilia úh hq;= wdldrh ;SrKh lsÍu ^Address Block&' fuh 

 b'  úúO ,smsk ieliqï ^More&
 c'  tu ieliqï Tfí ,smsk yd iei£u ̂  Match Field& i|yd fhdod .; yels  

 h'

•  mshjr 11' iqÿiq mßÈ fjkialï lr Next  la,sla lrkak'

•  mshjr 12' iqN me;=ï ^Create a Salutation& tla lsÍu i|yd fuu ljq¿j fhdod   

  .kak' iqÿiq mßÈ fjkialï lrkak'

•  mshjr 13' Next la,sla lrkak'

•  mshjr 14' Tnf.a ,smskh ia:dk .; lr .ekSu i|yd ^Adjust layout of address     
  block and salutation& ljq¿j fhdod .kak' Next la,sla lrkak'

•  mshjr 15' ,sms ,nkakka f;dard .ekSu iy f,aLkfha fmr oel=u ,nd .ekSu'  

  ^Preview and edit the document& ljq¿fjka isÿ lr .; yels h'

•  mshjr 16' Personalize document ljq¿j u.ska ,smskhka fidhd .ekSu iy tla   

  f,aLkhla ilia lr .ekSu l< yels h'

•  mshjr 17' Return to Mail Merge Wizard la,sla lrñka kej; Mail Merge fukqj   

  yd iïnkaO jkak' Next la,sla lrñka bÈßhg hkak'

•  mshjr 18' Save, Print or send document ljq¿j úúOdldr ;ekam;a lsÍï i|yd iy  

  uqøKh lsÍu i|yd fhdod .kak'

 a.   Save starting document - uQ,sl ,smsh ;ekam;a lsÍu'

 b'   Save merged document - ;ekam;a lsÍu ;eme,a uqiq lr .kakd ,o 

       ,smsh'

 c'  Print merged document - ;eme,a uqiq lr.kakd ,o ,smsh uqøKh lsÍu'

 d'   Send merged document as E-Mail - ;eme,a uqiq lr .kakd ,o ,smsh  

       b-;eme,a lsÍu'
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Tn úiska Ndú; lrkq ,nk joka ieliqï uDÿldx.h újD; lr 

.kak' my; § we;s l%shdldrlï lrkak'

1' l%shdldrlu(  rEmh 10ys olajd we;s ,smsh h;=re,shkh lrkak' 

tfy;a ''<>"  w;r we;s jpk fuka u tu i,l=Kq o h;=re,shkh 

fkdl< hq;= h' ta i|yd tla bvla muKla fjka lr ;nkak' bka miq 

tu f,aLkh ''Assign 10'' kñka f*da,avrfha ;ekam;a lrkak'

Computer Resource Centre
Senkadagala
28. 04.2014

‹Title› ‹First Name› ‹Last Name›
‹Address Line 1›
‹Address Line 2›

Teacher Parent Interact day

Please take this opportunity to discuss the progress of your child 
‹child’s Name› by meeting the class teacher on ‹Date› at ‹Time› 
at the classroom.

Principal

 

2'  ;eme,a uqiqj Ndú; lrkak' o;a; m%Njh$ ,smsk ,ehsia;=j ^Data Source / 
Address List& i|yd my; j.=fjys fmkajd we;s wdldrhg oi fokl=g heùu i|yd 

o;a; we;=<;a lrkak'

   l%shdldrlu rEmh 10

Title First Name

Chaminda Sampath
Chandrabose

Pelawaththa Battaramulla
Colombo

Yawaha 26.06.2014
26.06.2014
26.06.2014

Derwin
SharmilaDehiwala

Mattakkuliya
Hill StreetAmith

9.00 am
9.30 am
10.00 am

Pushparani
Mohamed

Child-
NameLast Name Address 1 Address 2 Date Time

Mr.

Mr.
Mrs.

  l%shdldrlu
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6'7'1  fláux h;=re ^Shortcut Keys&

 mß.Klh wdY%s; j lrkq ,nk ld¾hhka fõ.j;a j lsÍu i|yd fláux 

h;=re Ndú; lrkq ,nhs' tfia Ndú; jk fláux h;=re lsysmhla iy l%shdldß;aj 

my;ska olajd we;' l%shdldrlï i|yd fïjd Wmfhda. lr .ksñka ld,h b;sß 

lr.; yel'

            fláux h;=r               l%shdldß;ajh

                     Ctrl + N kj f,aLkhla ,nd .ekSug

                     Ctrl + S f,aLkhg kula fhdod iq/l=ï lsÍug

                     Ctrl + O f,aLkh újD; lsÍug

                     Ctrl + A f,aLkh f;aÍug

                     Ctrl + C wl=re$ jia;= msgm;a lsÍug

                     Ctrl + X wl=re$ jia;= lemSug

                     Ctrl + V wl=re$ jia;= we,ùug

                     Ctrl + H jpk m%;sia:dmkh lsÍug

                 Ctrl + HOME l¾irh f,aLkfha uq,g .ekSug

                   Ctrl + END l¾irh f,aLkfha wjidkhg .ekSug

1' Tn úiska Ndú; lrkq ,nk joka ieliqï uDÿldx.h újD; lr     

   .kak' my; § we;s f,aLk ilia lsÍug W;aidy lrkak'

²   iy;sl m;a

²   wdrdOkd m;a

²   b,a¨ï m;a

²   ,sms

²   ksfõok

²   nekrhla

2' Tn úiska ilia lrk ,o f,aLkh iq/l=ï lrkak' tys uqøK msgm;la ,nd 

.kak'

3' joka ieliqï uDÿldx. j, we;s jvd;a u jeäfhka Ndú; jk myiqlï ,ehsia;= 

.; lrkak'

   l%shdldrlu

   .kak' my; § we;s f,aLk ilia lsÍug W;aidy lrkak'
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6'1 joka ieliSu hkq ,smsf,aLk ilia lr .ekSuhs' 

ta i|yd joka ieliqï uDÿldx.hla Ndú; lsÍfï ,smsf,aLk úÑ;%j;a f,i yevijd 

.ekSug;a ;ekam;a lr ;nd .ekSug;a wjYH jQ úg kej; ,nd .ekSug iy       

uqøKh lr .ekSug;A mq¿jk'

 # joka ieliSfï uDÿldx. j¾. fndfyda we;' bka iuyr uDÿldx. ñ, § .; 

hq;= jqj;a wkA;¾cd,fhka fkdñf,A nd.; ^download& lr mß.Klhg     

m%;sia:dmkh lr .; yels joka ieliqï uDÿldx. we;' 

  

6'2 kj f,aLkhla ilia lsÍfï § jeo.;a lreKq" 

² kj f,aLkhla ,nd .ekSu

² ;ekam;a lsÍfï l%u f,aLkh jid ±óu

² .nvd l< f.dkqjla kej; újD; lsÍu 

6'3 f,aLkhla ks¾udKh lsÍfï § ie,ls,su;a úh hq;= lreKq" 

² f,aLkhla ilia lsÍu - msgq ieliqu

² f;aÍfï l%u

² yeviùï - wl=re yeviùu" fþo yeviùu" nq,Ü iy wxlk fhdod .ekSu" 

w÷re lsÍu iy fndav¾ fhdod .ekSu

6'4 f,aLkh úÑ;%j;a lsÍu i`oyd fhdod .; yels wx. iy Ñ;%l"

² yev;, iy Ñ;%l ks¾udKh lsÍu iy fjkia lsÍu

² i,l=Kq fhdod .ekSu

² YS¾Ilh iy mdolh" msgq wxl fh§u 

² ;Sre fjka lsÍu

² j.= ks¾udKh lsÍu iy fjkia lsÍu

6'5 fidaÿm;a ne,Su u.ska ,nd .; yels jdis iy uqøKh lsÍu"

² wlaIr úkHdih iy jHdlrK fodaI fiùu iy ksjerÈ lsÍu

² Yío ksêh Ndú; lsÍu

² jpk fiùu iy fjk;a jpk ta fjkqjg m%;sia:dmkh lsÍu  

6'6 ;eme,a uqiqj"

;eme,a uqiqj Ndú; lsÍfuka m%Odk f,aLkhla fhdod .ksñka ,sms ks¾udKh lr 

.; yels h' ta i`oyd o;a; m%Njh ks¾udKh lsÍu" ;eme,a uqiq lafIa;% tl;= lsÍu 

f,aaLk uqøKh ioyd fhduq lsrSu l< yels h'

idrdxYh
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7 úoHq;a me;=reïm;a

  
fuu mdvu yeoEÍfuka Tng

² me;=reïm;aj, uQ,sl myiqlï iy l%shdldß;ajh

² jevm;l ixrpl y÷kd .ekSu

² jevm;lg o;a; we;=<;a lsÍu yd ixialrKh lsÍu

² ir, .Kkh lsÍï i|yd fufyhjk iy w.hhka weiqßka iQ;% f.dv 

ke.Su

² iQ;% ,sùug fldaI ,smsk iy Y%s; Ndú;h

² jevm;la yeviõ lsÍu

² idfmalaI iy ksrfmalaI fldaI ,smsk Ndú;h  

² m%ia;dr ks¾udKh  

 ms<sn| ukd wjfndaOhla ,nd .ekSug yels jkq we;'

 7'1      úoHq;a me;=reïm;a

mqoa.,hkag tÈfkod lghq;=j, § fuka u jD;a;Shuh wjYH;d wkqj o úúO 

jQ .Kkh lsÍï lsÍug isÿ fõ' fuu .Kkh lsÍï i|yd úúO l%ufõo ñksid úiska 

Ndú; flf¾' .Kkh l< hq;= .eg¨fõ iajNdjh wkqj ir, .Kkh lsÍï ukiska 

yd w;e`.s,s Ndú;fhka o ixls¾K .Kkh lsÍï ,sÅ; j fyda .Kl hka;% u.ska o 

isÿ flf¾' fuu ld¾hh b;d u ksjerÈ j myiqfjka isÿ lsÍu ioyd  úoHq;a me;=reï 

m;a fhdod .kakd wdldrh .ek wOHhkh lruq'

l%uj;a j" ,sÅ; j .Kka iE§u ioyd fldgqrE,a fmd;a Ndú; lsÍu wfma 

idïm%odhsl l%uhhs' fuu fmdf;a iEu msgqjla u ;sria fma<s yd isria ;Srej,ska 

iukaú; h' fuu uQ,sl wdlD;sh mokï lr .ksñka fma<s yd ;Sre úYd, m%udKhlska 

iukaú; úoHq;a me;=reï m;a ks¾udKh lr we;'

yd w;e`.s,s Ndú;fhka o ixls¾K .Kkh lsÍï ,sÅ; j fyda .Kl hka;% u.ska o 

isÿ flf¾' fuu ld¾hh b;d u ksjerÈ j myiqfjka isÿ lsÍu ioyd  úoHq;a me;=reï 

l%uj;a j" ,sÅ; j .Kka iE§u ioyd fldgqrE,a fmd;a Ndú; lsÍu wfma 

idïm%odhsl l%uhhs' fuu fmdf;a iEu msgqjla u ;sria fma<s yd isria ;Srej,ska 

iukaú; h' fuu uQ,sl wdlD;sh mokï lr .ksñka fma<s yd ;Sre úYd, m%udKhlska 
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úoHq;a me;=reïm;a (Electronic Spreadsheets) Ndú;fhka my; oelafjk 

ld¾hhka ld¾hlaIuj;a ksjerÈj;a b;d myiqfjka isÿ lr .; yels h'

• ir, fuka u ixlS¾K .Kkh lsÍï

•   m%ia;dr u.ska o;a; ksrEmKh 

• o;a; wkqms<sfj<lska oelaùu

•   wjYH o;a; muKla fjkalr .ekSu

•   o;a;j, j,x.=;dj mÍlaId lsÍu

•   uqrmo fhdod o;a;j, wdrlaIdj ie,iSu

• miq Ndú;h i|yd iq/lSu

7'1'1  úoHq;a me;=reïm;a uDÿldx. 

úúO uDÿldx. ksIamdok iud.ï u.sska ksmojd we;s úoHq;a me;=reïm;a 

uDÿldx. lsysmhla j.=j 7'1 u.ska oelafõ' 
  

      j.=j 7'1 - úúO me;=reïm;a uDÿldx. yd tAjdfha ksIamdok iud.ï

              uDÿldx.h               ksIamdok iud.u

                    Excel           Microsoft Corporation
                    Numbers           Apple Inc
                    Libreoffice Calc           The Document Foundation
                    Openoffice Calc           Apache Foundation

    

7'1'2  me;=reïm;a uDÿldx. l%shd;aul lsÍu

me;=reïm;a uDÿldx. w;ßka Microsoft Office Excel 2010 iy LibreOffice 
Calc hk uDÿldx. ms<sn| j muKla fuu tallfha § idlÉPd flf¾' uDÿldx.h 

wdrïN lrk wdldrh fufyhqï moaO;sh wkqj fjkia úh yelsh' 

 Microsoft Office ksIamdok n,m;% iys; j ñ, § .; hq;= jk w;r 

LibreOffice ksIamdok ksoyia n,m;% iys; j Ndú; l< yels fõ'

Microsoft Office Excel 2010 i`oyd'''

Start → Programs→MicrosoftOffice 
→ Microsoft Office Excel 2010

LibreOffice Clac i`oyd'''

Start → Programs → Libre Office → 
Libre Office Clac 
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7'1'3  Microsoft Excel 2010ys w;=re uqyqK; yd tys ixrpl

              

      

            rEmh 7'1 - Microsoft 2010ys w;=re uqyqK;

                                 

   j.=j 7'2 - Microsoft Excel 2010ys ixrpl 

            ixrplh                   úia;r

1'  blauka m%fõY fuj,ï ;Srej Save, Print Preview, Undo, New  jeks ks;r 

u wjYH jk úOdk ,nd fohs'

2'  ud;Dld ;Srej fhÿï uDÿldx.fha kduh o¾Ykh lrhs'

3'  ßnkh Home, Insert, Page Layout  jeks má;s 

hgf;a fuj,ï  ,nd fohs'

4'  Woõj Wojq ,nd .ekSug Wmldß fõ'

5'  md,k fnd;a;ï jevfmd;a ljq¿j úYd, lsÍu" l=vd lsÍu yd 

jeiSu isÿ lrhs'

6'  Y%s; wdodkh iQ;% f.dvke.Su i|yd ixjdo ljq¿j ,nd 

fohs'

7'  má;s ßnkh udre lsÍu isÿ lrhs'

8'  iQ;% ;Srej iQ;% o¾Ykh lsÍu iy fldaIhl wka;¾.;h 

o¾Ykh lsÍu isÿ lrhs'

10' kdu fldgqj

    Name Box

6' Y%s; wdÞkh 

Insert Function  

 7' má;s 
Tabs

8' iQ;% ;Srej 

Formula Bar 9' ;Sre YS¾Il 

Column Headings

1' blauka m%fõY fuj,ï 

;Srej Quick Access Tool Bar
2'ud;Dld ;Srej

   Title Bar
  3' ßnkh

     Ribbon 4' Woõj

  Help

 5' md,k fnd;a;ï

    Control buttons

12' il%Sh fldaIh 

     Active Cell 

13' fma<s YS¾Il 

Row Headings

14' j evm;a      

  má;s 
Sheet Tab

11' isria wkqp,k ;Srej

     Vertical Scroll Bar

15' ;ssria wkqp,k ;Srej

  Horizontal Scroll Bar

19' iQuh md,kh

Zoom Control
18' oel=ï fnd;a;ï 
View Buttons

17' ;;a;aj ;Srej 
Status Bar

16' má;s 

fmr<SSfï 

fnd;a;ï

Worksheet   
Navigation

10' kdu fldgqj          
Name Box
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9'  ;Sre YS¾Il ;Sre wlaIrh o¾Ykh lrhs'

10' kdu fldgqj l%shdldß fldaIfhys ,smskh o¾Ykh lrhs'

11' isria wkqp,k ;Srej jevm; isria j wkqp,k Wmldß fõ'

12' il%sh fldaIh o;a; wdodkh jk fldaIh o¾Ykh lrhs'

13' fma<s YS¾Il fma<s wxlh o¾Ykh lrhs'

14' jevm;a má;s jevm; ksfhdackh lrhs'

15' ;sria wkqp,k ;Srej jevm; wkqp,k fmr<Sug Wmldß fõ'

16' má;s wkqp,k fnd;a;ï jevm;a udre lsÍug Wmldß fjhs'

17' ;;a;aj ;Srej jevm; yd ine¢ ;;a;ajhka o¾Ykh lrhs'

18' oel=ï fnd;a;ï jevm;a o¾Ykh jk wdldr olajhs'

19' iQuh md,kh jevm; úYd, lr fyda l=vd lr fyda n,d 

.ekSug fhdod .efka'
          

7'1'4  LibreOffice Calc 4'1 ys w;=reuqyqK; yd tys ixrpl

3' iïu; fuj,ï ;Srej 
  Standard Tool Bar

 2' fukq ;Srej

   Menu Bar

1' ud;Dld ;Srej

   Title Bar
5' kdu 

fldgqj    

Name 
  Box

9' il%Sh fldaIh 

   Active Cell 

6' Y%s; wdÞkh   

  Insert         
Function 7' iQ;% ;Srej 

Formula Bar 11' isria wkqp,k ;Srej

Vertical Scroll Bar

13' ;ssria wkqp,k ;Srej

   Horizontal Scroll Bar

16' ;;aj ;Srej 
     Status Bar

15' má;s fmr<Sfï fnd;a;ï 
      Worksheet Navigation

12' fma<s YS¾Il 

   Row Heading 

17' iQuh  md,kh

    Zoom Control

4' md,k fnd;a;ï 
   Control Buttons

8' yeviõ fuj,ï ;Srej

     Formating Tool bar

14' jevm;a má;s

      Sheet Tab

10' ;Sre YS¾Il 

   Column Heading
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                ixrplh                  úia;rh

1'  ud;Dld ;Srej fhÿï uDÿldx.fha kduh o¾Ykh 

lrhs'

2'  fukq ;Srej úOdk f;dard .ekSug myiqlï i,ihs'

3'  iïu; fuj,ï  ;Srej iïu; fuj,ï f;dard .ekSug 

myiqlï i,ihs'

4'  md,k fnd;a;ï jevfmd;a ljq¿j úYd, lsÍu"l=vd 

lsÍu" jid oeóu isÿ lrhs'

5'  kdu fldgqj il%sh fldaIfhys ,smskh o¾Ykh lrhs'

6'  Y%s; wdodkh iQ;% f.dv ke.Su i|yd  ixjdo ljq¿j 

,nd fohs'

7'  iQ;% ;Srej iq;% o¾Ykh lsÍu iy fldaIhl 

wka;¾.;h o¾Ykh lsÍu'

8'  yeviõ fuj,ï ;Srej jevm; yeviõ lsÍug Wmldr fõ'

9'  il%sh fldaIh o;a; wdodkh jk fldaIh o¾Ykh 

lrhs'

10' ;Sre YS¾Il ;Sre wlaIrh o¾Ykh lrhs'

11' isria fmr<k ;Srej jevm; isria j fmr<Sug Wmldr fõ'

12' fma<s  YS¾Il fma<s wlaIrh o¾Ykh lrhs'

13' ;sria fmr<k ;Srej jevm; ;sria j fmr<Sug Wmldr fõ'

14' jevm;a má;s jevm; ksfhdackh lrhs'

15' má;s fmr<Sfï fnd;a;ï  jevm;a fmr<Sug Wmldr fjhs'

16' ;;a;aj ;Srej jevm;  yd ine¢ ;;a;aj o¾Ykh 

lrhs'

17' iQuh jevm; úYd, lr fyda l=vd lr fyda 

n,d .ekSug fhdod .efka'

7'1'5  jevm; (Worksheet)

 oaúudk ;,hl isria ;Sre (Columns) yd ;sria fma<s ^Rows& jYfhka msysá 

fldaI iuQyhlska jevm; (Worksheet) ks¾udKh ù we;' th jevm;a má;s (Sheet 
Tab)  u.ska olajkq ,nhs'

j.=j 7'3 - LibreOffice Calc 4'1 ys ixrpl
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7'1'6  jevm;l ;Sre kï lsÍu

jevm;l we;s ;Sre kï lr we;af;a my; oelafjk mßÈ bx.%Sis lemsg,a 

wlaIr fyda wlaIr ixfhdack fyda u.sks' rEmh 7-3 n,kak'

A,B,C,D,'''''''''''''''''''''''Z olajd o 

AA,AB,AC.AD,AE,.................AZ olajd o 

BA,BB,BC,BD,BF.................BZ olajd o     wdÈ jYfhks'

7'1'7  jevm;l fma<s kï lsÍu

jevm;l we;s fma<s kï lr we;af;a 1" 2" 3" 4" 5"''''''''wdÈ jYfhka wxl u.sks' 

rEmh 7-3 n,kak'

idudkHfhka jevm;l fma<s m%udKh iy ;Sre m%udKh 2ys n,hla jk 

w.hlska mj;S'

me;=reï m;a uDÿldx.h   fma<s m%udKh ;Sre m%udKh 

Microsoft Excel 2003     65536 ^216&   256 ^28&

Microsoft Excel 2007$2010   1048576 ^220&  16384 ^214&

LibreOffice Calc  4'1    1048576 ^220&  1024 ^210&

fma<s

Rows
  ;Sre

Column

rEmh 7'3 - jevm;l fma<sj, yd ;Srej, msysàu'
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7'1'8  il%sh fldaIh

jevfmf;ys o;a; wdodkhg m%:ufhka tu fldaIh f;dard .; hq;= h' tfia 

f;dard .;a fldaIhla il%sh fldaIh (Active Cell) f,i ye¢kafjhs' my; oelafjk 

wjia:dfõ §  B3 fldaIh il%sh j mj;shs' il%sh fldaIh iEu úg u ;o fndavrhlska 

o¾Ykh fõ' rEmh 7'4 n,kak'

 7'2      jevm; ;=< ießieÍu

jevm;lg o;a; we;=<;a lsÍfï § m%:ufhka o;a; we;=<;a l< hq;= fldaIh 

il%sh l< hq;= h'

my; oelafjk h;=r$h;=re ixfhdack l%shd;aul lsÍfuka jevm; ;=< msysá 

´kE u fldaIhla fj; .uka lr th il%sh l< yels h'

h;=r$h;=re ixfhdackh   m%;sM,h

Arrow keys    wod< ÈYdjg^jug" ol=Kg" by<g" my<g& tla fldaIhla 

     .uka lrhs'

Ctrl  + Arrow Keys   wod< ÈYdjg o;a; we;=<;a mrdifhys wka; fj; .uka 

     lrhs'

Home     il%sh fldaIh msysá fma<sh Tiafia A ;Srej fj; .uka lrhs'

Ctrl + Home    A1 fldaIh fj; .uka lrhs'

Ctrl + End   o;a; we;=<;a mrdifhys ol=Kq mi my< fldaIh fj;  .uka 

     lrhs'

Page Up    jevmf;ys tla ;srhla by<g .uka lrhs'

Page Down    jevmf;ys tla ;srhla my<g .uka lrhs' 

rEmh 7'4 - jevm;l il%sh fldaIh
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7'2'1  fldaI ,smskh 

m<uq j ;Srefõ wlaIrh;a fojkq j fma<sfha wxlh;a fhdod fldaIh kï 

flf¾' th fldaI ,smskh (Cell Address) f,i ye¢kafõ' il%sh fldaIfha ,smskh 

kdu fldgqj u; Èiafõ' ^rEmh 7'1 iy 7'2 n,kak'&

Wod(  D ;Srefõ 3 jk fma<sfha msysá fldaIh D3 f,i kï flf¾' rEmh 7'5 n,kak'

7'2'2  fldaI mrdih 

 jevmf;ys wkqhd; fldaI iuQyhla fldaI mrdih (Cell Range) f,i 

ye¢kafõ' my; oelafjk jevm;a i,lkak'

kdu fldgqj Name Box
il%sh fldaIh Active Cell 

rEmh 7'5 - jevm;l il%sh fldaIh
  l%shdldrlu

KD74 hk fldaI ,smskh msysá fma<sh '''''''''' jk w;r ;Srej ''''''''''' fõ'

rEmh 7'6 - jevm;l ;Srejla Tiafia we;s

fldaI mrdihla  

fuu fldaI mrdihg B2, B3, B4, 
B5 hk fldaI 4 we;=<;a fõ' mrdih B2 ka 

wdrïN lr B5ka wjika lr we;' 

 fuu fldaI mrdih B2:B5 uÕska 

ksrEmKh fõ' 

;Srejla Tiafia we;s fldaI mrdihl 

;Srefõ wlaIrh ksh; j mj;shs'

 fuu fldaI mrdihg A3, B3, 
C3 hk fldaI 3 we;=<;a fõ' rEmh 7'7 

n,kak'

 fuu fldaI mrdih A3:C3 
u.ska ksrEmKh fõ' 

 fma<shla Tiafia we;s fldaI 

mrdihl fma<s wxlh ksh; j mj;S' rEmh 7'7 - jevm;l fma<shla Tiafia we;s

fldaI mrdihla  
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 fuu fldaI mrdih B2:C4 u.ska ksrEmKh fõ' ^rEmh 7'8 n,kak'&

fma<s iy ;Sre Tiafia we;s fldaI mrdihl fma<s wxl;a" ;Sre wlaIr;a fjkia fõ' 

igyk( jevm;l fldaI mrdi lSmhla oelaùu i|yd md,k h;=r (Control Key) 
fhdod .ksñka i,l=Kq lrkq ,efí' h;=re mqjrefõ  md,k h;=r Ctrl uÕska olajd 

we;'

 fuu fldaI mrdihg B2, B3, B4, 
C2, C3, C4 hk fldaI 6 we;=<;a fõ' 

^rEmh 7'7 n,kak'&

rEmh 7'8 - jevm;l fma<s yd ;Sre Tiafia we;s

fldaI mrdihla  

  l%shdldrlu

rEmh 7'9 u.sska oelafjk jevm; weiqßka my; wid we;s m%Yakj,g 

ms<s;=re i|yka lrkak' 

^1&   R 1 u.sska oelafjk mrdifhys wdrïNl fldaIfhys ,smskh l=ula o@

^2&  R 1 u.sska oelafjk mrdifhys wjidk fldaIfhys ,smskh l=ula o@

^3&  R 1 u.sska oelafjk mrdih i|yka lrkak'

^4&  R 2 u.sska oelafjk mrdih i|yka lrkak'

^5&  fma<shla Tiafia msysá mrdih l=ula o@

^6&  ;Srejla Tiafia msysá mrdih l=ula o@

^7&  R 3 u.sska oelafjk mrdih i|yka lrkak'

^8&  R 3 u.sska oelafjk mrdihg wh;a fldaI .Kk i|yka lrkak'

R1
R2R3

rEmh 7'9 - jevm;l we;s fldaI mrdihla  
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7'2'3  o;a; we;=<;a lsÍu 

 me;=reïm;g o;a; we;=<;a lsÍug fmr wod< fldaIh il%sh l< hq;= h' bka 

miq o;a; we;=<;a l< hq;= h' fldaIhl wka;¾.;h jkafka f,an,a (Label)" w.hka 

(Value) fyda iQ;% (Formula) hk tajdhska tlls'

1'f,an, 

 h;=re,shkh lrk ,o wlaIr (Letters)" ixLHd (Numbers)" úfYaI ixfla; 
(Special Symbols) u.ska fyda tajd ixfhdackfhka fyda ,nd .kakd mdG (Text) 
f,an, f,i ye¢kafõ' idudkHfhka f,an, fldaIhl jï tfl,a, fõ (Left Align)' 

my; rEmh 7'10 u.sska jevm;l f,an, jï tfl,a, j mj;sk wdldrh oelafõ' 

igyk ( fuys ÿrl:k wxl we;=<;a lsÍfï § my; oelafjk wdldrfhka u 

fldaIj, o¾Ykh fkd fõ' ^ÿrl:k wxlfha uq,ska u we;s 0 o¾Ykh fkdfõ&' 

f,an, wdldrfhka mj;ajd .ekSug ÿrl:k wxl we;=<;a l< hq;= fldaI mrdih 

mdG(Text) f,i yeviõ l< hq;= h' fldaI yeviõ lrk wdldrh miq j idlÉPd 

flf¾'

      

2' w.hka 

 ixLHd;aul jákdlula iys; o;a; w.hka f,i i,lkq ,nhs' idudkHfhka 

w.hka fldaIhl ol=Kq tfl,a, fõ (Right Align)' w.hka f,i mj;sk o;a;  

wdldr lSmhla rEmh 7'11 u.ska oelafõ'

  rEmh 7'10 - jevm;l f,an, jï tfl,a, ùu'

:

rEmh 7'11 - jevm;l w.hka  ol=Kq tfl,a, ùu
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igyk (  Nd. ixLHdjla we;=<;a lsÍfï § mQ¾K ixLHdj ghsma lr ;ks wjldYhlg            

(Single Space) miq j Nd. fldgi ghsma lrkak'

3' iQ;%

 .Kkh lsÍu Wfoid iudk ̂ }& ,l=‚ka wdrïN lr w.hhka" fldaI ,smsk iy 

Y%s; fhdod .ksñka ,shkq ,nk m%ldYk iQ;% f,i ye¢kafjhs' jevmf;a fldaIhlg 

iQ;%hla we;=<;a l< úg tu.sska .Kkh jQ w.h fldaIh ;=< Èiajk w;r iQ;%h iQ;% 

;Srefõ Èiafõ'

WodyrK 1 -   A1 iy  B1 fldaIj, wka;¾.;j, tl;=j C1 fldaIh ;=<g ,nd 

.ekSu' ^rEmh 7'12 n,kak&

 
 

 fufyhjkh     w¾:h

  ¬  tl;= lsÍu

  -  wvq lsÍu

  *  .=K lsÍu

  /  fn§u

  ^  n,h

igyk ( fufyhjk l%shd;aul jk wkqms<sfj< jryka fhdod fjkia l< yels h' 

túg jryka iys; fldgi m%:ufhka iq¿ fõ'

iQ;%fhka .Kkh jQ w.h

iQ;% ;Srej

C1 fldaIhg we;=<;a l< iQ;%h

rEmh 7'12 - iQ;% o¾Ykh jk whqre

 7'3 iQ;% ,sùu i|yd Ndú; lrkq ,nk .‚;uh fufyhjk
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fufyhjk m%uqL;d wkqms<sfj< (Operator Precedence)
m%:u  ^ &

fojk  ^
f;jk  * " $
isõjk  ¬ " -        by, isg my,g wvq fõ'

7'3'1  w.hka iy fufyhjk Ndú;fhka ir, .Kkh lsÍï isÿlsÍu

w.hka iy fufyhjk fhdod ,shk ,o ir, iQ;% lsysmhla j.=j 7'4 u.sska oelafõ'
   

    j.=j 7'4 - ir, iQ;% ,sùu

      fufyhjkh            iQ;%h          m%;sM,h

tl;= lsÍu ^ ¬ &            = 2¬4              6

wvq lsÍu   ^ - &            = 5-2              3

.=K lsÍu  ^ * &            = 4*5             20

fn§u ^ $ &            = 12$6              2

n,h ^^&             = 2^4             16

          

iQ;%hla ;=< fufyhjk lsysmhla mej;sh yels h' tjeks iQ;% wkqms<sfj<sska 

iq¿ lrk wdldrh oek .ksuq' fï i|yd 7'5 iy 7'6 j.= n,kak'

      j.=j 7'5 - ir, iQ;%j, jryka Ndú;h

           iQ;%h     iq¿ lrk wdldrh          m%;sM,h

= 2¬4*3       = 2¬12 = 14
= ^2¬4&*3       = 6*3 = 18
= 4*3^2       = 4*9 = 36
= (4*3)^2       = 12^2 = 144

   

WodyrKh = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5
iq¿ lrk mshjr = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5

= 5¬2*9$6-3 = 5¬2*3^2$3 = 8/2*3-8¬5
= 5¬18$6-3 = 5¬2*9$3 = 4*3-8¬5
= 5¬3 - 3 = 5¬18$3 = 12-8¬5
= 8-3 = 5¬6 = 4¬5

ms<s;=r = 5 = 11 = 9

j.=j 7'6 - iQ;% iq¿ lrk mshjr
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igyk ( jryka Ndú; fkdjk úg iu uÜgfï mj;sk .=K lsÍu ^ * & yd fn§u 

^ $ & hk fufyhjk o " tl;= lsÍu ^ ¬ & yd wvq lsÍu ^ - &  hk fufyhjk o 

iQ;%fha jï mi isg ol=Kq mig msysgd we;s wkqms<sfj< wkqj iq¿ lrkq ,nhs'

7'3'2  fldaI ,smsk yd fufyhjk Ndú;fhka  iQ;% f.dv ke.Su
 

 fldaI ,smsk iy fufyhjk Ndú;fhka iQ;% ,sùfuka w;ajk m%Odk;u 

jdish jkafka iQ;%hg wod< fldaIj, wka;¾.;h fjkia jk úg tu iQ;%h uÕska 

.Kkh lrkq ,nk w.hka iajhxl%Sh j u hdj;ald,Sk ùuhs'

  WodyrK 1

RcqfldaKdi%hl mßñ;sh yd j¾.M,h fiùu i|yd tys È. yd m<, ms<sfj<sska 
A2 iy B2 fldaIj,g we;=<;a lruq' mßñ;sh fiùug  C2, C3, C4 fldaIj, iy 

j¾.M,h fiùug D2 fldaIfha wod< iQ;% olajd we;'  7'13 rEmh n,kak'

     rEmh 7'13 - iDcqfldaKdi%hl mßñ;sh yd j¾.M,h

  l%shdldrlu

    my; oelafjk iQ;% iq¿ lsÍfuka ,efnk  w.hhka fidhkak'  

  ^1& = 6-4$2 ^6& = 4¬5*2^3    ^11& = 5$2¬1^3*4
  ^2& = 5*4¬3 ^7& = 8$4*2    ^12& = 3-4*3$2
  ^3& = 3¬4*5 ^8& = -4$2¬2    ^13& = 6$3*2^1-3
  ^4& = 2^5¬3 ^9& = 1¬2^2*3    ^14& = 3*^2¬4&$9¬1
  ^5& = 3¬5^2 ^10& = 3*4$2    ^15& = 2^3$^5-1^3&*5

  l%shdldrlu

7'13 rEmfha oelafjk jevm; Tn Ndú; lrk me;=reïm;a uDÿldx.h 

weiqßka ks¾udKh lrf.k A2 iy B2 hk fldaIj, w.hka fjkia 

lrñka C iy  D ;Srej, i|yka iQ;%j,ska ,efnk m%;sM, ksÍlaIKh 

lrkak'
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b;d jeo.;a ( D2 fldaIhg wod< iQ;%h  D2=A2*B2 f,i ,sùfuka th f,an,hla 

njg m;aùfuka .Kkh ùula isÿ fkdfõ'^rEmh 7'14 n,kak'& tu ksid iQ;% ,sùfï 

§ = ,l=Kg jï miska lsisjla igyka fkdl< hq;= h' ^rEmh 7-15 n,kak'&

  WodyrK 2

fmd;l ñ, iy mekai,l ñ, § we;s úg rEmh 7'16 u.sska oelafjk jevmf;ys 

i|yka iQ;% n,kak'

WodyrK 3

>klhl me;a;l È. § we;s úg j¾.M,h iy mßudj .Kkh lsÍu' ^rEmh 7'17 

n,kak'&

 ,l=Kg jï miska lsisjla igyka fkdl< hq;= h' ^rEmh 7-15 n,kak'&

rEmh 7'14 - iQ;%hla jeros f,i ksrEmKh rEmh 7'15 - iQ;%hla ksjeros f,i ksrEmKh

rEmh 7'16 - ñ, .Kkh

rEmh 7'17 - >klhl j¾. M,h yd mßudj fiùu'

  l%shdldrlu

7'16 rEmfha oelafjk jevm; Tn Ndú; lrk me;=reïm;a uDÿldx.h 

weiqßka ks¾udKh lrf.k B1 iy B2 hk fldaIj, w.hka fjkia 

lrñka B3, B4, B5, B6 hk fldaIj, i|yka iQ;%j,ska ,efnk m%;sM, 

ksÍlaIKh lrkak'
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igyk ( fldaI ,smsk Ndú;fhka ,shk ,o iQ;%j,ska ,efnk m%;sM,h" iEu úg 

u tu iQ;% ,sùug fhdod .;a fldaI ,smskj, w.hka fjkia l< úg iajhxl%Sh j 

hdj;ald,Sk fõ' 

               iQ;%h                  m%;sM,h

=A1*B1-D2
=D1-C2/A2
=B3^C3-A3
=A1*C1/C3
=D2*C4*E1
=A3/B3+A2*D1
=A1+(B2*C2)-B3+C2/B2
=B2-B3+B1*(D1+D2^B1)
=A2^B3-C2+A3*(B3+C1)
=A3/C3*(D2*D1)
=D3/C3/B3*A3+B2
=(D3/(A1+B2))^C2

      j.=j 7.7

  l%shdldrlu

 7'17 rEmfha oelafjk jevm;  Tn Ndú; lrk me;=reïm;a uDÿldx.h 

weiqßka ks¾udKh lrf.k B1 fldaIfha w.hka fjkia lrñka 

B2,B3,B4 hk fldaIj, i|yka iQ;%j,ska ,efnk m%;sM, ksÍlaIKh 

lrkak'

  l%shdldrlu

my; oelafjk jevm; ^rEmh 7'18 n,kak& iy iQ;% we;=<;a j.=j  

wOHhkh lrñka j.=j 7'7 ys i|yka iQ;%j, fufyhjk fh§ we;s 

m%uqL;d wkqms<sfj< i,ld n,ñka iq¿lr ,efnk wjidk w.h m%;sM, 

;Srefõ igyka lrkak' 

iQ;%h m%;sM,h

=A1+B1 12
=C1+C2+C3 17
=B2+C3+B3 7
=A2*C1 12
=C2/A2*D1 6
=B3^A2+D1 10

rEmh 7'18 - o;a; we;=<;a jevm;
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 7'4      .Kkh lsÍu i`oyd Y%s; Ndú;h  

o;a; m%udKh jeä jk úg fldaI ,smsk muKla  Ndú;fhka iQ;% ,sùu 

;rula wmyiq iy ixlS¾K lghq;a;ls' tjeks wjia:dj, § iQ;% ,sùu i|yd Y%s; 

Ndú; lruq' me;=reïm;a uDÿldx.j, úúO lafIa;% hgf;a .Kkh lsÍï isÿ lsÍug 

Y%s; úYd, m%udKhla we;' ta w;ßka nyq, j fhfok uQ,sl Y%s; lsysmhla y÷kd 

.ksuq' ^j.=j 7'8 n,kak'&

 Y%s;fha ku     ldrl Í;sh (Syntax)             Ndú;h

SUM =SUM(Number 1,Number2......) fldaI mrdihl msysá w.hkaf.a 

tl;=j fiùu'

AVERAGE =AVERAGE(Number1,Number2.......) fldaI mrdihl msysá w.hkaf.a 

idudkH w.h fiùu'

 MAX =MAX(Number1,Number2.......) fldaI mrdihl msysá w.hkaf.a 

úYd,u w.h fiùu'

 MIN =MIN(Number1,Number2......) fldaI mrdihl msysá w.hkaf.a 

l=vdu w.h fiùu'

COUNT =COUNT(Number1,Number2.......) fldaI mrdihl msysá w.hka 

we;=<;a fldaI .Kk fiùu'

       

 WodyrKhla f,i jevm;l A1 fldaIfha isg A10 fldaIh olajd tl;=j ,nd 

.ekSug fldaI ,smsk muKla Ndú;fhka 1 u.ska oelafjk iQ;%h iy Y%s; 

Ndú;fhka ,shk ,o 2 u.ska oelafjk iQ;%h i,luq' fuu iQ;% foflka u tl 

u m%;sM,hla ,nd fohs' fuu iQ;% fol ii|d n,k úg fldaI mrdih jeä jk 

úg 2 u.ska oelafjk iQ;%h Ndú;h ir, yd myiq nj Tng jegfykjd we;'

j.=j 7.8



215fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs214

=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10     1
=SUM(A1:A10)         2

=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10

          =SUM( A1: A10)

    

Y%s;h ;=< mrdih wdrïN jk fldaI ,smskh;a mrdih wjika jk fldaI 

,smskh;a igyka lrkq ,nhs'

rEmh 7'19 u.ska oelafjk jevm; weiqßka Y%s; Ndú;fhka iQ;% f.dvk.uq'

Y%s; Ndú; l< yels úúO wdldr y÷kd .ksuq'

SUM Y%s;h' ^j.=j 7'9 n,kak'&
j.=j 7.9

           iQ;%h          úia;rh      m%;sM,h

= SUM(A1,B1,C1) A1,B1 iy C1 hk 

fldaIj, w.hkaf.a tl;=j'

        12

= SUM(A1:C1) A1 isg C1 olajd fldaI mrdih ;=< 

msysá w.hkaf.a tl;=j'

        12

= SUM(A1:C1,B2) A1 isg C1 olajd fldaI mrdih ;=< 

iy B2 fldaIfhys we;s w.hkaf.a 

tl;=j'

        15

= SUM(B1:C2) B1 isg C2 olajd fldaI mrdih ;=< 

msysá w.hkaf.a tl;=j'

        20

= SUM(A1:A3,C1:C3) A1 isg A3 olajd iy C1 isg 

C3 olajd fldaI mrdi ;=< we;s 

w.hkaf.a tl;=j'

            35

rEmh 7'19 - jevm;
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AVERAGE Y%s;h ^j.=j 7.10&

           iQ;%h          úia;rh          m%;sM,h

= AVERAGE(A1,B1,C1) A1,B1 iy C1 hk fldaIj, 

w.hkaf.a idudkHh'

           4'00

= AVERAGE(A1:C1) A1 isg C1 olajd fldaI 

mrdih ;=< msysá w.hkaf.a 

idudkHh' 

           4'00

= AVERAGE(A1:C1,B2) A1 isg C1 olajd fldaI 

mrdih ;=< iy B2 fldaIfhys 

we;s w.hkaf.a idudkHh'

           3'75

= AVERAGE(B1:C2) B1 isg C2 olajd fldaI mrdih 

;=< msysá w.hkaf.a tl;=j'

           5'00

= AVERAGE(A1:A3,C1:C3) A1 isg A3 olajd iy C1 isg 

C3 olajd fldaI mrdi ;=< 

we;s w.hkaf.a idudkHh'

                5.83

     

igyk ( idudkH w.h i|yd úúO oYu ia:dk iys; ms<s;=re m%;sM, ,efí' tu 

m%;sM, we;=<;a fldaI mrdih wjYH oYuia:dk m%udKhlg yeviõ (Format) l< 

hq;= h'

MAX Y%s;h ^j.=j 7'11&

j.=j 7.11

         iQ;%h              úia;rh       m%;sM,h

= MAX(A1,B2,C1) A1"B2 iy C1 hk fldaIj, w.hka 

w;ßka úYd, u w.h h'

          4

= MAX(A2:C2,B3) A2 isg C2 olajd fldaI mrdih 

;=< iy B3 fldaIfhys we;s w.hka 

w;ßka  úYd, u w.h h'

          9

= MAX(A1:C1) A1 isg  C1 olajd fldaI mrdih 

;=< msysá w.hka w;ßka  úYd, u 

w.h h'

          6

= MAX(A1,B1:C2) A1iy B1 isg  C2 olajd fldaI 

mrdih ;=< msysá w.hka w;ßka  

úYd, u w.h h'

          7

j.=j 7.10
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MIN Y%s;h ^j.=j 7'12 n,kak&

       iQ;%h              úia;rh      m%;sM,h

= MIN(A1,B2,C1) A1"B2 iy C1 hk fldaIj, w.hka 

w;ßka l=vd u w.h h'

        2

= MIN(A2:C2,B3) A2 isg C2 olajd fldaI mrdih 

;=< iy B3 fldaIfhys we;s w.hka 

w;ßka l=vd u w.h h'

        3

= MIN(A1:C1) A1 isg  C1 olajd fldaI mrdih ;=< 

msysá w.hka w;ßka l=vd u w.h h'

        2

= MIN(A1,B1:C2) A1 iy B1 isg  C2 olajd fldaI 

mrdih ;=< msysá w.hka w;ßka l=vd 

u w.h h'

        2

COUNT Y%s;h ^j.=j 7'13 n,kak&'

         iQ;%h          úia;rh        m%;sM,h

= COUNT(A1,B1) A1, B1 iy C1 hk fldaIj, 

we;s w.hka .Kk'

          2

= COUNT(A1:C1) A1 isg C1 olajd fldaI mrdih 

;=< msysá w.hka .Kk'

          3

= COUNT(A1:A4) A1 isg A4 olajd fldaI mrdih 

;=< msysá w.hka .Kk'

          3

= COUNT(A1:C1,B2) A1 isg C1 olajd fldaI mrdih 

;=< iy B2 fldaIfhys we;s 

w.hka .Kk'

          4

= COUNT(B1:C3) B1 isg C3 olajd fldaI mrdih 

;=< msysá w.hka .Kk'

          6

= COUNT(A1:A3,C1:C3) A1 isg A3 olajd iy C1 isg 
C3 olajd fldaI mrdi ;=< we;s 

w.hka .Kk'

          6

    

j.=j 7.12

j.=j 7.13
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  l%shdldrlu

mdi,l f;dr;=re yd ikaksfõok ;dlaIKh yodrk isiqka yh fofkl=  

10 mka;sfha § ,nd .;a ,l=Kq rEmh 7'20ys olajd we;' 

    rEmh 7'20 - mdi,l isiqka 10 jif¾ § ICT i`oyd ,nd .;a ,l=Kq

Y%s; muKla fhdod .ksñka my; m%Yakj,g ms<s;=re imhkak'

^1& fla'Ndkq fidaur;ak ,nd .;a ,l=Kqj, tl;=j fiùug E2 fldaIhg we;=<;a  

    l< hq;= iQ;%h i|yka lrkak' 

^2& jika;ï chrdÊ ,nd.;a ,l=Kqj, idudkH w.h fiùug E3 fldaIhg we;=<;a  

    l< hq;= iQ;%h i|yka lrkak' 

^3& jdrh 1 i|yd ,nd we;s jeä u ,l=Kq ixLHdj fiùug B8 fldaIhg we;=<;a l< 

    hq;= iQ;%h i|yka lrkak' 

^4& jdrh 2 i|yd fmkS isá isiqka ixLHdj fiùug C8 fldaIhg we;=<;a l< hq;=  

    iQ;%h i|yka lrkak' 

^5& jdrh 3 i|yd ,nd we;s wvq u ,l=Kq ixLHdj fiùug D8 fldaIhg we;=<;a l<  

   hq;= iQ;%h i|yka lrkak' 
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7'5'1  Microsoft Excel 2010 ys yeviõ lsÍfï fuj,ï iys;  
   ßnkh

     j.=j 7.14

 wxlh        fuj,u             úia;rh

      1 Font jevmf;ys úúO j¾.fha wlaIr fhdod 

.ekSu'

      2 Font Size jevmf;ys úúO m%udKfha wlaIr fhdod 

.ekSu'

      3 Vertical Top Alignment fldaIh ;=< isria j by<ska msysgqùu'

      4 Vertical Middle Alignment fldaIh ;=< isria j ueÈka msysgqùu'

      5 Vertical Bottom Alignment fldaIh ;=< isria j my<ska msysgqùu'

      6 Orientation fldaI wka;¾.;h wdk; j msysgqùu'

      7 Number Format w.hka iys; fldaI yeviõ lsÍu'

      8 Bold fldaI wka;¾.;h ;o meye .ekaùu'

      9 Italic fldaI wka;¾.;h we, j msysgqùu'

     10 Underline fldaI wka;¾.;hg háka brla we£u'

     11 Left Alignment fldaIh ;=< ;sria j jï tfl,a, lsÍu'

     12 Center Alignment fldaIh ;=< ;sria j ueo tfl,a, lsÍu' 

     13 Right Alignment fldaIh ;=< ;sria j ol=Kq tfl,a, lsÍu'

     14 Increase decimal places w.hkaf.a oYu ia:dk m%udKh jeä lsÍu'

     15 Decreased  decimal places w.hkaf.a oYu ia:dk m%udKh wvq lsÍu'

 

 jevm;l wka;¾.;fhys we;s f,an, iy w.hka yeviõ (Formatting)
lsÍug yeviõ fuj,ï ;Srej fyda fldaI yeviõ ixjdo ljq¿j Ndú; l< yels h'

 7'5      jevm; yeviõ lsÍu

21 3

1310 11 151412

5 6

9

7

8

4

 rEmh 7'21 - Microsoft Excel 2010 yeviõ fuj,ï ;Srej
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7'5'2  LibreOffice  Calc j, yeviõ lsÍfï fuj,ï ;Srej

 

     

           j.=j 7.15

           

wxlh

         fuj,u          úia;rh

1 Font jevmf;ys úúO j¾.fha Font fhdod 

.ekSu'

2 Font Size jevmf;ys úúO m%udKfha Font fhdod 

.ekSu'

3 Bold fldaI wka;¾.;h ;o meye .ekaùu'

4 Italic fldaI wka;¾.;h we, j msysgqùu'

5 Underline fldaI wka;¾.;hg háka brla we£u'

6 Left Alignment fldaIh ;=< jï tfl,a, lsÍu'

7 Center Alignment fldaIh ;=< ueo tfl,a, lsÍu'

8 Right Alignment fldaIh ;=< ol=Kq tfl,a, lsÍu'

9 Increase decimal places w.hkaf.a oYu ia:dk m%udKh jeä lsÍu'

10 Decreased  decimal 
places

w.hkaf.a oYu ia:dk m%udKh wvq lsÍu'

8

3 4 5 61 2

7 9 10

rEmh 7'22 - LibreOffice  Calc 4.1 yeviõ fuj,ï ;Srej
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7'5'3  w.hhka yeviõ lsÍug ixjdo ljq¿ Ndú; lsÍu

fldaIhla fyda fldaI mrdi fyda yeviõ lsÍug fuj,ï ;Srefõ msysá 

fuj,ïj, úia;rd;aul Ndú; fldaI yeviõ ixjdo ljq¿(Format Cells Dialog 
Box) ;=<sska n,d .; yels h'

7'5'4  fldaI mrdihla oYuia:dk lsysmhlg yeviõ lsÍu 

w.hka fnok úg oYu ia:dk úúO m%udKj,ska ,efí' tjeks wjia:dj, § 

ksYaÑ; oYu ia:dk m%udKhlg yeviõ l< hq;= fõ' rEmh 7'25 n,kak'

fldaI wjYH oYu ia:dk m%udKhlg  yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

rEmh 7'25 - oYu ia:dk follg yeviõ lsÍu'

 rEmh 7'23 - fldaI ixjdo yeviõ ljq¿  rEmh 7'24 - fldaI ixjdo yeviõ ljq¿

Microsoft Office Excel 2010 i`oyd... 
Home Tab  → Number Group LibreOffice Clac i`oyd...

Format→Cells
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7'5'5 fldaI mrdihla f,an, f,i oelaúh yels wdldrhg yeviõ  
         lsÍu

 ÿrl:k wxlhl b,lalï oyhla wvx.= úh hq;= h' tfy;a me;=reï m;aj, 

§ fldaIhla ;=< § uq,ska wdodkh lrkq ,nk ìkaÿj ^0& fmkajkafka ke;' thg 

fya;=j th w.hla f,i igyka lr .ekSuhs' tneúka ÿrl:k wxl wdodkh lsÍug 

m%:ufhka we;=<;a lrkq ,nk fldaI mrdih mdG ^Text& f,i yeviõ l< hq;= h' 

^rEmh 7'26 iy rEmh 7'10 ys D ;Srej n,kak'&

fldaI mrdihla mdG (Text) wdldrhg yeviõ lsÍu i|yd my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu'

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu'

3' Number Tab f;dard .ekSu' 

4' Number f;dard .eksu'

5' wjYH oYu ia:dk m%udKh ilia lsÍu'

6' OK úOdkh l%shd;aul lsÍu'

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu'

2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu'

3' Number Tab f;dard .ekSu' 

4' Number f;dard .eksu'

5' wjYH oYu ia:dk m%udKh ilia lsÍu'

6' OK úOdkh l%shd;aul lsÍu'

rEmh 7'26 - fldaI mrdihla mdG (text) wdldrhg 

yeviõ lsÍu

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Text f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

6' ixLHd wdÞkh lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu

3' Number Tab f;dard .ekSu

4' Text f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

6' ixLHd wdÞkh lsÍu
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7'5'6 fldaI mrdihla m%;sY; oelaúh yels wdldrhg yeviõ lsÍu

tla w.hla ;j;a w.hlska fn¥ úg ,efnk ixLHdj m%;sY;hla (Percentage)
f,i ±laùug yeviõ l< hq;= h' mdi,a fmd;a wf,ú if,ys m<uq jdrh ;=< ,o 

udisl wdÞhu m%;sY;hla f,i .Kkh lr we;s whqre 7'27 rEmfhka ±lafõ'

rEmh 7'27 - fldaI mrdihla m%;sY; (Percentage) wdldrhg yeviõ lsÍu

fldaI mrdihla m%;sY; wdldrhg yeviõ lsÍu i|yd my; oelafjk mshjr 

wkq.ukh lrkak'

7'5'7 fldaI mrdihla úoHd;aul ixLHd oelaúh yels wdldrhg 
          yeviõ lsÍu

me;=reïm;aj, b;d l=vd ixLHd fuka u b;d úYd, ixLHd o .Kkh lsÍug 

yelshdj we;' tjeks w.hka lshjd f;areï .ekSu yd m%ldY lsÍu wmg ;rula ÿrg 

wmyiq ld¾hhls' tfy;aa úoHd;aul (Scientific) wxlkfhka oelajQ miq iEu w.hla u 

talSh l%uhlg m;aùu ksid lshjd f;areï .ekSu yd m%ldY lsÍu myiq lrhs' rEmh 

7'28 n,kak'

fldaI mrdihla úoHd;aul wxlkhg yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hhka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Percentage f;dard .eksu

5' wjYH oYu ia:dk m%udKh ilia lsÍu

6' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hhka yeviõ ixjdo fldgqj ,nd  

   .ekSu

3' Number Tab f;dard .ekSu

4' Percentage f;dard .eksu

5' wjYH oYu ia:dk m%udKh ilia lsÍu

6' OK úOdkh l%shd;aul lsÍu

rEmh 7'28 - úoHd;aul wxlkh
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7'5'8 fldaI mrdihla  Èk oelaúh yels wdldrhg yeviõ lsÍu

mß.Klhl Èkh (Date) 5$12$2014 u.ska olajkqfha  2014 uehs ui 12 fjks 

Èkhhs' fuh weußldkq l%uh fõ' ^mm/dd/yyyy&' ^mm-udih" dd - Èkh" yyyy - 
j¾Ih& me;=reïm;aj, Èkh wdldr lsysmhlska oelaúh yels h' rEmh 7'29 n,kak'

 

fldaI mrdihla Èkh oelaùug yeviõ lsÍu i|yd my; oelafjk mshjr  

wkq.ukh lrkak'

rEmh 7'29 - Èkh ±lafjk úúO yeviõ

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Date f;dard .eksu

5' Èkh ±laúh hq;= wdldrh f;aÍu

6' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu

3' Number Tab f;dard .ekSu 

4' Date f;dard .eksu

5' Èkh ±laúh hq;= wdldrh f;aÍu

6' OK úOdkh l%shd;aul lsÍu

Microsoft Office Excel  2010       
   i`oyd...
  1' fldaI mrdih f;dard .ekSu

  2' w.hka yeviõ ixjdo fldgqj ,nd 

     .ekSu

  3' Number Tab f;dard .ekSu 

  4' Scientific f;dard .eksu

  5'wjYH oYu ia:dk m%udKh ilia lsÍu

 6' OK úOdkh l%shd;aul lsÍu

 LibreOffice Calc i`oyd...
 1' fldaI mrdih f;dard .ekSu

 2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu

 3' Number Tab f;dard .ekSu

 4' Scientific f;dard .eksu

 5' wjYH oYu ia:dk m%udKh ilia lsÍu

 6' OK úOdkh l%shd;aul lsÍu
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7'5'9 fldaI mrdihla fõ,dj oelaúh yels wdldrhg yeviõ lsÍu

mß.Klhl fõ,dj (Time) 10:35:53 AM f,i igyka lrhs' fuh hh:mm:ss 
AM$PM f,i fmdÿfõ olajhs' rEmh 7'30 n,kak' fuys hh hkq meh .Kk" mm 
hkq úkdä .Kk iy ss hkq ;;amr .Kk fõ'hkq úkdä .Kk iy  hkq ;;amr .Kk fõ'

rEmh 7'30 - fj,dj ±lafjk úúO yeviõ

fldaI mrdihla fõ,dj oelaùug yeviõ lsÍu i|yd  my; oelafjk mshjr 

wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Time f;dard .eksu

5' fõ,dj ±laúh hq;= wdldrh f;aÍu 

6' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu

3' Number Tab f;dard .ekSu 

4' Time f;dard .eksu

5' fõ,dj ±laúh hq;= wdldrh f;aÍu 

6' OK úOdkh l%shd;aul lsÍu

7'5'10 fldaI mrdihla uqo,a f,i oelaúh yels wdldrhg yeviõ 
           lsÍu

uq,H jákdlula iys; w.hj, ^Currency& uqo,a i|yd Ndú; flfrk 

ixfla; ^$- fvd,¾" Rs - remsh,a&  w.hg bÈßfhka oelaúh hq;= h' 

fldaI mrdihla uq,H w.hka oelaùug yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3'  Number Tab f;dard .ekSu

4' Currency f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu

3' Number Tab f;dard .ekSu

4' Currency f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu
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7'5'11  fldaI mrdihla tfl,a, jk f,i yeviõ lsÍu

 fldaIj, f,an, fyda w.hka tfl,a,^Alignment& lsÍu ju"ueo iy ol=K 

jYfhka isÿ flf¾'

 jï tfl,a,      ueo tfl,a,   ol=K tfl,a, 

      (Left Alignment)         (Center Alignment)           (Right Alignment)
 fldaI mrdihla fõ,dj oelaùug yeviõ lsÍu i|yd  my; oelafjk mshjr 

wkq.ukh lrkak'

 fldaI mrdihla tfl,a, lr oelaùug" yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Alignment Tab f;dard .ekSu

4' ju" ueo" ol=K hk tajdhska tlla 

   f;dard .ekSu 

5' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc 2010 i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd  

   .ekSu

3' Alignment Tab f;dard .ekSu

4' ju" ueo" ol=K hk tajdhska tlla 

   f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

  l%shdldrlu

yeviõ fuj,ï Ndú; lrñka iy iQ;% ,shd rEmh 7'31 u.ska olajd 

we;s jevm; ks¾udKh lrkak'

rEmh 7'31 - úúO yeviõ iys; jevm;la



227fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs226

 7'6      idfmalaI iy ksrfmalaI fldaI fhduqj

7'6'1  iQ;%hla msgm;a lsÍu

mdif,a jdr úNd.hl isiqka ,nd .kakd ,l=Kq ,ehsia;=jla mka;sNdr 

.=re;=ud fyda .=re;=ñh úiska ilia lrkq ,efí' tla tla isiqjdf.a ,l=Kqj, tl;=j" 

idudkH w.h wdÈh fjka fjka jYfhka .Kkh lsÍu idïm%odhsl l%uhhs' tfy;a 

úoHq;a me;=reïm;a fhdod f.k fujeks ,l=Kq ,ehsia;= ieliSu ld¾hlaIu yd 

M,odhS l%uhls' thg fya;=j ,shk ,o iQ;%h msgm;a lsÍfuka fiiq .Kkh lsÍï 

b;d myiqfjka ,nd .ekSug yels ùuhs' tneúka jevm;l fma<shla Tiafia fyda 

;Srejla Tiafia iQ;%hla msgm;a lrk wdldrh úuid n,uq'

7'6'2  fldaIhl msrjqï ye~,h

jevmf;ys ´kE u fldaIhl ol=Kq mi my< fl<jf¾ msysá l=vd fldgqj 

msrjqï ye~,h (Fill handle) f,i kï flf¾' rEmh 7'32 n,kak'

 rEmh 7'32 - msrjqï ye~,h

msrjqï ye~,h

^1&  A ;Srej iy 2 fma<sh ueo tfl,a, lrkak'

^2&  2 fma<sh ;omeye (Bold) lrkak'

^3&  1 fma<sfha ud;Dldj háka brla w¢kak' wl=rej, m%udKh 16 lrkak'

^4&  A3,A4,A5 fldaI we, (Italic)  lrkak'

^5&  B6 fldaIhg ckjdß ui tl;=j ,nd .ekSug iQ;%hl sum Y%s;h fhdod ,shkak'

^6&  B7 fldaIhg ckjdß ui idudkHh ,nd .ekSug iQ;%hla average() Y%s;h fhdod 

    ,shkak'

^7& by; B6 iy B7 fldaIj, we;s iQ;% msgm;a lr b;sß udij, tl;=j iy 

    idudkHh fidhkak'

^8&  E3 fldaIhg l,d wxYfha  tl;=j ,nd .ekSug sum Y%s;h fhdod ,shkak'

^9&  F3 fldaIhg l,d wxYfha idudkHh ,nd .ekSug average() Y%s;h fhdod ,shkak'

^10& by; E3 iy F3 fldaIj, we;s iQ;% msgm;a lr b;sß wxYj, tl;=j iy idudkHh  

    fidhkak'
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7'6'3  iQ;% msgm;a lsÍu i|yd msrjqï ye`v,h Ndú; lsÍu

msrjqï ye~,h Ndú;fhka iQ;%hla msgm;a lsÍug my; oelafjk mshjr 

wkq.ukh lrkak' 

^1&' iQ;%h wvx.= fldaIh f;dard .ekSu

^2&' fldaIfha ol=Kq mi my< fl<jr msysá msrjqï ye~,h f;dard .ekSu

^3&' msrjqï ye~,h wjYH fldaIh fj; weof.k hdu

7'6'4  iQ;% msgm;a lsÍu i|yd Copy iy Paste  úOdk Ndú; lsÍu

Copy-Paste úOdk Ndú;fhka iQ;%hla msgm;a lsÍug my; oelafjk mshjr 

wkq.ukh lrkak' 

^1&' iQ;%h wvx.= fldaIh f;dard .ekSu 

^2&' Copy úOdkh ,nd §u ^Ctrl + C&

^3&' msgm;a lsÍug wjYH  fldaI mrdih f;dard .ekSu

^4&' Paste  úOdkh ,nd §u ^Ctrl + V&

7'6'5  idfmalaI iy ksrfmalaI fldaI fhduqj

fldaI ,smskhla ;Sre wlaIrhlska iy fma<s wxlhlska iukaú; fõ' iQ;%hl 

§ tjeks fldaI ,smskhla idfmalaI fldaI fhduqjla f,i ye¢kafõ' fvd,¾ ixfla;h 

^$& fma<s wxlh bÈßfha fh§fuka fma<s ksrfmalaI fldaI fhduqjla o" ;Sre wlaIrh 

bÈßfha fh§fuka ;Sre ksrfmalaI fldaI fhduqjla o"  fma<s wxlh iy ;Sre wlaIrh 

hk fol u bÈßfha fh§fuka fma<s iy ;Sre ksrfmalaI fldaI fhduqjla o ks¾udKh 

fõ'

  WodyrK 

H2 - idfmalaI fldaI fhduqj ^Relative cell reference&
H$2  - fma<s ksrfmalaI fldaI fhduqj ^Row absolute cell reference&
$H2 - ;Sre ksrfmalaI fldaI fhduqj ^Column absolute cell reference&
$H$2 - fma<s iy ;Sre ksrfmalaI fldaI fhduqj ^Row and column absolute cell   
    reference&

7'6'6  idfmalaI fldaI ,smsk

iQ;%h fma<shla  Tiafia msgm;a jk úg tys wvx.= fldaI ,smskj, fma<s wxlh 

wkqhd; j fjkia fõ kï iy ;Srejla  Tiafia  msgm;a jk úg tys wvx.= fldaI 

,smskj, ;Sre wlaIrh wkqhd; j fjkia fõ kï tjeks fldaI ,smsk idfmalaI 

fldaI fhduqjla ^Relative cell reference& f,i ye¢kafõ' 
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WodyrK 

C1 fldaIfha ,shd we;s }A1+B1 hk iQ;%h C ;Srej Tiafia my<g;a 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; rEmh 7'33ys oelafjk mßÈ fldaI ,smsk 

idfmalaI j fjkia fõ' ta wkqj A1 iy B1 hk fldaI ,smsk" idfmalaI fldaI fhduq 

f,i i,lkq ,nhs'

7'6'7  fma<s ksrfmalaI fldaI fhduqj

iQ;%hla fma<shla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI ,smskj, fma<s 

wxlh fjkia fkdfõ kï tjeks fldaI ,smsk" fma<s ksrfmalaI fldaI fhduq ^Row 
absolute cell reference& f,i ye¢kafõ'

WodyrK 

C1 fldaIfha ,shd we;s }A$1+B$1 hk iQ;%h C ;Srej Tiafia my<g;a 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; rEmh 7'34 ys oelafjk mßÈ fldaI ,smsk ;Srej 

Tiafia my<g fjkia fkdfõ' tfy;a fldaI ,smskj, ;Sre wlaIrh fma<sh Tiafia 

idfmalaI j fjkia fõ' ta wkqj A$1 iy B$1 hk fldaI ,smsk" fma<s ksrfmalaI 

fldaI fhduq f,i y÷kajkq ,nhs'

rEmh 7'33 - idfmalaI fldaI fhduq iys; jevm;la 

;Sre wlaIr fjkia fõ'

fma<s wxlh fjkia 

         fõ'

;Sre wlaIr fjkia fõ'

fma<s wxlh fjkia 

        fkdfõ'

rEmh 7'34 - fma<s ksrfmalaI fldaI fhduq iys; jevm;la'
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WodyrK 2 

mekai,l ñ, okakd úg mekai,a lsysmhl ñ, fiùu i|yd rEmh 7'35 u.ska 

oelafjk jevm; n,kak'

rEmh 7'35 - idfmalaI iy ksrfmalaI fldaI fhduq  

by; jevmf;ys C ;Srej Tiafia mekai,a m%udKhg idfmalaI j jákdlu 

.Kkh lsÍug C2 fldaIfha ,súh hq;= iQ;%h jkafka =A2*B2 fõ' fuh C ;Srej 

Tiafia my<g msgm;a lsÍfuka wfkl=;a mekai,a m%udKj, jákdlu ,nd .ekSug 

fkdyels h' 

 iQ;%h msgm;a ùfï § A2 hkak A3,A4,A5 wd§ jYfhka idfmalaI j fjkia 

úh hq;= h' tfy;a  iEu úg u B2 fldaIh iQ;%h ;=< § fkdfjkia j mej;sh hq;= 

h' ta wkqj C2 fldaIfha ,súh hq;= iQ;%h jkafka =A2*B$2 fõ'

7'6'8  ;Sre ksrfmalaI fldaI fhduqj

iQ;%hla ;Srejla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI ,smskj, ;Sre 

wlaIr fjkia fkdfõ kï tjeks fldaI ,smsk ;Sre ksrfmalaI fldaI fhduqj 

^Column absolute cell reference& f,i ye¢kafõ'

WodyrK 1 

C1 fldaIfha ,shd we;s =$A1+$B1 hk iQ;%h C ;Srej Tiafia my<g;a 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; rEmh 7'36 ys oelafjk mßÈ fldaI ,smsk 

;Srej Tiafia my<g fjkia fõ' tfy;a fldaI ,smskj, ;Sre wlaIrh fma<sh Tiafia 

fjkia fkdfõ' ta wkqj $A1 iy $B1 hk fldaI ,smsk" ;Sre ksrfmalaI fma<s 

idfmalaI fldaI fhduq f,i y÷kajkq ,nhs'

;Sre wlaIr fjkia fkdfõ'

fma<s wxlh fjkia 

        fõ'

rEmh 7'36  - ;Sre ksrfmalaI fldaI fhduq iys; jevm;la'
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WodyrK 2 

my; oelafjk rEmh 7'37 jevmf;ys 3 jk fma<sh Tiafia tla tla ́ jrh wjidkfha 

,nd we;s uq¿ ,l=Kq ixLHdj fiùug wjYH iQ;%h =SUM($B2:B2& fõ'

rEmh 7'37  - ;Sre ksrfmalaI fldaI fhduq    

iys; Y%s; we;=<;a jevm;la'

th 3 jk fma<sh Tiafia msgm;a l< úg my; rEmh 7'38 mßÈ Èiafõ'

rEmh 7'38 - ;Sre ksrfmalaI idfmalaI fldaI fhduq   

  iys; iQ;% we;=<;a jevm;la'

7'6'9  fma<s iy ;Sre ksrfmalaI fldaI ,smsk

iQ;%hla fma<shla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI ,smskj, fma<s 

wxlh fjkia fkdfõ kï iy ;Srejla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI 

,smskj, ;Sre wlaIr fjkia fkdfõ kï tjeks fldaI ,smsk fma<s iy ;Sre ksrfmalaI 

fldaI fhduq ^Row and column absolute cell reference& f,i ye¢kafõ'

 fldaI ,smskhl fma<s wxlh iy ;Sre wlaIrh hk fol u bÈßfha $ ixfla;h 

fh§fuka $B$2 wdldrfha fma<s iy ;Sre ksrfmalaI fldaI fhduq  iQ;%j, § fhdod 

.; yel'

WodyrK 1

C1 fldaIfha ,shd we;s =$A$1+$B$1 iQ;%h A ;Srej Tiafia my<g;a " 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; oelafjk rEmh 7'39 mßÈ fldaI ,smsk fjkia 

fkd fõ'

;Sre wlaIrh fjkia fkdfõ'

fma<s wxlh fjkia 

        fkdfõ'

rEmh 7'39 - ;Sre iy fma<s ksrfmalaI fldaI fhduq 

      iys; iQ;% we;=<;a jevm;la'
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 ta wkqj fma<s iy ;Sre ksrfmalaI fldaI fhduq iys; iQ;%hla fma<shla fyda 

;Srejla Tiafia msgm;a lsÍfï § iQ;%h ;=< § fldaI fhduqj fjkia fkd fõ'

WodyrK 2

my; oelafjk rEmh 7'40 jevmf;ys D4 isg I4  olajd fmd;a ixLHdjg wod< ñ,;a" 

C5 isg C10 olajd ÿisï ixLHdjg wod< ñ,;a fidhd .ekSug wjYH fõ' C1 
fldaIhg fmd;l ñ, we;=<;a l< ú.i wod< ñ, m%udK o¾Ykh jk mßÈ iQ;% 

,shuq' iQ;%h ;=< § C1 fldaI ,smskh ksrfmalaI j mej;sh hq;= h' thg fya;=j 

jkafka iQ;%h 4 jk fma<sh Tiafia iy C ;Srej Tiafia msgm;a jk úg iQ;%h ;=< § 

C1fkdfjkia j ;sìh hq;= neúks' tneúka wod< iQ;% ;=< $C$1 f,i fhdouq'

rEmh 7'40 - ;Sre iy fma<s ksrfmalaI fldaI fhduq'

  l%shdldrlu

1' my; oelafjk iQ;%" fma<sh Tiafia iy ;Srej Tiafia msgm;a l< úg 

wkqhd; fldaIj, § o¾Ykh jk wdldrh ,shkak'
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 7'7      me;=reïm;a Ndú;fhka m%ia;dr ks¾udKh

 ixLHd;aul j o;a; ksrEmKh jk wjia:dj, § th iei£u" úYaf,aIKh 

lsÍu" f;areï .ekSu yd bÈßm;a lsÍu ;rula ÿrg wmyiq ld¾hhls' tneúka yd 

m%ia;dr u.ska o;a; ksrEmKh lsÍu b;d id¾:l l%uhls' fï i|yd me;=reïm;a 

uDÿldx. fhdod .kakd wdldrh úuid n,uq'

m%ia;dr j¾. y÷kd .ksuq'

    j.=j 7.15 - m%ia;dr j¾. 

      m%ia;dr j¾.h      uQ,sl msßie,eiau            Ndú;h

;Sre m%ia;dr (Column 
Chart)

o;a; whs;u fYa%‚ 

iuQyhla tl jr iei£u'

ldKav jYfhka iei£u'

o~q m%ia;dr (Bar Chart) o;a; whs;u fYa%‚ 

iuQyhla tl jr iei£u'

ldKav jYfhka iei£u'

f¾Ld m%ia;dr (Line 
Chart)

o;a; whs;u fY%a‚ 

iuQyhla tl jr iei£u'

ldKav jYfhka iei£u'

jg m%ia;dr (Pie Chart) o;a; whs;u fY%a‚hla 

m%;sY; w.h u.skaa 

iei£u'

XY m%ia;dr (XY Scatter 
Chart)

hq., jYfhka mj;sk 

w.h iei£u'

 2'  idfmalaI iy ksrfmalaI fldaI ,smsk w;r we;s fjki ,shd olajkak'
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;Sre m%ia;dr iy jg m%ia;dr ks¾udKh i|yd my; oelafjk jevm; fhdod .ksuq'

m%ia;drh ks¾udKh i|yd  my; oelafjk mshjr wkq.ukh lrkak'

m%ia;drhg ud;Dldjla ,nd §u i|yd  my; oelafjk mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' o;a; mrdih f;dard .ekSu(A1:F3)
2' Insert → Chart
3' m%ia;dr j¾.h f;dard .ekSu

4' iqÿiq m%ia;drh f;dard .ekSu

LibreOffice Calc i`oyd...

1' o;a; mrdih f;dard .ekSu(A1:F3)
2' Insert → Chart
3' m%ia;dr j¾.h f;dard .ekSu

4' iqÿiq m%ia;drh f;dard .ekSu

5' Finish úOdkh ,nd §u

Microsoft Office Excel  2010 i`oyd...

 m%ia;dr f;dard .ekSu

 Layout→ Chart Title→ Above chart
 ud;Dldjla ghsma lsÍu

LibreOffice Calc i`oyd...

 m%ia;dr f;dard .ekSu

 Insert → Title
 ud;Dldjla ghsma lsrSu

 OK úOdkh ,nd §u

rEmh 7'41 - m%ia;dr ,l=Kq iys; jevm;

  l%shdldrlu

j.=j 7'15 ±lafjk tla tla m%ia;dr j¾. jvd;a u iqÿiq jk wjia:d i|yd 

WÞyrK fol ne.ska ,shkak'
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m%ia;drfha wlaI kï lsÍu i|yd  my; oelafjk mshjr wkq.ukh lrkak'

isiqka ,nd .;a uq¿ ,l=Kq jg m%ia;drhl olajuq'

  

Microsoft Office Excel  2010 i`oyd...

 1' m%ia;dr f;dard .ekSu

 2' Layout→ Axis Title
 3' Axis Type (Vertical or Horizontal) 
      wlaIr kï lsÍu

LibreOffice Calc i`oyd...

 1' m%ia;dr f;dard .ekSu

 2' Insert → Title
 3' wlaI kï lsrSu

 4' OK úOdkh ,nd §u

Microsoft Office Excel  2010 i`oyd...

1' o;a; mrdih f,i A1:A7 iy      

  G1:G7 mrdi ,l=Kq lrkak'

2' Insert→ Chart →  Pie chart
 

LibreOffice Calc i`oyd...

 1' o;a; mrdih f,i A1:A7 iy      

   G1:G7 mrdi ,l=Kq lrkak'

2' Insert→ Chart →  Pie chart
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WodyrK   Y= X2 - 5X - 3  j¾.c Y%s;fha m%ia;drh we£u

mshjr 1 ( jevmf;ys olajd we;s mßÈ  X i|yd -2 isg 7 olajd w.h we;=<;a lrkak'

mshjr 2 ( B2 fldaIhg my; oelafjk iQ;%h we;=<;a lrkak'

    =B1^2-5*B1-3
mshjr 3 ( B2 fldaIfhys we;=<;a l< iQ;%h K2 fldaIh olajd msgm;a lrkak'

mshjr 4 ( o;a; mrdih f,i A1:K2 mrdih i,l=Kq lrkak'

mshjr 5 ( Insert →Chart →XY Scatter
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wNHdih

 my; oelafjk jevm; weiqßka ms<s;=re imhkak'

^1&   2"6"10"14 we;=<;a fldaI mrdih kï lrkak'

^2&   9"10"11"12 we;=<;a fldaI mrdih kï lrkak'

^3&   6"7"8"10"11"12 we;=<;a fldaI mrdih kï lrkak'

^4&     A1 isg A4 olajd we;s w.hj, tl;=j A5 fldaIhg ,nd .ekSug wjYH iQ;%h  

     fldaI ,smsk muKla Ndú;fhka ,shkak'

^5&     A3 isg D3 olajd we;s w.hj, tl;=j E3 fldaIhg ,nd .ekSug wjYH iQ;%h  

     Y%s;hla Ndú;fhka ,shkak'

^6&   E3 ys iQ;%h E4 fldaIhg msgm;a lrk wdldrh i|yka lrkak'

^7&   E5 fldaIhg A1 isg D4 olajd idudkH w.h ,nd .ekSug wjYH iQ;%h Y%s;hla  

     Ndú;fhka ,shkak'

  l%shdldrlu

me;=reïm;a uDÿldx.hla Ndú; lrñka my; oelafjk jevm; ks¾udKh 

lrkak' fkdmeñ‚ isiqka ab u.ska olajd we;'
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;ks Y%s;hla Ndú; lrñka wod< iQ;% f.dvk.kak' 

^1& iuka l=udr ,nd .;a ,l=Kqj, tl;=j fiùug wjYH iQ;%h G2 fldaIhg   

    we;=<;a lrkak' 

^2& iuka l=udr ,nd .;a ,l=Kqj, idudkHh fiùug wjYH iQ;%h H2 fldaIhg   

    we;=<;a lrkak'        

^3& .‚;h úIhh i|yd isiqka ,nd we;s jeä u ,l=Kq ixLHdj fiùug wjYH   

    iQ;%h B9 fldaIhg we;=<;a lrkak' 

^4& tla tla úIhh i|yd isiqka ,nd we;s wvq u ,l=Kq ixLHdj fiùug wjYH   

    iQ;%h B10 fldaIhg we;=<;a lrkak' 

^5& tla tla úIhh i|yd fmkS isá isiqka .Kk fiùug wjYH iQ;%h B11  
    fldaIhg we;=<;a lrkak' 

^6&  tla tla úIhh i|yd ,nd we;s idudkH ,l=Kq fiùug wjYH iQ;%h B12 
    fldaIhg we;=<;a lrkak' 

idrdxYh

² oaúudk ;,hl isria ;Sre (Columns) yd ;sria fma<s (Rows) jYfhka msysá 

fldaI iuQyhlska jevm;  (Worksheet) ks¾udKh ù we;' 

² jevm;l we;s ;Sre kï lr we;af;a bx.%sis lemsg,a wlaIr fyda wlaIr ixfhdack 

fyda u.sks'

² jevm;l we;s fma<s kï lr we;af;a wxl u.sks'

² m<uq j ;Srefõ wlaIrh;a fojkq j fma<sfha wxlh;a fhdÞ fldaI kï lrkq 

,efí' th fldAI ,smskh (Cell Adress) f,i ye¢kafõ' 

² fldaIhl wka;¾.;h f,an,a (Label)" w.hka (Value) fyda iQ;% (Fomulae) 
j,ska tlls'

² iQ;%hla iudk (=) ,l=‚ka wdrïN lrkq ,efí' 

² fufyhjk (Operator) i|yd m%uqL;d wkqms<sfj<la mj;S'

² iQ;% ,sùu i|yd fldaI ,smsk" fufyhjk iy Y%s; (Function) Ndú; flf¾'

² f,an, iy w.hka yeviõ (Formatting) lsÍug yeviõ fuj,ï Ndú; flf¾' 

² iQ;%hla myiqfjka msgm;a lsÍug msrjqï ye~,h (Fill handle) Ndú; flf¾'

² idfmalaI fldaI fhduqjla (Relative cell reference) ksrfmalaI (Absolute) lsÍu 

i|yd fvd,¾ ixfla;h ($) Ndú; flf¾' 

² o;a; ixLHd;aul ksrEmKhg jvd m%ia;dr u.ska ksrEmKh" iei£u yd f;areï 

.ekSu myiq flf¾'



239fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihsPB

8 bf,lafg%dksl iu¾mK
 

wur (-  idud''' wfma .=re;=ud lsõjd fï .uk wfma f;dr;=re ;dlaIK Èkhg 

;dlaIKh fhdod f.k mdif,a b;sydih iu. f;dr;=re ;dlaIKh mdif,a 

Ndú;h .ek fyd| ks¾udKhla lrkak lsh,d'   

idud (-  wur''' wms fudkj o tfykï lrkafk ;dlaIK Èkhg''' 

wur : uu ys;df.k bkakjd wms lÜáh u tl;= fj,d fyd| b-iu¾mKhlaa 

yokak' t;fldg wmssg W;aijh fj,dfõ rÕyf,a fmkajkak;a mq¿jkafka" 

mdi,g w¨f;ka f.kdj nyqudOH m%lafIamK hka;%h;a Wojq lrf.k'

idud : tal kï fyd|hs' .=re;=udf.a äðg,a leurdfjka mdif,a mska;+r .kak;a 

mq¿jka iuyr wjia:d ùäfhda lr,d odkak;a mq`Mjka fka o @ 

wur : Tõ' Tõ' idud ta ú;rla fkfuhs wfma mdif,a ,dxPkh" fldäh jf.a tajd 

iÔùlrKh lr,d ,iaik lodjla yokak;a wmsg mq¿jka' 

idud : wmsg b-iu¾mKfhaa uqøs; msgm;la wdrdê; wuq;a;kag;a fokak mq¿jka fjhs 

fka o@

wur : Tõ' Tõ' idud wms oeka u huq i¾f.ka oek .ksuq fldfydu o fyd| 

b-iu¾mKhlaa yokafka lsh,d'

fuu mdvu yeoEÍfuka Tng 

•   iu¾mKhla hkq l=ula o"

•  .=Kd;aul b-iu¾mKhl wvx.= úh hq;= ,laIK"

•   iu¾mK uDÿldx.j, we;s uQ,sl ,laIK Ndú; lrñka is;a.kakd iq¨ nyqudOH 

   b-iu¾mKhlaa ks¾udKh lsÍu"

•  lodj miq;,h" lodj wdlD;s" lodj msßie,iqï .<md .ekSu"

²   b-iu¾mKhl wvx.= lodj ;=<g iqÿiq mska;+r fyda rEm igyka fyda we;=<;a 

   lsÍu"

•  b-iu¾mKhlg iÔúlrK wdfoaY lsÍu

  ms<sn`o j ukd wjfndaOhla ,nd .ekSug yels h'
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 8'1 iu¾mKhla hkq l=ula o ?

Presentation hkak 'iu¾mKh'" 'bÈßm;a lsÍu'" 'm%o¾Ylh' wdÈ úúO 

jpkj,ska ye¢kaúh yels h' lsishï mqoa.,fhl= fyda" mqoa., lKavdhula fyda ;u 

woyia" is;sú,s" ±lau fyda u;jdo fjk;a whg ±laùu ms‚i lrkq ,nk ´kE u 

m%h;akhla Prentation hkafkka woyia fõ' iu¾mKhla bÈßm;a lrkakd jdÑl 

yd wdx.sl wNsk fuka u" ndysr fuj,ï o Ndú; lrñka ;u woyi wkHhkag 

;yjqre lsÍug m%h;ak orkq ±lsh yels h' tjeks uE; 

ld,Sk fuj,ïj,g WÞyrK f,i Wäia m%lafIamlh 

(Over-head Projecter) yd oDYHrduq m%lafIamK 

hka;%h (Slide Prjecter) ±laúh yels h' Wäia$Wmß  

m%lafIamK hka;%h oDYH rduq m%lafIamK hka;%hg 

jvd l%shdlsÍfï § fjkia lula oelaù h' tys fhdod 

.kakd jQ úksúol mQ¾jfhka ilid ^rEmh 8'1'1& Wäia  

m%lafIamK hka;%hg fh§fukaa Ndú; l< yels w;r 

wjYH kï tu fudfydf;a § u ,shd oelaùu;a l< yels 

h' tfy;a ilid .;a úksúol kej; fjkia lrñka 

Ndú; l< fkd yels h' p,k Ñ;% fyda Yío wvx.= 

l< fkd yels h' fuu hka;%h ir, j Ndú; lsÍfï 

yelshdjla m%o¾Ylhd i;= úh' ;dlaI‚l fuj,ï 

Wmldr lr f.k m%o¾Ylhd ;u bÈßm;a lsÍï 

ks¾udKd;aul j isÿ lrk wjia:d nyq, jkakg 

úh' oDYHrduq m%lafIamK hka;%h Ndú;fha §  wod< 

oDYH rduq  (Slides) ieliSu i|yd wu;r fjfyila 

.ekSug isÿ úh' leurdjlska ,nd .;a PdhdrEm 

Ñ;%d.drhl ilia lrjd f.k wod< rduq ;=< w,jd 

.; hq;= úh' fuys § o p,k Ñ;% fyda Yío wvx.= 

l< fkdyels úh' mß.Kl ;dlaIKfha iy bf,lafg%dksl ;dlaIKfha ÈhqKqj;a 

iu.ska iu¾mK ilia lsÍu i|yd p,k rE.; 

lsÍfï leurd (Videocamera) iy nyqudOH 

m%lafIamk hka;%h (Multimedia Projector) wdÈ 

Wmdx. Ndú; lsÍug ks¾udK Ys,amSka Wkkaÿ 

jkq oelsh yels h' nyqudOH m%lafIamK hka;%h 

m%o¾Yl i|yd tla jkakg ùu úfYaI;ajhla 

.kS' fuu hka;%h;a mß.Klh;a ksid ksujk 

b-iu¾mK b;d flá ld,hla ;=< ksujd .; 

yels w;r nyqudOH wka;¾.; l< yels ùu jdis 

odhl úh' nyqudOH f,i y÷kajkq ,nk b,lalï (Numbers), wl=re (Letters), 
mska;+r" Ñ;%l yd m%;sìïn (Images), p,k Ñ;% iy ùäfhda (Animation and Videos&" 
j.= yd m%ia;dr (Tables and Graphs)" y~ (Sound) wdÈh b-iu¾mKhg wka;¾.; l< 

rEmh 8'1'2 - oDYH rduq 

m%lafIamK hka;%h

rEmh 8'1'1 - Wäia  m%lafIamk  
 hka;%h

rEmh 8'1'3 - nyqudOH m%lafIamK hka;%h
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yels úh' ta whqßka ks¾udKh l< yels ksid fuu iu¾mK nyqudOH bf,lafg%dksl 

iu¾mK  f,i y÷kajkq ,nhs' nyq udOH m%lafIamK hka;%h o kj ;dlaIKh ksid 

b;d l=vd lrñka kj wx. tla lrñka ksmojkq ,nhs' ^rEmh 8'1'3&

 8'2 .=Kd;aul b-iu¾mKhl wvx.= úh hq;= ,laIK 

.=Kd;aul b-iu¾mKhla wjYH jkqfha tu iu¾mKh krUkakdg ,nd 

fokakd jQ m‚úvh kshñ; wdldrfhka ,nd §ug wjYH f,i ilid .ekSug h' 

ilid .kakd jQ b-iu¾mK ;=< wka;¾.;h ms<sn| j jvd jeä wjOdkhla fhduq 

lsÍu u.ska .=Kd;aul Ndjh j¾Okh lr .; yels h' .=Kd;aul Ndjh jeä lr 

.ekSu i|yd ie,lsh hq;= lreKq fudkjd o hkak ms<sn| j wms oeka i,ld n,uq'

∗ wvx.= úh hq;= jdlH fma<s m%udKh

  wl=re m%udKh fuka u lodjl wvx.= úh hq;= jdlH fma<s m%udKh o jeo.;a 

h' fndfyda ÿrg tla lodjlg WÑ; jkafka fma<s 6 - 9 w;r m%udKhls' Bg jvd 

we;=<;a lsÍfuka wl=re l=vd ùu yd lshùug jeä ld,hla .;ùu jeks lreKq 

flfrys wjOdkh fhduq l< hq;= h'

∗  wl=rej, úYd,;ajh 

 b-iu¾mKfhaa lodj ;=< wvx.= jk mdGj," wl=rej, úYd,;ajh iy 

iu¾mKh iy fma%laIlhd w;r ÿr m%udKh fuys § jeo.;a h' idudkHfhka 

wl=re m%udKh fmdhskaÜ 32 (32 Points Font-size) fyda Bg jvd jeä úh hq;= h' 

túg krUkakdg oDYH rduqfõ we;s f;dr;=re meyeÈ,ss j lshúh yels jkq we;'

is;d n,kak" Tn ÿgq b-iu¾mKhl fuys i|yka ,laIK fldmuK m%udKhla 

wvx.= j ;snqKd o hkak' bÈß ld,fha olsk b-iu¾mK ;=<;a fuu ,laIK 

wvx.= j we;s oehs mÍlaId lr ne,Sug u;l ;nd .kak'

∗ wlaIr úkHdih yd NdId fhÿï ksjerÈ ùu

  ieliQ b-iu¾mK lsysm wjia:djla u fyd¢ka lshjd n,d wlaIr úkHdih 

yd NdId fhÿï ksjerÈ oehs ne,Su wksjd¾h lghq;a;ls' 

 l%shdldrlu

 ² idudkH m%o¾Ylhla b-iu¾mKhlska fjkiajk wdldrh meyeÈ,s  

   lr" tys we;ss jdis iy wjdis oelafjk j.=jla ilia lrkak'

²  Tn olajd we;s jdis Tfí wOHdmk lghq;=j,g wod< lr .; yels  

   wdldrh ,shd olajkak'
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∗ mska;+r" Ñ;%l fyda j.= iy m%ia;dr we;=<;a lsÍu

  mska;+r" Ñ;%l" j.= iy m%ia;dr wdÈh wka;¾.; lrkafka kï tla lodjl 

we;=<;a lsÍug fhda.H jkafka Wmßu f,i folla mu‚' jeä m%udKhla mska;+r" 

Ñ;%l" j.= iy m%ia;dr we;=<;a lsÍfuka tajdfha ;sfnk úia;r wemeyeÈ,s ùu 

fuhg fya;=jhs'

∗  j¾K fh§u  

 b-iu¾mK i|yd fhdod .kq ,nk j¾K o b;d jeo.;a fõ' jvd;a biau;= 

l< hq;= foa i|yd ;o j¾K" wl=re fnda,aâ lsÍu fyda fjk;a f*dkaÜ fh§u iqÿiq 

h' r;= j¾Kh lodj mqrd nyq, j fh§fuka krUkakdg wmyiqjla f.k fok nj 

okakd jQ lreKls' tfy;a wjOdrKh l< hq;= mdGhla" wxlhla fyda i,l=Kla 

r;= j¾Kfhka fh§u iqÿiq h' flfia fj;;a j¾K fh§fï § wlaIrj,g yd 

miqìug fhdokq ,nk mdg j¾K m%fNaokh (Contrast) ms<sn| j ie,ls,su;a úh 

hq;=hs' 

∗ p,k Ñ;% iy ùäfhda 

  p,k Ñ;% iy ùäfhda (Animation and Videos) we;=<;a lrkafka kï tla 

lodjl (Slide) tlla muKla we;=<;a lsÍu jvd;a iqÿiq h' fkd tfia kï tajdg 

fhdod we;s Yío ñY% ùu fuka u fma%laIlhdg keröfï ndOd o we;s úh yels 

h' 

∗  wruqK b,lal .; lsÍu

  nyqudOH fhdod .ekSfï § fma%laIlhdf.a wruqK b,lal .; ùu jeo.;a 

fõ' b-iu¾mK n,dfmdfrd;a;= jk woyi blaujd f.dia fjk;lg fma%laIlhd 

fhduq fkd jk wdldrhg nyqudOH wka;¾.; l< hq;= h' fkd tfia kï 

isÿ jkqfha b-iu¾mKh u.ska fm%laIlhd w;rux lsÍuls' WodyrKhla f,i 

oelajqj fyd;a b-iu¾mKfha wka;¾.; iÔùlrK (Animation) wkjYH f,i 

fhdod .ekSu ksid fma%laIlhd ta ms<sn| j" is;kakg jqj fyd;a wod< wruqK 

fj; <Õd ùug Tyqg ndOd we;s fõ' 

 l%shdldrlu

1' nyqudOH b-iu¾mKhla ks¾udKh lsÍfï§ .=Kd;aul Ndjh 

   wu;rj fjk;a jeo.;a jk ,laIKhka .fõIKh fldg ,ehsia;=   

   .; lrkak'

2' tu ,ehsia;=j weiqfrka .=Kd;aul Ndjh iy ks¾udKd;aul b- 

   iu¾mKhla ifydaor isiqka oekqïj;a lsÍug b-iu¾mKhla  

          ks¾udKh lrkak'
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 8'3  b-iu¾mK uDÿldx. (Presentation Software)
b-iu¾mK uDÿldx. hkqfjka woyia lrkq ,nkafka hï lsis ud;Dldjla 

fyda isoaêhla jgd f.dkq lr .; yels lreKq iuQyhl" jvd;a l%udkql+, j yd 

lsis hï ms<sfj<lg wka whg bÈßm;a lsÍug iydh jkakd jQ nyqudOH ,laIK 

wka;¾.; mß.Kl uDÿldx. úfYaIhls' 

m%p,s; b-iu¾mK uDÿldx. lsysmhla my; i|yka fõ' b-iu¾mK uDÿldx. 

ms<sn| ksoyia yd újD; fla; uDÿldx. (Free and Open source Software) iy uqo,a 

f.jd ,nd .; yels uDÿldx. (Commercial Software) hkqfjka j¾. lsysmhla 

olakg ,efí' 

fuhg wu;r j Tnf.a mß.Klfha ld¾hd, uDÿldx. lÜg,hla ia:dms; 

fkd lrk ,oaola kï Tng wjYH b-iu¾mKhla ilid .ekSu wmyiq jkq we;' 

tfy;a wka;¾cd,hg msúi la,jqâ fiajdjka (Cloud Srvices) Woõ u; Tfí ld¾hh 

bgq lr .ekSu i`oyd myiqlï imhd ;sfí' ksoiqka f,i MS Office -365 Power 
point,  Google Presentation fyda Microsoft Sky Drive - Power point fj; msúi 

wod< ld¾h ksu l< yels h' tmuKla fkdj wod< f.dkq iq/ls (Save) bv lv o 

Tjqyq ,nd fo;s' 

wka;¾cd,h ;=< ießirñka fuys we;s uDÿldx.j, úfYaI;ajh fidhd 

n,kak'

uDÿldx.fha ku ksuejQ wdh;kh ksoyia yd újD;  $ uqo,a 

f.úh hq;=

Apple Keynote Apple Inc. uqo,a f.úh hq;= uDÿldx.

Corel Presentation Corel Corporation uqo,a f.úh hq;= uDÿldx.

LibreOffice Impress Document Foundation ksoyia uDÿldx.

Microsoft 
PowerPoint

Microsoft 
Corporation

uqo,a f.úh hq;= uDÿldx.

Open Office.org 
Impress

Apache Corp. ksoyia uDÿldx.
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     8'4  b-iu¾mK uDÿldx.j, we;s uQ,sl ,laIK
 

 ld¾hd, uDÿldx. lÜg,hla PowerPoint iy ,síf¾ T*sia meflacfha wvx.= 

Impress b-iu¾mK uDÿldx. weiqßka úêu;a j b-iu¾mKhla ilid .kakd 

wdldrh my;ska ksrEmKh fõ'

        Microsoft Office PowerPoint wdrïN lsÍu

     MS PowerPoint 2010  wdrïN lsÍu Tng my; wdldrfhka isÿ l< yels h'

Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2010 
^fufyhqï moaO;sh wkqj fjkia úh yels h'&

         Microsoft Office 2010
 

 

by;ska oelafjkafka b-iu¾mK uDÿldx.fha wdrïNl ;srfha fukq iy 

fuj,ï  lsysmhls' fuys oelafjk fndfyda fuj,ï joka ieliqï uDÿldx.fha o 

olakg ,efí' 

rEmh 8'4'1 - Microsoft Power Point 2010 jev ;,h

1' blauka m%fõY   
   fuj,ï ;Srej 

  ( Quick Access          
     Tool Bar)

2' ud;Dld  

   ;Srej  

 (Title Bar)

3' má;s      

  ;Srej                        

 (Tabs )
5' lod ljq¿j  
(Slide Pane)

6' j ev ;,h         

 (Workspace)

7' l d¾h ljq¿j     

  (Task Pane)

8' igyka l jq¿j      

  (Notes Pane)
9' ;;a;aj ;Srej  

   (Status Bar)
10' oel =ï ;Srej          

   (View Tab)

4' ßnkh       

 (Ribbon)

11' md,lh 

(Zoom Control)
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1' blauka m%fõY fuj,ï ;Srej (Quick access tool bar) (- ud;Dld ;Srefõ jïmi 

fl<jf¾ msysá fuu ;Srefõ we;s úOdk myiqfjka yd blaukska ,nd Èh yelshs' 

ks;r wjYH jk úOdk fuu ;Srejg tl;= lr .ekSug wjia:dj ,nd § we;' 

;Srefõ ol=Kq mi B ysi u.ska my<g .,d tk fukqj ;=<ska ;j;a úOdk 

.Kkdjla tl;= lr .ekSug wjia:dj ,efí' blauka m%fõY fuj,ï ;Srej 

mßYS,lhdf.a wjYH;dj wkqj fjkia lr .; yelshs'

2' ud;Dld ;Srej (Title bar) ( w;=re uqyqKf;a by<ska u oelafjk ;Srej fuhhs' 

uDÿldx.fha ku fuka u újD; j we;s m%o¾Ylfha ku o fmkajhs' ljq¿j yl=<d 

oeófï fnd;a;u (Minimize), l=vd yd kej; msysgqùfï fnd;a;u (Maximize / 
Restore), ljq¿j jid oeófï  fnd;a;u (Close)  wdÈh o ol=Kq fl<jf¾ msysgd 

we;'

3' má;s ;Srej (Tabs) (  uDÿldx.fhys olakg ,efnk fuj,ï ;Srej fuys § 

ßnkh hkqfjka ye¢kafõ' ßnkfha we;s úfYaI ,laIKh jkafka tla tla 

má;sj,g wod< whs;u ksrEml (Icons) f,i tys oelaùuhs' Wod( Home úOdkh 

;=< ldKav lsysmhls' bka tla ldKavhla f,i Font ldKavh ye¢kaúh yelshs' 

ta ;=< wl=re (Fonts) i|yd wod< fuj,ï .Kkdjla f.dkq fldg oelafõ' 

^rEmh 8'4'2& mßYS,lhdg wjYH wdldrhg fuu ßnkh ilia lr .ekSug o 

myiqlï i,id we;'

4'  ßnkh (Ribbon) (-  fukq ;Srej mßYS,lhdg jvd;a myiq jk f,i ilid we;'  

tys úfYaI ,laIKh jkafka tla tla má;sj,g wod< whs;u ksrEml (Icons) 
f,i oelajd we;s w;r tajd ldKavhla f,i y÷kajkq ,eîu h' tu.ska tajdfha 

ld¾hh myiq lr we;' mßYS,lhdg wjYH wdldrhg fuu má;s ilia lr 

.ekSug o myiqlï i,id we;' ^rEmh 8'4'3&

5'  lod ljq¿j (Slide Pane) (- ljq¿fõ jï mi isria j msysgd we;af;a fuu ;Srejhs' 

fuu ;Srej f;dard we;s úg rduq oel .; yelafla l=vdjg hs' wjYH l=vd rduqj 

u; uQislh la,sla l< úg ljq¿fõ ueo úYd,kh ù rEm rduqj Èia fõ' túg 

wod< rduqfõ ixialrK fyda ksuejqï lsÍug yelshdj ,efí'

6'  jev ;,h (Workspace) (  b-iu¾mKhl ieliSu fuys isg isÿlrkq ,nhs' 

7'  ld¾h ljq¿j (Task pane) (  b-iu¾mKh ieliSfï § hï hï úl,am f;dard 

.ekSu i|yd fuu ljq¿j jeo.;a fõ' WodyrK f,i iÔùlrK (Animation)
fh§fï § fuu ljq¿j jeo.;a fõ'

rEmh 8.4.3 ßnkh (Ribbon)
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8  igyka ljq¿j (Notes Pane) ( b-iu¾mKfhaa wod< lodjlg wjYH jk igykla 

fh§u i|yd Ndú; l< yels h' fufia we;=<;a lrkq ,nk igyka iu¾mKh 

Odjkh ùfï § fndfyda úg krUkakkaf.ka ieÕù mj;S'

9'  ;;a;aj ;Srej (Status bar) ( b-iu¾mKfha ilid we;s lod .Kk" oekg f;dard 

f.k we;s lodfõ wxlh" f;dard f.k we;s NdIdj hkdÈ úia;r fuys oelafõ' 

10'  oiqka ;Srej (View Tab) ( MS Office ljq¿fõ lod fmkajk wdldrh fuu oiqka 

;Srefõ ksrEml (Icon) u.ska yqjudre lr .; yelsh' tys we;s ksrEml my;ska 

úia;r fõ' ^rEmh 8'4'4&

oiqka ;Srej  (View Tab)
rEmh 8.4.4 oel=ï ;Srej (View Tab)

Normal View 
idudkH oiqk

Slide Sorter View 
lod iqfnÿï oiqk

    Slide Show 
iu¾mK rduq oiqk

Reading View
lshjqï oiqk

• idudkH oiqk (Normal View) ( w;=re uqyqKf;a  § Tng ,efnkqfha fuu oiqka 

;srhhs' fuu oiqka ;srfha isg Tng iu¾mKh ks¾udKh lsÍu l< yels h'  

• ia,hsv iqfnÿï oiqka (Slide Sorter View) ( iu¾mKfha wvx.= ish¨ u lod 

l=vdjg fmkajhs' tu lod wkqms<sfj< h<s ielish hq;= kï Bg wjldY ,efí' 

kej; idudkH oiqka ;srh fj; fhduq ùug wod< lod u; oaú la,sla lsÍu u.ska 

o yels fõ'

• lshjqï oiqk (Reading View) ( f;dard f.k ;sfnkakd jQ lodjlaa mQ¾K ;srfha 

oelafjk whqßka u fuu oiqk ;=<ska oel .; yels h' lodjla ;=< ;sfnk ish¨ 

foa fuys § meyeÈ,s j lshjd ne,sh yels h' bka bj;a ùug Esc h;=r la,sla 

lsÍfuka l< yels h' 

• iu¾mK rduq oiqk (Slide Show) ( oekg f;dard f.k ;sfnk lodjla iïmQ¾K 

ljq¿j mqrd oel .ekSu i|yd fuu ksrEmlh (Icon) u.ska yelshdj ,efí' 

b-iu¾mKhlaa fma%laIlhdg bÈßm;a lsÍu i|yd o fuu ksrEmlh fhdod .; 

yels h'  óg wu;r j F5 h;=r la,sla lsÍfuka iu¾mKh uq, isg kerôh yels 

h' 

11' iQuh (Zoom control) (  b-iu¾mK ;srfha wvx.= oE úYd,kh lr ne,Sug fuu 

Wml%uh fhdod .kq ,nhs'
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8'5  LibreOffice Impress wdrïN lsÍu
    

my; úOdkh u.ska LibreOffice 4.1 b-iu¾mK uDÿldx.h Tng újD; lr 

.; yels h'

Start  → All Programs → LibreOffice 4.1 → LibreOffice Impress ^fufyhqï 

moaO;sh wkqj fjkia úh yels h'&

 by; rEmfha ±lafjkafka LibreOffice uDÿldx. lÜg,hl w;=re uqyqKf;ys 

rEm igykls' fuys oelafjk fndfyda fuj,ï LibreOffice joka ieliqï uDÿldx.

fha o olakg ,efí' 

1' ud;Dld ;Srej (Title bar) ( wdrïNl ljq¿fõ by<ska u oelafjk ;Srej fuh 

hs' fuys uDÿldx.fha ku fmkajhs' újD; j we;s iu¾mKfha ku o fmkajhs' 

Bg wu;r j ljq¿j yl=<d oeófï fnd;a;u (Minimize), l=vd lsÍu yd kej; 

msysgqùfï fnd;a;u (Maximize / Restore), ;srh jid oeófï fnd;a;u (Close) 
wdÈh o ol=Kq fl<jf¾ msysgd we;'

rEmh 8.5.1 LibreOffice 4.1  Impress jev ;,h
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2'  úOdk ;Srej (Menu Bar) ( b-iu¾mKh ieliSu i|yd wjYH ish¨ u úOdk 

fuu.ska ,nd .; yels h'

3' iïu; fuj,ï  ;Srej (Standard Tool Bar) ( úOdk ;Srefõ we;=<;a úOdk Ndú; 

lsÍfï myiqj fjkqfjka rEml (Icons) f,iska fuys wka;¾.; lr we;'

4' ia,hsv ljq¿j (Slide Pane) ( wdrïNl ;srfha jï miska isria j msysgd we;af;a 

fuu ;Srejhs' fuu ;Srej f;dard we;s úg rduq oel .; yelafla l=vdjghs' wjYH 

l=vd rduqj u; uQislh la,sla l< úg ljq¿j ueo úYd,kh ù wod< rEm rduqj 

Èia fõ' túg tu rduqfõ ixialrK fyda ksuejqï lsÍug yelshdj ,efí'

5'  jev ;,h (Workspace) (  b-iu¾mKh ieliSu fuys isg isÿ lrkq ,nhs'

6'  ld¾h ljq¿j (Tasks Pane) ( ld¾h ljq¿j 

fldgia mylska hqla; h' fldgia my u wdrïNl 

;srfha § újD; j ke;s w;r tlsfkl È. yeÍu 

i|yd wod< jpkh u; la,sla l< hq;=hs' ^rEmh 

8'5'2&

• .=re msgq (Master Pages) ( fuu.ska iu¾mK yd 

tys yevh (Style) ilid .; yels h' uDÿldx.h 

úiska u ieliQ .=re msgq (Slide Master) lsysmhla 

o wvx.= lr we;'

• lod msßjeiqu (Layouts) ( fmr ieliQ lod 

msßjeiqu (Layouts) uDÿldx.h ;=< r|jd ;sfí' 

wjYH msßjeiqï f;dard .ekSug fyda jeä ÈhqKq 

lr Ndú; lsÍug bv i,id we;'

• j.= ks¾udKh (Table Design) ( j.= ks¾udKh 

i|yd yev;, ,nd fohs'  wjYH mßÈ fjkia lr 

.ekSug yelshdj ;sfí'

• iÔùlrK ljq¿j (Custom Animation) ( lod 

;=< wvx.= úúOdldr mdG" Ñ;%l" wdÈh i|yd 

p,k fuka u iÔùlrK .Kkdjla wvx.= lr 

we;' wjYH iÔùlrK tla lsÍu" fjkia lsÍu fyda bj;a lsÍu l< yels h'

   

• lod ixl%uKh (Slide Transition) ( tla oDYH rduqjl isg ;j;a oDYH rduqjlg 

udre ùï úúOdldr whqßka ielish yelshs' ta i|yd wjYH úl,am f;dard .ekSug 

wjia:dj ,nd § we;' fõ.h" Yíoh" iajhxl%Sh lod yqjudrej wdÈ ixialrK 

fuys § ilia l< yels h'
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7.  Ñ;%l fuj,ï ;Srej (Drawing Tool Bar) ( iu¾mKh u; úúO Ñ;%Kh lsÍï 

i|yd wjYH fuj,ï ,nd .; yels h'

8.  ;;a;aj ;Srej (Status bar) ( iu¾mKfhaa ilid we;s rduq .Kk" oekg f;dard 

f.k we;s rduqfõ wxlh" f;dard f.k we;s NdIdj" md,lh hkdÈ úia;r fuys 

fmkajhs' 

rEmh 8.5.3 ;;a;aj ;Srej (Status bar)

9.  md,lh (Zoom control) (  b-iu¾mK ;srfha wvx.= oE úYd,kh lr ne,Sug   

fuu Wml%uh fhdod .kq ,nhs'

8.6  Microsoft Office Presentation…                                
lodfjyss m%udKh (Slide Size) ilia lsÍu

b-iu¾mKfhaa lodfõ m%udKh (Slide Size) 
ilia lr .ekSu wjYH;dj wkqj isÿ úh hq;= 

h' lod j¾.h" È. m<," m%udK" ÈYdk;sh 
(Slide Orientation) wdÈh ieliSu fuhska isÿ 

flf¾'  

² Design  → Page Setup ^rEmh 8.6.1 
n,kak&'

rEmh 8'6'1' - Ms PowerPoint uDÿldx.fha  

         msgqieliqï ljq¿j

rEmh 8'5'2 ld¾h ljq¿j (Tasks 
Pane)

msgq ieliqï ljq¿j LibreOffice 
Impress... 

lodjl  m%udKh (Slide Size) ilia lsÍu' 

Format  → Page
b-iu¾mKfhaa lodj, m%udKh (Slide 
Size) ilia lr .ekSu tys wjYH;dj 

wkqj isÿ úh hq;= h' lod j¾.h" È. m<," 

m%udK" ÈYdk;sh (Slide Orientation) wdÈh 

ieliSu isÿ flf¾' ^rEmh 8'6'2 n,kak'&

rEmh 8'6'2' LibreOffice Impress  
uDÿldx.fha msgq ieliqï ljq¿j
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T*sia msßie,iqï (Office Theme / Slide Layouts)
 msgqj wjYH m%udKhg ilia lr .;a miq ks¾udKh lsÍug n,dfmdfrd;a;= 

jk iu¾mKhg msßie,iqï (Office Themes / Slide Layouts) f;dard .ekSu l< yels 

h' MS Office yd LibreOffice w;r iq¿ fjkialï we;'

Microsoft Office Presentation...
• Home → New Slide fyda Layout → 

Office Theme túg ,efnk office 
Theme ljq¿fjys ;sr msgm;la  ̂ rEmh 

8'6'3&  

•  iu¾mKhg wjYH ie,iqï wdlD;sj, 

udos,s lsysmhla fuu.ska f;dard .; 

yels h' fjk;a msßie,iqï wdlD;s 

imhd .ekSu i`oyd Slides From 
Outside úOdkh Tiafia o yels h'

• Reuse Slide úOdkh u.ska ilia lrk 

,o m%o¾Ylh msßie,iqï oeka ksujk 

iu¾mKhg we;=<;a lr .; yels h' 

rEmh 8'6'3 T*sia msßie,iqï 

      (Office Theme)

LibreOffice Impress...
• Format → Slide → Layout^,efnk 

ld¾h ljq¿fjka oDYH rduq wdlD;s 

fyj;a msßie,iqï f;dard .ekSu l< 

yels h' ta u; uQislh la,sla lrkak' 

iu¾mKhg wjYH lod wdlD;sj, 

udÈ,s lsysmhla fuu.ska f;dard .; 

yels h' msgm;la ^rEmh 8'6'4&

• Format → Slide Layout Master Pages 
→ uDÿldx.h úiska u fmr ilik 

,o msßie,iqï .Kkdjla f;dard 

.ekSug wjia:dj i,ihs' w,xldrj;a 

f,i tajd ilid ;sfí'

rEmh 8'6'4 lod msßie,iqï      

        (Slide Layouts)
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• b-iu¾mKh ks¾udKh i|yd wdrïNl msßie,iqug (Office Theme / Slide 
Layout) ud;Dldjla fh§ug msß ie,iqula f;dard .kak' ta i|yd Title slide 
kï msßie,iqu f;dard .ksuq' oeka Tnf.a b-iu¾mKhg wod< jk ud;Dldjla 

iy Wmud;Dldjla tys h;=re,shkh lrkak' ^rEmh 8'6'5 n,kak'&

   

rEmh 8.6.5 ud;Dld lodj (Title Slide)
Microsoft Office Presentation  LibreOffic Impress

b - iu¾mKhla ksujuq

ta i`oyd kula fhdouq

b - iu¾mKhla ksujuq

ta i`oyd kula fhdouq

²  kej; my; l%shdj,shg fhduq jkak'

Microsoft Office Presentation...

• Home → New Slide fyda Layout Office 
Theme f;darkak' ;j;a w¨;a msßie,iqula 

we;=<;a lrkak'

•  fukq ;Srefõ Slide  Show → From 
Beginning la,sla lrkak' túg  

b-iu¾mKh iïmQ¾K ;srfha oela fõ' F5 
h;=r tîfuka o l< yels h' iu¾mKh 

krUkqfha fuu wjia:dfõ § h' kej; 

uQislh la,sla lr fmr ;srhg tkak'

LibreOffice Impress...
• Format → Slide Layout… → ^,efnk 

ld¾h ljq¿fjka ;j;a oDYH rduq 

wdlD;s fyj;a msßie,iqula f;dard 

we;=<;a lr .kak'

•  fukq ;Srefõ View → Start from first 
Slide la,sla lrkak' Tng b-iu¾mKh 

iïmQ¾K ;srfha Èia fõ'  F 5 h;=r 

tîfuka o l< yels h' iu¾mKh 

krUkqfha fuu wjia:dfõ § h' kej; 

uQislh la,sla lr fmr ;srhg tkak'

• ieliQ b--iu¾mKhlaa iqq/lSu (Saving)

• File → Save As → Folder Name → File Name ^f.dkqjg kula ghsma lrkak'& 
→ Save ^fuu.ska Tfí b-iu¾mKh mß.Klh ;=< iaÓr u;lhl ;ekam;a 

lrkak' túg kej; wjia:djl § újD; lr .; yels h'&
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Microsoft Office Presentation...
• Start → All Programs → 

MicrosoftOffice → Microsoft Office 
PowerPoint 2010 → File → Open →

;ekam;a (Save) l< b - m%o¾Ylfha ku 

f;dard b - m%o¾Ylh újD; (Open) lrkak'

LibreOffice Impress ...
• Start → All Programs → LibreOffice 

4.1→ LibreOffice Impress → File→ 
Open →

;ekam;a (Save) l< b - m%o¾Ylfha ku 

f;dard ;ekam;a l<  b - m%o¾Ylh újD; 

(Open) lrkak'

LibreOffice Impress...

• File → Save as → My Documents → 
file  Folder → File name  ^f.dkqfõ 

ku ghsma lrkak& → Save → túg 

mß.Klfha oDV ;eáfha iaÓr j 

;ekam;a (Save) l< yels h'

Microsoft Office Presentation...

• File → Save as → My Documents 
→ File name  ^f.dkqfõ ku ghsma 

lrkak& → Save → túg mß.Klfha 

oDV ;eáfha iaÓr j ;ekam;a (Save) l< 

yels h'

• ieliQ b-iu¾mKhlaa kej; újD; lsÍu' (Open an existing presentation) 

• lod miq;,h (Slide Background)
 ksu lrk ,o b-iu¾mKhg wjYH lod miq;,h ilid .ekSug o uDÿldx.h 

wjia:dj i,id fohs' tu.ska lodfõ miqìug úúO j¾K tl;= lr .ekSu" yev;, 

rgd ilid .ekSu" mska;+r fyda Ñ;%l wka;¾.; lr .ekSu i|yd myiqjlaa we;s 

lrhs'

 Microsoft Office Presentation...
• Design→ Background Styles
• Background Styles ys we;s ú,di (Styles) 

lodfõ miq;,hg tl;= lr .; yels h' 

^rEmh 8'6'6&  

  rEmh 8'6'6 - miqìï ú,di (Background Styles)
• Background→Format Background 
 ^tu.ska úúO j¾K" yev;, rgd" mska;+r fyda  

Ñ;%l wka;¾.; lr .ekSug W;aidy lrkak'&

 LibreOffice Impress...
• Format →  Page → Background
lodfõ miq;,hg j¾K fyda rgd ilid  

.ekSug fuu.ska wjia:dj i,id fohs' 

^rEmh 8'6'7& 

rEmh 8'6'7 miqìï j¾K

Background colours



253fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs252

• b---iu¾mK lodjlg mdG tla lsÍu' (Adding Text) 

• lodjlg jia;= tl;= lsÍu (Insert Object) 
 wl=re h;=re,shkh lsÍug fmr fyda miq j jia;+ we;=¿ lr .; yels h' 

we;=¿ lr .; yels jia;+ lsysmhla my; oelafõ'

•  yev;, (Shapes / Objects)
•  ksñ rE (Clip Art)
•  Ñ;%l (Pictures)

LibreOffice Impress...

• CLICK TO ADD TITLE → fujeks 

ia:dkhla mdG fldgqj (Text Box) 
kñka ye¢kafõ' tjeks ia:dkhl 

uQislh ;nd la,sla lr h;=re,shkh 

lrkak' wjYH jpk ,shd .; yels 

h'

• mdG fldgq fkdue;s ia:dkhl 

h;=re,shkh lsÍu' 

View → Tool Bars→ Drawing fuu.ska 

ljq¿j ;=<g Ñ;%l fuj,ï ;Srej ,nd 

.; yels h' tys we;s fuj,ï bÕsh (Tool 
Tip) u.ska Text fuj,u u; la,sla lr 

miqj lodfõ wod< ia:dkh u; wÈkak' 

bka ,efnk mdG fldgqj ;=< wjYH 

mdGh ,shd .kak'

(LibreOffice Writer ys Tn bf.k .;a" 

wl=re i|yd fhdod .;a ish¨ u l%shd fuys 

§ fhdod .; yels h'&

Microsoft Office Presentation...

lodjl CLICK TO ADD TITLE  kñka 

oelafjk ia:dkh ;eka orKqj (Place Holder) 
kñka ye¢kafõ' tjeks ia:dkhl uQislh ;nd 

la,sla lr h;=re,shkh lrkak' wjYH jpk 

,shd .; yels h'

;eka orKqj (Place Holder) fkdue;s ia:dkhl 

h;=re,shkh lsÍu'

• Insert → Text Box (Text Box)
     fuj,u la,sla lr oDYH rduqfõ wod<    

     ia:dkh u; wÈkak' miq j             

wjYH mdGh ,shd .kak'&

 Ms Word ys Tn bf.k .;a" wl=re i|yd 

fhdod .;a ish¨ u l%shd fuys § fhdod .; 

yels h'
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• yev;, we;---=<;a lsÍu (Inserting Shapes / Objects)

Microsoft Office Presentation...

• Insert má;af;ys → (Illustration) 
Shape → f;dard f.k .,d yef,k 

fukqfjka wjYH yev;,h uQislh 

la,sla lrñka f;dard f.k lodj u; 

weo.kak' (Drag) bka miq j tys jgd 

we;s l=vd ;=vq uQislh la,sla lrñka weo 

f.k hdfuka wjYH m%udKhg l=vd 

fyda úYd, fyda lr .; yels h'^rEmh 

8'6'5&

rEmh 8'6'8 uQislfhka m%udKh ieliSu'

LibreOffice Impress...

View→ Tool Bars → Drawing → ^ljq¿j 

;=<g Ñ;%l fuj,ï ;Srej ,nd .; yels 

h' tys we;s fuj,ï bÕsh (Tool Tip) u.ska 

wjYH yev;,h u; la,sla lr miq j oDYH 

rduqfõ wod< ia:dkh u; wÈkak(Drag)' 
bka miq j tys jgd we;s l=vd ;=vq uQislh 

la,sla lrñka weof.k hdfuka wjYH 

m%udKhg l=vd fyda úYd, fyda lr .; 

yels h'^rEmh 8'6'6&

rEmh 8'6'6 - uQislfhka m%udKh ieliSu

• yev;, j¾Kh fjkia lsÍï  (Changing the colours of Shapes / Objects)
úúO jQ yev;, b-iu¾mK lodjla u; we| wjYH wdlD;s fyda ta u; wl=re 

rgd fyda ilid .; yels h' ta i|yd my; l%u wkq.ukh lrkak'

• lodjlg ksñ rE we;=<;a lsÍu (Inserting Clip Art / Gallery Theme)
b-iu¾mK ;=<g uDÿldx.h úiska u ilid we;s úúO jQ ksñ rE wka;¾.; 

l< yels h' ta i|yd my; mshjr wkq.ukh lrkak' 

Microsoft Office Presentation...

•  wod< yev;,h u; uQislh ;nd ol=Kq 

mi fnd;a;u la,sla lrkak' ,efnk 

fukqfjka Format Shape ixjdo 

fldgqfjys úl,am fjkia lrñka iqÿiq 

j¾K" rgd" mska;+r yev;,hg tla lr 

.kak'

LibreOffice Impress... 

• View→Tool Bars →Line and Filling  
ljq¿j ;=<g Line and Filling fuj,ï 

;Srej ,nd.; yels h' j¾K .ekaùug 

wjYH yev;,h f;dard (Select) by; 

fuj,ï ;Srefõ bÕsh (Tool Tip) 
u.ska Area Style /Filling f;dard f.k 

j¾K .kajkak' 
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Microsoft Office Presentation...

• Clip Art & Insert má;af;ys (Images) 
Clip Art ^,efnk ld¾h ljq¿fõ Search 
for → bÈßfhka wod< ksñ rE j¾.hl 

kula h;=re,shkh lrkak' my;ska 

,efnk ksñ rejla u; la,sla lrkak'& 

bka miq j tys jgd we;s l=vd ;=vq uQislh 

la,sla lrñka weof.k hdfuka wjYH 

m%udKhg l=vd fyda úYd, fyda lr .; 

yels h'

LibreOffice Impress...

• Drawing Tool Bar → Gallery fyda 

•  úOdk ;Srefõ Tools → Gallery→
•  ,efnk Gallery ixjdo fldgqfjka 

New Theme hgf;a we;s f*da,avr 

újD; lrñka iqÿiq ksñ rejla f;dard 

jev;,hg wÈkak' (Drag)  bka miq j 

tys jgd we;s l=vd ;=vq uQislh la,sla 

lrñka weof.k hdfuka wjYH 

m%udKhg l=vd fyda úYd, fyda lr 

.; yels h'

• mska;+r we;=<;a lsÍu (Inserting Pictures) 
b-iu¾mKhla ;=<g mß.Klh ;=<ska fyda ndysßka fyda úúO mska;+r 

wka;¾.; lr .; yels h'

Microsoft Office Presentation...

• Insert Picture → ̂ ,efnk ixjdo fldgqj 

msßlaikak' .e<fmk mska;+rhla we;=<;a 

lr .kak'&

•  fmr mßÈ tys jgd we;s l=vd ;=vq 

uQislfhka la,sla lrñka weof.k 

hdfuka wjYH m%udKhg l=vd fyda 

úYd, lr.; yels h'

LibreOffice Impress...

•  úOdk ;Srefõ Insert  →Picture → 
From File … ^,efnk ixjdo fldgqj 

msßlaikak' .e<fmk mska;+rhla 

f;dard we;=<;a lr .kak' &

• Insert  → Picture → Photo Album … 

^,efnk we,anu ixjdo fldgqfjys 

Add fnd;a;u la,sla lr mska;+r 

tla lr .kak' miq j Insert Slides 
fnd;a;u la,sla lr mska;+rh we;=<;a 

lr .kak'&

 l%shdldrlu

1.  Tn óg fmr ieliQ —My first presentation˜ kñka mß.Klfha 

iq/ls  b -iu¾mKh újD; l rkak'                                                                                                      

2.  kj msßie,iqula tla fldg .e<fmk ksñ rejla iy Ñ;%lhla 

iqÿiq f,i we;=<;a lrkak'

3.  tu iu¾mKhg u .e<fmk ;j;a kj msßie,iqula tla fldg ùäfhda miqrla 

(Video Clip) yd Bg .e<fmk Yío miqrla (Audio Clip) wka;¾.; lrkak'
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• lodjlska lodjlg ixl%uK ú,di we;=<;a lsÍu (Inserting Slide Transition 
Effects) (

Microsoft Office Presentation...

• Transition má;af;ys (Transition to 
This Slide) ys we;s .e<fmk ú,dihla 

f;dard .kak' rduqjlska rduqjlg úúO 

jQ  iÔùlrK we;=<;a lr is;a .kakd 

f,i ilid .kak'

• Transition má;af;ys (Transition to 
This Slide &→Effect Options → ^u.ska 

iÔùlrKfha Èidjkays fjkialï 

w;ayod n,kak

• Transition → Sound → ^f;dard .;a 

ú,dihla i|yd Yíoh we;=<;a lsÍug 

W;aidy .kak'&

• Transition → Sound →Apply to All 
Slides → ̂ iu¾mKfha ish¨ u lodj,g 

f;dard .;a ú,dih we;=<;a l< hq;= o 

hkak ;SrKh lrkak'&

LibreOffice Impress...
 
•  ^úOdk ;Srefjka& Format → Slide 

Layout… → OR (Tasks Pane) → 
Slide Transition fj;g hkak' 

• Apply to Selected Slide → ^iqÿiq 

ú,dihla f;dard .kak'&

• Modify Transition → Speed ^f;dard 

.;a ú,difha ixl%uK fõ.h fjkia 

lrkak'&

• Modify Transition → Sound → 
^f;dard .;a ú,dihla i|yd Yíoh 

we;=<;a lsÍug W;aidy .kak'&

• Modify Transition → Advanced 
Slide  → On mouse Click / 
Automatically After  → ^f;dard .;a 

ú,dih uQislh la,sla lsÍfuka o 

ke;fyd;a iajhxl%Sh j o l%shd;aul 

úh hq;af;a hkak ;SrKh lrkak'&

• Modify Transition → Apply to 
All Slides  → ^m%o¾Ylfha ish¨ u 

lodj,g f;dard .;a ú,dih we;=<;a 

l< hq;= o hkak ;SrKh lrkak'&

iÔùlrK we;=<;a lsÍu (Animation) 
 lodjl we;=<;a lr we;s mdG" yev;," Ñ;%l" mska;+r wd§ ´kE u jia;=jlg  

iÔùlrK we;=<;a l< yels h' ta i|yd wod< jia;=jla uQislfhka f;dard .kak' 

bka miq my; mshjr wkq.ukh lrkak'

Microsoft Office Presentation...

• Animation má;af;ys→ (Animation) 
^iÔùlrK ldKavfha wvx.= iÔùlrK 

tl;= lr fjki w;ayod n,kak'&

• Animation má;af;ys (Timing) → 
Start ^tys we;s úl,am f;dardf.k 

uQislh la,sla lsÍfuka fyda fkdue;s j" 

iÔúlrKhla iajhxl%Sh j l%shd;aul 

lr .ekSug wjYH ;;a;ajh ilikak'&

LibreOffice Impress ...
^úOdk ;Srefjka & Format → Slide Layout …  
→ (Tasks Pane) → Custom Animation fj;g 

hkak' 

• Custom Animation → Modify effect 
→ Add → ^,efnk Custom Animation 
ljq¿j ;=<ska f;dard .;a jia;=jg leu;s 

iÔùlrKhla tl;= lr .kak' tu ljq¿fõ 

Entrance, Emphasis, Exit, Motion Paths, 
Misc, Effects wdÈ jYfhka má;s lsysmhl 

u iÔùlrK ú,di wvx.= fõ' fïjd 

tlsfklg fjkia jQ iÔùlrK ú,di 

olajhs'&
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•  ^rEmh 8'6'11 n,kak'&

rEmh 8'6'11 iÔùlrK tlalsÍu

Custom Animation → Modify effect → 
Change → ^fmr f;dard .;a ú,dihla 

kej; fjkia lsÍug yels h'& Custom 
Animation → Modify effect → Remove  
→^f;dard .;a ú,dihla bj;a lr .;  

yels h'&

• Animation má;af;ys (Timing) 
→ Duration / Delay → Start ^úl,am 

f;dardf.k iÔùlrKhla iajhxl%Sh j 

l%shd;aul lr .ekSfï ld,h wjYH mßÈ 

wvq jeä lr .kak'& ^8'6'10 rEmh&

rEmh 8'6'10 iÔùlrK ld,h

• Animation má;af;ys  (Advanced 
Animation) → Animation Pane → 
^iÔùlrK ljq¿j ,nd .kak' tu.ska 

we;=<;a l< iÔùlrK uld oeóu" 

fjkia lsÍu" fhdod .;a iÔùlrK yev 

.ekaùu" iÔùlrKhla yev ;,hlg fyda 

fnd;a;ula ;=<ska l%shd lrùu wdÈh l< 

yels h' w;ayod n,kak'&

• Yío we;=<;a lsÍu (Inserting Sounds) (-
b-iu¾mK i|yd Yío f.dkq we;=<;a l< yels h' my; mshjr wkq.ukh lrkak'

Microsoft Office Presentation...

Insert má;af;ys → Media& →Audio (fuys 
Media from File ..,Clip Art Audio… iy  
Record Audio … hkqfjka úl,am ;=kla 

we;'&

Media from File.., → ^mß.Klh ;=< fyda 

ndysßka ;sfnk y~ f.dkqjla (Media File) 
fuu.ska iu¾mKhg tl;= lr .kak'&

Record Audio → ^uhsl%fmdakhla 

mß.Klhg iïnkaO fldg tu.ska ,nd 

.kakd Yíoh mß.Kl u;lhg we;=<;a lr 

.; yels h' wod< Record Audio úl,amh 

la,sla l< úg ,efnk ixjdo fldgqfjys 

ÿUqre ;s;la iys; fnd;a;u la,sla lr Yíoh 

;eá.; lr .kak'

LibreOffice Impress...
Yío we;=<;a lsÍu (Sounds)

•  ^úOdk ;Srefjka& Insert → Movie and 
Sound  ^,efnk ixjdo fldgqfjka 

we;=<;a l< hq;= Yío miqr msßlaid 

újD; lr .kak' wka;¾.; lr .;a 

Yío miqrg iqÿiq iÔjlrKhla ,nd 

fokak'&

•  uhsl%fmdakhla u.ska má.; lrkq 

,enQ Yío miqrla jqj o by; whqßka 

b-iu¾mKhlg we;=<;a lr .; yels 

h'
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• ùäfhda wka;¾.; lsÍu  (Video)

Microsoft Office Presentation...
• Insert má;af;ys Media → Video ^fuys 

Video from File.., Video from Web 
Site.., iy Clip Art Video... hkqfjka 

úl,am ;=kla we;'

• Video from File.. → ^mß.Klh ;=< 

fyda ndysßka ;sfnk ùäfhda f.dkqjla 

(Video File) fuu.ska iu¾mKhg tl;= 

lr .kak' &

• Video from Web Site.. ^ùäfhda 

f.dkqjla wka;¾cd, .; fjí msgqjlska 

iu¾mKhg tl;= lr .kak'&

• Clip Art Video… → ̂ksñ rE wdldrfhka 

ilid we;s ùäfhdajla iu¾mKhg 

tl;= lr .kak' &

LibreOffice Impress...

•  ^úOdk ;Srefjka & Insert → Movie 
and Sound  → ^,efnk ixjdo 

fldgqfjka we;=<;a l< hq;= ùäfhda 

miqr msßlaid újD; lr .kak'&

•  wka;¾.; lr .;a ùäfhda miqr 

^Clip& wjYH m%udKhg úYd, lr 

.kak'

•  tu ùäfhda miqr i|yd iÔjlrKhla 

we;=<;a lrkak'

• b-iu¾mKh uqøKh lsÍu (Printing Presentation)
File → Print  →fuu.ska b-iu¾mKh uqøKh i|yd uqølhg úOdk l< 

yels h' tys § ,efnk fonia ljq¿fõ úl,am u.ska my; ld¾hhka bgq lr .; 

yels h'&

 l%shdldrlu

1. Tn óg fmr ieliQ ''My first presentation'' kñka mß.Klfha 

iq/ls (Save)  b-iu¾mKh újD; lrkak'

2.  thg my; i|yka iÔúlrK we;=<;a lrkak'

•   ixl%uK ú,dihla (Slide Transitions)
• we;=<;a l< jia;=jlg (Object) wNsu; iÔúlrKhla 

(Custom animation)
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Microsoft Office Presentation...
• Printer (- ^mß.Klhg wE|d we;s uqøK 

hka;%  f;dard .; yels h& ^rEmh 8'6'12&

• Settings (- ^ish¨ u lod m%udKh u 

uqøKh l< hq;= o@ ksYaÑ; wxls; lod 

lsysmhla fyda f;dard .;a lod muKla 

uqøKh lsÍug fuys we;s úl,am Ndú; 

lrkak'&

     rEmh 8'6'12 uqøKh lsÍu

•  wjYH;dj u; uqøKh" lvodisfha 

m%udKhg wkqj úYd, fyda l=vdjg 

ilid .; yels h'

LibreOffice Impress...
• General má;a; → Printer ^uqøK 

hka;%h f;dar .kak'&

• Range and copies (- ^ish¨ u lod 

m%udKh u uqøKh l< hq;= o @ 

ksYaÑ; wxls; ia,hsv lsysmhla fyda 

f;dard .;a lod muKla uqøKh 

lsÍug fuys we;s úl,am Ndú; 

lrkak'&

• Number of copies (- ^wjYH msgm;a 

ixLHdj ;SrKh lrkak'&

• Print (- ^fuys oelafjk Document 
bÈßfha we;s fldgqj ;=<ska wjYH jk 

úl,am f;dard Bg wkq.dó uqøK ,nd 

.kak'& ^rEmh 8'6'13&

                  rEmh 8'6'13 

•  wjYH;dj u; uqøKh" lvodisfha 

m%udKhg wkqj úYd, fyda l=vdjg  

ilid .; yels h'

   l%shdldrlu

•  b-iu¾mKhla o¾Yl ;srhlg fuka u w;a m;%sldjlg o fhdod .; 

   yelsh'

² Tng b-iu¾mKhla mß.Kl ;srhl kerôh yels h' tfy;a úYd, msßilg 

keröug kï úYd, ;srhlg fhduq l< hq;=h' tfia u b-iu¾mKfha uqøs; 

msgm;la iNdfõ isák ishÆfokdg o ,ndÈh yels h' 

 

² File → Print u.ska ,efnk fonia ljq¿fõ w;a m;%sld (Handouts) úl,am 

u.ska ,nd .; yels uqøKh iNdfõ ishÆ fokdg u msgm;a jYfhka fnodÈh 

yels h' tu uqøs;fha lod rEmhkag mfilska" krUkakdg wjYH hula igyka 

lr .ekSug o wjldYh ilid fokq ,nhs' ^rEmh 8'6'14&
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   l%shdldrlu

1'  Tn bf.k .;a by; mshjr wkq.ukh lrñka kj 

     iu¾mkhla ks¾udK lrkak'

2'   ta i|yd iqÿiq msßie,iqula f;dard my; ia,hsvfha wvx.=  

      ud;Dldj iy Wmud;Dldj we;=<;a lrkak'

3.  b-iu¾mKhlaa ks¾udKh lsÍfï § 8'2 ys i|yka lr we;s uQ,sl ,laIKj,g   

wu;r j Tng jeo.;a hehs yef`.k ;j;a ,laIK fidhd ,ehsia;= .; lrkak'

4. Tn W.;a mdvula ks¾udKYS,S j yd myiqfjka isiqkg wjfndaO jk f,i 

bf.kSu i|yd b-iu¾mKhla ks¾udKh lrkak' tys my; i|yka oE wvx.= 

lrkak' mdvu úia;r lrk mdGhkag wu;r j mska;+r" mdvug wod< pdÜ" 

iÔùlrK" Yío miqre" ùäfhda miqre" tlsfklg fjkia miqìï j¾K iy 

lodjlska lodjlg wdmiq ixl%uKh ùug Wml%u fhdokak'

5. mka;s ldurfha l¿,E,af,a we| úia;r lr §ug wmyiq kuq;a nyqudOH  

bf,lafg%dksl iu¾mKhlskaa myiqfjka ;yjqre l< yels Tn leu;s úIh  

fldgila b-iu¾mK uDÿldx.hla weiqßka ks¾udKh lrkak'

     iu¾mkhla ks¾udK lrkak'

      ud;Dldj iy Wmud;Dldj we;=<;a lrkak'
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fuys i|yka yß; mß.Kl ms<sn| ixl,amh lshjd wjYH wu;r lreKq 

fmd;am;a" iÕrd yd yels kï wka;¾cd,h u.ska .fõIKh lr Tfí 

.=re Nj;df.a iydhfhka b-iu¾mKhlaa ks¾udKh lrkak'

my; i|yka oE jeä ÿrg;a tys uqiq lrkak'

• iqÿiq ud;Dldjla iÔùlrK iys; j

• .e<fmk mska;+r lsysmhla

• flá ùäfhda miqrla (video clip)
• lgy~ iys; Yío miqrla (Sound clip)
• mßYS,lhdg Wojq f.k fok úêu;a fukqjla

• ia,hsvfhka i,hsvhg .uka lsÍug fnd;a;ï

• yß; mß.Kl ms<sn| ks.ukhla

l%shdldrlï 

Green computing …
yß; mß.Kl '''

 yß; mß.Kl hkqfjka woyia lrkqfha ksjerÈ j mß.Kl iïm;a 

mßyrKh" wOHhkh yd m%dfhda.sl j Ndú; lsÍuhs' fujeks jevigykl uQ,sl 

wNsm%dh jkqfha ;sridr mokula u; ixúOdkd;aul j iy iudc.; j  id¾:l;ajh 

;=<ska wkd.; f,dalh hym;a lsÍug úysÿKqq w.h yd Wmudk j¾Okh lsÍuhs' 

 kQ;k f;dr;=re ;dlaIK moaO;s ixlS¾K udkj iïñY%Khlska hq;= j 

cd, yd oDVdx. u; /§ mj;S' yß; mß.Kl uq, msßh hq;af;a iajNdj O¾uhd yd 

úêu;a j ne`ÿKqq mdßißl m%Yak úi÷ul fldgila f,i h' Ndú; lrkakdf.a 

iEySu" kej; ms<sfh, lsÍfï l<ukdldß;ajh" úêu;a bf,lafg%dak wmøjH 

neyer lsÍu" ksrjoH úÿ,s ixfoaYkh" ish¨ iïm;ays ;;a;ajlrKh" wrmsßueiqï 

Yla;s Ndú;h" ÿ¾j, fkd jQ wkq.%dyl úi÷ï" yd wdfhdackh kej; ,eîu wdÈ 

oE wvx.= jkafka h'
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² m%o¾Ylhla iy b-iu¾mkhla w;r fjki jgyd .ekSu

² .=Kd;aul b-iu¾mkhl wvx.= úh hq;= ,laIK

² m%o¾Yl uDÿldx.j, we;s uQ,sl ,laIK Ndú; lrñka is;a.kakd iq¿ nyqudOH 

b-iu¾mkhla ks¾udKh lsÍu

² lodmiq;,h" lod wdlD;s" lod msß ie,iqï fhdokq ,nk wdldrh mshjfrka 

mshjr wkq.ukh lrñka b-iu¾mkhla ks¾udKh lsÍu

² b-iu¾mkhl wvx.= lod ;=<g iqÿiq mska;+r fyda rEm igyka we;=<;a lsÍu

² b-iu¾mkhlg lod ixl%uKhka we;=<;a lsÍu

² b-iu¾mkhla i|yd iÔúlrK wdfoaY lsÍu

² b-iu¾mkhla uqøKh lr .ekSu

idrdxYh
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fuu mdvu yeoEÍfuka Tng :

²  o;a; iuqodh ms<sn| ks¾jpk

²  o;a; iuqodh Ndú;fha jdis

²  o;a; iuqodhl iqúfYaIS ,laIK

²  j.= ks¾udKh i|yd lafIa;% Ndú;h

²  h;=re lafIa;% y÷kd .ekSu

²  iïnkaê; o;a; iuqodh 

²  j.= w;r mj;sk iïnkaO;d 

²  f;dr;=re ,nd .ekSu i|yd úuiqu Ndú;h

²  o;a; wdlD;s m;% Ndú;h

²  f;dr;=re bÈßm;a lsÍu i|yd jd¾;d Ndú;h

  ms<sn`o ukd wjfndaOhla ,nd .ekSug yels jkq we;'

 9'1      o;a; iuqodh ixl,amh
o;a; iuqodhl wjYH;dj l=ula o hkak úuid n,uq'

Tn o;a; iy f;dr;=re ms<sn| j ukd wjfndaOhla m<uq mdvfï § ,nd 

f.k we;ehs is;uq' o;a; ixúOdkd;aul j ;eïm;a lsÍu ms<sn| j fuu tallfhka 

lreKq bÈßm;a lruq'

o;a; m%udKh jeä jk úg u;lfha r|jd .ekSu wmyiq ld¾hhls' fujeks 

wjia:dj, o;a; ,sÅ; j igyka lr ;nd .ekSu tla l%uhls' fuu l%uh w;ahqre 

o;a; iuqodh ^manual database& f,i y÷kajuq' tfia fkdue;s kï bf,lafg%dksla 

wdphk udOHhla ;=< ;eïm;a lr ;nd .ekSu wfkla l%uhhs' fuu l%uh 

bf,lafg%dksl o;a; iuqodh ̂ electronic database& f,i y÷kajuq' o;a; iuqodh ;=<ska 

l%udkql+, j o;a; ;eïm;a lsÍfuka kej; wjYH jQ wjia:djl ld¾hlaIu j ,nd 

.ekSug yels h' tneúka o;a; úYd, m%udKhka ;eïm;a lsÍu i|yd;a ;eïm;a l< 

o;a; b;d blaukska ,nd .ekSu i|yd;a o;a; iuqodh m%fhdackj;a fõ'

9 o;a; iuqodh
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 Tnf.a hy¿jkaf.a kï u;l ;nd .ekSu Tng ;rula myiq ld¾hhla 

jqj o, Tjqkaf.a kï iy ish¨ ÿrl:k wxl o u;lfha r|jd ;nd .ekSu ;rula  

wiSre ld¾hhla nj jegfykjd we;' fï i|yd fmd;l ku iy ÿrl:k wxlh 

,shd ;nd .ekSfuka ^rEmh 9'1& fyda cx.u ÿrl:kj, ;eïm;a lr ;nd .ekSfuka  

^rEmh 9'2& fyda wjYH wjia:djl myiqfjka kej; ,nd .ekSug yels fõ' ta wkqj 

ÿrl:k wxl fmd; ^Phone book& ir, o;a; iuqodhla ^Database& f,i ie,lsh 

yels h'

rEmh 9'1 - ÿrl:k wxl ^w;ahqre& rEmh 9'2 -  ÿrl:k wxl ^bf,lafg%dksl&

 

o;a; iuqodh w¾: oelaùu

ixúOdkh jQ o;a;j, tl;=jla o;a; iuqÞhla f,i w¾: oelafõ' 

9'1'1 bf,lafg%dksl o;a; iuqodhl (Database) jdis 

bf,lafg%dksl o;a; iuqÞhl jdis /ila mj;sk w;r bka lsysmhla my; 

±lafõ'

 ² f;dr;=re fiùu jvd ld¾hlaIu ùu : o;a; iuqodhl o;a; ukd j j.=j, 

 ixúOdkh lr we;s neúka wjYH f;dr;=re b;d flá ld,hla we;=<;  

 fidhd .ekSug yelshdj we;' 

 ² Wmia: msgm;a ,nd .ekSfï myiqj : bf,lafg%dksl udOHhl mj;sk o;a;  

 iuqodh b;d myiqfjka msgm;a lsÍug yelshdj we;'

 ² o;a; ;eïm;a lsÍug b;d wvq wdphk Odß;djla jeh ùu : úYd, o;a;  

 m%udKhla w;ahqre o;a; iuqodh wdldrfhka mj;ajd .ekSug jeä fN!;sl  

 wjldYhla jeh jqj o" bf,lafg%dksl udOHfhka o;a; ;eïm;a lsÍug b;d  

 wvq wdphk Odß;djla  jeh ùu'

 ² o;a; úYaf,aIKh b;d myiqfjka yd fõ.j;a j isÿ lsÍfï yelshdj : o;a; 

w;ßka wjYH tajd muKla fjka lr .ekSu yd wkqms<sfj<ska ieliSu isÿ 

lsÍug yelshdj we;' 

 WodyrK 
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 ² o;a; yjqf,a Ndú;h : tl u o;a; iuqodh úúO fhÿï uDÿldx. w;r yjqf,a 

Ndú; lsÍug yels ùu'

 ² o;a;j, iajdh;a;;dj : o;a; iuqodh iy fhÿï uDÿldx. taldnoaO j 

l%shd;aul jqj o fhÿï uDÿldx.j, fjkila fkdlr o;a; iuqodh j.=j, 

fjkialï lsÍug yelshdj we;' tneúka o;a; iy fhÿï uDÿldx. tlsfkl 

iajdh;a; j mj;S'

9'1'2  o;a; iuqodhl ,laIK

 ² o;a; iu;sßla;;dfjka úhqlal nj : o;a; ;eïm;a lsÍfï § tl u o;a; j.= 

lsysmhl ;eïm;a ùu o;a; iu;sßla;;dj ^Data Redundancy& f,i 

 ye`Èkafõ' 

 ksoiqkla jYfhka mdi,a YsIfhl=f.a ku we;=<;a ùfï f,aLkfha o" 

mqia;ld,fha idudðl f,aLkfha o fjka fjka j igyka flf¾' isiqjl=f.a ku 

fjkia l< wjia:djl iEu f,aLkhl u fjk fjk u tu ku ixfYdaOkh l< 

hq;= fõ' *sfrdaid ,dhs f,i igyka lr we;s ku *sfrdaid r*Sla f,i fjkia l< 

wjia:dj n,kak'

 j.=j 9'1 - we;=<;a ùfï f,aLkh

YsIH 

wxlh

ku Wmka Èkh we;=<;a jQ 

Èkh

Ndrlref.a 

ku

100 ufkdaÊ ohdr;a; 2$9$2008 1$1$2014 Ô'ohdr;ak

101 *sfrdaid ,dhs 

r*Sla

4$2$2008 1$1$2014 fla'*dhsia

        

         j.=j 9'2 - mqia;ld, idudðl f,aLkh

isiqjdf.a 

ku

fmdf;a 

ku

,nd .;a 

Èkh

Ndr Èh hq;= 

Èkh

*sfrdaid ,dhs r*Sla ck .dhkd 2$9$2014 16$9$2014

ufkdaÊ ohdr;a; kdgH yd rx. 

l,dj

3$9$2014 17$9$2014

*sfrdaid ,dhs r*Sla uQ,sl .Ks; 

ixl,am

3$9$2014 17$9$2014

ufkdaÊ ohdr;a; kdgH yd rx. 

l,dj

4$9$2014 18$9$2014

 

 tfy;a iïnkaê; o;a; iuqodh j.=j, o;a; ;eïm;a lsÍfuka fuu o;a; 

iu;sßla;;dj ke;s l< yels h$wju l< yels h' my; j.=j,ska isiqjl=f.a ku 

i|yka j we;af;a tla j.=jl mu‚'
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   j.=j 9'3 - iïnkaO;d o;a; iuqodh (Relational Database)

 ² o;a;j, ix.;;dj mej;Su : o;a; iu;sßla;;dj (redundency) ke;s lsÍfuka  

 $md,kh lsÍfuka tl u o;a; úúO j.=j, ;eïm;a ùu kej;sh yels h$wju  

 l< yels h' túg o;a;j, ix.;;dj ^Consistency& mj;ajd .ekSug yels  

 fõ'

by; iïnkaO;d iys; j.= n,kak' YsIH o;a;" fmd;a ms<sn| o;a; iy fmd;a 

mßyrKh ms<sn| o;a; fjk fjk u j.=j, mj;sk neúka isiqfjl=f.a ku" 

fmd;l ku wdÈh igyka l< hq;af;a tla jrla mu‚' tneúka o;a;j, 

ix.;;dj mj;S'

 ² ld¾hlaIu;dj jeä ùu : o;a; iuqodh j.= ukd j ixúOdkh ù we;s neúka  

 o;a; ;eïm;a lsÍu iy o;a; ,nd .ekSu ^lshùu& b;d fõ.j;a j isÿl<  

 yels h' tneúka ld¾hlaIu;dj ^Efficiency& b;d jeä h'

  by; WodyrKfha mßÈ *sfrdaid ,dhs f,i igyka j we;s ku *sfrdaid 

r*Sla f,i fjkia l< wjia:dj i,luq' tys § tl u o;a;h ^*sfrdaid ,dhs& 

úúO j.=j, ;eïm;a j we;s úg j.=j 9'2 tjeks ish¨ ;eka fiùug jeä 

ld,hla .;fõ' tneúka th wld¾hlaIu;djg fya;= fõ' tfy;a iïnkaO;d 

iys; o;a; iuqodhj, § ̂ j.=j 9'2& o;a;j, ix.;;dj ksid fõ.j;a nj jeä 

h' tneúka ld¾hlaIu;dj jeä fõ'

YsIH 

wxlh

ku Wmka Èkh we;=<;a jQ 

Èkh

Ndrlref.a 

ku

100 ufkdaÊ ohdr;ak 2$9$2008 1$1$2014 Ô'ohdr;ak

101 *sfrdaid r*Sla 4$2$2008 1$1$2014 fla'*dhsia

YsIH 

wxlh

fmdf;a 

wxlh

,nd.;a

 Èkh

Ndr Èh hq;=

 Èkh

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

fmdf;a 

wxlh

ud;Dldj l¾;Df.a ku

1111 uQ,sl .Ks; 

ixl,am

isjodika rdukdoka

2222 ck .dhkd chka; nKavdr

3333
kdgH yd 

rx. l,dj

moauud,S ueKsfla
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 ² ksrjoH;dj jeä ùu : o;a; iuqodhj, o;a; iu;sßla;;dj md,kh l< yels  

 neúka o;a;j, ix.;;dj wdrlaId ùu ksid ,nd .kakd f;dr;=rej, 

 ksrjoH;dj ^Accuracy& b;d jeä h'

 by; WodyrKfha mßÈ *sfrdaid ,dhs f,i igyka j we;s ku 

*sfrdaid r*Sla f,i fjkia l< wjia:dj i,luq' *sfrdaid ,dhs fjkqjg 

*sfrdaid r*Sla f,i ia:dk lsysmhl § ksjerÈ  lsÍfï § hï ;ekl w;miq 

ùula jQ úg ,nd .kakd f;dr;=re fodaI iys; fõ'

 tfy;a iínkaê; o;a; iuqodh j.=j, tla j.=jl muKla *sfrdaid 

,dhs fjkqjg *sfrdaid r*Sla f,i fjkia l< neúka o;a;j, ix.;;dj 

wdrlaId ùu ksid ,nd .kakd f;dr;=rej, ksrjoH;dj b;d jeä h'

 ² j,x.=;dj jeä ùu : o;a; iuqodh ie,iqï lsÍfï § lafIa;%j, .=Kdx. wjYH  

 mßÈ fjkia lsÍfuka  o;a; we;=<;a lrk fudfydf;a § tajdfha j,x.=;dj  

 mÍlaId l< yels neúka o;a; iuqodfha j,x.=;dj ^Validity& jeä fõ'

 o;a; iuqodh j.=jla ks¾udKh lsÍfï § o;a; m%rEmhg wod< .=Kdx. 

ilia lsÍfuka o;a;j, j,x.=;dj jeä lr .ekSug yels fõ'

 WodyrK f,i .dia;= m%udKh oYuia:dk follg oelaùug iy 

f.úh yels wju .dia;=j 1000la o th wksjd¾fhka u wdodkh l< hq;= 

wdldrhg  .=Kdx. ilia lr we;'

rEmh 9'3 - o;a; m%rEmhg wÞ, .=Kdx.
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 ² wdrlaIdj : o;a; iuqodhg uqrmo fh§fuka yd o;a; .=ma;fla;kh lsÍfuka  

 wkjir m%fõY yd l%shdldrlï isÿ ùug we;s bvlv iSud ùfuka o;a;j,  

 wdrlaIdj (Security) ;yjqre fõ'

 o;a; .=ma;fla;kh (Data Encription) hkq wkjir mqoa.,hskag lshúh 

fkdyels jk mßÈ o;a; mßj¾;kh lr,Suhs' my; rEmfha oelafjk mßÈ Employee 
Table ys we;s o;a; .=ma;fla;kfhka miq ndysr mqoa.,fhl=g y÷kd .; fkdyels 

o;a; njg m;a ù we;'

9'1'3 bf,lafg%dksl iy w;ahqre o;a; iuqodh

 bf,lafg%dksl o;a; iuqodh ks¾udKh lsÍu yd b;d myiqfjka ish¨ Y%jH  

yd oDYH udOH iys; o;a; b;d l=vd wdphk udOHhla ;=< ;eïm;a l< yels ùu 

úfYaI;ajhls' w;ahqre o;a; iuqodh iu. iei`§u i|yd j.=j 9'4 n,kak'

j.=j 9'4 - bf,lafg%dksl iy w;ahqre o;a; iuqodh ixikaokh

w;ahqre o;a; iuqodh  bf,lafg%dksl o;a; iuqodh

ld¾hlaIu;dj wvq h ld¾hlaIu;dj jeä h

ksrjoH;dj wvq h ksrjoH;dj jeä h

úYajdikSh;ajh wvq h úYajdikSh;ajh jeä h

o;a; úYaf,aIKh wiSre h o;a; úYaf,aIKh myiq h

wdodkh l< wkqms<sfj<ska u ±laùug 

isÿùu

wdodk wkqms<sfj< fjkia lr 

±laùug we;s yelshdj

wkjYH o;a; uelSu ^bj;a lsÍu& 

wmyiq h

wkjYH o;a; uelSu ^bj;a lsÍu& 

myiq h

o;a; hdj;ald,Sk lsÍu wmyiq h o;a; hdj;ald,Sk lsÍu myiq h

;eïm;a lsÍug jeä wjldYhla wjYH 

ùu

;eïm;a lsÍug b;d wvq wjldYhla 

wjYH ùu

ñksia Y%uh jeämqr wjYH ùu ñksia Y%uh wvqfjka wjYH ùu

rEmh 9'4 - o;a; .=ma;fla;kh
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9'1'4 iïnkaê; o;a; iuqodh ye¢kaùu

;ks jia;=jlg fyda mqoa.,fhl=g fyda wod< o;a; we;=<;a lafIa;% iuQyhla 

frfldavhla f,i ye`Èkafjhs' frfldavj, tl;=jla o;a; j.=jla f,i ye¢kafjhss'

tlsfkl iïnkaê; j.= tl;=jla iïnkaê; o;a; iuqodhla f,i ye`Èkafjhs'

lafIa;% 

iïnkaê; o;a; iuqodhla f.dvkef.k wdldrh mshjfrka mshjr úuid 

n,uq' ^rEmh 9'5& lafIa;% lsysmhlska frfldavhla iEfok w;r frfldav lsysmhlska 

j.=jla ;efkhs' j.= lsysmhla tl;= ù iïnkaê; o;a; iuqÞhla ielfihs'

,shdmÈxÑ 

wxlh

ku Wmka Èkh Ndrlref.a 

ku

100 ufkdaÊ ohdr;ak 2/9/2008 Ô'ohdr;ak

101 *sfrdaid r*Sla 4/2/2008 fla'*dhsia

,shdmÈxÑ 

wxlh

fmdf;a 

wxlh

,nd .;a 

Èkh

Ndr Èh hq;= 

Èkh

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

j.=

frfldav

iïnkaê; o;a; iuqodh
Relational Database

iïnkaê; o;a; iuqodh (Relational Database)

j.= 1 ¬ j.= 2 ¬ j.= 3 ¬ j.= 4 ''''''' (Tables)

frfldav 1 ¬ frfldav 2 ¬ frfldav 3 ¬ frfldav 4 ''''''' (Records)

j.=j

frfldavh 

lafIa;%h 1 ¬ lafIa;%h 2 ¬ lafIa;%h 3 ¬ lafIa;%h 4 ¬ ''''''' (Fields)

rEmh 9'5 - iïnkaê; o;a; iuqodhla iE§ we;s wdldrh
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 mdi,l bf.kqu ,nk iEu isiqfjl=g u YsIH m%.;s jd¾;dj b;d jeo.;a 

f,aLkhls' tys isiqjdf.a Ôj o;a; iy tla tla mx;sfha § ta ta úIhhka i|yd jdr 

;=kl § ,nd .;a ,l=Kq m%udK iy Tyq fyda weh ,nd we;s ia:dkh igyka flf¾' 

isiqka ;sfofkl=f.a Ôj o;a; lsysmhla my; i|yka mßÈ fõ' ^j.=j 9'5 n,kak&

j.=j 9'5 - isiqkaf.a Ôj o;a; m;%sldj

we;=<;a ùfï wxlh( 1426 we;=<;a ùfï wxlh( 1427 we;=<;a ùfï wxlh( 1428

ku( lú`ÿ m%NdIajr ku( ókdfoaú rdukdoka ku( fudfyduâ u,slald¾

Wmka Èkh ( 2005'05'23 Wmka Èkh ( 2005'08'12 Wmka Èkh ( 2005'02'07

ia;%S$mqreI Ndjh (mqreI ia;%S$mqreI Ndjh ( ia;%S ia;%S$mqreI Ndjh ( mqreI

ÿrl:k wxlh (0352287571 ÿrl:k wxlh (0352235696 ÿrl:k wxlh (0352815402

iEu isiqfjl=g u wod< f;dard .;a Ôj o;a; myla i|yd wod< o;a; by; 

oelafõ' fufia lú÷ m%NdIajr" ókdfoaú rdukdoka iy fudfyduâ u,slald¾ wd§ 

o;a; u.ska tla lafIa;%hla ksrEmKh flf¾' tjeks lafIa;%hla kï lsÍu i|yd 

“lafIa;% kduhla”˝fhdod .efka'

tla tla lafIa;% kdu hgf;a o;a; fm< .eiaùfuka j.=jla ks¾udKh lruq' ^j.=j 

9'6 n,kak&

we;=<;a ùfï 

wxlh

     ku Wmka Èkh ia;%S/mqreI      

Ndjh 

  ÿrl:k wxlh 

1426 lú`ÿ m%NdIajr  2005'05'23   mqreI  0352287571   

1427 ókdfoaú rdukdoka  2005'08'12   ia;%S  0352235696

1428 fudfyduâ u,slald¾  2005'02'07   mqreI  0352815402 

 j.=jl tla ;Srejla u.ska lafIa;%hla ksrEmKh flf¾' ta wkqj by; j.=jg 

lafIa;% myla we;' tajd we;=<;a ùfï wxlh" ku" Wmka Èkh" ia;%S mqreI Ndjh iy 

ÿrl:k wxlh fõ'

 lafIa;% ish,a, tla ùfuka frfldavhla ks¾udKh fõ' ta wkqj by; j.=jg 

frfldav ;=kla we;'

j.=j 9'6 - YsIH o;a;

 WodyrK 
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lafIa;% kdu (Field Names)

we;=<;a ùfï 

wxlh

ku Wmka Èkh ia;%S$mqreI 

Ndjh

ÿrl:k wxlh

1426 lú`ÿ m%NdIajr 2005'05'23 mqreI 0352287571

1427 ókdfoaú rdukdoka 2005'08'12 ia;%S 0352235696

1428 fudfyduâ u,slald¾ 2005'02'07 mqreI 0352815402

 frfldavh (Record)

fma<sh (Row)

;Srej (Column)

                     j.=j 9'7 - o;a; j.=jl ixrpl

fuu j.=fjys ku" Wmka Èkh " ia;%S$mqreI Ndjh iy ÿrl:k wxlh hk 

;Srej, tl u o;a;h kej; we;=<;a ùug bvlv we;' tfy;a we;=<;a ùfï wxlh 

hk ;Srejg we;=<;a j we;s o;a;hla kej; we;=<;a fkdfõ' tneúka we;=<;a ùfï 

wxlh hk lafIa;%h frfldavhla wkkH j y÷kd .ekSug jvd fhda.H fõ'

*sfrdaid r*Sla ,nd .;a fmd;a fudkjd o hkak iïnkaO;d j.=j,ska fidhd 

.kakd whqre(

    j.=j 9'6

YsIH 

wxlh

ku Wmka Èkh we;=<;a jQ 

Èkh

Ndrlref.a 

ku

100 ufkdaÊ ohdr;ak 2$9$2008 1$1$2014 Ôa'ohdr;ak

101 *sfrdaid r*Sla 4$2$2008 1$1$2014 fla'*dhsia

YsIH 

wxlh

fmdf;a 

wxlh

,nd .;a

 Èkh

Ndr Èh hq;=

 Èkh

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

fmdf;a 

wxlh

ud;Dldj l¾;Df.a ku

1111 uQ,sl .Ks; 

ixl,am

isjodika rdukdoka

2222 ck .dhkd chka; nKavdr

3333 kdgH yd 

rx. l,dj

moauud,S ueKsfla
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9'1'5 m%d:ñl h;=r ^Primary Key& 

j.=jl frfldav wkkH j y÷kd .; yels ^Unique&  ;Srejla ^fyda ;Sre 

ixfhdackhla& m%d:ñl h;=r ^Primary Key& f,i ye`Èkafõ'

  

rEmh 9'6

ksoiqkla f,i fmd;a lsysmhl o;a; we;=<;a my; 9'7 j.=j n,kak' 

j.=j 9'7 - fmd;a j.=j

mß.%yK 

wxlh

ud;Dldj l¾;Df.a ku fmd;l 

ñ,

fmd;a 

.Kk

2131 wka;¾cd,hg m%fõY fjuq ufyaIa .kalkao Rs.275.00 10

2132 mß.Kl NdId wOHhkh iqrksu, niakdhl Rs.300.00 5

2133 rpkd yqrej ksud,s fndaf.dv Rs. 225.00 12

2134 wOHdmk ufkdaúoHdj ohdkd;a chfialr Rs.400.00 6

2135 fou< ni bf.kqu rdÊ iqodlrka Rs.225.00 8

2136 mß.Kl NdId wOHhkh fudfyduâ kshdia Rs.150.00 4

2137 isxy, fou< Yío fldaIh rdÊ iqodlrka Rs.325.00 6

 

fuu j.=fjys"

 ² iEu fmd;l u mß.%yK wxlh ( Accession number) tlsfklg iudk fkdfõ' 

^wkkH fõ&

 ² iqrksu, niakdhl  iy fudfyduâ kshdia hk l¾;Djreka fofokd u mß.Kl  

NdId wOHhkh hk fmd; rpkd lr we;' 

 ² rdÊ iqodlrka hk l¾;Djrhd úiska fou< ni bf.kqu iy isxy, fou< Yío  

fldaIh hk fmd;a fol u rpkd lr we;'

 ² rpkd yqrej iy fou< ni bf.kqu hk fmd;a foflys u ñ, iudk ù we;'

 ² wOHdmk ufkda úoHdj iy isxy, fou< Yío fldaIh hk fmd;a 6 ne.ska we;'

 fuu lreKq wkqj fmd;l mß.%yK wxlh hk lafIa;% wkkH w.hj,ska 

iukaú; neúka th m%d:ñl h;=r i|yd jvd WÑ; fõ'

WÞyrK - 
mqoa., ye÷kqïm;a wxlh" mdi,a we;=,;a ùfï wxlh

rEmh 9'6

ksßlaIKh 

 m%d:ñl h;=rl iqúfYaIS;d

 ² ysia fkdúh hq;= h' ^wksjd¾hfhka u o;a; mej;sh hq;=hs'&

 ² wkqmsgm;a fkdfõ' ^iudk w.hka fkdmj;S'&
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   igyk( j.=jl m%d:ñl h;=r y÷kd .ekSu i|yd háka brla w`Èkq ,efí' 

   ^j.=j 9'8 n,kak'&

mß.%yK wxlh     ud;Dldj l¾;Df.a ku  fmd;l ñ, fmd;a .Kk

   

9'1'6 ixhqla; h;=r (Composite Primary Key)  

 j.=jl frfldavhla wkkH j y÷kd .; yels ;Sre folla fyda jeä .Kkla 

fyda ixfhdackh lsÍfuka iEfok m%d:ñl h;=r Composite Primary key f,i 

ye`oskafõ'

mdi,l l%Svd kdhl Wmkdhl ms<sn|  my; oelafjk 9'9 j.=j i,lkak'

j¾Ih l%Svdj kdhl Wmkdhl

2013 l%slÜ rIañ fiakdr;a; uqNdrla yqfiaka

2013 mdmkaÿ cd,sh idrx. úfkdaoka rdÊ

2013 w;amkaÿ wyïuâ kjdia iqfoaYa ;rx.

2014 l%slÜ uqNdrla yqfiaka Ndkq ohdr;ak

2014 mdmkaÿ cd,sh idrx. wyïuâ kjdia

2014 w;amkaÿ Nd;sh .ï,;a iqfoaYa ;rx.

 

Composite Key frfldavhla wkkH j y`ÿkd .ekSug j¾Ih iy l%Svdj 

hk lafIa;% fol u wjYH h'  

 fuu j.=fõ tla tla ;Srej, o;a; kej; kej; we;=<;a j we;s neúka 

frfldav wkkH j y÷kd .ekSug ;ks ;Srejla fkdmj;S' tla jirla ;=< tla 

l%Svdjlg ksYaÑ; kdhlfhl= iy Wmkdhlfhl= isáh hq;=hs' tneúka j¾Ih iy 

l%Svdj hk ;Sre foflys ixfhdackh ie,l+ úg frfldavj, wkkH;dj mj;S' 

tneúka j¾Ih iy l%SSvdj hk lafIa;% fol u tla j .;a úg m%d:ñl h;=r f,i 

ie,lsh yels h' fuu j.=fõ ;Sre folla  ixfhdackh lsÍfuka iEfok Composite 
key tl m%d:ñl h;=r i|yd iqÿiq fõ' ixhqla; m%d:ñl h;=r oelaùfï § tu lafIa;% 

háka fjk fjk u bß w`Èkq ,nhs' ^j.=j 9'10 n,kak&

j¾Ih l%Svdj kdhl Wmkdhl

by; j.=fõ m%d:ñl h;=r } j¾Ih ¬ l%Svdj

j.=j 9'8 - m%d:ñl h;=r ±laùu 

 ksoiqk

j.=j 9'9 - l%Svd j.=j

j.=j 9'10 - ixhqla; m%d:ñl h;=r oelaùu
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ksßlaIKh 

 wd.ka;=l h;=rl iqúfYaI;d

 ² j.= folla w;r iïnkaO;djla f.dvke.Su

 ² iïnkaê; j.=fõ m%d:ñl h;=re lafIa;%hg wkqrEmS o;a; muKla  

 mej;Su

 ² tla j.=jl wd.ka;=l h;=r ;j;a j.==jl m%d:ñl h;=r f,i mj;S'

9'1'7 wd.ka;=l h;=r (Foreign Key) 

 tla j.=jl lafIa;%hla ^fyda lafIa;% ixfhdackhla& u.ska fjk;a j.=jl 

fma<s wkkH j y÷kd .; yels kï tu lafIa;%h tu j.=fjys mj;sk wd.ka;=l 

h;=rla ^Foreign Key& f,i ye`Èkafõ' wd.ka;=l h;=r u.ska j.= folla w;r 

iïnkaO;djla f.dv kef.a'

ksoiqk 

 f;dr;=re yd ikaksfõok ;dlaIKh bf.k .kakd isiqka ;sfofkl= m<uq 

jdrh i|yd ,nd .;a ,l=Kq my; 9'13 j.=fõ oelafõ'

   j.=j 9'13 - m<uq jdrfha ,l=Kq

we;=<;a ùfï wxlh    ku Wmka Èkh ,l=Kq jdrh   j¾Ih

1426 lú`ÿ m%NdIajr 2005'05'23 69  1 2014

1427 ókdfoaú rdukdoka 2005'08'12 82  1 2014

1428 fudfyduâ u,slald¾ 2005'02'07 47  1 2014

j.=j 9'11 - 

isiqka j.=j 

^Student 
Table&

,shdmÈxÑ 

wxlh

ku Wmka Èkh we;=<;a jQ 

Èkh

Ndrlref.a 

ku

100 ufkdaÊ ohdr;ak 2/9/2014 1/1/2014 Ô'ohdr;ak

101 *sfrdaid r*Sla 4/2/2014 1/1/2014 fla'*dhsia

úNd. 

wxlh

.Ks;h úoHdj isxy, bx.S%is ,shdmÈxÑ 

wxlh

449683 B A C C 100
449697 A B B A 101

by; j.=j 9'11 yd j.=j 9'12 ie,l+ úg ,shdmÈxÑ wxlh 9'11 

isiqka (Student) j.=fjys m%d:ñl h;=r jk w;r ,shdmÈxÑ 

wxlh 9'12 úIhhka (Subject) j.=fjys wd.ka;=l h;=r fõ' 

;j o 9'12 úIhhka (Subject) j.=j i|yd fjk u m%d:ñl 

h;=rla mj;sk w;r th úNd. wxlh fõ'

j.=j 9'12 úIhh j.=j - ^Subject Table&

m%d:ñl h;=r

wd.ka;=l h;=r
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fuu isiqka fojk jdrh i|yd ,nd .;a ,l=Kq j.=jg we;=<;a lsÍfï § tu 

isiqkaf.a we;=<;a ùfï wxlh" ku iy Wmka Èkh hk lafIa;% i|yd kej; tu 

o;a; we;=<;a lsÍug isÿ fõ' ^j.=j 9'14 n,kak&

     j.=j 9'14

we;=<;a ùfï wxlh    ku Wmka Èkh ,l=Kq  jdrh  j¾Ih

1426 lúÿ m%NdIajr 2005'05'23 69 1 2014

1427 ókdfoaú rdukdoka 2005'08'12 82 1 2014

1428 fudfyduâ u,slald¾ 2005'02'07 47 1 2014

1426 lú`ÿ m%NdIajr 2005'05'23 79 2 2014

1427 ókdfoaú rdukdoka 2005'08'12 68 2 2014

1428 fudfyduâ u,slald¾ 2005'02'07 66 2 2014

 fufia j.=jl tla tla ;Srej, o;a; kej; kej; we;=<;a ùu o;a; 

wkqmsgm;a ùu ^Data Duplication& f,i ye`Èkafõ'

j.=jl o;a; wkqmsgm;a ùu ksid my; olafjk wjdis we;s fõ'

(i) frfldavj, wkkH;dj mj;ajd f.k hdug m%d:ñl h;=re lafIa;%hla f;dard 

.ekSug fkdyels ùu'

(ii) ksjerÈ j o;a; úYaf,aIKh lsÍug fkdyels ùu'

by; j.=fõ ,l=Kq 60 g  jeäfhka ,nd.;a  isiqka  ixLHdj 5 la f,i 

fmkakqï l< o mka;sfha u isákafka isiqka ;sfofkls' ta wkqj ksjerÈ 

j o;a; úYaf,aIKh lsÍug fkdyels h'

(iii) o;a; iuqodfha ld¾hlaIu;dj wvq ùu

by; j.=jg j¾I .Kkdjl ,l=Kq wdodkh lsÍfï § tl u isiqjdf.a 

we;=<;a ùfï wxlh" ku iy Wmka Èkh we;=<;a lsÍug jeä ld,hla 

.; jk neúka ld¾hlaIu;dj wvq fõ'

(iv) fodaI iys; f;dr;=re ,eîug we;s yelshdj jeä ùu

tl u o;a; kej; kej; we;=<;a lsÍfï § jerÈ isÿ úh yels h' 

tla fma<shl  fudfyduâ u,slald¾ f,i o ;j;a fma<shl fudfyduâ 

u,lald¾ f,i o igyka ùug bv we;' túg o;a; w;r fkd.e<mSï ksid 

fodaI iys; f;dr;=re ,eîug we;s bvlv jeä h' tneúka ksrjoH;dj 

ke;s fõ' 

(v) o;a; wdodkh lsÍu wmyiq ùu

isiqfjl= ,nd .;a ,l=Kq we;=<;a lsÍug kï Tyqf.a ku iy Wmka Èkh 

kej; kej; wdodkh lsÍug isÿ fõ'

(vi) o;a; uelSfï § fodaI we;s ùu

tla YsIHfhl=g wod< frfldav lsysmhla mj;sk neúka tajd uelSfï § 

w;miq ùï ksid b;sß ùug bv we;' 

(vii) o;a; hdj;ald,Sk lsÍu wmyiq ùu 

tla YsIHfhl=g wod< frfldav lsysmhla mj;sk neúka tajd hdj;ald,Sk 

lsÍug tlska tl fidhd hdj;ald,Sk lsÍug isÿ ùu'

j.=j 9'11 - fojk jdrfha ,l=Kq
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 fuu ;;a;aj we;s jQfha ;ks j.=jl ish¨u o;a; we;=<;a lsÍu ksid h' 

tneúka tu ;;a;aj md,kh lsÍug tjeks j.=jla j.= lsysmhlg fjka lr .ekSu  

isÿ flf¾'

 fuys § o;a; wkqmsgm;a ùug fya;=jQ lafIa;% bj;a jk mßÈ j.= folla ^YsIH 

j.=j iy ,l=Kq j.=j & ks¾udKh lruq'

 YsIH j.=j i|yd we;=<;a ùfï wxlh" ku iy Wmka Èkh hk lafIa;% 

we;=<;a 9'15 j.=j ks¾udKh lruq'

 YsIH j.=fõ  ku iy  Wmka Èkh hk lafIa;%j, o;a; wkqmsgm;a ùug 

yelshdjla we;' tfy;a we;=<;a ùfï wxlh hgf;a o;a; wkqmsgm;a ùula isÿ 

fkdfõ' frfldav wkkH j y÷kd .ekSug we;=<;a ùfï wxlh jvd WÑ; fõ' 

tneúka YsIH j.=fõ m%d:ñl h;=r we;=<;a ùfï wxlh fõ'

 
j.=j 9'15 - YsIH j.=

   we;=<;a ùfï wxlh            ku        Wmka Èkh

1426 lú`ÿ m%NdIajr 2005'05'23

1427 ókdfoaú rdukdoka 2005'08'12

1428 fudfyduâ u,slald¾ 2005'02'07

we;=<;a ùfï wxlh" ,l=Kq" jdrh iy j¾Ih hk lafIa;% we;=<;a 9'16 ,l=Kq 

j.=j ks¾udKh lruq'

we;=<;a ùfï wxlh        ,l=Kq        jdrh         j¾Ih

1426 69 1 2014

1427 82 1 2014

1428 47 1 2014

1426 79 2 2014

1427 68 2 2014

1428 66 2 2014

 

 ,l=Kq j.=fõ we;=<;a ùfï wxlh hgf;a we;s o;a;hlg$o;a;j,g wkqrEmS 

tla o;a;hla muKla YsIH j.=j ;=< mj;S'

 tneúka we;=<;a ùfï wxlh hk lafIa;%h YsIH j.=fõ m%d:ñl h;=r jk 

w;r ,l=Kq j.=fõ wd.ka;=l h;=r fõ'

j.=j 9'16 - ,l=Kq j.=j
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 9'2    w;ahqrej ir, o;a; iuqÞh j.=jla ks¾udKh lsÍu

o;a; m%rEm (  tla lafIa;%hlg wod< o;a; j¾.h o;a; m%rEmhla f,i ye`Èkafõ'   

 nyq, j Ndú; flfrk o;a; m%rEm lsysmhla my; ±lafõ'

• ixLHd;aul ̂ Numeric& ( .Kkh lsÍï i`oyd fhdod .kq ,nhs' wdldr lsysmhlska 

mj;S'

∗ Integer ( Ok fyda RK f,i mj;sk mQ¾K ixLHd;aul w.h fõ'

   Wod ( 12" -23

∗ Real  ( oYu  iys; mj;sk Ok fyda RK ixLHd fõ'

  Wod ( 8'125" -2'64" 4'00 

• mdG ̂ Text& ( wlaIr" b,lalïj,ska fyda úfYaI i,l=Kq ̂ WÞ - %, *, -)  iukaú;h' 

b,lalï Ndú; l< o .Kkh lsÍug fhdod fkd.efka'

Wod( cd;sl ye`ÿkqïm;a wxlh 889534731v
       ÿrl:k wxlh 0112785123" 0112-785123
• uqo,a ^Currency&  ( uQ,H w.h oelaùug fhdod .efka'

  Wod (  $ 12'45" Rs 35'00

• Èkh iy fõ,dj ^Date/Time& ( Èk iy fõ,dj olajhs'

  Wod (  12$23$2013" 7'35 a.m
• nQ,shka ^Boolean& ( i;H ^True&$wi;H ^False& f,i Boolean ^Logical& w.h 

folla muKla mj;S'

 lafIa;%hl m%udKh" thg wdodkh lrk o;a;j, iajNdjh yd m%udKh wkqj 

fjkia úh yels h'

Wod (  lafIa;%fha ku ^;Srefõ ku&  lafIa;% m%udKh ^;Srefõ m<,&

  úIhfha ku     15

  úIh fla;dxlh    5

j.=j ks¾udKfha § lafIa;%hg wod< o;a; m%rEm y÷kd .; hq;=hs'

       lafIa;% kduh    o;a; m%rEmh     

  fmdf;a mß.%yK wxlh  mdG ^Text&   

 ud;Dldj    mdG ^Text&   

 l¾;Df.a ku    mdG ^Text&
 fmd;l ñ,    uqo,a ^Currency)
 fmd;a .Kk    ixLHd ^Number&
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^1& mdi,a mqia;ld,fha we;s fmd;a 10 l o;a; by; i|yka lafIa;% hgf;a  

     j.=jl olajkak'

^2& mka;sfha isiqka ,nd .;a ,l=Kq we;=<;a lsÍug WÑ; j.=jla ks¾udKh  

     lrkak'

fuu j.=jg we;=<;a ùfï wxlh" ku iy Tn bf.kqu ,nk úIhhka i`oyd ,o 

,l=Kq we;=<;a úh hq;= h'

my; oelafjk 9'17 j.=fõ lafIa;% i|yd jvd;a u iqÿiq o;a; m%rEmh i|yka lrkak'
    

    j.=j 9'17 - o;a; m%rEm j.=j

               lafIa;%h ^Field& o;a; m%rEmh ^Data Type&
we;=<;a ùfï wxlh ^Admission_Number&
we;=<;a ùfï Èkh  ^Date_of_Admission&
úIhh fla;h  ^Subject_Code&
ffjoH .dia;=j ^Doctor’s_Fee&
fomd¾;fïka;=fõ ku ^Department_Name&
u.Ska ixLHdj ^Number_of_Passengers &
,shdmÈxÑ ù weoao@ ^Is_Registered?&

^3&  lafIa;% i|yd jvd;a u iqÿiq o;a; m%rEmh f;dard .ekSfï jeo.;alu WÞyrK  

     iys;j myokak'

  l%shdldrlu 

 9'3 w;ahqre o;a; iuqÞh bf,lafg%dksl udOHhg mßj¾;kh lsÍu 

w;ahqre l%uhg ie,iqï l< o;a; iuqodh bf,lafg%dksl o;a; iuqodhla njg 

mßj¾;kh lsÍu i|yd bf,lafg%dksl o;a; iuqodh moaO;s y÷kd .ksuq'

w¾: oelaùu

mßYS,lhdg o;a; iuqodh ie,iqï lsÍug iy kv;a;= lsÍug myiqlï i,ik 

l%uf,aL tl;=jla o;a; iuqodh l<uKdlrK moaO;shla ^Database Management 
System-DBMS& f,i ye¢kafõ' o;a; iuqodh l<ukdlrK moaO;sj, j.=" úuiqu" 

wdlD;s iy jd¾;d wd§ jYfhka jia;= lsysmhlska iukaú; fõ' ^rEmh 9'7 n,kak&
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 rEmh 9'7 - o;a; iuqÞh l<ukdlrK moaO;shl jia;=ka

9'3'1  o;a; iuqodh l<uKdlrK moaO;s (Database Management System)      
         uDÿldx. 

wdlD;s

jd¾;d

j.=

úuiqu

o;a; iuqodh 

l<ukdlrK

moaO;s

(DBMS)
(Reports)

(Forms)

(Queries)

(Tables)

úúO ksIamdok iud.ï u.ska ksmojd we;s o;a; iuqodh l<ukdlrK moaO;s 

uDÿldx. ^DBMS Software& lsysmhla j.=j 9'18 u.ska oelafõ'

    j.=j 9'18 - úúO o;a; iuqodh l<ukdlrK moaO;s yd ksIamdok iud.ï

             uDÿldx.h           ksIamdok iud.u

Access Microsoft Company
Base The Document Foundation
Oracle Oracle Cooperation

9'3'2 o;a; iuqodh l<ukdlrK moaO;s uDÿldx. l%shd;aul lsÍu 

o;a; iuqodh l<ukdlrK moaO;s uDÿldx. w;ßka Microsoft Office Access 
LibreOffice Base hk uDÿldx. ms<sn| j muKla fuu tallfha § idlÉPd flf¾' 

uDÿldx. wdrïN lrk wdldrh fufyhqï moaO;sh wkqj fjkia úh yels nj 

lreKdfjka i,lkak'

1'   o;a; iuqodh uDÿldx. wdrïN lsÍu

Microsoft OfficeAccess i|yd''''''''' 

Start→ Programs → Microsoft Office 
→ Microsoft Office Access → Blank 
Database → Select Folder and Type 
Name → Create
 

LibreOffice Base  i|yd'''''''''

Start → Programs → LibreOffice →
LibreOfficeBase → Create a new 
database → Next → Finish → Select 
Folder and Type Name → Save
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2'  o;a; j.=jla ie,iqï lsÍu

 o;a; iuqodh uDÿldx. wdrïN lr my; oelafjk 9'8 rEmfhka oelafjk 

lafIa;% iy o;a; m%rEm iys; j.=jla ie,iqï lrkak' j.=fõ ku —mqia;ld,˜ f,i 

fhdokak'

Microsoft OfficeAccess i|yd''''''''' 

Create →  Table Design →  lafIa;% 

kduh iy o;a; m%rEm ,nd fokak →  
.=Kdx. ilia lrkak → j.=j ;eïm;a 

lrkak'

 

LibreOffice Base  i|yd'''''''''

Select Table in Design View → lafIa;% 

kduh iy o;a; m%rEm ,nd fokak → 
.=Kdx. ilia lrkak →j.=j ;eïm;a 

lrkak

rEmh 9'8 - mqia;ld, j.=fõ lafIa;% yd o;a; m%rEm 

3'  o;a; j.=jl m%d:ñl h;=r msysgqùu

j.=jl fma<s wkkH j y÷kd .ekSug o;a; wkqmsgm;a fkdúh hq;= h' j.=jl 

;Srejla fyda ;Sre lsysmhla m%d:ñl h;=re lafIa;%hla njg m;a lsÍfuka  frfldavj, 

wkkH;dj mj;ajd .ekSug yels fõ' by; rEmh 9'8 ys mß.%yK wxlh hk lafIa;% 

m%d:ñl h;=re lafIa;%hla njg m;a lrkak'

Microsoft OfficeAccess i|yd''''''''' 

Create →  Table Design → lafIa;% kduh 

iy o;a; m%rEm ,nd fokak → m%d:ñl 

h;=r njg m;a l< hq;= lafIa;%h wvx.= 

fma<sh fyda fma<s f;darkak →  m%d:ñl 

h;=r u; la,sla lrkak' j.=j ;eïm;a 

lrkak'

 

LibreOffice Base  i|yd'''''''''

Select Table in Design View → lafIa;% 

kduh iy o;a; m%rEm ,nd fokak →  
m%d:ñl h;=r njg m;a l< hq;= lafIa;%h 

wvx.= fma<sh u; uQislfha ol=Kq mi 

fnd;a;u la,sla lrkak' → m%d:ñl h;=r 

f;darkak' →  j.=j ;eïm;a lrkak' →  
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4'  j.=jg o;a; we;=<;a lsÍu 

ie,iqï l, j.=jlg o;a; wdodkh lsÍug tys oiqk fjkia l< hq;= h'

Microsoft Office Access i|yd'''''''''

 

All Access Objects ljq¿fjka j.=j 

f;dard .kak' Data Sheet View f;darkak'  

→ o;a; wdodkh  lrkak → j.=j 

jikak'

  

 o;a; wdodkh  lrkak  j.=j 

LibreOffice Base  i|yd'''''''''

Tables hgf;a we;s j.=j u; oaú la,sla 

lsÍu fyda ol=K la,sla lr Open f;aÍu 

→ o;a; wdodkh  lrkak → j.=j 

jikak'

mqia;ld, j.=jg my; 9'10 rEmfhka oelafjk o;a; wdodkh lrkak' 

rEmh 9'10 - mqia;ld, j.=fõ frfldav

 9'4    iïnkaê; o;a; iuqÞhla (Relational Database)
            ks¾udKh lsÍu

j.=jl m%d:ñl h;=r iy  wd.ka;=l h;=r hkak ms<sn| j wjfndaOhla  9'1 

tallfha § ,nd f.k we;ehs is;ñ' ;ks j.=jl ish¨u o;a; mj;ajdf.k hdug 

jvd yels ;dla ÿrg fjk fjk u j.=j, o;a; mj;ajd .ekSu o;a; wdodkh lsÍug" 

o;a; hdj;ald,Sk lsÍug iy o;a; uelSug b;d myiq ld¾hlaIu fuka u jvd 

M,odhS o jQ l%uhls' tneúka o;a; j.=jla ir, j j.= lsysmhlg ì`§u ^fjka lsÍu& 

yd tajd w;r iïnkaO;d f.dvke.Su ms<sn| j wjfndaOhla ,nd .ekSug fuu 

fldgi uekúka wOHhkh lruq'

rEmh 9'9 - m%d:ñl h;=r iys; mqia;ld, j.=j

rEmh 9'10 - mqia;ld, j.=fõ frfldav
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 iïnkaê; o;a; iuqÞh ksrudKh lsÍfï§ j.= w;r iïnkaO;d j¾. 

lsysmhla mej;sh yels jk w;r tAjd tl-tl iïnkaO;dj  (one-to-one), tl-

nyq iïnkaO;dj (one-to-many) yd nyq-nyq iïnkaO;dj (many-to-many) f,i 

y÷kajhs'

9'4'2  tl-tl iïnkaO;dj (one-to-one relationship)

j.=jl tla frfldavhla fjk;a j.=jl tla frfldavhla iu. iïnkaO 

jkafka kï yd kï u muKla tu j.= fol w;r mj;sk iïnkaO;dj tl-tl 

^one-to-one& iïnkaO;djla f,i ye¢kafõ'

j.= fol A iy B kï ñka woyia flfrkafka A j.=fõ we;s tla frfldavhla  

B  j.=fõ we;s tla frfldavhla iu. muKla iïnkaO jk njhs' tfia ke;s kï 
B  j.=fõ we;s tla frfldavhla  A  j.=fõ we;s tla frfldavhla iu. muKla 

iïnkaO jk njhs'

ksoiqk

 5 fY%a‚fha YsIH;aj úNd.hg fmkS isá  isiqkaf.a ,l=Kq we;=<;a my; 9'19 

j.=j i,lkak'

we;=<;a ùfï wxlh            ku Wmka Èkh úNd. wxlh ,l=Kq

1426 lú`ÿ m%NdIajr 2005'05'23 23234 151

1427 ókdfoaú rdukdoka 2005'08'12 23876 186

1428 fudfyduâ u,slald¾ 2005'02'07 23758 172

1429 rYañ cfkdaord 2005'06'16 23765 193

 9'19 j.=fõ we;s o;a; 9'20 YsIH j.=j iy 9'21 ,l=Kq j.=j f,i j.= foll 

olajuq'

 

 ,l=Kq j.=fõ tla frfldavhla YsIH j.=fõ tla frfldavhla iu. muKla 

iïnkaO ù we;' YsIH j.=fõ tla frfldavhla ,l=Kq j.=fõ tla frfldavhla iu. 

muKla iïnkaO ù we;'

 YsIH j.=fõ we;=<;a ùfï wxlh m%d:ñl h;=r jk w;r th ,l=Kq j.=fõ 

wd.ka;=l h;=r fõ' ,l=Kq j.=fõ úNd. wxlh m%d:ñl h;=r fõ' fuu j.= fol 

w;r wd.ka;=l h;=r yryd f.dv kef.k iïnkaO;dj tl-tl iïnkaO;djla fõ' 

^rEmh 9'11 n,kak&

j.=j 9'19 - YsIH;aj ,l=Kq

j.=j 9'20 - YsIH j.=j j.=j 9'21 - ,l=Kq j.=j
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we;=<;a ùfï wxlh ku Wmka Èkh

úNd. wxlh ,l=Kq we;=<;a ùfï wxlh

j.= w;r iïnkaO;dj oelaùfï § wd.ka;=l h;=r isg m%d:ñl h;=r olajd  

B;,hla we`o olajkq ,efí'

9'4'2  tl-nyq iïnkaO;dj (one-to-many Relationship)

j.=jl  tla  tla frfldav iïnkaê; j.=fõ frfldav lsysmhla iu. 

iïnkaO jkafka kï tu j.= fol w;r mj;sk iïnkaO;dj tl-nyq ^one-to-
many& iïnkaO;djla f,i ye`oskafõ'

j.= fol A iy B kï yd B hkq iïnkaê; j.=j kï tajd w;r iïnkaO;dj 

j.=j 9'22 ys oelafõ'

A j.=j B j.=j ^iïnkaê; j.=j&

A  j.=fõ tla frfldavhlg B j.=fõ 

frfldav lsysmhla iu. iïnkaO úh 

yels h'

B  j.=fõ tla frfldavhlg A j.=fõ 

tla frfldavhla iu. muKla iïnkaO 

úh yels h'

B  j.=fõ frfldav iu. iïnkaO 

fkdjQ frfldav mej;sh yels h'

A j.=fõ frfldav iu. iïnkaO fkdjQ 

frfldav mej;sh fkdyels h'

m%d:ñl h;=r wvx.= ;Srefõ o;a; 

wkqmsgm;a úh fkdyels h'

wd.ka;=l h;=r wvx.= ;Srefõ o;a; 

wkqmsgm;a úh yels h'

A j.=fõ frfldavhlg iïnkaO 

jk  B  j.=fõ frfldavhla  mej;Su 

wksjd¾h fkdfõ' 

B  j.=fõ frfldavhlg iïnkaO jk  A  
j.=fõ tla frfldavhlaa wksjd¾hfhka 

u mej;sh hq;= h'

YsIH j.=j

,l=Kq j.=j   

rEmh 9'11 - tl tl iïnkaO;dj oelaùu

j.=j 9'22 - tl nyq iïnkaaO;djl ,laIK

 j.= w;r iïnkaO;dj we`o oelaùu
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ksoiqk

 isiqkaf.a fm!oa.,sl o;a; iy fiajd yd myiqlï .dia;=  f.ùï ms<sn| o;a; 

we;=<;a my; 9'23 j.=j i,lkak'

we;=<;a 

ùfï wxlh

ku Wmka 

Èkh

ßisÜm;a 

wxlh

f.jk ,o 

Èkh

myiqlï 

.dia;=j

1426 lú`ÿ m%NdIajr 2005'05'23 1000 2014'01'04 40'00

1427 ókdfoaú 

rdukdoka

2005'08'12

1428 fudfyduâ 

u,slald¾

2005'02'07 1001 2014'01'06 120'00

1426 lú`ÿ m%NdIajr 2005'05'23 1002 2014'01'12 80'00

 

 fuu j.=fõ ßisÜm;a wxlh hk lafIa;% u; f.jk ,o Èkh iy myiqlï 

.dia;=j hk  lafIa;% r`od mj;S' tfuka u ßisÜm;a wxlh hk lafIa;%fhys wkkH 

o;a; muKla mj;S' thg fya;=j ßisÜm;a wxl tlsfkl iudk fkdùuhs' ßisÜm;a 

ksl=;a l< hq;af;a .dia;= f.jk wkqms<sfj<g neúka j.=fõ wiïmQ¾K frfldav 

mej;Sug fuh fya;=jla fõ' ^j.=fõ R u.ska olajd we;'& ;j o fuu j.=fõ o;a; 

wkqmsgm;a ùu o isÿ ù we;'

 tneúka fuu j.=j 9'24 YsIH j.=j iy 9'25 myiqlï .dia;= j.=j f,i j.= 

follg fjka lr .ksuq'

ßisÜm;a wxlh hkq myiqlï .dia;= j.=fõ m%d:ñl h;=r fõ'

 we;=<;a ùfï wxlh hkq YsIH j.=fõ m%d:ñl h;=r jk w;r myiqlï .dia;= 

j.=fõ  wd.ka;=l h;=r fõ'

 

  

  

j.=j 9'23 - fiajd yd myiqlï .dia;=

we;=<;a ùfï 

wxlh

         ku ÿrl:k wxlh

1426 lú`ÿ m%NdIajr 0352287571

1427 ókdfoaú rdukdoka 0352235696

1428 fudfyduâ u,slald¾ 0352815402

         j.=j 9'25 - myiqlï .dia;= j.=j

ßisÜm;a

wxlh

f.jk ,o 

Èkh

.dia;=j we;=<;a ùfï 

wxlh

1000 2014'01'04 40'00 1426

1001 2014'01'06 120'00 1428

1002 2014'01'12 80'00 1426

j.=j 9'24 - YsIH j.=j

R



285fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs284

YsIHfhl=g ;u myiqlï .dia;= Wmßu jYfhka wjia:d ;=kl § f.úh yels 

kï YsIH j.=fõ tla frfldavhlg  wkqrEm j myiqlï .dia;= j.=fõ frfldav  0" 

1" 2 fyda 3la mej;sh yels h'

•  frfldav  m%udKh 0 hkqfjka woyia jkafka myiqlï .dia;= f.jd fkdue;s 

    njhs'

•  frfldav m%udKh 1 hkqfjka woyia jkafka myiqlï .dia;= tla j;djla f.jd we;s 

   njhs'

•  frfldav  m%udKh 2 hkqfjka woyia jkafka myiqlï .dia;= foj;djla f.jd we;s 

   njhs'

•  frfldav m%udKh 3 hkqfjka woyia jkafka myiqlï .dia;= ;=ka j;djla f.jd we;s 

   njhs'

fï wkqj YsIH j.=fõ tla frfldavhlg wkqrEm j myiqlï .dia;= j.=fõ 

frfldav  fkdmej;Su fyda tla frfldavhla fyda frfldav  lsysmhla mej;Su isÿ úh 

yels h' ta wkqj fuu j.= fol w;r mj;sk iïnkaO;dj tl-nyq iïnkaO;djla 

fõ' ^rEmh 9'12 n,kak&

we;=<;a ùfï wxlh ku ÿrl:k wxlh

ßisÜm;a wxlh f.jk ,o Èkh .dia;=j we;=<;a ùfï wxlh

YsIH j.=j

myiqlï .dia;= j.=j

     

9'4'3  nyq-nyq iïnkaO;dj (many-to-many Relationship)

tla j.=jl frfldavhla fjk;a j.=jl frfldav lsysmhla iu. iïnkaO 

jkafka kï  iy tu iïnkaê; j.=fõ frfldavhla wfkla j.=fõ frfldav  

lsysmhla iu. iïnkaO jkafka kï tu j.= fol w;r mj;sk iïnkaO;dj nyq-

nyq ^many-to-many& iïnkaO;djla f,i ye`Èkafõ'

rEmh 9'12
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WodyrK

 mdi,a isiqyq úIh ndysr lghq;= jYfhka iuQy ^lKavdhï& l%Svd lr;s' 

l%slÜ" w;amkaÿ" mdmkaÿ wd§ jYfhka l%Svd lsysmhla mj;sk w;r tla isiqfjl= 

wju jYfhka tla l%Svdjlj;a kshe,sh hq;=hs' tfuka u tla l%Svdjla i|yd isiqka 

lKavdhula isáh hq;= h'

fuu o;a; we;=<;a my; 9'26 j.=j i,luq' 

we;=<;a ùfï 

wxlh

ku Wmka Èkh l%Svd 

wxlh

l%Svdj lKavdhu ks;H 

idudðl 

ixLHdj

1426 lú`ÿ m%NdIajr 2005'05'23 S001 l%slÜ A 11
1426 lú`ÿ m%NdIajr 2005'05'23 S002 mdmkaÿ A 16
1428 fudfyduâ 

u,slald¾

2005'02'07 S001 l%slÜ B 11

1428 fudfyduâ 

u,slald¾

2005'02'07 S002 mdmkaÿ A 16

1428 fudfyduâ 

u,slald¾

2005'02'07 S003 w;amkaÿ B 06

1429 cks;a wdfIal 2005'04'15 S001 l%slÜ A 11
1429 cks;a wdfIal 2005'04'15 S003 w;amkaÿ A 06

 fuu j.=fõ o;a; wkqmsgm;a ùu nyq, jYfhka isÿ ù we;' fuu ;;a;ajh 

j<lajd .ekSug ;ks ;ks j.=j,g fjka lruq' l%Svd ms<sn| o;a; l%Svd j.=jg;a ^9'27 

j.=j& isiqka ms<sn| o;a; YsIH j.=jg;a ^9'28 j.=j& fjka lruq'

 YsIH j.=j iy l%Svd j.=j w;r mj;sk nyq-nyq iïnkaO;dj (many-to-
many)iïnkaê; o;a; iuqodhj, § kej; tl-nyq iïnkaO;d njg mßj¾;kh 

flf¾' fï i|yd fuu j.= folg wu;r j ;j;a j.=jla wjYH fõ' ^tu j.=j 9'30 

YsIH l%Svd j.=j f,i kï lruq& isiqka ksfhdackh lsÍug YsIH j.=fõ we;=<;a ùfï 

wxlh;a" l%Svd ksfhdackh lsÍug l%Svd j.=fõ l%Svd wxlh;a YsIH l%Svd j.=jg we;=<;a 

lruq'

j.=j 9'26 - l%Svd lrk isiqka j.=j

we;=<;a 

ùfï wxlh

ku Wmka 

Èkh

1426 lú`ÿ m%NdIajr 2005'05'23

1428 fudfyduâ 

u,slald¾

2005'02'07

1429 cks;a wdfIal 2005'04'15

j.=j 9'27 - YsIH j.=j

l%Svd 

wxlh

l%Svdj ks;H 

idudðl 

ixLHdj

S001 l%slÜ 11

S002 mdmkaÿ 16

S003 w;amkaÿ 6

j.=j 9'28 - l%Svd j.=j
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we;=<;a ùfï wxlh hkq YsIH j.=fõ m%d:ñl h;=r jk w;r YsIH l%Svd 

j.=fõ  wd.ka;=l h;=r fõ'

l%Svd wxlh hkq l%Svd j.=fõ m%d:ñl h;=r jk w;r YsIH l%Svd j.=fõ 

wd.ka;=l h;=r fõ'

YsIH l%Svd j.=fõ m%d:ñl h;=r jkafka we;=<;a ùfï wxlh ¬ l%Svd wxlh 

fõ'

YsIH iy l%Svd jeks nyq-nyq iïnkaO;djla iys; j.= folla tl-nyq 

iïnkaO;d  iys; j.=j,g mßj¾;kh l< úg ,efnk iïnkaO;d i|yd rEmh 

9'13 n,kak'

we;=<;a ùfï wxlh ku Wmka Èkh

1426 lú`ÿ m%NdIajr 2005'05'23

1428 fudfyduâ u,slald¾ 2005'02'07

1429 cks;a wdfIal 2005'04'15

j.=j 9'29 - YsIH j.=j

we;=<;a ùfï 

wxlh

l%Svd wxlh lKavdhu

1426 S001 A
1426 S002 A
1428 S001 B
1428 S002 A
1428 S003 B
1429 001 A
1429 S003 A

l%Svd 

wxlh

l%Svdj ks;H idudðl 

ixLHdj

S001 l%slÜ 11
S002 mdmkaÿ 16
S003 w;amkaÿ 6

j.=j 9'31 - l%Svd j.=j

j.=j 9'30 - YsIH l%Svd j.=j
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we;=<;a ùfï wxlh ku Wmka Èkh

we;=<;a ùfï wxlh l%Svd wxlh lKavdhu

l%svd wxlh l%Svdj ks;H idudðl ixLHdj

nyq-nyq iïnkaO;djla iys; j.= folla tl-nyq iïnkaO;d f,i we| ±laùu'

rEmh 9'13

ta wkqj" 

YsIH j.=j iy YsIH l%Svd j.= fol w;r tl-nyq iïnkaO;djla mj;S'

l%Svd j.=j iy YsIH l%Svd j.= fol w;r tl-nyq iïnkaO;djla mj;S'

tneúka nyq-nyq iïnkaO;djla tl-nyq iïnkaO;d njg wu;r j.=jla 

fhdod .ksñka mßj¾;kh l< yels h'

9'5 o;a; iuqodh l<ukdlrK moaO;s uDÿldx.    
      Ndú;fhka iïnkaê; o;a; iuqÞh ks¾udKh lsÍu

o;a; iuqodh l<ukdlrK uDÿldx. Ndú;fhka j.= w;r iïnkaO;d 

^relationships& f.dvk.k wdldrh wOHhkh lruq' ta i|yd my; oelafjk lafIa;% 

kdu iy o;a; m%rEm we;=<;a YsIH j.=j ^rEmh 9'14& iy ,l=Kq j.=j ^rEmh 9'15& 

hk j.= fol ks¾udKh lrkak'
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rEmh 9'14 - YsIH j.=fõ lafI;% kdu yd o;a; m%rEm

rEmh 9'15 - ,l=KQ j.=fõ lafIA;% kdu yd o;a; m%rEm

9'5'1 j.= fol w;r iïnkaO;dj f.dv ke.Su

Microsoft Office Access i`oyd''''''''

Database Tools f;darkak  Relationship 
úOdkh f;darkak  iïnkaO l< hq;= j.-=j 

f;darkak  Add úOdk fnd;a;u l%shd;aul 

lrkak' ^wjYH j.= m%udKh olajd&  

iïnkaO l< hq;= j.=fõ wd.ka;=l h;=r u;g 

m%d:ñl h;=r weo oukak' ^rEmh 9'16&  Edit 
Relationship ixjdo ljq¿j u; Èiajk Enforce 
Referential Integrity f;darkak' ^rEmh 9'17 

n,kak&  Cascade Update Related Field iy  
Cascade Update Related Records f;darkak' 

 Create úOdk fnd;a;u l%shd;aul lrkak'   

Libre Office i`oyd''''''''

Tools fukqj f;darkak  Relationship 
úOdkh f;darkak  iïnkaO l< hq;= 

j.-=j f;darkak  Add úOdk fnd;a;u 

l%shd;aul lrkak' ̂ wjYH j.= m%udKh olajd& 

 iïnkaO l< hq;= j.=fõ wd.ka;=l 

h;=r u;g m%d:ñl h;=r weo oukak'   

Relationship tl u; ol=K la,sla lr Edit 
f;darkak  Relations ixjdo ljq¿j u; 

Èiajk Update Option tl hgf;a we;s 
Update cascade f;darkak' Delete Option 
hgf;a we;s Delete cascade f;darkak ^rEmh 

9'18&  OK úOdk fnd;a;u l%shd;aul 

lrkak
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rEmh 9'16 - j.= fol w;r tl - nyq iïnkaO;dj

rEmh 9'17 - Editing Relationship ixjdo ljq¿j (Access)

rEmh 9'18 - Relations ixjdo ljq¿j (Libreoffice Base)
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we;=<;a ùfï wxlh YsIH j.=fõ m%d:ñl h;=r jk w;r ,l=Kq j.=fõ 

wd.ka;=l h;=r fõ'

ksßlaIKh 

 j.= iïnkaO l< miq oelsh yels úfYaI;d

  Referential Integrity u.ska YsIH j.=fõ m%d:ñl h;=re lafIa;%hl 

w.h hdj;ald,Sk l< ú.i u thg wkqrEm iïnkaê; j.=fõ wd.ka;=l 

h;=re lafIa;%fha w.h iajhxl%Sh j fjkia fõ'

 tfuka u YsIH j.=fõ frfldavhla uel+ úg tu frfldavhg wkqrEm 

iïnkaê; j.=fõ frfldav iajhxl%Sh j uelS hhs'

 m%:ufhka YsIH j.=jg o;a; we;=<;a l< hq;= h' bka miq ,l=Kq j.=jg o;a; 

we;=<;a l< yels h'

 YsIH j.=jg o;a; we;=<;a l< miq tu j.=j ;=<ska u ,l=Kq j.=jg o;a; 

we;=<;a l< yels h'

 fï i|yd YsIH j.=fõ we;=<;a ùfï wxlh bÈßfha we;s Ok i,l=K u; 

la,sla lrkak' túg ,l=Kq j.=jg myiqfjka o;a; wdodkh l< yels h' ^rEmh 9'19 

n,kak'&

rEmh 9'19 - YsIH j.=jg iy ,l=Kq j.=jg o;a; wdodkh lsÍu



293fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs292

 9'6 o;a; we;=¿ lsÍug iy ±laùug o;a; wdlD;s m;%   
      ks¾udKh lsÍu

j.=jla újD; lr o;a; wdodkh lrk wdldrh ms<sn| wjfndaOhla Tn ,nd 

we;' o;a; iuqodh l<ukdlrK moaO;sj, § j.=jlg o;a; wdodkh lsÍug Ndú; 

flfrkafka wdlD;s m;% fõ ^Forms&' tfuka u j.=jg we;=<;a l< o;a; oelaùu 

i|yd o wdlD;s m;% Ndú; flf¾'

fuys § j.=jl tla fma<shla ^frfldavhla& jYfhka o;a; wdlD;s m;%h ;=<ska 

oelaùu;a wdodkh lsÍu;a isÿ fõ' ^rEmh 9'18 n,kak&

wdodkh lrk iEu frfldavhla u j.=fõ wjidk frfldavhg we;=<;a fõ' 

j.=fõ we;s iEu frfldavhla u o;a; wdlD;s m;%h ;=<ska jrlg tl ne.ska oelaúh 

yels h' fï i|yd wdlD;s m;%hl Record Navigation bar Ndú; flf¾' ^rEmh 9'20 

n,kak&

o;a; j.=j 

rEmh 9'18 - j.=j yd o;a; wdlD;s m;%

ku ,smskh ÿrl:kh b-fï,a

wkaj¾ w;=re.sßh 0773684949 anvmom@dd.uk
ksu,a .f,afj, 07184632481 nigl@ya.com

iqodlrka uykqjr 0817587484 suda@gmal.com
iuka lE.,a,

ku

ku ksu,a

iuka
.f,afj,

lE.,a,
07184637481

,smskh

,smskh

ÿrl:kh

ÿrl:kh

b--fï,a

b--fï,a nigl@ya.com

wdlD;s m;%h ;=<ska o;a; ±laùu 

wdlD;s m;%h ;=<ska o;a; wdÞkh 
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rEmh 9'20 - o;a; wdlD;sh u.ska frfldav ne,Su

  
kj ^ysia& 

frfldavh

m<uq frfldavh
fmr frfldavh

oeka mj;akd 

frfldavh

uq¿ frfldav .Kk

B<. frfldavh

wjidk frfldavh

1'  o;a; wdlD;s m;%hla f.dv ke.Su

Microsoft Office Access i|yd'''''''''

Create → Form Design → Add Existing Fields → Show tables → wjYH j.=j f;darkak' 

j.=fõ lafIa;% wdlD;s m;% u;g weo oukak' ^rEmh 9'21 n,kak&

rEmh 9'21 - YsIH j.=jg o;a; wdÞkh lsÍu i|yd wdlD;s m;%h

2'  j.=fõ frfldav wdlD;s m;%h ;=<ska oelaùu

Microsoft Office Access i|yd'''''''''

Home Tab →  View → Form View  ^rEmh 9'22 n,kak&



295fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs294

 

3'  wdlD;s m;%hg md,k fnd;a;ï we;=<;a lsÍu

rEmh 9'22 - YsIH j.=fõ frfldav ±laùu

Microsoft Office Access i|yd'''''''''

Design Tab → Control Wizards f;darkak' ^rEmh 9'23 n,kak&→xxxx u.ska olajd we;s 

fnd;a;u f;dard .kak' → wdlD;s m;%h u; fnd;a;u msysgqjkak'

→ Command Button Wizard ys Record Operation f;darkak ^rEmh 9'24 n,kak& → we;=<;a 

l< hq;= Action tl f;darkak' ^Wod - Add New Record& → fnd;a;ug iqÿiq kula fokak' → 
Finish lrkak'

rEmh 9'23 - md,k fuj,ïrEmh 9'23 - md,k fuj,ï

rEmh 9'24 - Cammand Button Wizard
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 9'7  f;dr;=re ,nd .ekSu i|yd úuiqu (Query)  
 ks¾udKh lsÍu

tlsfkl iïnkaê; j.=j, o;a;j,ska wjYH f;dr;=re ,nd .ekSu i|yd 

úuiqu Ndú; lruq'

úuiqu u.ska tla tla j.=j, f;dard .;a lafIa;%j,g ^;Sre& wod< o;a; ksfhdackh 

flf¾' ^rEmh 9'25 n,kak'&

rEmh 9'25 - úuiqug j.=j,ska o;a; ,nd .ekSu

 

 
 

 

YsIH wxlh ku úoHq;a ;emE,

A1 mqnqÿ Pu2@gmail.com
A2 *dßia pari@yahoo.com
A3 lu,dka Kam_n@hotmal.

com
A4 ;kQcd Thanu7@slt.lk

úIhh YsIH 

wxlh

,l=Kq

A1 B1 67
A2 B3 89
A1 B3 50
A3 B2 75

úIh 

wxlh

úIhh

B1 .‚;h

B2 úoHdj

B3 bx.%Siss

by; j.= ;=fkka ku" úIhh iy ,l=Kq úuiqula u.ska ,nd .;a úg my; mßÈ 

fõ'

ku úIhh ,l=Kq

mqnqÿ .‚;h 67

*dßia bx.%Sis 89

mqnqÿ bx.%Sis 50

;kQcd úoHdj 75
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úuiqu ks¾udKh lsÍu

  

Microsoft OfficeAccess i|yd'''''''''

Create Tab → Query Design → wjYH j.=j fyda j.= f;dard .kak'^rEmh 9'26 n,kak& → 
j.=fjka fyda j.=j,ska wjYH lafIa;%h f;darkak' ^rEmh 9'27 n,kak& → úuiqu Odjkh 

^Run& lrkak'

j.=j fyda j.= f;dard .kak'^rEmh 9'26 n,kak& 

j.=fjka fyda j.=j,ska wjYH lafIa;%h f;darkak' ^rEmh 9'27 n,kak& 

rEmh 9'26 - j.= f;dark ixjdo ljq¿

rEmh 9'27 - úuiqu ks¾udKh lrk ljq¿j
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úuiqu Odjkh l< miq ,efnk f;dr;=re i|yd my; 9'28 rEmh n,kak'

rEmh 9'28 - úuiqu Odjkfha ,enQ f;dr;=re

9'28 rEmfha oelafjk mßÈ 2013 iy 2014 j¾Ij, isiqka ,nd we;s ,l=Kq fmkajhs'

2014 j¾Ifha muKla isiqka ,nd we;s ,l=Kq n,d .ekSug Criteria f,i 

j¾Ih 2014 f,i ,nd §fuka ^rEmh 9'29 n,kak& my; rEmh 9'30 ka oelafjk 

f;dr;=re ,efí'

 

 úuiqu ;=<ska lafIa;% fhdod f.k úúO .Kkh lsÍï isÿ l< yels h' isiqka 

,nd we;s ,l=Kqj, tl;=j ,nd .kakd wdldrh úuid n,uq'

 tl;=j f,i úuiqfï kj ;Srejla f.k tys isÿ úh hq;= .Kkh oelafjk 

m%ldYkhl f.dvke.Su l< hq;= h' th úIhhkaf.a ,l=Kqj, tl;=j ,nd .ekSug" 

   

    

f;dr;=re ,efí'

rEmh 9'29 - úuiqu i|yd Criteria ,nd §u

rEmh 9'30 - Criteria iys; úuiqu Odjkfhka ,o f;dr;=re



299fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs298

 tl;=j( [,l=Kq j.=j]æ[.‚;h]¬[,l=Kq j.=j]æ[úoHdj]¬[,l=Kq j.=j]æ[bx.%Sis]
f,i ghsma lsÍu l< hq;= h' ^rEmh 9'31 n,kak'&  tfia fkdue;s kï m%ldYkh 

f.dv ke.Sug  tl;=j ,nd .; hq;= ;Srej u; uQislfha ol=Kq mi fnd;a;u 

l%shd;aul lr Build úOdkh l%shd;aul l< hq;= h' túg ,efnk ixjdo ljq¿j 

^rEmh 9'32 n,kak'& fhdod .efka'

rEmh 9'31 - úuiqfuys tl;=j oelafjk ;Srej úYd,kh lr ±laùu

 

 
rEmh 9'32 - m%ldYk f.dv k.k ixjdo ljq¿

  fuf,i f.dv ke.+ úuiqu Odjkh l< miq wod< f;dr;=re my; rEmh 9'33 

mßÈ fõ'
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rEmh 9'33 - 2013 jif¾ § isiqka ,nd .;a ,l=Kq iy tl;=j ±laùu

9'8 f;dr;=re bosßm;a lsÍu i|yd jd¾;d ks¾udKh lsÍu

iïnkaê; j.=j, we;s o;a;j,ska  ,nd .kakd jeo.;a f;dr;=rej, uqøK 

msgm;a ,nd .ekSu i|yd jd¾;d Ndú; flf¾' jd¾;d ieliSu i|yd j.= iy úuiqu 

hk foj¾.h u fhdod .; yels h'

by; rEmh 9'33 u.ska oelafjk úuiqfuka ,nd fok f;dr;=re jd¾;djla 

ilik wdldrh úuid n,uq'

jd¾;d myiqfjka ks¾udKh lsßu i|yd Report Wizard Ndú; flf¾'

Microsoft Office Access i|yd'''''''''

Create Tab → Report Wizard → wjYH j.=j fyda úuiqu f;dard .kak' ^rEmh 9'34 n,kak'& 

→ j.=fjka fyda úuiqfuka jd¾;djg wjYH lafIa;% f;darkak' → Next fnd;a;u l%shd;aul 

lrñka wjYH mßÈ jd¾;dfõ ieliSï isÿ lrkak' → Finish lrkak' túg jd¾;dj rEmh 9'35 

u.ska oelafjk mßÈ jd¾;djla Èiafõ'
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rEmh 9'34 - jd¾;d ieliSug fhdod .kakd Report Wizard 

jd¾;djl we;=<;a ixLHd;aul o;a;j, .Kkh lsÍï isÿ lrk wdldrh 

úuid n,uq'

fï i|yd isiqka úiska f.jk ,o we;=<;a ùfï .dia;=j, tl;=j fidhuq'

by; wdldrfhka u Report Wizard Ndú; lr we;=<;a ùfï wxlh" ku iy we;=<;a 

ùfï .dia;=j iys; jd¾;djla ks¾udKh lrkak' bka miq  Report View j, isg 

Design View j,g udre lrkak' túg rEmh 9'36 u.ska oelafjk mßÈ jd¾;d 

ie,iqula Èiafõ'

rEmh 9'35 - 2013 j¾Ifha ,l=Kqj, tl;=j olafjk jd¾;dj
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rEmh 9'36 - jd¾;d ie,iqu

fuj,ï ;Srefõ ab f,i oelafjk fuj,u f;dard f.k Report Footer 
hgf;a ^rEmh 9'37 n,kak& mdG fldgqj msysgqjkak'hgf;a ^rEmh 9'37 n,kak& mdG fldgqj msysgqjkak'

rEmh 9'37 - mdG fldgqj msysgqùurEmh 9'37 - mdG fldgqj msysgqùurEmh 9'37 - mdG fldgqj msysgqùu

mdG fldgqj Unbound f,i ±lafõ' thg fya;=j thg lafIa;%hla mjrd 

fkdue;s neúks' thg we;=<;a ùfï .dia;=j, tl;=j ,nd .ekSug Property Sheet 
^rEmh 9'38 n,kak& tys Control Source bÈßfha we;s ;s;a ;=kla iys; fnd;a;u 

l%shd;aul lsÍfuka m%ldYk f.dvk.k ixjdo ljq¿j Èiafõ' ^rEmh 9'39 n,kak&

rEmh 9'38 - Property Sheet
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rEmh 9'39 - m%ldYk f.dvk.k ixjdo ljq¿j

we;=<;a ùfï .dia;=j, tl;=j ,nd .ekSug = Sum ([YsIH j.=j]![we;=<;a 

.dia;=j])  f,i ghsma lsÍfuka fyda tu m%ldYkh f.dvke.Sfuka miq OK lrkak' 

bka miq oiqk Design View j, isg  Report View fj; udre lrkak' túg we;=<;a 

ùfï .dia;=j, tl;=j oelafjk jd¾;dj o¾Ykh fõ' ^rEmh 9'40 n,kak&

 rEmh 9'40 - we;=<;a ùfï .dia;=j, tl;=j oelafjk jd¾;dj  
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jd¾;dj uqøKh lsÍu

oiqk Report View ys isg Print Preview fj; udre lrkak' rEmh 9'41 u.skaa 

oelafjk fuj,u l%shd;aul lrkak' wjYH msgm;a m%udKhla uqøKh lr.kak'

rEmh 9'41 - uqøK fuj,ï

^1&  bf,lafg%dksl o;a; iuqodhl we;s jdis úia;r lrkak'

^2& bf,lafg%dksl o;a; iuqodhl we;s ,laIK WodyrK iys;j úia;r  

     lrkak'

^3&  bf,lafg%dksl yd w;ahqre o;a; iuqodh ixikaokh lrkak'

^4&  o;a; .=ma; fla;kh (data encryption) hkq l=ula±hs úia;r lrkak'

^5&  lafIa;%" f¾fldav" j.= weiqßka iïnkaê; o;a; iuqodh (relational database)  
     iE§ we;s wdldrh úia;r lrkak'

^6&  m%d:ñl h;=r w¾: olajd WodyrK ;=kla ,shd olajkak'

^7&  ixhqla; h;=re (compsite key) w¾: olajd WodyrK ;=kla ,shd olajkak'

^8&  wd.ka;=l h;=r (foreinn key) w¾: olajd WodyrK ;=kla ,shd olajkak'

^9&  o;a; wkqmsgm;a ùu (data duplication) ys we;s wjdis myla ,shd olajkak'

^10& (a)  o;a; m%rEmhla (data type) hkq l=ulaoehs ,shd o;a; m%rEmh i`oyd WodyrK  

       imhkak'

   (b) ÿrl:k wxlh .nvd lrk lafIa;%hg (integer) o;a; m%rEmh jvd;au  

  iqÿiq j¾.h fkdjkafka uka±hs úia;r lrkak'

^11&  iïnkaê; o;a; iuqodhka ys Ndú;d jk one-to-one, one-to-many, many- 
         to-many iïnkaO;d úia;r lr WodyrK fol ne.ska ,shd olajkak'

^12&  o;a; iuqodhl l,ukdlrK moaO;shl (DBMS) mj;sk jia;+ka (objects)  

      fudkjd±hs úia;r lr tajdfha we;s m%fhdack ielúka úia;r lrkak'

  l%shdldrlu 
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tlsfkl iïnkaO j.= lsysmhla o;a; iuqodhla f,i w¾: olajkq ,efí'

j.=jl ;Srejla lafIa;%hla ^Field& f,i ye`Èkafõ'

j.=jl fma<shla frfldavhla ^Record& f,i olajkq ,efí'

bf,lafg%dksl o;a; iuqodhl jdis

 ² f;dr;=re fiùu jvd ld¾hlaIu ùu

 ² Wmia: msgm;a ,nd .ekSfï myiqj

 ² o;a; ;eïm;a lsÍug b;d wvq wdphk Odß;djla jehùu

 ² o;a; úYaf,aIKh b;d myiqfjka yd fõ.j;aj isÿlsÍfï  yelshdj

 ² o;a; yjqf,a Ndú;h

 ² o;a;j, iajdh;a;;dj

o;a; iuqodhl ,laIK

 ² o;a; iu;sßla;;dfjka úhqlal nj

 ² o;a;j, ix.;;dj mej;Su

 ² ld¾hlaIu;dj jeäùu 

 ² ksrjoH;dj jeäùu

 ² o;a;j, j,x.=;dj jeäùu

 ² o;a;j, wdrlaIdj jeäùu

j.=jl  frfldav  wkkH j y÷kd .; yels ;Srejla ^fyda ;Sre ixfhdackhla& 

m%d:ñl h;=r ^Primary Key& f,i ye`Èkafõ'

tla j.=jl lafIa;%hla ^fyda lafIa;% ixfhdackhla& uÕska fjk;a j.=jl fma<s 

wkkH j y÷kd .; yels kï tu lafIa;% wd.ka;=l h;=r ^Foreign Key& f,i 

ye`Èkafõ' 

wd.ka;=l h;=r uÕska j.= folla w;r iïnkaO;djla ^Relationship& f.dvkef.a' 

j.=jl tla tla ;Srej, o;a; kej; kej; we;=<;aùu o;a; wkqmsgm;a ùu ^Data 
Duplication& f,i ye`Èkafõ'

o;a; ;eïm;a lsÍfï § tl u o;a; j.= lsysmhl ;eïm;a ùu o;a; iu;sßla;;dj 

^Data Redundancy& f,i ye`Èkafõ'

tla lafIa;%lg wod< o;a; j¾.h o;a; m%rEmhla ^Data Type& f,i ye`Èkafõ'

iïnkaê; o;a; iuqodhl j.= w;r tlg-tl ^one to one&" tlg-nyq ^one to many& 
iy nyq-nyq ^many to many& f,i iïnkaO;d ;=kla mj;S'

o;a; we;=¿ lsÍug iy oelaùug o;a; wdlD;s ^Forms& m;%" Ndú; flf¾'

f;dr;=re ,nd .ekSu i|yd úuiqu ^Query& Ndú; flf¾'

f;dr;=re bÈßm;a lsÍu i|yd jd¾;d ^Report&  Ndú; flf¾'

idrdxYh
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